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Chapter

1 NX Help usability enhancements

What is it?

NX Help has a new interface that makes it easier for you to find information
and browse content.

Returns you to the Home page.

Displays the table of contents.

Lets you navigate back through the
hierarchy of Help categories.
Displays search results. The Search
box is available on every page.

Displays search tips.

Prints the current page.

Displays links to related and
supporting information.
Plays video animations. Voice
instructions are included.
Lets you send feedback on content.
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Click Preferences to change your search preferences. Enable Filter search
areas to search in just the areas of NX that you use.

Why should I use it?

• Search performance is improved. You do not have to click a button to
display the Search box. It is available at the top of the Help window.
This makes search easier to access and decreases search time. When you
click on a search results link, the page is displayed in the same browser
window to reduce window clutter. To return to the search results page,
use your browser’s Back button or click Search again. Search filtering
gives you control to search in specific areas of NX.

• Help is reorganized to make navigation more logical, to increase the
relevancy of search results, and to make search filtering more specific.

• Breadcrumb links are available on each page to help you keep track of
your location. A table of contents is still available, but is not displayed
by default.

• Links to all related information are displayed on the right side. You no
longer have to click the Options, How to, and other links on a page to
see related information. Links are organized by information type under
different headings.

Where do I find it?

Menu Help ® NX Help

Keyboard accelerator F1
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2 HD3D

Visual Reporting

Visual Reporting usability enhancements

What is it?

• A new report selection command on the Visual Reporting toolbar allows
you to quickly run visual reports from the toolbar at any time.

The Explore Visual Report toolbar is renamed the Visual Reporting
toolbar.

• Display of visual reports is enhanced.

o You can define group priority to focus visibility in case of overlapping
tags.

o New layout template files define the default contents and layout of
tool tips and of the Visual Reporting Information (Info View) dialog
box. You can modify the layout template files to change the defaults.
You can copy, modify, and then save template files with a new name in
order to reference the modified templates for individual report formats.
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o You can define custom tag icons, custom tool tips, and custom result
detail dialog boxes.

The bitmap image for the visual reporting tag.

A set of property information to include in either or both of
the following:

Visual reporting tag tool tips

Visual Reporting Information (Info View) detail dialog boxes

A message string that appears in the additional information
area of the Visual Reporting Information (Info View) dialog box.

• You can filter lists of part attribute names, lists of Teamcenter property
names, and lists of user-specified entries in visual reporting dialog boxes
by typing in an initial portion to match.

• You can send a report group or component part files to the Check-Mate
or Requirements Validation tool.

Why should I use it?

You can select, activate, and deactivate HD3D Visual Reports using minimum
options. You can make tags more distinctive according to report type and
choose the information you want to display in report results.
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Where do I find it?

Toolbar Visual Reporting
Resource bar HD3D Tools®Visual Reporting®Edit
Location in dialog
box

Visual Report Definition®Results group

File system %UGII_BASE_DIR%\UGII\visual_reports\
customization\templates\[language]

Visual Reporting functionality enhancements

What is it?

• New capability to select multiple report definitions at once in the dialog
box that appears when you click Open Report, or to define reports that
contain multiple top-level properties. While the reports are active, you
can switch among the top-level report properties in order to group and
sort reported data in different ways.

Use multiple-property reports to quickly group and sort data, and
color objects, based on different report properties without having to
sequentially run several different Visual Reports.

• You can compare properties in a scope term of a report definition.

• You can report on dates in report definitions.

• Units are displayed along with values in report results. By default,
Visual Reporting now uses the top level assembly part unit system in
conditions or grouping. You can specify a different unit system in the
visual reporting definition file.

• The part attribute type “null“ reports on parts and components for which
an attribute of a given name is defined, or on parts that do not include
an attribute definition of a given name, without regard to the attribute’s
value or type within the part or component.
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• Existing reports are updated to utilize the new features available in NX
8.0.

• New properties in queries and new visual reports.

New properties available for
visual reporting New visual reports

o Check-Mate results

o Check-Mate rule evaluation
result

o Requirements Validation status

o Last modified time

o Last modified user

o Parts modified in Teamcenter
since the start of the current
session

o Number of freedom degrees of a
component at its position related
to Assembly constraints

o Representation status

o Check-Mate results

o Check-Mate rule evaluation
result

o Requirements Validation status

o Representation status

o Parts modified since a given date
time

o Parts modified in Teamcenter
since the start of the current
session

o Parts created for a particular
program

o Status of parts currently in a
workflow†

o Status of parts currently in a
change process†

o Parts affected by a change order†

o Parts that have higher revisions
than the ones that are being
used in this assembly†

†These reports use Teamcenter
server side processing. Requires
Teamcenter 9.
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• New support for results of Teamcenter Report Builder (server-side)
reports.

Teamcenter 9 includes the following Report Builder (server side) reports
for use with Visual Reporting:

o Affected By Change Notice
o Affected by Change Request
o Affected by Problem Report
o Has Higher Revision
o Overall Status In Change Process
o Overall Status In Workflow

You can create additional server-side reports with the Teamcenter 9
Report Builder based on functions included with Teamcenter 9, or on
custom functions written to gather other Teamcenter data of interest.

• By default, Visual Reporting now uses case insensitive comparison in
conditions or grouping.

You can specify case sensitive comparison in the visual reporting
definition file.

• The ugmgr_vpximport utility for importing reports to Teamcenter has
been enhanced with new switches for improved usability.

• A new teamcenter_sample_reports_setup.pl perl script has been
added to the ugmanager folder for use in automatically importing into a
Teamcenter database the out-of-the-box report definition files included
with NX kits. The script includes an option to automatically create and set
the Teamcenter preference TC_NX_default_visual_report_folder_path
required for Visual Reporting.
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Where do I find it?

Prerequisite Teamcenter 9 is required for all server side reports.
Server side reports related to change management
require that the change management template is active
in Teamcenter.

Resource bar HD3D Tools®Visual Reporting®Open Visual Report
Location in dialog
box

Visual Report Definition®Report Property group

Toolbar Visual Reporting
Context menu While a multi-property visual report is active, in the

Visual Reporting Legend right-click a top-level (key)
category®Make Active Category.

File system %UGII_BASE_DIR%\ugii\visual_reports\
definitions\[language]

%UGII_BASE_DIR%\ugmanager

Requirements Validation

Requirements Validation in HD3D

What is it?

Use the Requirements Validation HD3D tool to create and import
requirements, create requirement checks, and locate checks in the model
geometry in order to check a design’s compliance with requirements. New
visual tags and reports in the HD3D tool and the graphics window provide
easy access to detailed information.

Note The Requirements Validation command and HD3D tool replace and
provide enhancements to functionality that in earlier releases was
provided by a Check Requirements command and dialog box.
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Where do I find it?

Menu Analysis®Requirements Validation
Resource bar HD3D Tools®Requirements Validation
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HD3D tags in product templates

What is it?

As the result of this enhancement, you can now add HD3D tags to a product
template to do the following:

• Provide a link to documentation for the template.

• Provide usage guidance for the template.

• Highlight failures or warnings generated by requirement checks in the
template.

• Document and guide WAVE re-parenting operations in the template.

Where do I find it?

Application Product Template Studio
Prerequisite You must add HD3D tags to a product template.
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3 Gateway

Repeat Command
Use Repeat Command to rerun any one of the last ten commands that you
used.

The last ten commands that you used appear in the Repeat Command
drop-down list in the order in which they were activated. The most recently
activated command appears at the top of the list. When you choose a
command from the list, NX validates whether the command can be rerun in
the current scenario, and then activates it. For example:

• If you choose the Extrude command from the Repeat Command list, the
Extrude dialog box opens.

• If you turned the WCS on the last time you chose the Display WCS
command, the WCS is turned off when you choose Display WCS in the list.

The Repeat Command list is cleared when you do any of the following:

• Change applications.

• Close a part.

• Enter or exit a task environment, such as the Sketch task environment.
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You can also run the last command that you used at any time when you
press F4.

MenuScript users can customize the Repeat Command list in the following
ways:

• Exclude commands from the list, using the NO_REPEAT keyword in
menu files.

• Customize the command name that appears in the list, using the
TOOLBAR_LABEL keyword.

Why should I use it?

To reduce the needed number of clicks and mouse movement.

Where do I find it?

Prerequisite

Only commands that appear on the menu bar, toolbars,
or shortcut menus that are available in the graphics
window, are displayed on the list.

Toolbar

Repeat Command

Standard®Repeat Command Drop-down list
Menu Tools®Repeat Command

Shortcut menu
Right-click in the background of the graphics
window®Repeat Command

Export CGM enhancement

What is it?

In exported CGM files, you can now output NX fonts as polylines and standard
fonts as text using the new Best Fit option, in the Export CGM dialog box.
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Why should I use it?

Using the Best Fit option ensures that exported CGM files work well with
other CAD applications, which otherwise may not have the capability to
render NX fonts.

Where do I find it?

Menu File®Export®CGM
Location in dialog
box

Export CGM dialog box®Settings group®Output Text
list®Best Fit

Customizing fonts

What is it?

You can now customize the font, the font style, and the font size of the text
that appears in the graphics window. For example, you can customize the
fonts used for view names, CSYS names, and object names.

You can change the default font to any standard font that is installed on your
system. No standard fonts are supplied with NX.
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Where do I find it?

Prerequisite

In the Visualization Preferences dialog box, on the
Names/Borders tab, the options to show object names
and view names must be selected.

Menu Preferences®Visualization
Location in dialog
box

Visualization Preferences dialog box®Color/Font
tab®Session Settings group

Shortcuts to common tools options

What is it?

You can now display the list options as shortcuts for the following common
tool options in dialog boxes:

• Specify Point

• Specify Vector

• Specify Plane

You can turn on the shortcuts by selecting Show Shortcuts. This gives you
easy access to the most recently used options.

Specify Point example

Specify Vector example

Specify Plane example
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Selection enhancements

What is it?

A new option is added to the Selection bar and tooltips are available at the
cursor location for objects in the graphics window.

Selection bar option

Clear Snap Point — Turns off all selected Snap Point options on
the Selection bar.

Tooltips at the cursor location

You can point to an object to view its name or type in a tooltip that appears
at the cursor location. In previous releases, this information was available
only on the Status line.

Preselected object with tooltip

Note Tooltips at the cursor location appear translucent in computers running
on the Windows XP or Windows 7 operating systems.

The tooltips are visible by default. To turn off these tooltips, clear the Object
Tooltip on Rollover check box.

Where do I find it?

Menu Preferences®Selection
Location in dialog
box

Selection Preferences dialog box® Highlight
group®Object Tooltip on Rollover check box
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On-screen input box enhancements

What is it?

Grips Grips have been added to on-screen input boxes. To move
an onscreen-input box, click the grip and drag the box to
a new location.

Selection options Selection options that are common to many dialog boxes
are now available from on-screen input boxes.

• Limits

• Location along an arc

• Chamfer types
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Display of object
selection

Why should I use it?

Mouse travel from the graphics window to the dialog box is reduced,
increasing efficiency.

Balloon tooltips for options

What is it?

Balloon tooltips are now available in some dialog boxes for options that need
more information. The tooltip appears when you move your cursor over the
label or icon. To turn on these tooltips, select the new Show Balloon Tooltips
on Dialog Options check box in the Customize dialog box.

NX Open users and Block UI Styler users can add balloon tooltips to the
dialog box options that they create, using block properties.

Where do I find it?

Menu Tools®Customize

Location in dialog
box

Customize dialog box®Options tab®Tooltips
group®Show Balloon Tooltips on Dialog Options
check box
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Toolbar access for commands

What is it?

You can now easily and quickly access the following commands from their
respective toolbars.

Location on toolbar Name of the command

Active Mockup Grid and Work Plane

Analyze Shape

Display Non-Proportional Zoom

Set Non-Proportional Zoom

Non-Proportional Zoom Options

Mirror Display

Set Mirror Plane
Direct Sketch Orient View to Sketch
Utility®Show/Hide
Drop-down list Show and Hide

Utility Object Preferences

View®View Operation
Drop-down list

Fit All Views

Set View to WCS

Perspective

Perspective Options
View®Rendering Style
Drop-down list Rendering Style

3-8 What’s New in NX 8



Gateway

View®View Layout
Drop-down list

Open Layout

New Layout

Update Display

Regenerate All Views

Replace View

Delete Layout

Save Layout

Save Layout As

Visualization

Line Antialiasing

Facet Settings

Face Edges

Facet Edges

Full Scene Antialiasing

Translucency

Random Color Display

Shuffle Random Color
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Common tool enhancements

What is it?

The Point tool, Vector tool, and Plane tool are now enhanced as follows:

• When you edit an existing point, vector, or plane, NX remembers its type.

Note A point is displayed as a Fixed type when the point being edited
is not associative.

• A new Constructed option is available on the Point, Vector, or Plane lists.
This option is available when you edit a point, a vector, or a plane that
was created by using an option that is not available on the lists. To access
all the parameters of a constructed point, vector, or plane, you must use
the Point, Vector, or Plane dialog box.

Example If you use the Point dialog box to create an associative point that
includes an offset, when you edit that point, the point appears as a
Constructed point on the Point list.

Constructed point
icon

Constructed vector
icon

Constructed plane
icon

• When you choose a type for creating a point, vector, plane, or CSYS, the
dialog box remembers your selection when you reopen the dialog box.
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• When the tool option in the dialog box is the current selection option, the
display of the handle for the tool changes.

Tool Option
Handle display when
the tool option is the
current selection.

Handle display when
the tool option is
not the current
selection.

Specify Point

Specify Vector

Specify Plane

Shape: Plane object

Color: Handle selection
color

Size: Thicker than
previous wireframe.

Shape: Plane object

Color: Handle color

Size: Same as previous
wireframe

Attributes enhancements
NX attributes are now enhanced. You can:

• Define part attributes of the null, Boolean, string, integer, number, and
date data types.

• Use variable length arrays of supported data types to define values of
part attributes.

• Define the unit of measure for a part attribute of the number data type.

• Map attributes between NX and Teamcenter in a better way, as part
attributes are no longer restricted to the string data type.

• Edit the set of attributes in component instance objects.

• Access attributes through a single standardized user interface.

• Link expressions to attributes. Any change in the attributes is propagated
to the linked expressions.
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• Link attributes to expressions. The value of an attribute is calculated by
evaluating the linked expression.

Note Attributes of the date data type cannot be linked to or be linked
from expressions.

• Link an attribute in one object to an attribute in another object.

• Use the new Attribute Templates command to create and manage
attribute templates that you can use to create attributes.

When you use attribute templates, you can:

• Create attribute templates and save them either in a catalog file or in a
part file. You can share attribute templates saved in a catalog file across
sessions but you can use attribute templates saved in a part file within
the part only.

• Standardize attribute identification data, such as title, type, and
dimension.

• Store and standardize attribute semantic data, such as a note, or a
category.

• Store and standardize data that assists in the value entry of an attribute,
such as a default value, a constraint, or a value list.

• Specify whether attributes are to be copied when an object is copied.

• Define an alias for the title of a standard attribute. The alias may use
non-English characters.

• Use a mapped attribute to define user access to non-mapped attributes,
in Teamcenter Integration.

Where do I find it?

Attribute Templates command

Menu File®Utilities®Attribute Templates
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Viewing Files

Rotate enhancements

What is it?

When you use the Rotate command, you can now do the following:

• Switch between rotating a model about a set center of rotation and
standard rotation by holding Alt and dragging the middle mouse button.
In standard rotation, a model is rotated about an arbitrary center of
rotation located in the center of the view volume. Previously, you could
rotate a model either about a set center of rotation or by using standard
rotation, but you could not switch between the two modes of rotation. If
you wanted to return to a previously defined center of rotation, you had to
redefine it.

• Rotate a model with greater precision when you select the High Precision
Rotation preference.

High Precision
Rotation
preference

Provides finer control over rotations in the
current session. This preference is a session
setting. The default rotation provided when
you select this preference is the same as the
rotation provided when the environment variable
UGII_ROTATION_PRECISION_VALUE = 8.
For more precise rotations, specify a value from 1 to
25 for the UGII_ROTATION_PRECISION_VALUE
environment variable. A value of 1 provides standard
rotation and higher values provide finer rotation.

Note These enhancements apply only to mouse rotation and not to space
ball rotation.

Why should I use it?

Fine rotations are extensively used in design evaluation workflows to:

• Study a model and analyze its surface to identify flaws or imperfections.

• Ensure that the product appearance is acceptable from all possible
viewing directions.
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Where do I find it?

Menu Preferences®Visualization

Location in dialog
box

Visualization Preferences dialog box®View/Screen
tab®Session Settings group®High Precision Rotation
check box

Perspective Options

What is it?

Use the Perspective Options command to control the distance from the
camera to the target in a perspective view. The display updates instantly.

Trimetric camera far from target Trimetric camera close to target

Why should I use it?

Previously, to adjust the perspective you had to use the Camera®Edit
command, which is slow to start and not as easy to use as the Perspective
Options command.

Where do I find it?

Prerequisite

You must click Perspective on the View toolbar
in the View Operation Drop-down list or choose
View®Operation®Perspective.

Toolbar

View®View Operation Drop-down list®Perspective

Options

Menu View®Operation®Perspective Options
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Camera staging view enhancements

What is it?

The camera staging view has the following enhancements:

• The model is rendered using the Static Wireframe rendering style. As
objects are displayed using only edge geometry, this reduces the time
required to regenerate the model when you change the view.

• The orientation of the model when you enter the camera staging view is
now almost the same as the orientation in the original view. Previously,
the orientation was not predictable.

• The results view is now opaque and appears on the top right corner of the
camera staging view. Therefore, you cannot see any part of the model in
the camera staging view which appears in the same space as the results
view.

1. Camera staging view with handles for manipulating the target and
camera

2. Results view showing the view as seen by the camera

Why should I use it?

You can easily and quickly set up the camera using the enhancements
available in the camera staging view.
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Where do I find it?

Toolbar Visualization®Capture and Edit Camera
Menu View®Camera
Part Navigator Cameras

2D planar texture space enhancements

Enhancing 2D planar texture space mapping

What is it?

You can enhance 2D planar texture space mapping by updating the texture
space vectors based on the camera direction of the view.

The following options are available on the Texture Space tab in the Material
Editor dialog box:

Camera Direction
Plane

Automatically adjusts the texture space vectors — normal
vector or normal and up vectors — based on the camera
direction of the view.

The Camera Direction Plane option is similar to the
Arbitrary Plane option for texture space mapping.
When you select either option, texture is mapped onto a
user defined plane that is defined with a center point,
an up vector, and a vector normal to the plane. The
difference is that if you use the Camera Direction Plane
option, the texture space vectors adjust automatically
based on the camera direction of the view. The texture
orientation and position update dynamically as you rotate
the part. If you use the Arbitrary Plane option, you must
click Update Texture to Camera Direction to rectify the
texture space mapping.

Note When you update the texture space based on camera
direction, the texture orientation and positioning
update dynamically as you rotate the part. This could
degrade display performance, especially when the part
is large. To delay the update, use the Disable Dynamic
Update Camera Direction Plane Texture Space
option available in the Visualization Performance
Preferences dialog box. For more information, see
Disabling dynamic update for Camera Direction
Plane.
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Update Texture to
Camera Direction

Updates either the texture space normal vector or both
normal and up vectors based on the camera direction.
Use this option to rectify incorrect texture mapping which
appears when you use the Arbitrary Plane option.

Arbitrary Plane texture mapping
Arbitrary Plane texture

mapping after clicking Update
Texture to Camera Direction

Normal Vector
and Normal and
Up Vectors

Updates either the texture space normal vector or both
normal and up vectors based on the camera direction.

Texture space normal vector only
updated based on the camera

direction

Texture space normal and up
vectors updated based on the

camera direction

= Up Vector

What’s New in NX 8 3-17



Gateway

Why should I use it?

Existing texture space types suit regular shaped 3D models. For example, for
cylindrical 3D models, such as beer bottles, you can use the Cylindrical option
for texture space mapping. For irregular shaped 3D models, the WCS Auto
Axis option provides the best results. However, the WCS Auto Axis option
produces undesirable results at edges between planes. Use the new options
to rectify incorrect texture mapping.

Where do I find it?

Prerequisite

(Camera Direction Plane) Advanced Studio Display
mode must be enabled.

(Normal Vector and Normal and Up Vectors) Type must
be set to Arbitrary Plane or Camera Direction Plane.

(Update Texture to Camera Direction) Type must be set
to Arbitrary Plane.

Toolbar Visualize Shape®Materials/Textures
Menu View®Visualization®Materials/Textures
Location on dialog
bar Editor group®Launch Material Editor
Location in dialog
box Material Editor®Texture Space tab

Disabling dynamic update for Camera Direction Plane

What is it?

Use the Disable Dynamic Update Camera Direction Plane Texture Space
option to delay the update of texture orientation and position based on the
camera direction of the view.

When you select the Camera Direction Plane option for texture space
mapping in the Material Editor dialog box, the texture space vectors are
automatically adjusted based on the camera direction of the view. The
orientation and position of texture updates dynamically as you rotate the
part. Use this option to delay the update of texture orientation and position,
so that the update occurs only after you release the mouse button. For more
information about updating texture space vectors based on camera direction,
see Enhancing 2D planar texture space mapping.

Why should I use it?

When you update the texture space based on camera direction, the orientation
and positioning of texture updates dynamically as you rotate the part. This
could degrade display performance, especially when the part is large.
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Where do I find it?

Prerequisite

Rendering style must be set to Studio.

Advanced Studio Display mode must be enabled.

Camera Direction Plane must be selected in the Type
list on the Texture Space tab in the Material Editor
dialog box.

Menu Preferences®Visualization Performance

Location in dialog
box

Visualization Performance Preferences dialog
box®General Graphics tab®Session Settings
group®Studio Views

Facet Settings for visualization

Facet Settings for visualization

You can use the Facet Settings command to adjust the tolerances used for
generating facets for display of exact geometry (solid and sheet bodies) in
the graphics window.

You can:

• Modify the current resolution settings to control faceting. You can view,
edit, and save the current resolution settings to produce coarser or finer
tessellations.

• Maintain a constant view scale to ensure that the facets appear at the
same locations on the model, even when you modify the tolerance settings.
Previously, the facets appeared at different locations when you zoomed
in or out. Now, you can specify a constant facet to view scale to ensure
that facets appear at the same location. This is especially useful when
you want to evaluate a design.

• Reproduce faceting when you specify a constant view scale. This setting
is saved with the part file.

• Prevent your specified tessellation parameters or facet scale from
changing by setting Update = None.

Resolution setting values are predefined in the Facet Settings section of
the Customer Defaults dialog box.

Tip To find a customer default, choose File→Utilities→Customer Defaults,

and click Find Default .
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To evaluate a design, you might want to make minor adjustments to the
default facet settings to isolate a problem on a particular model. You can
customize the facet settings to produce tessellations that are either coarser or
finer than the default tessellations.

Note Very fine tolerance settings present a smooth surface on points of
inflection, but at a high performance cost. As finer tolerance settings could
generate millions of facets, NX requires time to produce the tessellations.

The new Facet Settings command provides new facet setting options for
visualization and easy access to the following options:

• Facet settings that were previously available only in the Part Settings
group on the Faceting tab in the Visualization Preferences dialog box.

• Facet setting customization options that were previously available only in
the Customize Tolerance Settings dialog box.

Where do I find it?

Toolbar Visualization®Facet Settings
Menu View®Operation®Facet Settings

Note All options available in the Facet Settings dialog box are also available
in the Visualization Preferences dialog box®Faceting tab®Part Settings
group.

Facet Settings options for visualization

What is it?

The new Facet Settings command provides new facet setting options and
easy access to the following options:

• Facet settings that were previously available only in the Part Settings
group on the Faceting tab in the Visualization Preferences dialog box.

• Facet setting customization options that were previously available only in
the Customize Tolerance Settings dialog box.

3-20 What’s New in NX 8



Gateway

The following options are either renamed or are newly available in the Facet
Settings dialog box.

Shaded Views and Advanced Visualization Views group
New name Old name Description
Resolution Tolerance

This has a new option
called User defined.

Update Update Mode

Facet to View
Ratio

This is a new option. Adjusts the facet to view scale.

Automatic: Automatically adjusts
faceting based on the view scale.
When you zoom in or zoom out,
the location of facets on the model
changes. This is the default value.

User Defined: Maintains a constant
facet to view scale specified by Facet
Ratio.

Facet Ratio This is a new option. Available when Facet to View Ratio
is set to User Defined.

Specifies a constant facet to view
scale to ensure that facets appear
at the same locations on the model
even when you zoom in or zoom out.
Specify a ratio up to ten times the
actual basic setting. This setting is
saved in the part file, so that you can
reproduce the same faceting when
required.

Resolution Tolerances subgroups

New name Old name Description
Edge Edge Tolerance
Face Face Tolerance
Angle Angle Tolerance
Width Width Tolerance
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Reset This is a new option. Resets the resolution tolerance values
of the selected Resolution setting to
the values specified in the customer
defaults.

Note If you select the Render Solids Using Stored Facets check box in the
General Graphics tab of the Visualization Performance Preferences
dialog box the shaded views are rendered using stored facets. This
overrides the settings in the Shaded Views group in the Facet Settings
dialog box and the specified values of tolerance are ignored.

Use one of the following methods to update the stored facets:

• Select View®Layout®Update Display.

• In the Visualization Performance Preferences dialog box, click the
General Graphics tab and in the Shaded Views group clear the
Render Solids Using Stored Facets check box.

Why should I use it?

You can use the Facet Settings command to easily control faceting and modify
the attributes of the current resolution.

Where do I find it?

Facet Settings command

Toolbar Visualization®Facet Settings
Menu View®Operation®Facet Settings

Part Settings group

Menu Preferences®Visualization
Location in dialog
box

Visualization Preferences dialog box®Faceting
tab®Part Settings group

Render Solids Using Stored Facets check box

Menu Preferences®Visualization Performance
Location in dialog
box

Visualization Performance Preferences dialog
box®General Graphics tab®Shaded Views group

Update Display command

Menu View®Layout®Update Display
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Customizing a command dialog box
Use the Save Favorite and Save Favorite As commands to save a single or
multiple versions of a command dialog box. If there are specific values and
layouts of a dialog box that you use frequently, for instance if you expand or
collapse certain groups, then you can set up the dialog box as you frequently
use it, and save it as a favorite. This saves you from re-entering values for
often-used cases.

Note You cannot save on-screen selections that you make in NX as favorites.

You cannot save dialog favorites in Teamcenter.

You can:

• Save multiple versions of the same command.

• Use the saved favorite in current and future NX sessions.

• Access the saved favorite from the role that you created it in. The saved
favorite is added to the role that you save it in.

• Open the saved favorite in existing commands.

For example, you can customize the Measure Distance command to create
a new layout by displaying only the start and end points and hiding all
the other groups in the Measure Distance dialog box.
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• Add the saved favorite to a toolbar or a menu for easy and direct access.

For example, you can load the customized version of theMeasure Distance
command in the Analysis menu or on the Utility toolbar.

Where do I find it?

Location in dialog
box

Click Show Menu on the dialog title bar®Save
Favorite / Save As Favorite
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True Studio Task

True Studio Task

What is it?

You can use the True Studio Task environment together with the

Advanced Studio Display mode for easy setup and realistic visualization
of your model and to generate static images.

Note Advanced Studio Display mode requires a Studio Visualize license.

You can:

• Generate High Quality Images.

Note High Quality Images require a Studio Render license.

• Access all Advanced Studio Display mode features.

• Have access to all visualization tools in NX in one place.

• Generate static images of real-time display using Capture Studio Image

.

You can also add effects of:

• System Scenes

• Advanced Studio Ambient Shadows

• Different System Materials and Studio Global Materials

• Advanced Studio Image-Based lighting

• Advanced Studio Render Methods

What’s New in NX 8 3-25



Gateway

Where do I find it?

Toolbar Visualize Shape toolbar

Menu View®Visualization®True Studio Task

Studio Global Materials

Use Studio Global Materials to simplify material set up in Studio, Advanced
Studio and High Quality Image rendering modes. You can control the Studio

Global Materials in the True Studio Task environment.

NX displays a Studio Global Material on the model geometry when no
material is assigned.

You can choose from the following global materials:

• Plastic Object Colors

• Shiny Metal Colors

• Clay

• Plasticine
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• Chrome

You can customize the default Studio Global Material by using the Studio
Global Material customer default.

Colorwash Global Materials use the object color along with the material
characteristics, such as shiny metal, when displaying the model geometry.

Plastic colorwash Shiny metal
colorwash

Clay

Where do I find it?

Studio Global Material

Prerequisite
True Studio Task needs to be selected from the
Visualize Shape toolbar.

Toolbar

True Studio®Studio Global Material Drop-down list

Studio Global Material customer defaults:

Menu File®Utilities®Customer Defaults
Location in dialog
box Gateway®Visualization®Materials/Texture tab

Advanced Studio Ambient Shadows

Use the Advanced Studio Ambient Shadows command to produce more
realistic shadows for advanced studio views. This command produces
shadows by considering the ambient lighting of the entire scene, instead of a
single light source. It adds depth to the model and helps you perceive the 3D
shape of the model better. Areas that are partially hidden by other objects,
such as convex corners, are darkened.
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Shadows rendered considering the
ambient lighting

Shadows rendered using a single
light source

When you use the command, you can:

• Create new visualization scenes with different Advanced Studio Ambient
Shadows settings.

• Edit the Advanced Studio Ambient Shadows settings in the Scene
Editor dialog box to produce optimal results for the part. The results are
displayed dynamically. The settings are saved with the part.

• Delay the update of the shadows by using the Disable Dynamic Update
Advanced Studio Ambient Shadows Visualization preference.

Note The real time ambient shadow rendering could degrade display
performance, especially when the part is large and if you are not using
high end graphics devices. You can use this preference to delay the
update of shadow orientation and position, so that the update occurs
only at the end of dynamic viewing.
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Where do I find it?

Prerequisite

Advanced Studio Ambient Shadows is supported only
on devices that support the Advanced Studio Display
mode and requires availability of DirectX 10.

The Advanced Studio Display mode must be enabled.
On the Visualize Shape toolbar, click Advanced Studio

Display , or choose View®Visualization®Advanced
Studio Display to enable the Advanced Studio Display
mode.

Note If your device does not support Ambient Shadows,
you will get an error message stating the same.

Advanced Studio Ambient Shadows command

Toolbar

Visualize Shape®Advanced Studio Ambient Shadows

Advanced Studio Image-Based Lighting

What is it?

Use Advanced Studio Image-Based Lighting to add realistic lighting to 3D
scenes.

Image-Based Lighting uses light from the surrounding scene during
rendering to create more realistic display.

Note This functionality is available only on devices that have the Advanced

Studio Display mode available and enabled.

Image-based Lighting: Off Image-based Lighting: On
Notice the harsher lighting from the
default scene lights directed from the

left and right

Notice the softer lighting from the
light boxes in the environment

image
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Why should I use it?

Use this to make Advanced Studio Display rendering more realistic
and to match HQI rendering better.

Where do I find it?

Prerequisite
The Advanced Studio Display mode must be
enabled.

Menu View®Visualization®Scene Editor

Toolbar Visualize Shape®Scene Editor
Location in dialog
box Global Illumination tab

Car paint material shader

What is it?

Use this material shader to simulate the effects of paint used in the
automobile industry.

The Car Paint material shader has the following components:

• Base color

• Metallic flake

• Lacquer

You can use the car paint material shader only in:

• Advanced Studio real-time display mode.

• High Quality Image static rendering.

A new set of System Materials based on the Car Paint material shader:
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Why should I use it?

Use car paint material shaders for realistic rendering of parts.

Where do I find it?

Toolbar
True Studio®Materials/Textures ®Material Editor
dialog box

Menu
View®Visualization®Materials/Textures®Material
Editor dialog box

Location in dialog
box General®Type®Car Paint

Resource bar System Materials ®automotive folder

Advanced Studio Render Methods

What is it?

Use the Advanced Studio Render Methods to choose quality and performance

trade-offs for the Advanced Studio Display mode.
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Full Render Improved Render Preview Render

Provides the best quality
display by including all
Advanced Studio effects.

Provides a fast display
by eliminating some
Advanced Studio effects.

Provides a fast quality
display by eliminating
many Advanced Studio
effects.

The following features are present in the Advanced Studio Display
mode, depending on the Render Method selected:

Advanced Studio
Rendering Feature

Full Render Improved Render Preview Render

Soft Shadows
Soft Shadows during
dynamics
Ambient Shadows
Ambient Shadows
during dynamics
Image-Based
Lighting
Image-Based
Lighting during
dynamics
Floor Reflections
Floor Reflections
during dynamics
Entire update during
dynamics

Note

• Default Render Method is set to Improved Render.

• Individual UI controls do not change depending on the Render Method.
You will be warned when a low Render Method is enabled.
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• Visualization Performance Preference settings take precedence
over Advanced Studio render settings.

For instance, the Image-Based Lighting dynamic update is supported
in Full Render mode. However if Disable Dynamic Update Advanced
Studio Image-Based Lighting is selected in the General Graphics tab

in Visualization Performance Preference , then you cannot get
dynamic update of Image-Based Lighting.

Where do I find it?

Prerequisite

Advanced Studio Display must be enabled.

True Studio Task must be enabled.

Toolbar

True Studio®Advanced Studio Render method

drop-down list®Full Render

True Studio®Advanced Studio Render method

drop-down list®Improved Render

True Studio®Advanced Studio Render method

drop-down list®Preview Render

System Materials

What is it?

You can use a new set of System Materials provided in NX. Use these
materials to work together with the set of System Scenes for realistic
visualization.

You can:

• Apply or drag a material from this palette to your selection. This

automatically copies the material to the Materials in Part palette.

• Copy materials from this palette to the Materials in Part palette and
edit to make your own material.
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Metal Plastic

Where do I find it?

Prerequisite
A part must be loaded or True Studio Task needs
to be selected from the Visualize Shape toolbar.

Toolbar True Studio®System Materials

Resource bar System Materials tab

System Scenes

You can use a new set of System Scenes provided in NX. Use these
scenes to work together with the set of System Materials for realistic
visualization.

You can:

• Use the System Scenes for high-end rendering techniques such as global
illumination with image-based lighting.

• Use the Scene Editor dialog box to make further changes to your
background, scenes, lighting, and reflection.
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• Applying system visualization scenes to your model overrides
all existing scene characteristics such as lights, shadows, and
environment.

• Use the True Studio Task Render Methods to define quality and
performance trafe-offs.

Grey Studio 1 Granite Counter

Where do I find it?

Prerequisite
A part must be loaded or True Studio Task needs
to be selected from the Visualize Shape toolbar.

Toolbar True Studio®System Scenes

Menu Studio®System Scenes

Resource bar System Scenes
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4 CAD (Design)

Sketching

Direct Sketching enhancement

The Direct Sketch toolbar is now available in the Shape Studio, and Sheet
Metal applications.

The following Sketch commands are now available on the Direct Sketch
toolbar:

• Project Curve

• Intersection Curve

• Intersection Point

• Trim Recipe Curve

Why should I use it?

Use the commands on the Direct Sketch toolbar to create a sketch on a plane
without entering the Sketch task environment. Direct sketching requires
fewer mouse clicks, which makes creating and editing sketches faster and
easier.

Where do I find it?

Application Modeling, Shape Studio, Sheet Metal
Toolbar Direct Sketch

Sketch dimension enhancement

Perpendicular, Horizontal, Vertical, and Angular dimensions maintain their
direction when the expression value is set to zero. You can also enter negative
values for these dimension types to achieve the same results as using the
Alternate Solution command.
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Where do I find it?

Application Modeling, Drafting, Shape Studio, Sheet Metal

Toolbar

(Modeling, Shape Studio, Sheet Metal) Direct Sketch

(Sketch task environment and Drafting) Sketch Tools

Menu

(Modeling, Shape Studio, Sheet Metal) Insert®Sketch
Constraint®Dimensions

(Sketch task environment) Insert®Dimensions

(Drafting) Insert®Dimensions

Sketch General Pattern

You can use the new General Pattern option in the Pattern Curve dialog
box to pattern a set of sketch curves:

• From a point to one or many points

• From a CSYS to one or many CSYS
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Selected curve for pattern.

Selected From Coordinate System
From a point or CSYS.

Selected To Coordinate Systems
To a point or coordinate system or many
points or coordinate systems.

Orientation = Follow Pattern

You can use the Lock Orientation option in the Pattern Curve dialog box to
lock the rotational angle constraint to follow the original curves. If you do not
select the option, you can change the rotation angle of the entire pattern.

Where do I find it?

Application Modeling, Drafting, Shape Studio, Sheet Metal

Toolbar

(Modeling, Shape Studio, Sheet Metal) Direct

Sketch®Pattern Curve

(Sketch task environment and Drafting) Sketch

Tools®Pattern Curve

Menu

(Modeling, Shape Studio, Sheet Metal, Drafting)
Insert®Sketch Curve®Pattern Curve

(Sketch task environment) Insert®Curve from
Curves®Pattern Curve

Location in dialog
box Pattern Definition group®Layout list®General

Sketch Pattern enhancement

There are four new pattern options in the Pattern Curve dialog box to pattern
a set of sketch curves. These options are especially useful when you add
sketch curves to a drawing.

These additional pattern curve options are only available if you disable

Create Inferred Constraints .
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Polygon Creates an equilateral polygon, defined by an origin, the
number of sides, and a radial component defined by the
object to pattern on the corner.

Spiral Creates an Along pattern where simplified control of the
spiral is provided. The object to pattern will always be
at the origin of the spiral. You can specify the distance
between the coils, left or right handedness, the total
number of turns, and a rotation angle.

Reference Creates a pattern based on another pattern.

Pattern
Increment

Increases or decreases the distance between each pattern
instance by the value specified. Pattern Increment can
be used with the Linear, Circular, Polygon, Spiral, and
Along layouts.
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Where do I find it?

Application Modeling, Drafting, Shape Studio, Sheet Metal

Prerequisite Disable Create Inferred Constraints

Toolbar

(Modeling, Shape Studio, Sheet Metal) Direct

Sketch®Pattern Curve

(Sketch task environment and Drafting) Sketch

Tools®Pattern Curve

Menu

(Modeling, Shape Studio, Sheet Metal, Drafting)
Insert®Sketch Curve®Pattern Curve

(Sketch task environment) Insert®Curve from
Curves®Pattern Curve

Location in dialog
box Pattern Definition group®Layout list

Delaying Sketch updates

Use the Delay Update During Edit of Sketch to delay updating the model from
the sketch while sketching directly in Modeling, Shape Studio, or Sheet Metal.

You can then use the Update Model from Sketch command to update the
model to reflect all the changes you made to the sketch.

Why should I use it?

When you edit a sketch directly in an application, the dependent features are
updated for every sketch modification you make. You can use these commands
to streamline the editing of a sketch that has many dependant features.

You can first implement a series of sketch edits and then see the results of
the edits. This creates a streamlined workflow because you update the model
when you are ready.

Where do I find it?

Application Modeling, Shape Studio, Sheet Metal

Toolbar

Direct Sketch®Delay Update During Edit of Sketch

Direct Sketch®Update Model from Sketch
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Menu

Tools®Update®Delay Update During Edit of Sketch

Tools®Update®Update Model from Sketch

Group commands

What is it?

The terminology and interaction of Group commands is now consistent across
all NX applications.

• You can now create sketch groups when working in Drafting.

• When a sketch is in Modeling and in Drafting, you can select curves and
dimensions and group them using the shortcut menu.

• In the Part Navigator, in the Drafting application, sketch groups now
appear under the sketch node in the sheet and the view sketch leaves
of the tree hierarchy.

• Group labels and their function are now as follows in all applications:

o New Group — Creates a new regular group

o New Sketch Group— Creates a sketch group

o New Active Sketch Group— Creates a new empty active sketch group

Where do I find it?

Application Modeling, Shape Studio, Drafting, Sheet Metal

Menu

Format®Group®New Group

Format®Group®New Active Sketch Group

Synchronous Modeling

Cross Section Edit enhancement

You can now use the Edit Cross Section command in History Mode. The
sketch of the cross section is saved and you can use this for further edits.

When you section a model, you can:

• Section multiple bodies.

• Select individual faces.

• Exclude holes and blends.
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• Add sketch constraints.

Where do I find it?

Application Modeling, Shape Studio, Manufacturing

Toolbar Synchronous Modeling®Edit Cross Section
Menu Insert®Synchronous Modeling®Edit Cross Section

Reorder Blends

Use the Reorder Blends command to change the order of two intersecting
blends of opposite convexity. For example, from “B overflows A” to “A
overflows B”.
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Why should I use it?

You can reorder blends:

• When re-creating the blends in a different order would be too time
consuming.

• To change the overflow of two blended edges in just one area.

• In parts with or without a feature history.

Where do I find it?

Application
Modeling, Shape Studio, Advanced Simulation, and
Manufacturing

Toolbar Synchronous Modeling®Reorder Blends

Menu
Insert®Synchronous Modeling®Detail
Feature®Reorder Blends

Delete Face enhancement

When you use the Delete Face command you can now delete a face without
healing neighboring faces when you clear the new Heal check box. If you
delete a face on a sheet body, the result is a sheet body with open edges. If
you delete a face on a solid body, the solid body is converted to a sheet body.

Without the Heal option With the Heal option
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Where do I find it?

Application
Modeling, Shape Studio, Advanced Simulation,
Manufacturing

Toolbar Synchronous Modeling®Delete Face
Menu Insert®Synchronous Modeling®Delete Face
Location in dialog
box Settings group®Heal check box

Improved surfaces when extending freeform faces

What is it?

Making face modifications using some Synchronous Modeling commands,
such as Move Face, Make Coplanar, and Linear Dimension, can now result in
extended surfaces that are of substantially improved quality.

Setting the new Surface Extension Method preference to Soft extends faces
smoothly as curvature continuous C2 surfaces.
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Setting the Surface Extension Method preference to Linear extends faces
using the original NX algorithm, which produces a less smooth surface with
additional, unnecessary C0 knots and surface poles.

Where do I find it?

Application Modeling
Menu Preferences®Modeling
Location in dialog
box Freeform tab, Surface Extension Method set to Soft
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Face Region Boundary enhancement

What is it?

You can now use the Face Rule option Region Boundary Faces for selecting
faces in Historymode when using the Pull Face and Offset Region commands.

Curves on top face of part

Portion of face selected using
Region Boundary Faces

Why should I use it?

When you are in History mode and need to Pull or Offset a Region of faces,
and need to select a portion of a face limited by curves.

Where do I find it?

Application Modeling, Shape Studio
Selection bar Face Rule®Region Boundary Faces.

Prerequisite

Synchronous Modeling→Pull Face or Offset

Region .

Interpart selection in Synchronous Modeling

What is it?

You can now use the following Synchronous Modeling commands to select
interpart objects:

• Make Coplanar

• Make Coaxial

• Make Symmetric

• Make Tangent

• Make Parallel
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• Make Perpendicular

• Paste Face

• Linear Dimension

• Angular Dimension

• Replace Face

You can specify interpart selections using the Selection Scope and

Create Interpart Link options on the Selection bar.

Where do I find it?

Application Modeling
Toolbar Selection bar

Move Face direction and location enhancements

What is it?

You can now set direction and location parameters directly from the graphics
window when working with the Move Face command.

After selecting a face to move you can:

Set the linear direction
Click the distance axis (stem) of the dimension handle and then define a
direction by clicking an object or using OrientXpress.
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Set the angular direction
Click the angle axis (hoop) of the dimension handle and then define a
direction by clicking an object or using OrientXpress.

Set the handle location
Move the combined linear/angle handle to a new location by clicking its
point and either selecting or dragging to a new point.

Angular and linear transforms
Drag the angle handle on the hoop to transform the selected face in the
angular direction.
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Drag the distance handle to transform the face in the linear direction.

Note The angle axis hoop appears when the linear direction is parallel with a
global axis (x, y, or z).

Why should I use it?

You can now interact directly with the objects in the graphics window without
using the dialog box to set the options.

Where do I find it?

Application Modeling

Toolbar Synchronous Modeling®Move Face
Menu Insert®Synchronous Modeling®Move Face

Modeling

Pattern Feature

Use the Pattern Feature command to create patterns of features (linear,
circular, polygon, etc.) with various options for defining pattern boundaries,
orientation of instances, clocking and variance.

• You can create pattern features using a variety of pattern layouts.

Linear

Circular

Polygon

Spiral

Along

General

Reference
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• You can fill a specified boundary with a pattern feature.

• For a Linear layout, you can specify a Symmetric pattern in one or both
directions. You can also specify to Stagger columns or rows.

• For a Circular or Polygon layout, you can choose to radiate a pattern.

• You can define a Pattern Increment by using expressions to specify
pattern parameters.

• You can export pattern parameter values to a spreadsheet and make
positional edits that are propagated back to your pattern definition.
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• You can explicitly select individual instance points for clocking,
suppression and variance of pattern features.

• You can control the orientation of a pattern.

Orientation same as input
Orientation follows pattern

(circular)

• You can choose between Simple and Variational pattern methods.

Where do I find it?

Application Modeling and Shape Studio
Prerequisite History mode

Toolbar Feature®Pattern Feature
Menu Insert®Associative Copy®Pattern Feature

Studio Spline enhancements

What is it?

The Studio Spline command has been enhanced in the following ways.

• You can now switch between Through Points and By Poles spline types.

o When you switch from Through Points to By Poles, the through points
and any internal constraints are deleted.

o Only the start and end constraints are retained.
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• When you define a By Poles studio spline and reference existing geometry,
you can define G1, G2 and G3 constraints for the first spline point
immediately after you specify the point.

• You can specify degree control for a single segment studio spline. The
number of poles is automatically adjusted depending on the degree you
specify.

• There are two new inferred constraints available.

o Normal – You can infer a G1 constraint from the natural normal of
a curve or surface.

o Perpendicular to Curve or Edge – You can infer G1, G2, and G3
constraints from a curve on surface or surface edge.
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• There are two new methods available for specifying G1 or G2 constraints.

Numeric specification of tangent
magnitude

Numeric specification of curvature
radius

• When you mirror studio splines, you can symmetrically constrain an end
point so both splines are tangent continuous.

• You can move existing poles or points in the following ways:

o Within the view plane.

o Along a specified vector.

o Within a specified plane.

o Along WCS axes or principal WCS planes.

o Normal to the spline.

Note

Use the OrientXpress tool to help specify vector and
planes during pole and point movement.
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• When you move poles and points in the view plane, you can use the Shift
key for exact vertical and horizontal movement.

• You can now decide how a spline is updated when parents of its
constraints are modified.

o You can specify that the spline is updated so all points and poles
between the updated point and the next fixed point are moved
proportionally.

End point of the vertical line is a
defining point of the spline.

When the line is moved, the
unconstrained points are updated
proportionally in relation to the
next constrained points.

o You can specify that only the point of the updated constraint is moved.

• You can now extend or shorten a studio spline.

Positive
value
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Negative
value

o When you extend a spline, it creates a natural extension on top of the
spline; the original spline is not modified.

o When you extend or shorten a spline, it does not change the endpoint.

o You can modify the extension during an edit.

• You can use the Undo command (Ctrl-Z) to undo any changes to the input
spline parameters as long as the dialog box is open and you have not
clicked OK or Apply.

Where do I find it?

Application Modeling and Shape Studio

Toolbar Curve®Studio Spline
Menu Insert®Curve®Studio Spline

Copying symbolic threads

What is it?

You can now use Copy Threads option when creating copied bodies.

You do not need to re-create symbolic threads that look the same as the
symbolic threads on the source body for the following copied bodies in CAM
and Drafting:

• Linked bodies

• Extracted-bodies

• Mirrored-bodies
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Where do I find it?

Application Modeling, Shape Studio, Sheet Metal, Manufacturing

Toolbar

Assemblies®WAVE Geometry Linker

Feature®Associative Copy Drop-down list®Extract

Body

Feature®Associative Copy®Mirror Body

Feature®Associative Copy®Instance Geometry

Menu

Insert®Associative Copy®WAVE Geometry
Linker®Body

Insert®Associative Copy®WAVE Geometry
Linker®Mirror Body

Insert®Associative Copy®Extract Body®Body

Insert®Associative Copy®Mirror Body

Insert®Associative Copy®Instance Geometry
Location in dialog
box Settings group®Copy Threads check box

Paste Feature enhancements

What is it?

You can now more easily resolve external parent references and understand
dependencies when you paste a feature.

• Parent references now appear in the Paste Feature dialog box with
understandable descriptions.

• You can also see additional information about parent references and their
resolution.

• You can resolve dependency references using methods that were available
when the feature was originally created.

• You can specify that the dependency geometry be automatically extracted,
either associatively or non-associatively.

What’s New in NX 8 4-21



CAD (Design)

Why should I use it?

Use Paste with the Paste Feature dialog box when you want to create a copy
of a previously modeled feature.

Where do I find it?

Toolbar Standard®Paste ®Paste Feature dialog box
Menu Edit®Paste®Paste Feature dialog box

Advanced Curve Fit

What is it?

The Advanced Curve Fit option has been added to the Project Curve, Offset
Curve and Intersection Curve commands. This option provides advanced
control of the parameterization of the output curves and replaces the Curve
Fit options of previous releases.

Advanced Curve Fit provides four curve fitting methods:

• Degree and Segments – Use this option to specify the degree and segment
of output curves. This provides explicit control on the parameterization
of output curves

• Degree and Tolerance – Use this option to specify the maximum degree
and the tolerance to control the parameterization of the output curve.

• Keep Parameterization – Use this option to inherit the degree, segments,
pole structure and the knot structure from the input curve (or, in the case
of Intersection Curve, the input surface) and apply it to the output curve.

• Auto Fit – This replaces the Advanced option of previous releases.
Use this option to specify the minimum degree, the maximum degree,
the maximum number of segments and tolerance to control the
parameterization of the output curve.

If the output curves do not meet the specified tolerance, then an Alert
message is displayed to inform you that the specified tolerance is not met.

The Align Curve Shape option has been added to the Project Curve and
Offset Curve dialog box settings.

When selected, Align Curve Shape applies the pole distribution of the input
curve to the projected or offset curve regardless of the curve fitting method
used.
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Where do I find it?

Application Modeling and Shape Studio

Toolbar

Curve ® Project Curve

Curve ® Offset Curve

Curve ® Intersection Curve

Menu

Insert ® Curve from Curves ® Project

Insert ® Curve from Curves ® Offset Curve

Insert ® Curve from Bodies ® Intersect
Location in dialog
box Settings group

Blend enhancements

What is it?

Both Face Blend and Edge Blend now support conic blends.

Conic blends have a soft appearance and are used to improve the aesthetic
quality and formability of cast and sheet metal parts.

Changes to
conics in Face
Blend

Face Blend now has two types of conic blends under the
Shape option menu:

• Symmetric Conic

Employs a single set of handles to simultaneously
control both edges of the blend to provide blend
symmetry.
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• Asymmetric Conic

Uses individual handles to control the edges of the
blend, letting you vary the blend on each edge.

Separate conic methods options with their own controls
simplify creating the default conic face blends.

Conic shape
added to Edge
Blend

As with Face Blend, Edge Blend has a new Shape option
menu to let you create conic shaped blends.

Conic Method Conic methods provide choice and flexibility in helping
you determine the optimum conic method based on your
requirements.

You can create the following conic blend shapes:

• Boundary and Center

• Boundary and Rho

• Center and Rho

There are also these additional enhancements to blends.

Trimming a blend In Edge Blend, you can now use an edge or a face as a
limiting object. You can reverse the direction of the edge
limit type to see alternate solutions for either side of the
limit edge.

In Face Blend, the Overriding Trim Objects option is
simplified for consistency and improved ease of use.

Stop Short of
Corner handles

In Edge Blend you can now drag the Stop Short of
Corner handles across the end of an edge and onto an
adjacent edge. This can reduce the occurrence of tiny
blends (or slivers) occurring on the blend. This improves
its quality and avoids the need to manually construct
blend patches to fill any gaps.
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Why should I use it?

You can now use some of the more advanced, previously unavailable blending
options with simple edge blends.

For both edge and face blends, you can create blends that enhance the
aesthetic appearance of your products while also improving their formability
and capacity to be manufactured from cast and sheet metal parts.

Where do I find it?

Application Modeling, Shape Studio

Toolbar

Feature®Edge Blend

Feature®Face Blend

Menu

Insert®Detail Feature®Edge Blend

Insert®Detail Feature®Face Blend

Optimizing curves

What is it?

You can use the new Optimize Curve option in the Modeling Preferences
dialog box to make features more tolerant to change.

The option helps prevent failures when input curves are changed and the
features are updated.

The option introduces an allowed gap size between curves in a selected string
by multiplying the current Distance Tolerance and Angle Tolerance by the
Optimize Curve Tolerance Factor (below the Optimize Curve check box). Any
gap or overlap within that size is removed in the output curve when you
use the following commands:

• Ruled, Through Curves, Through Curve Mesh, Sweep Along Guide,
Swept, Section Surface, and Law Extension Surface.

• Tube

• Project Curve, Intersection Curve, Join Curves, and Offset Curve in
Face.
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Original curves selected for a
section string, with gap.

Resulting optimized curve
used for surface generation (or the
projected or intersection curve)
using the allowed gap size derived
by multiplying the Distance
Tolerance and the Optimize Curve
Tolerance Factor.

The Optimize Curve check box is cleared by default.

Why should I use it?

You can overcome poorly constructed curves that cause the features using the
string of curves to fail when you create or update them.

Where do I find it?

Application Modeling, Shape Studio, NX Sheet Metal

Prerequisite
In the Modeling Preferences dialog box, the Optimize
Curve check box must be selected.

Menu

Preferences→Modeling→General→Optimize Curve
File→Utilities→Customer
Defaults®Modeling→General→Tolerances/Scales.

Changing hole types during edit

What is it?

When you edit a hole of one of the following hole types, you can now change it
to any of these other types:

• General Hole

• Drill Size Hole

• Screw Clearance Hole

• Threaded Hole

Note When you edit a hole of the Hole Series type you cannot change it to
any other hole type; nor can you change any other hole type to the Hole
Series type.
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Where do I find it?

Application Modeling
Toolbar Edit Feature®Edit Feature Parameters

Menu

Edit®Feature®Edit Parameters

Edit®Feature®Edit with Rollback

Graphics window

Double-click a hole feature

Right-click a hole feature and choose Edit Parameters

Right-click a hole feature and choose Edit with Rollback
Location in dialog
box Type group, Type list

Draft feature enhancement

What is it?

When you add draft to a part that contains blends it is no longer necessary to
reorder the blends to be after the draft feature in the Feature Navigator. The
blends will remain tangent with the drafted face.

Blends are not tangent. Blends are now tangent.
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Where do I find it?

Application Modeling, Shape Studio

Toolbar Feature®Draft
Menu Insert®Detail Feature®Draft

Internationalization of expressions

What is it?

When you create an expression, you can now type the expression name in a
supported international language (locale).

DesignLogic functions can accept such localized expression strings as
parameters, and return the strings in the same locale.

Why should I use it?

This enhancement is useful if you run NX in languages other than English.

Where do I find it?

Application Modeling, Shape Studio
Menu Tools®Expression

Location in dialog
box

Name box

Formula box

Feature and relations Browser

What is it?

The new Browser replaces the former Feature Browser with a graphic view
of features and their relations.

The browser illustrates how features (and some non-features) are related.
You can browse a feature to understand cause and effect:

1. What ancestors affect a feature?

2. If you edit a feature what descendents might be affected?

When you roll over a node in the browser, the respective object highlights in
the graphics window and in the Part Navigator, either as it exists now or as it
was when it was created (depending on the setting of the Highlight Original
selection preference).
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The following types of features appear in the new Browser:

• Body-based features

• Curve features

• Point features

• Datum features

• Sketch features
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You can interact with nodes in the browser display.

• To expand a node click the node.

• To display a shortcut menu, right-click a node.

• To edit a node, double-click the node.

You can also browse non-feature relations.

• Expressions (both feature expressions and user expressions)

• Non-feature geometry that has relations to a feature, such as a
non-associative curve that is the parent of a feature

You can perform the following actions on geometry in the browser:

• Hide a body (using Hide Body)

• Show parents

• Hide parents

• Show a body (using Show Body)

You can use the following commands on features in the browser:

• Suppress Feature / Unsuppress Feature

• Replace Feature

• Make Current Feature / Make Current Tool Feature / Isolate Tool Body

• Delete

• Properties

Why should I use it?

You can browse features in your part and review their relations with other
features and objects.

Where do I find it?

Application Modeling, Shape Studio
Menu Information®Browser
Graphics window Right-click a feature®Browse

Part Navigator

Right-click a feature®Browse

Right-click an expression®Browse
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Extract Body Here

What is it?

Use Extract Body Here to extract a body at a particular time stamp order
location.

Why should I use it?

You do not need to use the following commands to extract the body at a
particular timestamp: Make Current Feature, Extract (with the Fix at Current
Timestamp check box selected), and Make Current Feature again.

Where do I find it?

Application
Modeling, Shape Studio, Sheet Metal, Advanced
Simulation

Location in the
Part Navigator Right-click a node and choose Extract Body Here

Delete Edge

Use the Delete Edge command to delete an edge or chain of edges from a
sheet body. You can use it to remove a hole, or to untrim an exterior boundary.

If you want to remove specific edges from a sheet body, use the Delete Edge
command. If you use the Untrim command the sheet body is copied. The copy
is returned to its natural boundaries and you may need to retrim some edges.

Delete Edge Untrim
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Where do I find it?

Application Modeling, Shape Studio
Menu Insert®Trim®Delete Edge

Swept enhancements

What is it?

The Swept command has been enhanced in the following ways:

• You can now use the Blend interpolation method when sweeping more
than two sections along one guide.

This option has been added to the Linear and Cubic interpolation methods.

Linear Cubic Blend

• You can now use the Another Curve scaling option when creating a swept
feature using two guides.

o Use the Another Curve option to select a curve as a reference for
controlling the height of a swept surface.

o As Another Curve is a scale curve and not a guide curve, it does not
control the surface orientation, as is the case when you use the 3 -
guide method. This can help avoid surface distortion problems.
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3 Guides Another Curve

1. Section rectangle

2. Guides (3)

1. Section

2. Guides (2)

3. Another Curve

Where do I find it?

Application Modeling and Shape Studio

Toolbar Surface®Swept
Menu Insert®Sweep®Swept
Location in dialog
box Section Options group

Editing linked or extracted face/body enhancements

What is it?

When you replace the parents of a linked or extracted object, the direction
for the replacement object is now inferred from the replaced object. The
directions for both the replaced and the replacement objects are displayed for
comparison. You can now determine whether to reverse the direction.

Linked seed face being replaced
(deselected).

Replacement seed face
(selected).

Notice both direction arrows are
displayed.
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Why should I use it?

These enhancements ensure that downstream features do not fail when they
are updated.

Where do I find it?

Application Modeling, Shape Studio

Toolbar

Edit Feature®Edit Feature Parameters or Edit

with Rollback .
Menu Edit→Feature→Edit Parameters, or Edit with Rollback.
Graphics window Double-click an Extracted or Linked feature.

Relief added to threaded holes in a Hole Series

What is it?

You can now add relief to a threaded hole when it is part of a Hole Series.

The same Relief and Relief Chamfer options that are available with the
Threaded Hole type are now available with threaded holes in the Hole Series
type.

Where do I find it?

Application Modeling, Shape Studio

Toolbar Feature®Hole
Menu Insert®Design Feature®Hole

Location in dialog
box

Type group®Hole Series

Specification group®End tab®Form®Threaded

Specification group®End tab®Relief

Specification group®End tab®Relief Chamfer

Variable Offset enhancement

What is it?

When you use the Variable Offset command, you now have dynamic control
for the offset and location of each offset point.

• You can drag a point handle to an offset value or enter an offset value in
the on-screen input box or in the dialog box.

4-34 What’s New in NX 8



CAD (Design)

• You can drag the point location or enter the point U and V values into the
on-screen input box.

• You can select the Offset method to be Linear or Cubic.

• You can use Keep Parameterization to maintain the original surface
parameters in the Variable Offset surface.

• You can use Dynamic Deviation display for visual verification.

In this example, you can see the difference between the offset methods.

Linear Method Cubic Method

Why should I use it?

You can change the offset values and creation method while creating the
Variable Offset Surface.

Where do I find it?

Application Modeling and Shape Studio

Toolbar

Feature®Offset/Scale Drop-down®Variable Offset

.
Menu Insert®Offset/Scale®Variable Offset

Replace Feature

What is it?

The Replace Feature command lets you replace an original feature and its
dependents with a replacement feature. The command has the following
enhancements:
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• When you select a feature, either the original feature or the replacement
feature, the new Add Prior Features of Body option lets you automatically
select ancestor features of the body.

• You can select a dependent of the original feature for the replacement
feature. For example, you can replace an original body with an offset
of the body.

• When dependent features are changed from an original feature to a
replacement feature, only the dependents downstream of the latest
original feature will be updated.

Why should I use it?

This enhancement is useful if you model a basic design, add numerous
detailed features to it, and then model a new version of the basic design. The
enhancements to Replace Feature let you replace the original basic design
with the new version, while automatically switching the dependent detailed
features to the new version.

Where do I find it?

Application Modeling, Shape Studio

Toolbar Edit Feature®Replace Feature
Menu Edit®Feature®Replace

Location in dialog
box

Feature to Replace group®Related Features®Add
Prior Features of Body

Replacement Feature group®Related Features®Add
Prior Features of Body

Bridge enhancements

What is it?

When you use the Bridge command, you now have more control over the
surface parameters.

• You can drag the edges of a bridge surface onto the faces that correspond
to the primary input edges.
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• You can independently drag the bridge surface vertices to change the edge
length. Use this when bridge surfaces are not of even length.

Where do I find it?

Application Modeling and Shape Studio

Toolbar Feature®Detail Feature Drop-Down®Bridge
Menu Insert®Detail Feature®Bridge

Add references to part and object attributes with an expression

What is it?

You can create expressions that reference part or object attributes.

If the part or object attribute is later modified the expression is updated
automatically.
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Why should I use it?

Use attribute expressions when you need to refer to a part or object as an
expression that is dynamically updated.

Where do I find it?

Application Modeling, Shape Studio
Menu Tools®Expression

Location in dialog
box

Reference Part Attribute

Reference Object Attribute

Selection Intent available in commands when specifying points, vectors,
planes, and axes

What is it?

Selection Intent is available from within a command for the following option
and type settings:

Specify Point option, when the type is set to either of the following:

Point on Curve/Edge

Intersection Point

Specify Vector option, when the type is set to:

On Curve Vector

Specify Plane option, when the type is set to:

Tangent Plane

Why should I use it?

Using Selection Intent with Datum Plane, Datum Axis, associative Point,
and other commands that use these option types to specify points, vectors,
and planes will enable robust model update by allowing features to adapt to
changes to input geometry.

Where do I find it?

Application Modeling, Shape Studio
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Feature timestamp sequencing

What is it?

The feature timestamp order is updated in the Part Navigator when you
use feature groups.

• When you create or reorder feature groups, the member feature
timestamps are re-sequenced.

• When you create or reorder feature groups, the gaps in the feature
timestamp sequence are removed.

You cannot resequence features of some parent child relationships.

Reorder feature group

Previous result Updated result

What’s New in NX 8 4-39



CAD (Design)

Why should I use it?

• Child features appear in the correct location in the Part Navigator with
respect to their parents.

• Feature timestamps are generally in order, and the number of missing
timestamps are minimized.

• The sequential order of timestamps is not disturbed when you move
feature groups, and when you move features into, our of or between
feature groups.

Where do I find it?

Application Modeling and Shape Studio

Extension enhancements

What is it?

The Extension Surface command options are redesigned based on typical
surface extension workflows and the dialog box has been updated.

Type
• You can specify Edge or Corner as the extension type.

Edges to Extend
• When you use the Edge type, you can specify the edges to be extended.

Corner to Extend
• When you use the Corner type, you indicate a corner of a face to be
extended.

Extension
• For the Edge type, you can specify either a tangential or circular
method of extension and specify the distance of the extension either
by length or a percentage of the original face.
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Tangential example Circular example

• For the Corner type, you can specify a percentage of the original face
in the U and V directions to specify the size of the corner extension.

Note The Angled and Normal to Surface options that were available in
previous releases have been removed because similar functionality is
available in the Law Extension command.

Where do I find it?

Application Modeling and Shape Studio

Toolbar Surface® Extension Surface
Menu Insert®Flange Surface®Extension

Divide Curve Enhancement

What is it?

You can now divide curves using multiple bounding objects, when you set
Type to By Bounding Objects.

Why should I use it?

This enhancement lets you get multiple divide curve results using bounding
objects when you use the Divide Curve command.
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Where do I find it?

Application Modeling

Toolbar Edit Curve®Divide Curve
Menu Edit®Curve®Divide

Isoparametric Curve

You can create feature-based isoparametric curves from surfaces.

Isoparametric curves can be useful in constructing adjacent surfaces that
follow the flow lines of the parent surface.

Since Isoparametric curves are features they are easily edited and updated.

Note This command replaces the former Isoparametric Curve option found
under the Extract Curve command.

Where do I find it?

Application Modeling, Shape Studio
Toolbar Curve®Isoparametric Curve
Menu Insert®Curve from Bodies®Isoparametric Curve

Referencing feature dimensions enhancement

What is it?

You can now select feature dimensions, sketch dimensions, and auto
dimensions from the graphics window when you use the DesignLogic
Reference option.
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Why should I use it?

You can quickly select the dimensions from the graphics window instead of
selecting them from a list box.

Where do I find it?

Application Modeling
Location in dialog
box [parameter entry] DesignLogic list®Reference.

Selecting objects from the Part Navigator

What is it?

You can select the following nodes in the Part Navigator as input to the
active command:

• Body features as body input

• Curve features as curve input, when the Feature Curves selection intent
rule is available

• Body features as face input, when the Feature Faces selection intent
rule is available

• Body objects as face input, when the Body Faces selection intent rule
is available
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When Select Object is the active option in a command, you can select the
following objects in the Part Navigator:
• Point features as point input, when Point is available on the Selection
bar Type filter.

• Datum CSYS features as CSYS input, when CSYS is available on the
Selection bar Type filter.

Why should I use it?

In a complicated part, it can be easier to select items from the Part Navigator
instead of the graphics window.

Where do I find it?

Application Modeling, Shape Studio
Menu Tools®Part Navigator

Display features as created

What is it?

When a feature is selected or preselected, the feature now displays as it was
when it was created.

Complete part

Holes selected, revealing the
counterbored hole faces that have
since been consumed (deleted by
subsequent features).

Why should I use it?

It is automatic. This is the way features now display.

Where do I find it?

Prerequisite
A feature must be selected or pre-selected, either in the
graphics window or in the Part Navigator
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Law Extension – Keep Parameterization

What is it?

The Law Extension command has updated Rebuild options.

• Degree and Tolerance – Use this option to specify the maximum degree
and the tolerance to control the parameterization of the output surfaces.

• Auto Fit – This replaces the Advanced option of previous releases. Use
this option to specify the minimum and maximum degree, maximum
segments and tolerance to control the parameterization of the of the
desired output surface.

If the output surfaces do not meet the specified tolerance, then an Alerts
message will be displayed to inform you that the specified tolerance is
not met.

• Keep Parameterization – Use this option to inherit the degree, segments,
pole structure and the knot structure from the input surfaces and apply it
to the output surface.

o G0/G1 tolerances will not be considered.

o Each law extension surface will have the same degree and segments
as its input curve.

o The continuity between adjacent law extension surfaces will follow the
continuity of their corresponding curves.

Law extension surfaces are at the upper left
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In addition, both law extension surfaces and studio surfaces are now created
in a more streamlined manner.

• Surfaces are produced with the least number of poles necessary to create
the surfaces so it is easier to edit the surfaces.

• Surfaces are created with no C0 or C1 knots.

• Surfaces are created with reasonable knot spacing and regular pole
structure, with spacing between poles and rows that produce minimal
inflections.

Why should I use it?

Use the Keep Parameterization option to create surfaces with the same
parameterization of the input curves, ensuring subsequent surface operations
will be of high quality.

Also, keeping parameterization between input curves and derived surface
makes it easier to go between a mesh and sweep based workflow and a pole
editing based workflow.

Where do I find it?

Application Modeling and Shape Studio

Toolbar Surface ® Law Extension
Menu Insert ® Flange Surface ® Law Extension
Location in dialog
box Settings group

DesignLogic List expressions

A new expression List data type lets you streamline NX DesignLogic
interactions and provide additional functionality capable of handling a wider
variety of design tasks.

With the List data type you can:

• Store and access arrays using the expression sub system.

• Access arrays using lists related DesignLogic functions.

Expressions of the list data type are called list expressions. You can use the
Extended Text Entry option to conveniently specify list expressions with
comma separated values of any DesignLogic data type as list expressions
using braces {}, as shown below:

coordinates={1,1.5,2}
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Why should I use it?

Use these enhancements to operate on an array of expressions or values of
different data types.

Where do I find it?

Application Modeling

Menu

Tools®Expression®Extended Text Entry

Tools®Expression®Extended Text Entry®Insert

Function

Tools®Expression®Extended Text Entry®Insert

Conditional

Durability analysis in the Modeling application

What is it?

The Durability Wizard is now available from the Modeling application. To
run the Durability Wizard, you need to have a Simulation file that contains
stress or strain results from a static stress analysis solution. To obtain this
Simulation file, use the Stress Wizard.

Why should I use it?

You can test your parts for fatigue damage directly in the Modeling
application by doing a durability analysis.

Where do I find it?

Durability Wizard

Application Modeling, Design Simulation, Advanced Simulation
Prerequisite Results from a static stress analysis solution
Menu Tools ® Durability Wizard

Stress Wizard

Application Modeling, Design Simulation, Advanced Simulation
Resource bar Process Studio ® NX CAE Stress Wizard
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Assemblies

Constraint Navigator

What is it?

Use the Constraint Navigator to analyze, organize, and work on assembly
constraints in your work part.

As in the Assembly Navigator, the Constraint Navigator has columns that
you can display, hide, and reorder. Some columns are specific to assembly
constraints, such as Constraint Type and Creation Date. To access the column
options, right-click the title bar and move your cursor over Columns.

You can also group the navigator tree nodes in different ways to analyze the
information you are interested in. For example, the Group by Components
option makes it easy to see which constraints are used to position each
component, and the Group by Constraints option makes it easy to find all
failing constraints. Right-click the title bar and choose the grouping method
that you want. The following figure compares two grouping methods for the
same assembly.

Group by Constraints Group by Components

You can group the navigator tree nodes by any of the following:

• Constraints

• Components

• Status

• Component level

• Inherited

• Component status
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Why should I use it?

The Constraint Navigator makes it easy for you to do the following:

• Find and work on constraints that are of interest to you.

• Resolve constraint issues.

Where do I find it?

Resource bar Constraint Navigator

Unique part files from existing components

What is it?

Use the Make Unique command to create a new part file for one or more
selected occurrences of the same part.

For example, the following figure shows four selected occurrences of a
part named GKballjoint. You can use the Make Unique command to
convert the two occurrences near the tires to use a new unique part file
named GKballjoint_tire, which is created by this command as a copy of
GKballjoint. The other two occurrences, which are attached to the steering
column subassembly, continue to reference the GKballjoint part file.

Why should I use it?

When you create a unique part file, you can modify the occurrences that
reference the new part without affecting occurrences that still reference
the original part. For example, you can modify the GKballjoint_tire part
file so its occurrences fit larger tire subassemblies without affecting the
GKballjoint ball joints that are attached to the steering column subassembly.
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Where do I find it?

Application Assemblies
Menu Assemblies®Components®Make Unique
Graphics window Right-click a component®Make Unique

Load Interpart Data enhancements

What is it?

The Load Interpart Data assembly load option, which you can select to ensure
that sufficient data from components is loaded to enable interpart updates,
has the following enhancements:

• Loading of component data to enable interpart relationships to update
is quicker and more memory-efficient than in previous releases.
NX is more selective about when to load extra data in order to
support interpart updates. These improvements also apply to the
Assemblies®WAVE®Load Interpart Data command.

• When you make changes in your assembly that cause interpart
relationships to become out-of-date, NX loads extra data from
partially-loaded components as needed to update the relationships.
Previously, NX only applied the Load Interpart Data assembly load option
when you loaded new components.

Examples of interpart relationships include:

• Interpart expressions

• WAVE links

• Promotions

• Assembly constraints

Why should I use it?

The ability to dynamically load extra data from partially-loaded components
whenever interpart relationships become out-of-date makes it easier to keep
your assembly model up-to-date.

To optimize the performance of assembly loading without losing the ability
to update interpart relationships, you should use the Load Interpart Data
assembly load option in conjunction with partial loading.
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Where do I find it?

Application Assemblies
Menu File®Options®Assembly Load Options
Location in dialog
box Scope group®Load Interpart Data

Load Interpart Data command

Application Assemblies
Menu Assemblies®WAVE®Load Interpart Data

Reopening modified parts

What is it?

When you select one or more component nodes in the Assembly Navigator,
you can use the following new shortcut commands:

• Use the Reopen Part command to close selected components that are
modified and reopen their saved versions. A component is regarded as
modified when it has changed in your NX session, or when the underlying
part file in Teamcenter or the operating system has been updated.

• Use the Reopen Assembly command to close modified part files in a
subassembly and reopen those part files. A subassembly includes the
selected part file and all its children.

When you select a single component node, the commands appear only if the
component is modified.

Why should I use it?

When you are working in the Assembly Navigator, the Reopen Part and
Reopen Assembly commands provide a quick way to discard unwanted
modifications to a part or to refresh a loaded part with an updated version
from Teamcenter or the operating system. This is faster to use than the
Reopen Part dialog box options.
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Where do I find it?

Application Assemblies

Assembly
Navigator

Right-click one or more selected component
nodes®Close®Reopen Part or Reopen Assembly

Right-click the Component Groups
node®Components®Close®Reopen Part or
Reopen Assembly

Edit Suppression State enhancement

What is it?

When you use the Edit Suppression State command, you can now select
multiple components in different branches of your assembly structure and
change the suppression state at any level from the lowest common parent to
the top-level assembly.

Why should I use it?

Previously, you could select multiple components only when they were all
children of the same occurrence.

Where do I find it?

Application Assemblies
Menu Assemblies®Components®Edit Suppression State
Assembly
Navigator Right-click a component node®Suppression
Location in dialog
box Controlling Parent list box

Advanced Weight Management enhancements

What is it?

The Advanced Weight Management command is enhanced to improve
support for component groups. If you specify a component group to define
which components to include in an assembly weight calculation, NX
re-evaluates the component group before making the calculation to ensure
that it includes the components that currently satisfy the component group
criteria.

Options on the Weight Management dialog box that previously referred
to a component set now refer to a component group. For example, the Set
Component Set option is now the Set Component Group option.
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Where do I find it?

Menu
Analysis®Advanced Mass Properties®Advanced
Weight Management

Read-only work parts

What is it?

When you attempt to make a read-only part the work part, a message informs
you that the part is read-only. You can control the display of the message by
using the Display Message when Work Part is Read-only customer default.

Why should I use it?

The message makes it more obvious when your work part is read-only.
Without the message, you might not realize that your work part is read-only
until you attempt to save the work part after making modifications.

Where do I find it?

Menu File®Utilities®Customer Defaults
Location in dialog
box Assemblies®General®Miscellaneous

Synchronize Links

What is it?

The following enhancements help you update a linked feature and its
dependent features to match changes in the source feature:

• A Synchronize Links command

• A Reverse Direction option in the WAVE Geometry Linker dialog box
when Type is set to Datum

Use the Synchronize Links command to do the following:

• Update an out-of-date linked feature to the current version of its source.

• Map descendents of the linked feature to changes in the linked feature in
order to update the descendents.

Mapping cross-references topology objects in the out-of-date geometry to the
current version of the source, so that descendents that reference the topology
are adopted by their new parent. Topology objects include faces, edges, and
curves.
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Why should I use it?

In a WAVE link, it is not uncommon to delay updating in the linked feature.
The Synchronize Links command provides the ability to not only update the
linked feature, but to map all of its dependent features.

Where do I find it?

Menu Assemblies®WAVE®Synchronize Links

Assembly constraints icons

What is it?

Beginning in NX 7.5.2, in the Assembly Navigator, unsolved assembly
constraints are marked with new icons that indicate the severity and nature
of the situation. The severity icons are error , warning , and info . The
category indicator identifies the specific problem. The same icons appear in
the Info column, where they have tool tips that describe the problem.

Icons also appear on the Constraints folder and its Info column when any of
its constraints have a severity status, are out-of-date due to constraint delays,
or are being ignored in the current arrangement.

Note In NX 8.0, a new navigator (the Constraint Navigator) is being
introduced. The icon changes described in this topic also apply to the
Constraint Navigator, except that additional information appears in the
Status column instead of the Info column.
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For example, suppose a constraint has an error because its components
cannot be moved relative to each other.

• In the left-most Assembly Navigator column, a icon appears beside the
constraint name. The same icon appears in the Info column with a tool tip
that says Referenced objects cannot move relative to each other.

Note If you need additional information, you can right-click an unsolved
constraint and choose Information. For this example, the Information
window says The objects referenced by this constraint cannot move

relative to one another. This may be due to the presence of Fix

or Bond constraints.

• The Constraints folder that contains the error has a icon. The same
icon appears in the Info column, where its tool tip says Some constraints

have errors.

Note If your current assembly arrangement is using the Ignore All
Constraints arrangements property, the Constraints folder has a
icon instead with a tool tip that says All constraints are ignored in

the current arrangement.

See the Assemblies Help for more information.

Why should I use it?

Icons now clearly indicate the severity and category of the problem for each
unsolved constraint. You also have faster access to additional information by
using the new Info column tool tips.

Where do I find it?

Application Assemblies

Resource bar

Assembly Navigator

Constraint Navigator

Fix and Bond constraints

What is it?

The ability to drag components is disabled during the creation or editing of
Fix or Bond assembly constraints.

Why should I use it?

Because Fix and Bond constraints are designed to hold components in place,
this functionality was disabled to prevent any accidental movement of the
components.
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Where do I find it?

Application Assemblies
Toolbar Assemblies®Assembly Constraints

Menu
Assemblies®Component Position®Assembly
Constraints

Location in dialog
box Type®Fix or Bond

Drafting

DraftingPlus enhancements

Drawing templates

A set of commands on the Drawing Format toolbar let you create and edit
your own custom drawing templates.

Drawing Format toolbar with all buttons displayed

You can:

• Create and edit associative borders and zones for each drawing sheet
in the template file.

• Construct and modify a custom title block from one or more tabular notes.

• Mark the current drafting part as a reusable drawing template.

• Create and link template regions.

• Associate notes, tables, symbols and views with a template region.

• Apply Knowledge Fusion rules to govern the behavior of objects in the
template when it is inserted into another part.

Where do I find it?

Application Drafting
Toolbar Drawing Format
Menu Tools®Drawing Format
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Mark as Template

The Mark as Template command creates a sheet or drawing template based
on the configuration of the currently open drawing sheet. The template
can include associative borders and zones, views, notes, template regions,
symbols, and custom title blocks.

Marking a drawing as a template gives you access to the template regions
and rules functions as well as allows you to choose to add the template to your
collection of sheet and drawing templates.

If you elect to save the template in your template directory, you must specify
a presentation name, description, template type, and the .pax file location.

Three different template types are available:

Sheet
Creates a sheet template from the current drafting part. A sheet template
is used to add a new sheet to an existing drawing.

Reference Existing Part
Creates a master model drawing template from the current drafting part.
A master model drawing template is used to create a separate drafting
part that includes the current model as a component.

Standalone
Creates a 2D drawing template. A 2D template is used to create a
standalone drawing that does not reference a master model part.

When you save the template part, the specified .pax file is created or updated
and the template is displayed by its presentation name on the Resource bar
palette.

Note You must have write permission to the .pax file and file directory to add
a new template or update an existing template.
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Where do I find it?

Application Drafting

Toolbar Drawing Format→Mark as Template
Menu Tools→Drawing Format→Mark as Template

Template Region

A template region is a rectangular area on a drawing template designated to
accept only certain types of drafting objects. The Template Region command
defines the origin and the rectangular dimensions of the area on the drawing
template and the specific types of drafting objects that can be contained
therein.

You can designate a template region as a note, symbol, table, or view type
region. This designation determines the type of drafting object that can be
added to the template region. You can apply Knowledge Fusion rules to
template regions to govern the behavior of objects in them when the drawing
template is incorporated into another part.

Note Although this command is only available for drawing templates, it is not
necessary to create template regions in order to add drafting objects to the
drawing template. You can add views, custom symbols, title blocks, and
notes to your drawing template without template regions.

Phantom lines denoting the boundary of a template region

When the contents of a template region grow beyond its borders, the region
behaves in one of two ways:
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As a growing region
Contents that extend beyond the template region’s boundary continue
into other template regions of the same object type. Depending on how
you set the Continuation for the template region, the overflow extends to
other template regions of the same type on the same sheet, or to template
regions of the same type on another sheet.

As a fixed region
Contents that extend beyond the template region are displayed outside
the boundary of the region and do not continue to any other region.

Note View regions are always fixed regions.

After you create a template region, you can re-size it, move it, or delete it in
the drawing template.

However, after you import a region as part of a drawing template, you cannot
edit it, move it, or delete it.

Priority and Content Control

If content from two growing regions grow into each other, the region with the
larger priority number will move to the continuation area. You may also
control whether the entire contents of the lower priority region move to
another region, or if only the overlapping portion moves.

Customer Defaults

Customer defaults govern the display of template regions. The defaults are
contained in the Customer Defaults dialog box, on the Drafting®Drawing
Automation ®General tab:

Display Region in Non-Template Part— Displays the template region’s
border when a drawing template is imported into another part.

Display Region Label— Displays the template region’s name, type, and
the rule file name at the center of each region.

You can also set color, font, and width settings for region borders here.

These options also control the default setting for the template region options
on the General tab of the Drafting Automation Preferences dialog box.

What’s New in NX 8 4-59



CAD (Design)

Where do I find it?

Application Drafting

Prerequisite

You must be in a drawing template, which was created
using the Mark as Template command, to make this
command available.

Toolbar Drawing Format→Template Region
Menu Tools→Drawing Format→Template Region

Adding objects to a region

After a drawing has been marked as a drawing template and template regions
are added to it, you can add objects like notes, symbols, tables, or views to the
regions in your drawing template.

Note When you add an object to a template region, it must be compatible
with the region’s type and must lie within the region’s boundary. NX will
not automatically relocate the object for you. When you add an object to
a template region, any rule associated with the region is applied to that
object when the drawing template is used to generate a drawing sheet.

You can add objects to a template region using the following methods:

To Do this
Add custom symbols from the Reuse
Library to a template region. Use the Add Symbols to Region

command.
Add an existing table to a template
region.

Right-click the table and choose Add
to Region. Only one table can be
added to a template region.

Add an existing note to a template
region.

Right-click the note and choose Add
to Region. Multiple notes may be
added to a template region.

Add an existing view to a template
region.

Right-click the view border and
choose Add to Region. Only one view
can be added to a template region.

Add an existing symbol to a template
region.

Right-click the symbol and choose
Add to Region. Multiple symbols can
be added to a template region.
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To control the appearance and
position of objects in a template
region. For example, to control the
orientation and scale of views, the
application of view labels, along
with the location and behavior
of tables via the TableData and
TableDataFromFile.

Use the Select Rule option to assign
specific Knowledge Fusion rules to
the template region.

The commands becomes available when the drawing is marked as a template.

To remove objects from a template region, right-click the region boundary and
choose Remove Objects from Region.

Where do I find it?

Add Symbols to Region command:

Application Drafting

Prerequisite

You must be in a drawing template, which was created
using the Mark as Template command, to make this
command available.

Toolbar Drawing Format→Add Symbols to Region
Menu Tools→Drawing Format→Add Symbols to Region

Add to Region command:

Application Drafting

Graphics window
Right-click a drafting object (view, table, and so
on)®Add to Region

Remove Objects from Region command:

Application Drafting

Graphics window

Right-click a template region’s border®Remove
Objects from Region, and then select the object to
remove.

Automation Rules

The Automation Rules command adds configurable Knowledge Fusion-based
rules to your drawing template. You can use automation rules to define the
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behavior and location of automatic dimensions, symbols, and notes when the
template is used to create a drawing.

The Knowledge Fusion rules are the mechanism by which information
is passed to the drawing file. The actual rules may be written in any
programming language such as .NET, Visual Basic, C, C+, or NX/Open.

Drafting Automation Preferences

When you apply automated dimensioning rules to a template part, you can
control dimension placement and behavior with the Drafting Automation
Preferences dialog box. For example, on the Annotation Distribution
Rules tab, you can specify the minimum and maximum distances between
dimensions and geometry, as well as minimum distances between adjacent
annotations. You can also prioritize the application of the rules. The
preferences become effective when you add the template to a part.

Where do I find it?

Application Drafting

Prerequisite
This command becomes available only after the drawing
is marked as a template.

Toolbar Drawing Format→Automation Rules
Menu Tools→Drawing Format→Automation Rules
Preferences Preferences→Drafting Automation
Customer
Defaults Drafting→Drawing Automation

Automated drawing customization

The automation tools and processes available in NX Drafting lend themselves
to a great deal of user customization. A lot of basic customizations can be
managed with customer defaults. More extensive customizations can be
managed with a system of automation rules.

There are two types of automation rules available:

Simple – These rules do not require mathematical or complex logic and
can be configured using customer defaults, for example, Annotation
Distribution and Dimension rules.

Knowledge Fusion (KF) – These rules require more complex logic, such
as configuring drawing templates and booklets. Although they are
constructed as a KF routine, they can be used to directly call a C, C++, or
.net program from the NX Open Application Programming Interface (API).
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For example, a KF rule can be used to assign the default orientation of
a base view and the application of view scales and labels in a drawing
template. The rules are saved with the template part and evaluated when
the template is used to create drawings. For booklets, KF rules define the
booklet names, booklet disciplines, types, and available templates.

A repository of KF rules is found in the
UGII_BASE_DIR/draftingplus/automation/example directory. You can copy
any of them to a writable location and customize them to your specifications.

Applying rules to drawing templates

You can imbed rules into custom templates to automate dimension, note,
and symbol creation when the template is used to construct a drawing in
another part.

The KF rule applied to a template region affects the behavior of drafting
object(s) associated with that region. A few of the examples you can utilize
are:

Template Region Type KF file
View ViewScale.dfa

Defines the scale (1:1) of the view
added to the template region.

ViewLabelText.dfa
Defines the label content of a view.

Table SampleReferenceTable.dfa
Supplies table data to create and
populate a tabular note when the
template is used to create a drawing.

Note NoteBuilderExample.dfa
Adds text to the note region.

Symbol SymbolDataExample.dfa
Adds symbol data to a symbol region.

Tip You can also apply a rule directly to an annotation or symbol that
appears on the drawing by right-clicking the annotation or symbol and
selecting Specify Rule. Only those rules available for that object type
will be selectable.

You can also manually create and position rules-based dimensions to drawing
views with the Annotate Views and Distribute Annotations command.

What’s New in NX 8 4-63



CAD (Design)

Annotate Views

Annotate Views lets you automatically annotate manually created drafting
views based on the KF rules and automation preferences embedded in the
drawing template used to create the view.

You can delete and recreate all existing annotation in the views, or add
annotations to newly created views while preserving the automated
annotations originally placed on the drawing.

Note To use this tool, the template used to create the drawing must
have automation rules applied to it via the Tools→Drawing
Format→Automation Rules command.

Where do I find it?

Application Drafting
Menu Tools→Drawing Automation→Annotate Views

Distribute Annotations

Distribute Annotations places dimensions in relative locations to each other
and to other objects in a view. This command is intended primarily for
annotations automatically generated from a drawing template. You can also
use it for dimensions created with the Annotate Views command as well as
for those created manually.

When you distribute annotations in a view, NX applies the values and
rules on the Annotation Distribution Rules tab of the Drafting Automation
Preferences dialog box to the dimensions in that view.

Before Distribute Annotations
applied

After Distribute Annotations
applied
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Where do I find it?

Application Drafting
Menu Tools→Drawing Automation→Distribute Annotation

Import AutoCAD Block

Use Import AutoCAD Block to create custom symbols by importing block
definitions from AutoCAD DXF and DWG files.

There are two methods for selecting AutoCAD files with blocks:

• Select an AutoCAD file and its list of blocks will be extracted.

• Select a folder and any AutoCAD files open and any list of blocks is
extracted.

Users can mix any selection of files and folders, the blocks tree list will
accumulate all selections.

By default the block name will be used to define the symbol name, and the
symbol part file name will be the symbol name with a .sym.prt extension (not
applicable to part symbols).

The Import Summary will show the number of blocks processed, number
of symbols created and their status.

To remove a new symbol, you can delete it after import like any other custom
symbol.

You can recreate symbols for simple blocks as you migrate AutoCAD data to
NX Drafting. However, in the case of more complex blocks or large block
libraries, it is easier to use this functionality to create the NX symbol from
the existing AutoCAD blocks. In the event of symbol name clashes, a number
will be appended to the name.

Note See DXF/DWG import interface for more information about importing
AutoCAD data.

Where do I find it?

Application Drafting

Prerequisite
The DXF / DWG Translator (dxfdwg kit) must be
installed.

Menu File→Import→AutoCAD Block

Resource bar
Reuse Library tab ® Custom Symbol Library ®
right-click a folder® Import AutoCAD Block
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Copy to 3D enhancements

What is it?

Several enhancements have been made to the Copy to 3D command.

• You can now output selected curves as sketches, basic curves, sketches
and solid body, or component parts from groups.

• When you specify an automatic placement location, you can use the
Automatically Reposition Geometry option to have NX automatically
reposition the geometry for better alignment.

Previously, when geometry in drawing views was properly dimensioned but
not aligned, the output was not aligned in Modeling.

The Automatically Reposition Geometry option allows you to automatically
place geometry in Modeling.
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Output

When Output is set to Sketches, Sketches and Solid, or Component Parts
from Groups, modeling sketch dimensions will be generated corresponding to
the input drafting sketch dimensions.

In the following graphics the output is set to Sketches and Solid.

Before Copy to 3D
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After Copy to 3D

Where do I find it?

Application Drafting
Menu Tools ® Copy to 3D
Shortcut Menu Right-click selected Drawing views®Copy to 3D

Part Navigator
Right-click one or more Drawing view nodes ®Copy
to 3D
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Custom symbol enhancements

Associative custom symbols

When you create custom symbols from a master custom symbol definition,
you can make the custom symbols associative to the master custom symbol.
If the master custom symbol changes, the associative copies of the symbol
also change.

Note Associativity is not supported for nested custom symbols or PMI custom
symbols inherited onto a drawing.

When you create associative custom symbols, it is important to note the
following.

• Associativity to the master symbol is lost if the master symbol is deleted,
the folder containing the master symbol is deleted, or the symbol instance
is smashed into its constituent parts. You cannot add master symbol
associativity to existing symbol instances created in previous NX releases.

• When you create an instance of a master custom symbol, the Lock Update
option is available. When set, the symbol instance is locked, and changes
to the master symbol definition do not affect the instance.
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Original master symbol
Symbol instances from original

master symbol

Changed master symbol
Symbol instances from changed

master symbol

– Unlocked symbol – Locked symbol

• You can manually update symbol instances that are unlocked.

See Out-of-Date Folder for additional information.

• You can also change the locked status of existing custom symbol instances.

• The Reassociate command lets you reassociate a symbol instance to its
master symbol definition. You can only use the Reassociate command
on symbol instances created in NX 8 and above.

Create Associative Symbols customer default and the Lock Update option

A new customer default, Create Associative Symbols, determines whether
or not to create an associative custom symbol instance. It also determines
the visibility and availability of the Lock Update option in the Custom
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Symbol dialog box. When Create Associative Symbols is selected, the Lock
Update option is visible and available, and you can create both associative
and non-associative symbol instances. When it is not selected, the Lock
Update option is not visible and symbol instances are always created as
non-associative copies of the master custom symbol.

Why should I use it?

Create associative custom symbol instances when you want your symbol
instances to always reflect the master definition of the original custom symbol.

Where do I find it?

Lock Update option

Application Drafting and PMI

Toolbar

In the Drafting application:

Symbol®Symbol Drop-down list®Custom Symbol

In the PMI application:

PMI®PMI Symbols Drop-down®Custom Symbol

Menu

In the Drafting application:

Insert®Symbol®Custom

In the PMI application:

PMI®Symbol®Custom
Location in dialog
box Settings group®Lock Update

Create Associative Symbols customer default

Menu File®Utilities®Customer Defaults
Location in dialog
box

Drafting®Custom Symbols®All tab®Create
Associative Symbols

Reassociate command

Application Drafting and PMI
Graphics Window Right-click custom symbol instance®Reassociate
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Edit Custom Symbol

You can edit the definition of a master custom symbol by using the Edit
Custom Symbol command. You can also edit the master custom symbol
by directly opening the master symbol part, or in the Reuse Library by
right-clicking the symbol and choosing Edit.

• You can only edit a master custom symbol in the Drafting environment.

Note If the symbol was created as a 3D object, NX will attempt to display
the symbol as a 2D object in the Drafting environment. If it cannot be
displayed, a warning is displayed and you cannot edit the symbol.

• You can change all constituents of the master custom symbol except the
symbol name and the symbol location.

• You can only edit those symbols for which you have write permission.

• You must use the Finish Custom Symbol Edit command to save any
geometric and annotation changes to the master symbol definition.

• You can use the Exit Custom Symbol Edit command to exit the custom
symbol editing environment without saving your changes.

• After clicking Finish Custom Symbol Edit, you can change the symbols
anchor points, leader line points, symbol icon image, and any text
attributes in the Finish Symbol Edits dialog box. When you click OK in
the Finish Symbol Edits dialog box all edits are saved and the master
symbol part is closed.

Use the Custom Symbols node in the Out-of-Date folder in the Part
Navigator to locate and manually update unlocked instances of the master
custom symbol in your parts.

Where do I find it?

Application Drafting

Prerequisite
You must be able to edit your master custom symbol in
the Drafting environment

Toolbar

Symbol®Symbol Drop-down list®Edit Custom

Symbol
Menu Edit®Symbol®Edit Custom Symbol

Resource bar
Reuse Library tab®Member Select
panel®right-click a custom symbol®Edit
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Finish Custom Symbol Edit

Use Finish Custom Symbol Edit to do the following.

• Save all geometric and annotation changes you made to a master custom
symbol.

• Create a new snapshot of the master custom symbol.

• Change the leader attachment type and attachment point.

• Re-specify any text parameters.

The Finish Custom Symbol Edit command is only available when you are
editing the definition of a master custom symbol.

See Edit Custom Symbol for more information.

Where do I find it?

Application Drafting

Toolbar

Symbol®Symbol Drop-down list®Finish Custom

Symbol
Menu Edit®Symbol® Finish Custom Symbol Edit

Exit Custom Symbol Edit

Use Exit Custom Symbol Edit to exit the custom symbol editing environment
without saving your geometric or annotation changes.

The Exit Custom Symbol Edit command is only available when you are
editing the definition of a master custom symbol.

See Edit Custom Symbol for more information.

Where do I find it?

Application Drafting

Toolbar

Symbol®Symbol Drop-down list®Exit Custom

Symbol
Menu Edit®Symbol® Exit Custom Symbol Edit
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Define Symbol from Catalog

What is it?

Use the Define Symbol from Catalog command to create a 2D custom
symbol in the Custom Symbol Library from the Fasteners catalog.
Optionally, you can immediately add the created symbol instance to your
drawing using the Custom Symbol dialog box.

While defining the symbol from the catalog item, you can do the following:

• Browse the catalog and select the catalog item to create the 2D custom
symbol.

• Set individual parameters for the item being created.

• Choose the view orientation in which the 2D custom symbol is created.

• Choose to create centerlines for the 2D custom symbol.

• Identify in what custom symbol library folder you want to place the
symbol once it is created.

• Name the created 2D custom symbol or use automatically generated name.

The Fasteners catalog contains fastener items that are classified by standard
and by type. The size and length characteristics of items are stored
parametrically in the catalog. The items are not stored in symbol part files,
but their information is stored in the catalog XML file.

Only 2D custom symbols can be created.

Why should I use it?

Use the Define Symbol from Catalog command to create only the 2D custom
symbols you need from the catalog items. This saves disk space.

Where do I find it?

Application Drafting

Toolbar Symbol®Define Symbol from Catalog
Menu Insert®Symbol®Define Symbol from Catalog
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Drafting welcome

After you install NX, a welcome page automatically opens from the Resource
bar the first five times you log in and enter Drafting. This welcome page
provides general information, tips, and tutorials for using the Drafting
environment.

Recommended Setup

Under Recommended Setup, Specify my Drafting Standard allows you to
preset all of the drafting preferences in your session according to one of the
NX-supplied Drafting standards or to a customized standard.

Overview of NX Drafting

Under Overview of NX Drafting, you can review the primary components of
the graphic user interface in Drafting, or open the What’s New Guide for
more information on the latest release of NX.

Tutorials

If you are a new user, you can familiarize yourself with the fundamentals of
Drafting by viewing online tutorials that cover:

• Creating new drawing parts and sheets.

• Adding base and orthographic views of a 3D model.

• Creating section views, detail views, and view breaks.

• Adding and editing dimensions.

• Creating and editing annotations and centerlines.

• Making a standalone drawing and sketching in Drafting.
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Each tutorial is supplied with a sample part so that you can complete the
activity.

Resetting the welcome page

After the fifth login, you can restore the welcome page to the Resource
bar by clicking Reset Welcome Page on the General page of the Drafting
Preferences dialog box.

Customer defaults

You can use two customer defaults to control the appearance and behavior
of the welcome page:

Drafting Welcome Page Duration
Sets the number of log-ins for which the welcome page appears.

Display Recommended Setup in Welcome Page
Displays the Recommended Setup section, under which the Specify my
Drafting Standard option appears.

See the Miscellaneous tab under Drafting→General.

Where do I find it?

Application Drafting

Resource bar Internet Explorer tab

Drafting user interface improvements

What is it?

The user interface for the Drafting application is simplified to improve
usability and make the system more intuitive. Enhancements include:

• Non-drafting commands on menus and toolbars are removed. For example,
some commands are only visible when the sheet display is turned off.
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• The drafting commands have been reorganized so that they are easier
to find.

• The toolbar and menu icons are consistent between Drafting and PMI.

• The default background color is white and most drafting object colors
are black.

• Out-of-the-box drawing templates are updated and made more intuitive.
There will be a single set of drawings for each template type, regardless of
the relationship type.

• The base view part defaults to the loaded, or partially loaded, master
model part. If the master model is not loaded, the base view part defaults
to the current drawing part and an alert is issued. The options in the list
Model View to Use are derived from the part specified in the Part group.

• A new relationship filter on the File→New dialog box makes creating a
2D type drawing intuitive.

The Relationship filter

In Native Mode, in the New dialog box, on the Drawing page, there is a new
Relationship filter, which sorts the list of available drawing templates.

The following options are available on the Relationship filter:

• Reference Existing Part – The template list shows only those templates
that support referencing existing parts. For example, you can choose
this option to create a drawing of an existing part or a manufacturing
operation on an existing part.

• Stand-alone Part – The template list shows only those templates that
support the creation of a new stand-alone part. For example, you can
choose this option to create a new model, or to create a drawing that does
not reference an existing model.

• All – The template list shows all the templates.

Why should I use it?

The enhancements make it easier to use NX. You or your system
administrator can configure the user interface enhancements to match your
company’s requirements and preferences.
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Where do I find it?

New dialog box

Application Drafting

Toolbar Standard→New
Menu File→New

Support for Standard Fonts

Standard font types available in the FreeType Font library are supported in
the PMI and Drafting environments.

Note Although the FreeType Font library supports non scalable and other
font types, only scalable TrueType, OpenType, and PostScript fonts are
supported.

When setting your character font, it is important to remember the following
points:

• Existing NX font types are still available and are located in a directory set
by the UGII_CHARACTER_FONT_DIR environment variable.

• Standard Fonts files are found in your normal font directories, usually in
the C:\Windows\Fonts on Windows or in a configuration file on Unix.

• You can use custom fonts by placing the font files in a directory referenced
by the UGII_STANDARD_FONT_DIR environment variable.

• NX will search for the character font in the following order:

1. Standard font location (that is, C:/Window/Fonts).

2. The directory specified by UGII_STANDARD_FONT_DIR.

3. The directory specified by UGII_CHARACTER_FONT_DIR.

• A default font is used when a font cannot be found. The default font can
be changed, but is initially set to Arial Unicode MS. If Arial Unicode MS
is not found, the default font is set to Tahoma. If Tahoma is not found,
then the default font is set to Arial.

Why should I use it?

Use Standard Fonts to replace, enhance, or supplement your current set
of drafting and PMI character fonts.
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Where do I find it?

All fonts found in standard directories and in the custom directory are
automatically available in customer defaults, preference dialog boxes, style
dialog boxes, and any other dialog box that lets you specify a character font.

Cut, copy, and paste enhancements

What is it?

The cut, copy, and paste capabilities in Drafting have been enhanced. You can
now copy and paste the following Drafting objects:

• Sheets and drafting views between parts.

• Associative and retained annotations.

• PMI-inherited annotations, view labels, and section line letters.

You can also:

• Reassociate an object when you use Paste.

• Trim pasted sketch curves using the boundary of the original drawing
member view.

• Copy view-dependent edits of sketch curves.

Note Copies of associative or retained annotations will always be on the
current sheet, though they may be associated to other copied geometry in
the destination member view.

Completely unassociated annotations, and dimensions which are not
retained, which were copied in NX 7.5 will still be pasted into the
destination view or sheet.

Where do I find it?

Application Drafting

Toolbar Standard→Cut or Copy or Paste
Menu Edit→Cut or Copy or Paste

Graphics window

Right-click on a drawing member view ®Cut or Copy
or Paste

Right-click on a drawing sheet®Copy or Paste
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Out-of-Date folder

What is it?

In the Part Navigator, an Out-of-Date folder is available under the Drawing
node.

Drawing
Sheet “Sheet 1” (Work-Active)
Out-of-Date

This folder serves as a container for following types of drafting objects:

• Custom symbols

• Parts lists

• Tabular notes

Out of date checks

The empty Out-of-Date folder initially appears with a question mark (?)
symbol in front of it.

Out-of-Date

When you place a supported annotation type on the drawing, a sub-folder
for the annotation is added under the Out-of-Date folder. The question
mark indicates that an out of date check has not yet been performed on the
annotation.

Out-of-Date
Tables

As objects become out of date, they are marked in the navigator with the
stop watch symbol.

Out-of-Date
Parts List
Parts List

Tables
Tabular Note (1)
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Updating Objects

You can use the Out-of-Date folder to update the objects listed in it. When an
object is up to date, it is removed from its respective folder, and a green check
mark symbol appears on that node.

Out-of-Date
Parts List
Tables

Shortcut menu commands

You can use shortcut menu commands on the objects in the Out-of-Date folder
to do the following:

Update All
Updates all the out of date objects under the selected folder.

Refresh
Expands the Out-of-Date folder when you return to the Drafting application.
You can choose Refresh again to perform an out of date check on any of the
folders.

Also removes any unneeded folders from the Out-of-Date folder.

Refresh All
Performs an out of date check on the contents of the selected folder.

Collapse All
Collapses the contents of the selected folder.

Expand All
Expands the contents of the selected folder.

Why should I use it?

Use the Out-of-Date folder to identify and update objects whose out of date
status may not be readily apparent on the drawing sheet. This is especially
useful in cases where automatic updates have been turned off for parts lists
and tabular notes. Likewise in the case of custom symbols, NX does not
automatically check to see if a symbol is out of date with respect to its master
symbol geometry. You can use the Out-of-Date folder to manually check for
symbol updates.

Where do I find it?

You can access the Out-of-Date folder from the Part Navigator.
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Title Block

Use the Title Block command to construct a customized title block that you
can use in your drawing template or part file.

You can:

• Create a single title block entity comprised of one or more tabular notes,
pre-arranged in the positions you want on the drawing sheet. The cells
of the tabular note can have a designated annotation type or mixture of
annotation types. Annotation types are limited to simple text, symbols,
images, or associative text such as expressions or attributes.

Title block comprised of three tabular notes

• Designate a cell as locked or unlocked. When the title block is imported as
part of a template, the contents of a locked cell cannot be edited.

• Provide labels for each cell in the title block, which are used to identify
cells during the edit process.

• Designate an alignment position for moving and locating the title block.

After you select all the tables for your title block, a bounding box is calculated
around the area of the title block. The table’s alignment position is derived
from one of the four corners of the bounding box.

Note

• Non-tabular notes (such as parts lists, hole tables, and routing tables),
tables with more than one section, tables which are in drafting views
or modeling views, and tables with leaders cannot be included in a
custom title block. Also, the Auto Size Row, Auto Size Column, and
Wrap fit methods are not supported. Auto Size Text is used instead.
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• Because you can enter only one piece of information per cell, any cell
in a title block containing more than one attribute, expression, or
other object is automatically locked.

• After the title block is defined and imported as part of a template into
another drawing, you can set the default to prompt you for manual
input to the title block.

• You should consider on which layer to create the title block. You
might consider putting the title block on a layer that is normally not
selectable. For example, with the NX supplied templates, the drawing
borders and title blocks are always found on layer 256.

Where do I find it?

Application Drafting

Toolbar Drawing Format→Title Block
Menu Tools→Drawing Format→Title Block

Populate Title Block

Use the Populate Title Block command to edit the contents of individual
unlocked title block cells.

You can:

• Use the Populate Title Block command to add content to the title
block In a template part,

• Right-click the title block and use the Populate command to add content
to the title block In an instantiated template.

Editing title block contents when instantiating a drawing template

To edit the content of a title block while instantiating a drawing template, you
must set the Display Populate Title Block Dialog on Template Instantiation
option in the Customer Default dialog box. This default is on the Title Block
tab under Drafting→Drawing

The Populate Title Block dialog box opens when you instantiate a drawing
template. You can then edit the contents of any unlocked cell.
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Where do I find it?

Application Drafting

Toolbar Drawing Format®Populate Title Block
Menu Tools→Drawing Format→Populate Title Block
Shortcut Menu Right-click the title block®Populate

Editing title blocks

Editing title block definitions

To edit the label or lock status of a cell:

• Right-click the title block and choose Edit Definition.

The Edit Definition command opens the Define Title Block dialog box.

To re-size rows or columns, or to merge cells, you must first remove the table
from the title block.

After you make your edits, add the table back to the title block template by
clicking Select Tables, and then selecting the table.

Removing a table from the title block

1. In the Define Title Block dialog box, click Select Tables.

2. Hold Shift and select the table.

You can remove all but the last remaining table from the title block. If there
is only one table in the title block, you first need to add a temporary table to
the title block, and then remove the table you wish to edit. When you make
the needed changes to the table, add it back to the title block. Afterward,
remove the temporary table.

Where do I find it?

Application Drafting
Shortcut menu Right-click the title block®Edit Definition

Borders and Zones

The Borders and Zones command adds associative borders and zones to
the active drawing sheet in your part. The border of a drawing is the line
that defines the outer boundary of the drawing sheet. Drawing zones are
separate, rectangular cells on the drawing sheet which are lettered in the
vertical direction and numbered in the horizontal direction.

4-84 What’s New in NX 8



CAD (Design)

If you mark the drawing as a template, the associative border and zone data
is saved with it.

Note You cannot edit borders or zones in legacy parts. You must first delete
the existing border and zone information, and then create new borders
and zones with this command. If you import border and sheet zones from
a template part, you cannot edit them.

The color, font, and width settings for border lines and zone marking lines
are based on the customer defaults and preferences for general NX curves.
The color, font, and width settings for zone labels are based on the customer
defaults and preferences for general text annotation.

Borders

For borders you can:

• Control their appearance and width (1).

• Control the appearance and extension size of horizontal and vertical
centering marks (2).

• Control the appearance and size of trimming marks (3).
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Zones

You can set the zone type to:

None No drawing sheet zones are created.

Standard Drawing sheet zones are created according to the current
Drafting Standard. This is the default.

Custom Lets you specify unique zone parameters such as size,
origin, and margin.

For Standard and Custom zones, you can:

• Control the appearance, size, and font of zone labels (4).

• Control the appearance and size of zone dividing lines (5).
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• Display the zone grid when you set the Use Sheet Zone Grid.

• Control the appearance and size of margins which limit zones to a specific
portion of the drawing sheet. If margins are specified and the sheet zone
grid is on, a dotted box representing the sheet zone area is displayed (6).
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• Display the associative sheet zone reference in view labels and section
line symbols.

Note The View Label option in the View Label Preferences dialog box
must be set in order to display associative sheet zone reference
information in views and section line symbols.

• Use the Insert Sheet Zone option to insert an associative sheet zone
reference of a view into a note, table, or symbol. For example:

1. Refer to 2B4,

where 2B4 is the sheet number and zone reference of a specific view.

The Insert Sheet Zone option is located in the any annotation command

that supports the use of the Text Editor for textual content.

Note You should consider on which layer to create the borders and zones. You
might consider putting the them on a layer that is normally not
selectable. For example, with the NX supplied templates, the drawing
borders and title blocks are always found on layers 255 and 256.
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Where do I find it?

Application Drafting

Toolbar Drawing Format→Borders and Zones
Menu Tools→Drawing Format→Borders and Zones

Drawing sheet numbers and revisions

What is it?

You can assign a name, number and revision to individual sheets in a
drawing. The sheet number may contain a primary index, a delimiter, and a
secondary index such as 1-A.

Sheet numbers and revisions appear on the Insert Sheet and Edit Sheet
dialog boxes where you can modify their values. The sheets are displayed in
the Part Navigator in sheet number order. Revision letters also appear in
the Part Navigator where they can be incremented.

Customer defaults for automated sheet numbering appear in the Customer
Defaults dialog box, under Drafting→General, on the Drawing tab. These
settings also appear on the Sheet tab of the Drafting Preferences dialog box.

Where do I find it?

Application Drafting

Toolbar

Drawing→New Sheet

Drawing Edit→Edit Sheet

Menu

Insert→Sheet

Edit→Sheet

Location in dialog
box

Name group®Sheet Number

Name group®Revision

View Creation Wizard

The View Creation Wizard simplifies the process of adding one or more
drafting views to a drawing sheet.
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The wizard steps you through the following process of:

• Selecting a currently loaded, recently loaded, or unloaded part or
assembly.

• Specifying the preview style and view display parameters.

• Optionally inheriting existing PMI data from the assembly model.

• Optionally selecting existing assembly arrangements.

• Specifying a view orientation for the parent view.

• Constructing a multi-view layout.

Note The View Creation Wizard is available for master model drawings only.
It is not available for standalone drawings.

By default, the View Creation Wizard is launched immediately after creating
a new drawing or a new drawing sheet. You can change this default behavior
by adjusting the options on the General tab of the Drafting Preferences dialog
box, or by adjusting the options on theWorkflow tab under Drafting→Drawing
on the Customer Defaults dialog box.
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The View Creation Wizard window

The options in the View Creation Wizard window step you through the
process of defining and placing a group of views on the current drawing sheet.

You can:

• Select the part or assembly to be depicted on the drawing.

• Set your preferences for the display. You can click View Style to
set view style preferences not directly available from the from the View
Creation Wizard window.

• Specify the parent view orientation.

• Configure a view layout. You can include up to six standard orthographic
views in the layout, along with an isometric or trimetric view. The
projection angle of the views is derived from the projection angle of the
drawing.

• Place the view layout on the drawing sheet using Margins to define the
minimum distance between adjacent view borders in the layout, and
between view borders and the edge of the drawing sheet.

If the View Placement option is set to Automatic, you can complete the
placement of the views in the first step. Use the Manual option if you want to
place the center of the view layout anywhere on the drawing sheet.

Where do I find it?

Application Drafting

Toolbar

Drawing→Add View Drop-down list®View Creation

Wizard

Drawing→View Creation Wizard
Menu Insert→View→View Creation Wizard
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Sheet dialog box:

Location in dialog
box

Settings group®Automatically Start View
Creation®View Creation Wizard

View Creation Wizard preferences:

Menu Preferences→Drafting
Location in dialog
box

General tab®Model–based Drawing Workflow®View
Creation Wizard

View Creation Wizard customer defaults:

Menu File→Utilities→Customer Defaults
Location in dialog
box

Drafting®General®Drawing tab®Model–based
Drawing Workflow®View Creation Wizard

View Break

What is it?

You can use the View Break command to add multiple horizontal or
vertical breaks to a view. Two types of view breaks are available:

Regular
The view break has two break lines representing the conceptual gap on
the drawing.

Single-Sided
The view break has only one break line, and only one side of the break is
visible.

For the first view break in a view, the direction of the break lines can be
horizontal, vertical, or general. NX sets the default break direction to
horizontal if the geometry is wider than it is high on the sheet, otherwise it
sets it to vertical. You can also specify a vector to set a general direction
for the break line. When you add a new break to a view that already has a
view break, the direction must be either parallel or perpendicular to the
previous breaks.
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You can add breaks to the following views:

• Base views.

• Projected views.

• 2D drawing views.

• Section views with simple or stepped section line symbols.

Note You cannot add breaks to detail views, perspective views, and legacy
broken views using the View Break command.

When the parent view (1) already has a view break, you can create projected
views (2) and section views with view breaks that NX creates automatically.

The view breaks created in the projected and section views are independent
and can be modified and deleted.

Note The Propagate View Break customer default controls whether or not the
view break propagates to projected and section views.

The breaks associated to a view are displayed in the Part Navigator.

Sheet ²Sheet 3² (Work-Active)
Drawing View ²TOP@22²
Sketch ²SKETCH_TOP22_000²

View Break ²1²
View Break ²²²2²²²
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You must suppress the view break to modify the sketch or the boundary of
the view.

Why should I use it?

View breaks allow more compact views to be drawn on the drawing sheet, so
that long areas of the geometry can be omitted and areas of interest can be
shown and documented. The new View Break command allows streamlined
creation of view breaks.

Where do I find it?

Application Drafting

Toolbar

Drawing→ Add View Drop-down list® View Break

Drawing→ View Break
Menu Insert→View→View Break
Graphics window Right-click the view border®Add View Break

Set View Break defaults

Customer
Defaults dialog
box

File→Utilities→Customer
Defaults→Drafting→General→View Break tab

ASME Y14.5-2009 Drafting Standard enhancements

What is it?

New options are available to create ASME Y14.5-2009 compliant annotations.
Enhancements to the Drafting and PMI annotation functionality let you
do the following:

• Create basic dimension types that are not to scale.
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• Create a Datum on Dot Terminated leader with an arrowhead for Feature
Control Frames (FCS), Datum Feature Symbols (DFS), and notes.

• Create a leader with an all over symbol for a feature control frame.

• Correctly attach annotations, such as a feature control frame, to a
dimension using a Flag leader.

• Create a datum target symbol with a spherical zone shape.
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• Specify an angular dimension as a fractional division of an arc.

Where do I find it?

Basic, Not to Scale dimension type

Application Drafting and PMI

Toolbar

In the Drafting application:

Annotation®Annotation Preferences

Menu

In the Drafting and PMI applications:

Preferences®Annotation

Location in dialog
box

Dimensions tab®Dimension Display Type list®Basic,

Not to Scale

Datum on Dot Terminated leader with an arrowhead

Application Drafting

Toolbar

Annotation→Datum Feature Symbol

Annotation→Feature Control Frame

Annotation→Note

Menu

Insert®Annotation®Datum Feature Symbol

Insert®Annotation®Feature Control Frame

Insert®Annotation®Note

Location in dialog
box

Leader group®Type®Dot Terminated

Style subgroup® Arrowhead
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Leader with an All Over symbol for a feature control frame

Application Drafting and PMI

Toolbar

In the Drafting application:

Annotation®Feature Control Frame

In the PMI application:

PMI®PMI Annotation Drop-down®Feature Control

Frame

Menu

In the Drafting application:

Insert®Annotation®Feature Control Frame

In the PMI application:

PMI®Feature Control Frame
Location in dialog
box Leader group®Type®All Over

Datum target symbol with a spherical zone shape

Application Drafting and PMI

Toolbar

In the Drafting application:

Annotation®Datum Target

In the PMI application:

PMI®Datum Target

Menu

In the Drafting application:

Insert®Annotation®Datum Target

In the PMI application:

PMI®Datum Target
Location in dialog
box Type group®Spherical
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Angular dimension as a fractional division of an arc

Application Drafting and PMI

Toolbar

In the Drafting application:

Annotation®Annotation Preferences

Menu

In the Drafting and PMI applications:

Preferences®Annotation
Location in dialog
box Units tab®Display as a Fraction

ESKD Drafting Standard enhancements

The following enhancements are provided in both Drafting and PMI to better
support the ESKD drafting standard.

Note The ESKD standard must be set in customer defaults, or in Surface
Finish option on the Symbols tab of the Annotation Preferences dialog
box.

• You can specify surface finish symbols with roughness values in which the
lay symbol and roughness are in a single line.
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• The Not Specified weld type lets you create a symbol with just weld
properties and no specific weld type.

Where do I find it?

Surface finish symbol with a single line roughness callout

Application Drafting and PMI

Prerequisite
Your drafting standard must be set to ESKD in the
Annotation Preferences dialog box.

Toolbar

In the Drafting application:

Annotation®Surface Finish Symbol

In the PMI application:

PMI®Surface Finish

Menu

In the Drafting application:

Insert®Annotation®Surface Finish Symbol

In the PMI application:

PMI®Surface Finish®Attributes
group®Standard®ESKD

Location in dialog
box Attributes group®Single Roughness Value
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Not Specified weld type

Application Drafting and PMI

Prerequisite
Your drafting standard must be set to ESKD in the
Annotation Preferences dialog box.

Toolbar

In the Drafting application:

Annotation®Weld Symbol

In the PMI application:

PMI®Weld Symbol

Menu

In the Drafting application:

Insert®Annotation®Weld Symbol

In the PMI application:

PMI®Weld Symbol

Location in dialog
box

Other Side group®Weld Symbol list®Not Specified

Arrow Side group®Weld Symbol list®Not Specified

Tabular Note dialog box enhancements

What is it?

You can now create and edit tabular notes from a block style dialog box.

In previous versions of NX, you could not edit the tabular note’s default
configuration until you placed it on a drawing sheet. Now as you can place
the tabular note, you can use the options in the Tabular Note dialog box to
define the note’s:

• Alignment and orientation.

• Leader type and origin.

• Column and row configuration.

• Annotation style.

Preferences for tabular notes

You can set preferences for the tabular notes using the new options in the
Annotation Preferences and Annotation Style dialog boxes.

You can:

• Specify how the table behaves when it exceeds its maximum size.
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• Set the distance between adjacent table sections of the tabular note.

• Append a continuation note to the table.

• Set or edit the following table preferences:

o Lock table formats to prevent end users from modifying the table
format properties.

o Lock data in the tabular note so it cannot be manually changed.

o Display locked deleted rows in various ways.

o Automatically update the part or object attributes, part numbers, and
expression values inside the tabular note.

Where do I find it?

Application Drafting

Toolbar Table→Table Drop-down list→Tabular Note
Menu Insert→Table→Tabular Note

Customer defaults
Drafting→Annotation, Tabular Note tab or Sections
tab.

General annotation enhancements

The following enhancements are provided to improve and optimize how you
create and use annotations.

• When you create or edit a note, the Inherit option on the Note dialog box
lets you inherit the text, style preference, and text alignment settings of
an existing note on the current drawing sheet.

• When you position a surface finish symbol created with a leader type set
to Flag, you can select either side of the leader line to place the symbol.
The symbol will automatically change its orientation when you place it on
the opposite side of the leader line.

Note If you want any associated surface finish symbol text to also be
reoriented, you must select Invert Text in the Settings group of the
Surface Finish dialog box.
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• A new Position at Snap Point option lets you position all annotation and
symbols using the Snap Point functionality on the Selection bar.

• A new customer default, Show All Extension Handles, displays all
centerline handles when you create or edit centerlines, regardless of the
setting of the Set Extension Individually option.

• You can now reposition annotation that is retained due to lost associativity.

• You can add part attributes, object attributes, and non-sketch related
expressions to master custom symbols.

• You can use Snap Point functionality to select points on the geometry of a
custom symbol without smashing it first.

Where do I find it?

Inherit option for notes

Application Drafting

Toolbar Annotation→Note
Menu Insert→Annotation→Note
Location in dialog
box Inherit group→Select Note

Surface Finish Symbol positioning

Application Drafting
Prerequisite The symbol must be placed with Leader Type set to Flag

Toolbar Annotation→Surface Finish Symbol
Menu Insert→Annotation→Surface Finish Symbol
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Surface Finish Symbol positioning

Application PMI
Prerequisite The symbol must be placed with Leader Type set to Flag

Toolbar PMI→Surface Finish Symbol
Menu PMI→Surface Finish Symbol

Position at Snap Point option

Application Drafting and PMI

Toolbar
Any command that contains the Origin group in the
dialog box

Menu
Any command that contains the Origin group in the
dialog box

Location in dialog
box

Origin group®under Alignment®Position at Snap
Point check box

Show All Extension Handles customer default

Application Drafting and PMI
Menu File®Utilities®Customer Defaults
Location in dialog
box

Drafting®Annotation®Symbols tab®Show All
Extension Handles check box

Suppress stacking and alignment for new dimensions

What is it?

New Stacking and Alignment options on the Dimensions dialog bar let you
disable automatic stacking and alignment when you add dimensions on
a drawing sheet.

You can also press the ALT key to temporarily disable automatic stacking and
alignment when you place dimensions.

Note The Stacking option is available for all Drafting dimensions except
ordinate, baseline, and chain dimensions. The Alignment option is
available for all Drafting dimensions except ordinate dimensions. These
options are not available while editing Drafting dimensions.

These options are not available for PMI dimensions.

Why should I use it?

Use these options to position dimensions in areas of the drawing sheet that
contain a large number of annotations or other dimensions.
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Where do I find it?

Application Drafting

Toolbar

Dimensions dialog bar→Stacking

Dimensions dialog bar→Alignment

Shortcut Menu

Right-click when you place a dimension →Stack
Annotation

Right-click when you place a dimension →Align
Horizontal or Vertical

Crosshatch and Area Fill enhancements

The following enhancements will help you create and update complex
crosshatch and area fill objects.

• Improved update behavior for crosshatch and area fill boundaries
associated to section edges, extracted edges, and silhouette curves lets you
more successfully update these types of annotations.

• Find Apparent Intersections is a new customer default you can use to
create boundaries using apparent intersections; apparent intersections
are intersection curves that appear to exist based on the view orientation,
but do not physically exist in the geometry.

• You can use the new Boundary Curve Tolerance option to set how closely
NX approximates the crosshatch boundary along irregular curves, such
as splines and conics.

• You can use the new Distance Tolerance option to control the allowable
gap between the boundary curves used for closed boundary detection.
In Boundary Curve selection this tolerance is also used for curve rule
selection.

Note This option is available when you create or edit new boundaries only.
It cannot be applied to existing boundaries.
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• The following options are available when the Selection Mode is set to
Point in Region.
o Identify Gaps lets you detect gaps in the boundary curves, which can
lead to bleeding of a crosshatch or area fill. Use the Smaller Than
option to control the size of acceptable gaps.

o The Region to Search options can be used to create a boundary box
around the set of curves you want to process for closed boundary
detection. These options are useful if you want to reduce the closed
boundary detection time for drawings with a large number of curves
or edges.
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o Ignore Inner Boundaries option that lets you ignore islands and holes
when you create crosshatch or area fill symbols.

Ignore Inner Boundaries selected

Ignore Inner Boundaries not selected

• You can now preview a crosshatch or area fill symbol before creating it.

• You can now see visual representations of crosshatch pattern in the dialog
box for each crosshatch and area fill pattern type.

• The display of crosshatch and area fill symbols created on arrangements,
explosions, deformed parts, and on geometry with assembly operations
that reposition components, such as Move Component, is improved.
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Where do I find it?

Distance Tolerance option

Application Drafting

Toolbar

Annotation®Crosshatch

Annotation®Area Fill

Menu

Insert®Annotation®Crosshatch

Insert®Annotation®Area Fill
Location in dialog
box Boundary group®Tolerance®Distance Tolerance

Boundary Curve Tolerance option

Application Drafting

Toolbar

Annotation®Crosshatch

Annotation®Area Fill

Menu

Insert®Annotation®Crosshatch

Insert®Annotation®Area Fill
Location in dialog
box Settings group®Boundary Curve Tolerance box

Crosshatch and Area Fill Boundary Curve Tolerance annotation preference

Application Drafting

Toolbar Annotation®Annotation Preferences
Menu Preferences®Annotation
Location in dialog
box Fill/Hatch tab
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Identify Gaps and Smaller Than options

Application Drafting

Toolbar

Annotation®Crosshatch

Annotation®Area Fill

Menu

Insert®Annotation®Crosshatch

Insert®Annotation®Area Fill
Location in dialog
box Boundary group®Gaps

Region to Search options

Application Drafting

Toolbar

Annotation®Crosshatch

Annotation®Area Fill

Menu

Insert®Annotation®Crosshatch

Insert®Annotation®Area Fill
Location in dialog
box Boundary group®Region to Search

Ignore Inner Boundaries option

Application Drafting

Toolbar

Annotation®Crosshatch

Annotation®Area Fill

Menu

Insert®Annotation®Crosshatch

Insert®Annotation®Area Fill
Location in dialog
box Boundary group®Ignore Inner Boundaries

4-108 What’s New in NX 8



CAD (Design)

PMI

Model view UI improvements

Naming convention for model view names

User defined views can now be saved in lower case letters. View names in
legacy parts will still have capital letters until the name is changed by the
user.

Resize PMI

Previously the size of the PMI was fixed and was controlled by the attributes
for preference and style. As you zoomed the display in or out, the PMI got
larger or smaller; this could cause the PMI to be too small or too large to
be read on the screen.

The Resize PMI command enables you to resize the PMI display to make
it more readable relative to the current viewing perspective.

View display before zoom
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View display after zoom, PMI objects difficult to read

View display after selecting Resize PMI

You can use the resize options on the Customer Defaults and PMI Preferences
dialog boxes to control the size of PMI display. These options are part
preferences and are saved with the part.
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Resize on Create

Enables the automatic resize of PMI
at the time that it is created.

This is in contrast to creating the
PMI, then selecting Resize to adjust
the size.

Resize on View Save Determines whether or not PMI will
be resized when you save a view.

Style Settings Relative to Saved View
Scale

Resizes PMI based on its display
attributes relative to the Saved View
Scale. This option preserves the
different sizes of the PMI.

Style Settings Relative to View Zoom
Factor

Resizes PMI based on its display
attributes relative to the View Zoom
Factor. This option preserves the
different sizes of the PMI.

Independent of Style Settings
Resizes all PMI the same size,
regardless of the display attributes for
each PMI.

Where do I find it?

Resize PMI

Application PMI

Toolbar PMI→Resize PMI
Menu PMI→Resize

Resource bar
In the Part Navigator, right-click the model work view
→ Resize PMI In View

PMI Preferences

Menu
Preferences→PMI→PMI→ Display tab → Resize
Options

Customer Defaults

Menu File→Utilities→Customer Defaults
Location in dialog
box PMI →PMI General →Display tab→Resize Options
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Checking PMI GD&T Validity

You can use the two Check-Mate tests, Check PMI GD&T Semantic Validity
and Check PMI GD&T Syntactic Validity, to verify that the PMI GD&T on the
part is compliant with the GD&T standards for the part.

The results from the check of PMI GD&T symbols are listed in the HD3D
Tools navigator in the Results group; associated visual tags also appear in
the graphics window.

For more detailed information about each result, you can right-click the object
in the Results list and select Show Info View.

Where do I find it?

Application PMI

Toolbar Check-Mate→Set Up Tests
Menu Analysis→Check-Mate→Set Up Tests
Location in dialog
box

Tests tab→PMI→Check PMI GD&T Semantic Validity
or Check PMI GD&T Syntactic Validity

Resource bar

HD3D Tools tab →Check-Mate→Settings

group→Set Up Tests

Box type PMI Lightweight Section View

PMI lightweight section views can be defined using a box type of clipping
boundary.

Only the material from selected components or bodies within the box clipping
boundary will remain displayed. Components or bodies that have not been
selected are unaffected. This allows for large complicated models to be
simplified in order to make views of them more manageable.
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Before lightweight section view Box type section view

Existing PMI lightweight section views will be converted to a one plane type
of PMI lightweight section view.

How do I use it?

To create a Box PMI lightweight section view, select the desired type on the
PMI lightweight section view dialog box and use the controls on screen and
on the dialog to define the placement of the clipping planes.

Where do I find it?

Application PMI

Toolbar PMI→Lightweight Section View
Menu PMI→Section→Lightweight Section View
Location in dialog
box Lightweight Section View dialog box® Type list® Box

Inheriting PMI lightweight section views on drawings

You can now place a PMI lightweight section view on a drawing as a base view.

The inherited PMI lightweight section view is an associative copy of the 3D
PMI Model View, and any changes to the section view need to be made in the
3D PMI Model View.
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A one plane type lightweight section view

The same view inherited on a drawing

New customer default options for inherited lightweight section views

Crosshatch
Inherited PMI
Lightweight
Section Views

Lets you determine whether to add crosshatching to the
cut face portions of a PMI lightweight section view that
has been inherited to a drawing.

Compound Box
Type Lightweight
Section View

Lets you determine whether multiple inherited box type
PMI lightweight section views can be combined into a
drafting view.

Where do I find it?

Application Drafting

Toolbar Drawing→Base View
Menu Insert→View→Base
Location in dialog
box Model View group®Model View to Use
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Customer defaults

Menu File→Utilities→Customer Defaults

Location in dialog
box

Drafting→View→General tab→Crosshatch Inherited
PMI Lightweight Section Views option

Drafting→General→View tab→Compound Box Type
Lightweight Section View option

Crosshatch Inherited PMI Lightweight Section Views

Application Drafting
Menu Preferences→View
Location in dialog
box

Inherit PMI tab→Crosshatch Inherited PMI Lightweight
Section Views

PMI Search enhancements

You can now use the PMI Search command to find datum feature symbols
and datum targets on a model that meet the criteria you specify. You can
examine PMI symbols that match the criteria one by one, or you can save the
results to a search model view, which you can review at a later time. Search
model views are saved with the part.

The following datum target types are supported:

• Point

• Line

• Rectangular

• Circular

• Annular

• Cylindrical

• Arbitrary

Where do I find it?

Application PMI

Toolbar PMI→PMI Search
Menu Information→PMI→Search
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WAVE PMI Linker

Use the WAVE PMI Linker to make an associative copy of a PMI object from
one part to another so that other operations, such as Manufacturing, can
reference the PMI. When the contents of the source PMI are changed, the
PMI in the target part will also be updated. You can select the target part
and the source part from which the PMI will be copied.

Geometry to WAVE Link

You can select either Body or Topology to WAVE link.

• Body – NX will prefer to WAVE link the entire solid body that contains
the edge/face to which the PMI is associated.

• Topology – NX will prefer to WAVE link the edge/face as a separate
WAVE link feature.

By creating a WAVE link for the PMI object, you can track the relationships of
the object between parts using the Assembly WAVE Interpart Link Browser
or the Relations Browser.

Note If you only want to see component PMI in a parent assembly, you can use
the PMI Assembly Filter instead of making an associative copy of the PMI.

Where do I find it?

Application PMI
Menu Insert→Associative Copy→WAVE PMI Linker

Support for Standard Fonts

Standard font types available in the FreeType Font library are supported in
the PMI and Drafting environments.

Note Although the FreeType Font library supports non scalable and other
font types, only scalable TrueType, OpenType, and PostScript fonts are
supported.

When setting your character font, it is important to remember the following
points:

• Existing NX font types are still available and are located in a directory set
by the UGII_CHARACTER_FONT_DIR environment variable.

• Standard Fonts files are found in your normal font directories, usually in
the C:\Windows\Fonts on Windows or in a configuration file on Unix.

• You can use custom fonts by placing the font files in a directory referenced
by the UGII_STANDARD_FONT_DIR environment variable.
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• NX will search for the character font in the following order:

1. Standard font location (that is, C:/Window/Fonts).

2. The directory specified by UGII_STANDARD_FONT_DIR.

3. The directory specified by UGII_CHARACTER_FONT_DIR.

• A default font is used when a font cannot be found. The default font can
be changed, but is initially set to Arial Unicode MS. If Arial Unicode MS
is not found, the default font is set to Tahoma. If Tahoma is not found,
then the default font is set to Arial.

Why should I use it?

Use Standard Fonts to replace, enhance, or supplement your current set
of drafting and PMI character fonts.

Where do I find it?

All fonts found in standard directories and in the custom directory are
automatically available in customer defaults, preference dialog boxes, style
dialog boxes, and any other dialog box that lets you specify a character font.

Associative custom symbols

When you create custom symbols from a master custom symbol definition,
you can make the custom symbols associative to the master custom symbol.
If the master custom symbol changes, the associative copies of the symbol
also change.

Note Associativity is not supported for nested custom symbols or PMI custom
symbols inherited onto a drawing.

When you create associative custom symbols, it is important to note the
following.

• Associativity to the master symbol is lost if the master symbol is deleted,
the folder containing the master symbol is deleted, or the symbol instance
is smashed into its constituent parts. You cannot add master symbol
associativity to existing symbol instances created in previous NX releases.

• When you create an instance of a master custom symbol, the Lock Update
option is available. When set, the symbol instance is locked, and changes
to the master symbol definition do not affect the instance.
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Original master symbol
Symbol instances from original

master symbol

Changed master symbol
Symbol instances from changed

master symbol

– Unlocked symbol – Locked symbol

• You can manually update symbol instances that are unlocked.

See Out-of-Date Folder for additional information.

• You can also change the locked status of existing custom symbol instances.

• The Reassociate command lets you reassociate a symbol instance to its
master symbol definition. You can only use the Reassociate command
on symbol instances created in NX 8 and above.

Create Associative Symbols customer default and the Lock Update option

A new customer default, Create Associative Symbols, determines whether
or not to create an associative custom symbol instance. It also determines
the visibility and availability of the Lock Update option in the Custom
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Symbol dialog box. When Create Associative Symbols is selected, the Lock
Update option is visible and available, and you can create both associative
and non-associative symbol instances. When it is not selected, the Lock
Update option is not visible and symbol instances are always created as
non-associative copies of the master custom symbol.

Why should I use it?

Create associative custom symbol instances when you want your symbol
instances to always reflect the master definition of the original custom symbol.

Where do I find it?

Lock Update option

Application Drafting and PMI

Toolbar

In the Drafting application:

Symbol®Symbol Drop-down list®Custom Symbol

In the PMI application:

PMI®PMI Symbols Drop-down®Custom Symbol

Menu

In the Drafting application:

Insert®Symbol®Custom

In the PMI application:

PMI®Symbol®Custom
Location in dialog
box Settings group®Lock Update

Create Associative Symbols customer default

Menu File®Utilities®Customer Defaults
Location in dialog
box

Drafting®Custom Symbols®All tab®Create
Associative Symbols

Reassociate command

Application Drafting and PMI
Graphics Window Right-click custom symbol instance®Reassociate
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General annotation enhancements

The following enhancements are provided to improve and optimize how you
create and use annotations.

• When you create or edit a note, the Inherit option on the Note dialog box
lets you inherit the text, style preference, and text alignment settings of
an existing note on the current drawing sheet.

• When you position a surface finish symbol created with a leader type set
to Flag, you can select either side of the leader line to place the symbol.
The symbol will automatically change its orientation when you place it on
the opposite side of the leader line.

Note If you want any associated surface finish symbol text to also be
reoriented, you must select Invert Text in the Settings group of the
Surface Finish dialog box.

• A new Position at Snap Point option lets you position all annotation and
symbols using the Snap Point functionality on the Selection bar.

• A new customer default, Show All Extension Handles, displays all
centerline handles when you create or edit centerlines, regardless of the
setting of the Set Extension Individually option.

• You can now reposition annotation that is retained due to lost associativity.

• You can add part attributes, object attributes, and non-sketch related
expressions to master custom symbols.

• You can use Snap Point functionality to select points on the geometry of a
custom symbol without smashing it first.
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Where do I find it?

Inherit option for notes

Application Drafting

Toolbar Annotation→Note
Menu Insert→Annotation→Note
Location in dialog
box Inherit group→Select Note

Surface Finish Symbol positioning

Application Drafting
Prerequisite The symbol must be placed with Leader Type set to Flag

Toolbar Annotation→Surface Finish Symbol
Menu Insert→Annotation→Surface Finish Symbol

Surface Finish Symbol positioning

Application PMI
Prerequisite The symbol must be placed with Leader Type set to Flag

Toolbar PMI→Surface Finish Symbol
Menu PMI→Surface Finish Symbol

Position at Snap Point option

Application Drafting and PMI

Toolbar
Any command that contains the Origin group in the
dialog box

Menu
Any command that contains the Origin group in the
dialog box

Location in dialog
box

Origin group®under Alignment®Position at Snap
Point check box

Show All Extension Handles customer default

Application Drafting and PMI
Menu File®Utilities®Customer Defaults
Location in dialog
box

Drafting®Annotation®Symbols tab®Show All
Extension Handles check box
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ASME Y14.5-2009 Drafting Standard enhancements

What is it?

New options are available to create ASME Y14.5-2009 compliant annotations.
Enhancements to the Drafting and PMI annotation functionality let you
do the following:

• Create basic dimension types that are not to scale.

• Create a Datum on Dot Terminated leader with an arrowhead for Feature
Control Frames (FCS), Datum Feature Symbols (DFS), and notes.

• Create a leader with an all over symbol for a feature control frame.
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• Correctly attach annotations, such as a feature control frame, to a
dimension using a Flag leader.

• Create a datum target symbol with a spherical zone shape.

• Specify an angular dimension as a fractional division of an arc.
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Where do I find it?

Basic, Not to Scale dimension type

Application Drafting and PMI

Toolbar

In the Drafting application:

Annotation®Annotation Preferences

Menu

In the Drafting and PMI applications:

Preferences®Annotation

Location in dialog
box

Dimensions tab®Dimension Display Type list®Basic,

Not to Scale

Datum on Dot Terminated leader with an arrowhead

Application Drafting

Toolbar

Annotation→Datum Feature Symbol

Annotation→Feature Control Frame

Annotation→Note

Menu

Insert®Annotation®Datum Feature Symbol

Insert®Annotation®Feature Control Frame

Insert®Annotation®Note

Location in dialog
box

Leader group®Type®Dot Terminated

Style subgroup® Arrowhead
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Leader with an All Over symbol for a feature control frame

Application Drafting and PMI

Toolbar

In the Drafting application:

Annotation®Feature Control Frame

In the PMI application:

PMI®PMI Annotation Drop-down®Feature Control

Frame

Menu

In the Drafting application:

Insert®Annotation®Feature Control Frame

In the PMI application:

PMI®Feature Control Frame
Location in dialog
box Leader group®Type®All Over

Datum target symbol with a spherical zone shape

Application Drafting and PMI

Toolbar

In the Drafting application:

Annotation®Datum Target

In the PMI application:

PMI®Datum Target

Menu

In the Drafting application:

Insert®Annotation®Datum Target

In the PMI application:

PMI®Datum Target
Location in dialog
box Type group®Spherical
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Angular dimension as a fractional division of an arc

Application Drafting and PMI

Toolbar

In the Drafting application:

Annotation®Annotation Preferences

Menu

In the Drafting and PMI applications:

Preferences®Annotation
Location in dialog
box Units tab®Display as a Fraction

ESKD Drafting Standard enhancements

The following enhancements are provided in both Drafting and PMI to better
support the ESKD drafting standard.

Note The ESKD standard must be set in customer defaults, or in Surface
Finish option on the Symbols tab of the Annotation Preferences dialog
box.

• You can specify surface finish symbols with roughness values in which the
lay symbol and roughness are in a single line.

4-126 What’s New in NX 8



CAD (Design)

• The Not Specified weld type lets you create a symbol with just weld
properties and no specific weld type.

Where do I find it?

Surface finish symbol with a single line roughness callout

Application Drafting and PMI

Prerequisite
Your drafting standard must be set to ESKD in the
Annotation Preferences dialog box.

Toolbar

In the Drafting application:

Annotation®Surface Finish Symbol

In the PMI application:

PMI®Surface Finish

Menu

In the Drafting application:

Insert®Annotation®Surface Finish Symbol

In the PMI application:

PMI®Surface Finish®Attributes
group®Standard®ESKD

Location in dialog
box Attributes group®Single Roughness Value
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Not Specified weld type

Application Drafting and PMI

Prerequisite
Your drafting standard must be set to ESKD in the
Annotation Preferences dialog box.

Toolbar

In the Drafting application:

Annotation®Weld Symbol

In the PMI application:

PMI®Weld Symbol

Menu

In the Drafting application:

Insert®Annotation®Weld Symbol

In the PMI application:

PMI®Weld Symbol

Location in dialog
box

Other Side group®Weld Symbol list®Not Specified

Arrow Side group®Weld Symbol list®Not Specified

PMI support in STEP translator

What is it?

You can now translate PMI data from NX to STEP as polyline (presentation)
data. You can also now import PMI (polyline form) from STEP to NX.

Why should I use it?

Use this if you want to translate NX PMI to STEP and Import STEP PMI to
NX.

Where do I find it?

Application NX

Menu

File®Import®STEP203

File®Import®STEP214

File®Export®STEP203

File®Export®STEP214
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View Creation Wizard

The View Creation Wizard simplifies the process of adding one or more
drafting views to a drawing sheet.

The wizard steps you through the following process of:

• Selecting a currently loaded, recently loaded, or unloaded part or
assembly.

• Specifying the preview style and view display parameters.

• Optionally inheriting existing PMI data from the assembly model.

• Optionally selecting existing assembly arrangements.

• Specifying a view orientation for the parent view.

• Constructing a multi-view layout.

Note The View Creation Wizard is available for master model drawings only.
It is not available for standalone drawings.

By default, the View Creation Wizard is launched immediately after creating
a new drawing or a new drawing sheet. You can change this default behavior
by adjusting the options on the General tab of the Drafting Preferences dialog
box, or by adjusting the options on theWorkflow tab under Drafting→Drawing
on the Customer Defaults dialog box.

The View Creation Wizard window

The options in the View Creation Wizard window step you through the
process of defining and placing a group of views on the current drawing sheet.
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You can:

• Select the part or assembly to be depicted on the drawing.

• Set your preferences for the display. You can click View Style to
set view style preferences not directly available from the from the View
Creation Wizard window.

• Specify the parent view orientation.

• Configure a view layout. You can include up to six standard orthographic
views in the layout, along with an isometric or trimetric view. The
projection angle of the views is derived from the projection angle of the
drawing.

• Place the view layout on the drawing sheet using Margins to define the
minimum distance between adjacent view borders in the layout, and
between view borders and the edge of the drawing sheet.

If the View Placement option is set to Automatic, you can complete the
placement of the views in the first step. Use the Manual option if you want to
place the center of the view layout anywhere on the drawing sheet.

Where do I find it?

Application Drafting

Toolbar

Drawing→Add View Drop-down list®View Creation

Wizard

Drawing→View Creation Wizard
Menu Insert→View→View Creation Wizard
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Sheet dialog box:

Location in dialog
box

Settings group®Automatically Start View
Creation®View Creation Wizard

View Creation Wizard preferences:

Menu Preferences→Drafting
Location in dialog
box

General tab®Model–based Drawing Workflow®View
Creation Wizard

View Creation Wizard customer defaults:

Menu File→Utilities→Customer Defaults
Location in dialog
box

Drafting®General®Drawing tab®Model–based
Drawing Workflow®View Creation Wizard

Shape Studio

Highlight Lines enhancements

What is it?

The enhancements to the Highlight Lines dialog box makes it easier to do
the following:

• You can use the Light Placement option list to specify how the lights
are configured.

• You can use the Point Dialog button to specify locations when using the
Through Points or Between Points placement method.

• You can use the Number of Lights and Light Spacing options or the
input fields.
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In addition, new Light Plane options that work in conjunction with the
Manipulator enhance your ability to designate and manipulate the light plane.

• You can choose from principal XC, YC, ZC planes. An Offset option is
available when using these options.

• You can choose to designate an Arbitrary Plane using standard Specify
Plane options.

• You can specify the display resolution of the analysis.

Where do I find it?

Application Modeling and Shape Studio
Toolbar
(Shape Studio
only) Analyze Shape®Highlight Lines
Menu Analysis®Shape®Highlight Lines

Law options enhancements

What is it?

Commands that have Law options have been enhanced in the following ways.

• You can now use dynamic manipulation handles for law types Constant,
Linear and Cubic.
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• You can use shortcut menus for parameter editing for these law types:

o Constant

o Cubic

o Non-inflecting

o Linear

o Multi-transitional

o S-shaped

• The dialog box options for S-shaped and Non-inflecting law types have
been consolidated and more descriptive labels for these options have
been added.

• Handles applied between start and end nodes have an initial Transition
value of Free.

Commands that use the Multi Transition law have been updated to eliminate
possible overlapping Law definitions.

The Linear Along Spine and Cubic Along Spine laws are removed because
the Multi Transition laws Linear and Blend provide similar functionality.

The following commands are affected:

• Aesthetic Face Blend

• Law Extension

• Silhouette Flange
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Where do I find it?

Application Modeling and Shape Studio

Commands

Offset Curve

Law Extension

Section Surface

Swept

Aesthetic Face Blend

Silhouette Flange

Global Shaping

Toolbars

Curve

Feature

Surface

Menu

Insert®Curve from Curves®Offset Curve

Insert®Detail Feature® <various commands>

Insert®Mesh Surface®Section

Insert®Sweep® Swept

Insert®Flange Surface® <various commands>

Draft analysis objects

What is it?

The Draft Analysis command now creates a draft analysis object (DAO) when
you click OK or Apply in the dialog box.

• Draft analysis now supports facet bodies.

• Draft analysis objects appear as objects in the Part Navigator.

• You can select multiple faces and facet bodies for the analysis, but only
one analysis object is created.

• You can have multiple analysis objects on a single face or facet body.
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The Draft Analysis command also has these enhancements:

• A color legend appears for each displayed analysis object, indicating
areas that are:

o Above draft

o Above draft limit

o Below draft limit

o Below draft

• The display mode switches automatically to Face Analysis when you
click the command.

• You can optionally create non-associative isocline curves from the analysis.

• You can reverse the normals of all input faces and facet bodies in a single
operation or individually one by one.

• You can create labels to visualize local draft angle values and drag them
across the selected faces.

• You can specify the display resolution of the analysis.

Where do I find it?

Application Modeling, Shape Studio

Toolbar Analyze Shape®Draft Analysis
Menu Analysis®Shape®Draft

Snip Surface enhancements

What is it?

The functionality of the Isoparametric Trim/Divide command is consolidated
with the Snip Surface command.

You can use the Snip Surface command to do the following:

• Snip along surface isoparameters.

• Snip with a surface.

• Edit a copy of the original surface.

• View a deviation display of the snipped surface from the original.
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The Isoparametric Trim/Divide command is no longer available.

Note You can trim using UV parameters with the Enlarge command. This
functionality is not duplicated in the Snip Surface command.

Why should I use it?

You can now perform divide operations with the Snip Surface command to
produce single unified Class-A surfaces with a reduced number of workflow
steps.

Where do I find it?

Application Modeling, Shape Studio

Toolbar Edit®Snip Surface
Menu Edit®Surface®Snip Surface

Match Edge enhancements

What is it?

The Match Edge command has been enhanced with the following
functionality:

• You now can edit poles using Shape Control and then use theMovement
options without having to click Apply after you edit the poles.

• In the Method group, the Opposite Edge Constraint option is now outside
the Movement and Shape Control tabs so you can set this option in
conjunction with the options on either tab.

• You can now use Edit Poles when in Associative Edit Freeform mode.

• When in Associative Freeform Editing mode, you can select the Keep
Selected check box in the Settings group to keep the Edge to Edit and
Reference objects selected for subsequent match edge operations.

• Pole structure can now be displayed on both the Edge to Edit and
Reference faces.

• The Reset Edit Poles option in Shape Control resets any poles that were
edited to their original state.

• When using Section Analysis with Match Edge, Preview now shows how
the analysis object will be updated based on the proposed match edge
surface.
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Preview – off

Preview – on

Where do I find it?

Application Modeling and Shape Studio

Toolbar Edit Surface ® Match Edge
Menu Edit ® Surface ® Match Edge
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Match Edge and Edge Symmetry enhancements

What is it?

The following are available for the Match Edge command with the Project
movement method:

• Fix Poles options Fix Start and Fix End to constrain the position of the
start and end poles.

• Offset handles that behave similar to the Normal movement method.

For the Edge Symmetry command, aWCS movement method has been added
with XYZ vector options to specify direction.

Where do I find it?

Application Modeling and Shape Studio

Toolbar

Edit Surface®Match Edge

Edit Surface®Edge Symmetry

Menu

Edit®Surface®Match Edge

Edit®Surface®Edge Symmetry

Dialog box

Match Edge®Method group®Movement tab

Edge Symmetry ®Method group®Movement tab

X-Form enhancements

What is it?

The X-Form command has been enhanced in the following ways.

• You can now edit non-B-Spline curves using X-Form.

o Selected curves are converted to B-Splines for editing. In the case of
curve features, curve parameters are removed before conversion.

o You can set your preferred default command for spline editing.

Default Action on Spline

Studio Spline X-Form
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This is available in two places.

Preferences® Modeling® Freeform

File® Utilities® Customer Defaults® Modeling® Freeform
Modeling

• You can now use the keyboard arrow keys, to step up and step down the
input Step Value when moving poles in conjunction with Microposition
options.

o Arrow-up  key corresponds to the + button.

o Arrow-down ¯ key corresponds to the – button.

• You can right-click a polyline to insert a row of poles before or after the
selected polyline.

When a row of poles is inserted, the original rows of poles are not
displaced and maintain their original position.

1. Insert Pole Row – Next

• When you are using the Shape Studio application, you can double-click on
unparameterized surfaces to start the X-Form command.
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• You can now move one pole or set of poles by specifying X, Y, and Z
coordinates.

o The XYZ option is now available when using the WCS option in
the Move tab.

o XYZ Coordinates can also be accessed from the shortcut menu.

o You specify X, Y, Z coordinates using an on-screen input box.

• You can now use Shift-select to deselect an input face and select another
face during X-Form editing.

Where do I find it?

Application Modeling and Shape Studio

Toolbar Edit Surface®X-Form
Menu Edit®Surface®X-Form

Aesthetic Face Blend enhancements

What is it?

The Aesthetic Face Blend command has been enhanced in the following ways.
• You can now specify a Spine Curve when creating a Chord Length
Tangent Line type blend.

Specifying a spine curve helps orient the cross sections of the blend normal
to the specified spine curve, which helps improve the output blend surface.

• In cases where the continuity of input faces is not within a specified
tolerance, you can use Blend Across Sharp Edges in the Settings group
to compute (or modify) the tangent hold lines of the blend.

• You can now specify a variable chord length for tangent line creation in
addition to the current constant chord length tangent line control.

• In blend cases where the rolling ball radius is larger than the curvature
radius of the input face chains and the blend washes out, use theWashout
Surface Creation option to build a washout surface patch.

• You can use the Overriding Trim Object option to manually specify the
start and end of the blend surface.

• You can now specify G3 continuity constraints on conic shaped cross
sections while holding the center radius specification.
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• You can now control the Tangent Magnitude on each input face chain
independently.

o The tangent magnitude uses a constant law value on each face chain
along the length of the blend.

o You can specify tangent magnitude using either on-screen handles or
the input fields in the dialog box.

• You can now specify separate, individual continuity constraints on each
face of an input face chain. For instance, the continuity of the first input
chain of faces can be G1, while the second input chain of faces can have
G2 continuity.

• The Sew All Faces option has been added to Trim Options.

• You can now trim a blend at a specified location, which lets you limit the
blend to a selected object such as a plane, face or edge.

• You can use the Non-associative Center line Curve Output option specify
a non-associative centerline curve of the blend be created when the blend
is generated.

• Use the Bezier Output option in the Settings group to specify Bezier
surface patches be generated instead of B-surfaces. The Bezier Output
option divides blend faces at knot values.

Note the Trim and Attach option is not available with Bezier output.

• You now can control the segmentation of a generated blend surface. There
are four options.

o Use the Both Face Chains option to segment the blend surface at the
boundaries of both the input face chains.

o Use the On Face Chain 1 option to segment a blend surface at all
the boundaries of first face chain.

o Use the On Face Chain 2 option to segment a blend surface at all the
boundaries of second face chain.

o Use the On Both Face Chains and Merge Small Blend Faces option
to segment the blend surface at all the face chains then merge all the
faces whose tangent curves are shorter than a specified threshold
value.
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Where do I find it?

Application Modeling and Shape Studio

Toolbar Feature®Aesthetic Face Blend
Menu Insert®Detail Feature®Aesthetic Face Blend

Data Reuse

Reuse Library

Reuse Library Management

Use the Reuse Library Management command to configure the content of
the Reuse Library. You can:

• Add user defined libraries to the Reuse Library, or remove them.

• Edit the descriptive name, path, and the icon of the libraries.

• Specify which libraries are visible in the Reuse Library.

• Load your own library configuration file.

• Specify the NX applications in which a library is available.

• Set the catalog visibility for the standard parts library.

You can also use this command to access libraries which are stored on your
machine, even when you run Teamcenter Integration. Libraries on your
machine can include the reusable object library, UDF library, and 2D section
library.

Where do I find it?

Resource Bar Reuse Library

Toolbar Reuse Library® Reuse Library Management
Menu Tools® Reuse Library® Reuse Library Management
Reuse Library
Navigator

Right-click the title of the main panel® Reuse Library
Management
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Integrating reusable objects with a spreadsheet

You can define values and options in a spreadsheet and integrate that
spreadsheet with a reusable object or a knowledge enabled part. When you
add a knowledge enabled part or a reusable object to the graphics window,
the Add Reusable Component or the Reuse Paste dialog box appears. The
dialog box displays the available parameter values that are listed in the
spreadsheet, and lets you chose a value for each parameter.

In the spreadsheet, you can define values and options for the following:

• The location of the bitmap file used as the preview image for the object

• Part attributes

• Expressions

Expressions can be listed in primary, secondary, and tertiary levels in the
spreadsheet. In this format, the values available at each level depend on the
value selected for the preceding parameter or expression. For example, A is
a primary expression with two value options of 10 and 20. B is a secondary
expression and the value of that can be 0 or 5 if A=10 and 5 or 10 if A=20.

BITMAP ./cylinder.bmp

PARAMETERS
A B
10 0,5
20 5,10
END

Where do I find it?

Resource Bar Reuse Library

Prerequisite
You must drag a reusable object or a knowledge enabled
part from the Reuse Library to the graphics window.

Reuse Paste

When you add a reusable object to your work part from the Reuse Library,
you can now use the Reuse Paste dialog box to do the following:

• Change the position or orientation of the part.

• Modify any parameters specified in the spreadsheet integrated with the
reusable object.
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• Assign a Boolean operation and Boolean sequence to the selected target
body.

• Position a sketch-based reusable object with a single click.

• Associate a sketch-based reusable object to a datum CSYS.

• Edit a reusable object.

The Reuse Paste dialog box is available for the following reusable objects:

• Face, body, or general type

• 2D sections with spreadsheet data

• Parts with the part attribute REUSE_LIBRARY_OBJECT_TYPE set
to REUSE_IMPORT

Where do I find it?

Resource Bar Reuse Library

Reuse Library
Navigator

In the Member Select area, right-click a reusable object
and choose Insert.

Drag a reusable object from the Member Select area to
the graphics window.

Reuse Library navigator enhancements

In the Reuse Library navigator, you can now:

• Right-click a library folder and choose Open Source Folder to view and
open the directory path for a library.

• Copy or cut a reusable object in the Member Select area, and paste it to
another folder in that area.

• Display an HTML document. This document must have the same name
as the object in the Member Select area.

• Display a descriptive name for the part attribute in the Member Select
area. You can specify the descriptive name using the Customer Defaults
dialog box.
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Where do I find it?

Resource Bar Reuse Library

Reuse Library
navigator

Main panel ® Right-click a library folder ® Open
Source Folder

Member Select panel® Right-click an object® Copy
or Cut

Reusable object examples

NX now provides examples for the following types of reusable objects in the
Reuse Library:

• Feature template

• Law curve

• Punch, rib, shape, and snap

Where do I find it?

Resource bar Reuse Library

Reusable object enhancements

These enhancements let you:

• Add a reusable component to a feature pattern.

• Select a template part for the reusable component if it is not found during
editing.

• Drag a knowledge enabled part family member from the Teamcenter
classification to the graphics window.

Where do I find it?

Resource bar Reuse Library

Reuse Library
Navigator

In the Member Select area, right-click a reusable
component and choose Insert.

Drag a reusable component from the Member Select
area to the graphics window.
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Fastener Assembly

Customize Fastener Assembly

Use the Customize Fastener Assembly command to add your own parts
to the Fastener Assembly library. This command registers your parts as
standard fastener assembly parts by updating the knowledge definition
files. Knowledge definition files include the HoleFastenerMap.krx file and
the ReuseLibraryFasteners.krx file that are defined by the customer default
settings.

The registration process begins with a check for standard parts. A selected
part is rejected if it is not a knowledge enabled part. You must do the
following:

• Specify which standard part parameter is used for the diameter of the
hole and the length of the hole.

• Add the selected part to the knowledge definition files.

• Specify the hole type for the parts in the knowledge definition files.

Where do I find it?

Toolbar Reuse Library® Customize Fastener Assembly

Menu
Tools®Reuse Library® Fastener Assembly
Assistant® Customize Fastener Assembly

Remove Fastener Assembly Node

Use the Remove Fastener Assembly Node command to remove the top node
of a fastener assembly. This command finds all fastener assemblies in the
assembly and removes the top nodes automatically.

Where do I find it?

Toolbar Reuse Library® Remove Fastener Assembly Node

Menu
Tools®Reuse Library® Fastener Assembly
Assistant® Remove Fastener Assembly Node
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Fastener Assembly customer default enhancements

You can now use the Customer Defaults dialog box to set the following:
• Library path for the fastener assembly

• Path to configuration files in Teamcenter when you run NX in Teamcenter
Integration mode.

Where do I find it?

Menu
File®Utilities® Customer Defaults® Gateway®
Reuse Library ® Fastener Assembly

Reusable Pocket enhancements

These enhancements let you:

• Break a pocket link from your component.

• Add a default extended length for threaded holes.

• Support add Material.

Where do I find it?

Toolbar Reuse Library® Reusable Pocket
Menu Tools® Reuse Library® Reusable Pocket

Product Template Studio

Usability enhancements

What is it?

As the result of the usability enhancements, you can now add the following
parameters to a template dialog box:

• Optimization study

• Point, vector and Boolean expressions

• NX requirement checks

• HD3D tags

• General relinker options

• Material properties
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• Read only text boxes for string parameters

• A help tag for the template dialog box to behave like context sensitive help

Other enhancements include the ability to:

• Modify the text box size in the template dialog box. This is to support
non-English template dialog boxes.

• Store and access template images in Teamcenter in bitmap format and
use them for template labels.

• Store other data types like HTML, PDF, Excel spreadsheets, and Word
documents used in templates in Teamcenter.

• Have the template dialog box updated automatically after you run a
visual rule. The template dialog box displays updated parameter values
when a visual rule changes the value of an expression.

• Select to have the Redefine Constraint dialog box appears when you drag
a template part to the graphics window from the Reuse Library. Use this
when your template part contains remembered constraints defined by the
Remember Assembly Constraints command.

• Select to have the template component positioned at the drop point
instead of the global origin when you drag it from the Reuse Library to
the graphics window.

Where do I find it?

Application Product Template Studio
Prerequisite You must open a model or a template.

Visual Rule enhancement

What is it?

When you use the Add Rule command, you can now add a visual rule to:

• Launch a .NET application.

• Replace a component in the product template.

• Control the text for a label in the template dialog box. When a label no
longer represents what the parameter controls as the result of a template
operation, your visual rule can update the label to represent what the
parameter controls.
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Where do I find it?

Application Product Template Studio
Prerequisite You must open a model.

Toolbar Template Operations® Add Rule

Initial values for template parameters

What is it?

When you add a product template to an assembly, NX scans the existing
expressions in the assembly. If an expression has the same name as a
parameter in the template dialog box, the value of this expression is used as
the initial value of the parameter in the template dialog box.

Note When working with routing templates and assemblies, NX scans the
expressions of stock components as well.

Where do I find it?

Prerequisite You must add a product template to an assembly.

Add Routing Placement Solution Control

What is it?

Add the Add Routing Placement Solution Control dialog component to a
routing template part to let the template user cycle through connection points
and select the desired one. This dialog component appears in the template
dialog box when you add the template part to an assembly.

Note This dialog component is similar to the Placement Solutions group
available in the Place Part and the Routing Solver dialog boxes.

Where do I find it?

Application Product Template Studio

Graphics Window Dialog component bar
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HD3D tags in product templates

What is it?

As the result of this enhancement, you can now add HD3D tags to a product
template to do the following:

• Provide a link to documentation for the template.

• Provide usage guidance for the template.

• Highlight failures or warnings generated by requirement checks in the
template.

• Document and guide WAVE re-parenting operations in the template.

Where do I find it?

Application Product Template Studio
Prerequisite You must add HD3D tags to a product template.

Routing Systems

Routing Systems

Part placement enhancements

What is it?

The Instance Name Lookup command is new.

You can now create a part instance name table in a Comma Separated Values
(.csv) file format and use the new Instance Name Lookup command to place
parts based on the instance name specified in the table.

The Place Part command is enhanced.

You can now automatically select and place a part based on the destination
characteristics and the run definition by using the Place Part command.
The filter or the part Search criteria is based on the specification rules and
relationships that you define.

The parts are placed only if they do not disturb the flow or continuity of the
pipes at the selected destination. For example, you cannot place an elbow at a
pipe center as it disrupts continuity of the flow along the pipe.

You can also define the screw seat location for a part using the options in the
new Measurement Holder Location group of the Place Part dialog box.
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Place a mounting or screw seat under a pipe by selecting a point on the stock
segment or an RCP. Specify the distance by which to offset the screw seat
from the RCP. This offset is usually the radius of the stock or pipe.

Screw seat placed on a stock with an offset from the segment

Mounting placed at an anchor on an elbow joint
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Why should I use it?

These enhancements help you to automate part selection and placement
tasks and reduce modeling time. For example, you can define a rule to
automatically place a flange every time you place a valve.

Where do I find it?

Instance Name Lookup command

Application Routing Mechanical

Prerequisite

A part instance table must be defined and the ship
number must be specified using the Ship Identifier
customer default under Routing®General in the
File®Utilities®Customer Defaults dialog box.

Menu Tools®Instance Name Lookup

Place Part command

Application Routing

Toolbar Routing toolbar®Part Drop-down list®Place Part
Menu Insert®Routing Part®Place Part

Create Fabrication enhancement

What is it?

You can now add additional fabrication attributes using the options in the new
Attributes group and Optional subgroup in the Create Fabrication dialog box.

Why should I use it?

You can add more description to the fabrication without opening the
ugroute_mech_xxx.xml file.

Where do I find it?

Application Routing Mechanical

Toolbar

Routing Mechanical®Part Drop-down list®Create

Fabrication
Menu Insert®Routing Part®Create Fabrication
Location in dialog
box Attributes group®Optional subgroup
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Design Rule Violation Objects Color

What is it?

The new Design Rule Violation Objects Color customer default allows you to
change the color of an object that violates design rules.

In the case of a spline bend radius design rule violation, the specified color is
applied to the temporary spline segments that show the violation of the bend
radius, and not to the entire spline. In other cases, the color is applied to all
the displayable objects that violate the design rule.

Why should I use it?

This customer default helps you to easily recognize design rule violations.

Where do I find it?

Menu File®Utilities®Customer Defaults
Location in dialog
box

Routing®General®Display tab®Design Rule
Violation Objects Color

Routing checks

What is it?

You can now test the validity of Routing connections and display the results.

You can:

• Check parts in Routing Mechanical and Routing Electrical applications.

• Configure a callback to determine the validity of connections. If you do not
use callbacks, NX relies on design rule results to check connection points
in a part. To determine the validity of the connections, NX checks if the
vectors for the connected ports are opposite and collinear.

• Override invalid connection points and record a justification. The
overridden invalid connection points appear as valid in the display.

• Filter the results of the checks according to status of connection points.
For example, you can view only invalid connections.

A visual display of the results of the check is created.
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Valid

Indicates that the
connection point was
determined to be valid
by the tests that were
run.

Invalid

Indicates that the
connection point was
determined to be invalid
by the tests that were
run.

No connection found
Indicates that the
connection point
contains a single port.

Overridden
Indicates that an invalid
connection point was
changed to valid.

You can set up the tests in the following ways:

• Use Check-Mate tools.

• Launch the callback.

You can view the results in the following ways:

• Use Check-Mate tools.

• Use the HD3D visual reporting tools.
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Why should I use it?

You can customize the callback and specify your own conditions and
parameters for checking the connections.

Where do I find it?

The callback location is ugroute_mech\plugins.

Application Routing

Toolbar

Check-Mate®Set Up Tests /View Check-Mate

Results

Menu
Analysis®Check-Mate®Set Up Tests/View
Check-Mate Results

Resource bar HD3D Tools tab® double-click Check-Mate.

Edit Line Segment enhancement

What is it?

The Edit Line Segment dialog box has a new Detach Active Control Point
option. Use this option to delete all the constraints on the active RCP.

When you use this option, NX detaches the segment from all connections and
creates new RCPs at all the detached ends. You can then use the new RCPs
to move the line segment without affecting other line segments that were
previously attached.

To reconnect the detached line segment, use the Connect Path command.

Where do I find it?

Application Routing Logical and Routing Mechanical

Toolbar

Routing toolbar®Edit Path Drop-down®Edit Line

Segment
Menu Edit®Routing Path®Edit Line Segment
Graphics window Right-click a route line®Edit Line Segment
Location in dialog
box Settings group®Detach Active Control Point button

What’s New in NX 8 4-155



CAD (Design)

Assign Corner enhancements

What is it?

The Assign Corner command now includes the functionality of the Cope
Corner command, which is no longer available.

When you use the Assign Corner command, you can now do the following:

• Create the following new types of corners:

o U-Bend

o U-Elbow

o Mitered Bend

• Change the type of the corner from mitered to cope or cope to mitered.

Miter corner Cope corner

Why should I use it?

Use the U-Bend corner type when you want to create a U-bend using two
RCPs or three stock segments.

Use the U-Elbow corner type to assign elbows to RCPs when the side
segments are parallel and it allows 0 mm gap between the two elbows,
U-Elbow assigns cut-elbows when the two side segments are not parallel.

Use the Mitered Bend option to create a bend similar to bend with radius
option, it allows user to specify number of miters in the bend.
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Where do I find it?

Application Routing

Prerequisite
The Cope command is available only in Routing Logical
and Routing Mechanical.

Toolbar

Routing toolbar®Path Drop-down list®Assign Corner

Menu Insert®Routing Path®Assign Corner
Location in dialog
box

Corner group®Corner Type list®U-Bend or U Elbow
or Cope or Mitered Bend

Routing Mechanical

Run Navigator commands

What is it?

New shortcut commands are available from the Run Navigator.

Split Run Splits a run into two separate runs.

You can change the default name for the split run by
using the options provided in the Run Name group in
the Split Run dialog box. The default name used for the
split run is created by appending the name of the original
run with a text string. You can use the Split Run String
customer default to customize the text string.

Integrate Runs Integrates two runs to create a unified run.

Reverse Flow Reverses the direction of components and symbols that
have characteristics defined for inlet and outlet ports, and
that have collinear inlet and outlet points.

This command automatically interchanges the From and
To items of a run.

Where do I find it?

Run Navigator commands

Application Routing Mechanical and Routing Logical

Prerequisite
The Integrate Runs command is available only when
you select two runs in the Run Navigator.

Menu Tools®Run Navigator®Split Run or Integrate Runs

Run Navigator
Right-click a run®Split Run or Reverse Flow or
Integrate Runs.

What’s New in NX 8 4-157



CAD (Design)

Split Run String customer default

Menu File®Utilities®Customer Defaults
Location in dialog
box Routing®Mechanical®General tab®Run group

Watertight Fittings

Use this command to create watertight fittings and add them to a new
subassembly. You can create watertight penetrations by creating additional
hardware around a selected pipe or around multiple pipes that penetrate a
wall.

The watertight fitting in the watertight subassembly shown was created
from a sketch curve.

Where do I find it?

Application Routing Mechanical

Toolbar

Routing Mechanical®Tools Drop-down

list®Watertight Fittings
Menu Tools®Watertight Fittings
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Routing Specification commands

What is it?

Use the routing specifications command to create new routing specifications,
edit existing specifications, and specify current specifications. In previous
releases, project leads or managers had to create specifications by editing the
APV files. The new specification commands help you to:

• Create specifications interactively, from a run, or from the P&ID diagrams.

• Search compatible parts and define part placement rules, automatically.

• Use the Compatibility Tables option to specify valid companion parts that
are added when a connection is made.

• Use the Generic Post Placement option to specify an additional part that
you want to be placed along with the part you place.

Where do I find it?

Application Routing Mechanical

Prerequisite
You must define at least one discipline such as Tubing
or Piping.

Reuse Library
Right-click the Routing Specification node®Create
New Specification

Duct Size Calculator

What is it?

Use this command to calculate the size of ducts used for HVAC applications.
You can use this command to calculate parameters of ducts that have the
following cross sections:

• Rectangular

• Flat Oval

• Circular
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Rectangular Flat Oval Circular

Why should I use it?

You can:

• Calculate the size of the cross section of the duct based on the flow
parameters.

• Adjust the flow parameters based on a specified duct size.

• Assign the calculated flow parameters to the selected segments as
attributes of the segment, and display the parameters.

• Edit the flow parameters or cross-section parameters of multiple segments
simultaneously if the parameters are identical.

• Create space reservations if required.

Where do I find it?

Application Routing Mechanical

Toolbar

Routing Mechanical®Tools Drop-down list®Duct Size

Calculator
Menu Tools®Duct Size Calculator

Create Linear Path enhancements

What is it?

When you use the Create Linear Path command, you can now make eccentric
pipe connections on a path. New options let you specify the direction and
distance from the centerline of the initial path to define a branch that is
eccentric.

Use the:
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• Eccentric Branch Point type to create eccentric branch segments. You can
select this option only after specifying a point on the curve from which you
want the branch to begin.

• Specify Vector option to specify a direction for the eccentric branch.

The default direction is down where down refers to the routing definition.

• Eccentric Offset option to specify the distance.

When you create the eccentric branch segment, the parent segment is
subdivided at the specified point location.

An eccentric branch segment has the following characteristics:

• It is not associative to its parent segment and therefore its length is not
updated when the stock on the parent segment changes.

• You cannot assign stock to an eccentric branch segment.

• You cannot assign bend corners at the end RCP of an eccentric branch
segment.

• You can change an eccentric branch segment to a normal segment and a
normal segment to an eccentric branch segment. To do this, you must
select the Eccentric Branch Segment check box in the Edit Line Segment
dialog box.
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Where do I find it?

Create Linear Path dialog box

Application Routing Mechanical

Prerequisite
The eccentric branch options are available only after
you specify a start point on a linear segment.

Toolbar Routing Mechanical®Create Linear Path
Menu Insert®Routing Path®Create Linear Path

Location in dialog
box

Specify Point group

Mode list®Eccentric Branch Point

Eccentric Offset

Match Eccentric Stock End check box

Edit Line Segment dialog box

Application Routing Mechanical

Toolbar

Routing Mechanical®Edit Path Drop-down list®Edit

Line Segment
Menu Edit®Routing Path®Edit Line Segment
Location in dialog
box Settings group®Eccentric Branch Segment check box

Pipe End Prep plug-in

What is it?

You can use this plug-in to:

• Create a point at the connection with weld attributes on it.

• Create connection notes about end preparations, manufacturing
instructions, and so on, using an attribute such as PIPE_END_NOTES
on the pipe end port.

NX uses the plug-in when any two ports are connected to form a new
connection.

Why should I use it?

The plug-in stores the pipe end preparation information that is required
during the cutting or manufacturing process.
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Where do I find it?

The plug-in location is ugroute_mech\plugins.

Transform Path enhancements

What is it?

Using the Transform Path command, you can now:

• Copy objects from one assembly to another assembly.

• Inherit specified attributes from the destination within the same assembly
or across assemblies.

• Maintain constraints when you move or copy routing objects across
assemblies.

• Automatically connect the routing objects at selected destination, if the
destination is valid.

• Move a part using the Dynamic motion option.

• Use the Copy Connected Parts check box to automatically move or copy
connected parts. It also subdivides a segment automatically when you
copy another segment onto it.

• Use the Move with Extension Segments check box to easily create
U-shaped paths.
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Why should I use it?

The Copy Attributes group helps you move or copy routing objects with:

• Stationary attributes that you want to continue at the new destination.

• Destination attributes that you want to inherit from the selected
destination.

The Dynamic motion enhancement helps you move a part along the axis or
rotate around the axis.

Where do I find it?

Application Routing Mechanical
Menu Edit®Routing Path®Transform Path

Toolbar

Routing Mechanical®Edit Path

Drop-down®Transform Path

Location in the
dialog box

Copy Attributes group®Defaults/User Specified

Transform group®Motion list®Dynamic

Settings group®Copy Connected Parts check box

Settings group®Move with Extension Segments check
box

Unify Path enhancements

What is it?

A new Place Dummy Symbol for Parts not found customer default is
available. If this customer default is selected, you can
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• Place dummy symbols in a routing path for the parts and stocks that
are not available in the part library.

• Replace the symbols with parts and stocks that have matching
characteristics after you update the library.

Why should I use it?

This enhancement helps you detect and visually mark parts and stocks that
do not match specifications.

Where do I find it?

Application Routing Mechanical

Customer Default
Routing Mechanical ®General tab® Unify Path group
®Place Dummy Symbol for Parts not found

Additional Pipe Length

What is it?

Use this command to add additional length to specified pipe ends.

You can use NX Open plug-ins to determine details such as:

• The minimum length that is necessary for a specific bending machine.

• The additional length that is necessary to account for weld shrinkage.

You can use this command on connected and unconnected ports. Connected
ports are hidden by default. You can make the connected ports visible by
using the new Display Connected Ports Routing preference.
For more information on visualizing templates, see **Unsatisfied xref title**.

For more information on checking and calculating pipe production length,
see **Unsatisfied xref title**.

Where do I find it?

The callback location is ugroute_mech\plugins.

Additional Pipe Length command
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Application Routing Mechanical
Toolbar Pipe Production Length®Additional Pipe Length
Menu Tools®Additional Pipe Length

Display Connected Ports Routing preference

Application Routing
Menu Preferences®Routing
Location in dialog
box

Routing Preferences dialog box®Display tab®Display
Connected Ports

Visualize Templates

What is it?

Use the Visualize Templates command to display the locations at which pipe
template lengths are applied.

You can:

• Display one or more of the following: ports, segments, stock.

• Display templates based on the template string, template values, or both.

• Display templates in only the work part or in all displayed parts.

For more information on creating additional pipe lengths, see **Unsatisfied
xref title**.

For more information on checking and calculating pipe production length,
see **Unsatisfied xref title**.

Where do I find it?

The callback location is ugroute_mech\plugins.

Application Routing Mechanical
Toolbar Pipe Production Length ®Visualize Templates
Menu Tools®Visualize Templates

Check and Calculate Pipe Production Length

What is it?

Use this command to examine pipe ports received as inputs.

When you run this command, NX does the following:

• Determines which stock or pipe the port belongs to.
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• Determined the appropriate bend machine to use.

• Read template length from the pipe end port and calculates the required
cut length.

If the template length is longer than the calculated cut length, the cut
length is set to 0. In all other cases, the cut length is set equal to the
difference, even if the difference is 0.

• Calculate the required shrinkage compensation.

If the template length is longer than the calculated weld shrinkage, the
weld shrinkage is set to 0.

• Locates the other stock port and computes the production length using
the values from both end ports.

The value of the production length is stored in the appropriate attribute
on the pipe.

• Adds the following attributes as needed:

o Adds attributes on the port to manage additional production
length. For example, CUT_LENGTH, TEMPLATE_LENGTH,
WELD_SHRINKAGE.

o Adds an attribute on the stock to store the calculated production
length.

o Adds attributes on the stock to store the assigned bend machines.

• Check for other design rule violations, or cases where the additional
production length cannot be calculated and reports the violations.

For more information on creating additional pipe lengths, see **Unsatisfied
xref title**.

For more information on visualizing templates, see **Unsatisfied xref title**.

Why should I use it?

This command enables the cut lengths and weld shrinkages of a port to be
updated based on changes made to the template length value.

Where do I find it?

The callback location is ugroute_mech\plugins.

The Check and Calculate Pipe Production Length command is run
automatically when you click OK or Apply in the Insert®Routing
Stock®Additional Pipe Length dialog box.
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Application Routing Mechanical

Toolbar
Pipe Production Length®Check and Calculate Pipe
Production Length

Menu Tools®Check and Calculate Pipe Production Length

Displaying routing stock as components in Teamcenter

What is it?

You can display routing fitting overstock and transition stock as separate
components in Teamcenter when you select the Stock as Components
routing preference.

If this preference is selected, you can also display the space reservation stock
as separate components in Teamcenter, using the Space Reservation as
Components option. The space reservation stock does not include non-routing
space reservation such as light cones, sprinklers, or other modeling fixtures.

Why should I use it?

You can interact with these routing components in the Product Structure
Editor without opening the part files in NX. You can also include these
components in the Bill of Materials.

Where do I find it?

Stock as Components

Application Routing Mechanical
Menu Preferences®Routing
Location in the
dialog box

Stock tab®Stock as Components

Space Reservation as Components

Application Routing Mechanical
Prerequisite The Stock As Component check box must be selected.
Menu Preferences®Routing
Location in the
dialog box

Stock tab®Space Reservation as Components
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Converting legacy space reservation stock as components in NX

What is it?

You can now convert legacy space reservation stock to components in NX.

Why should I use it?

You can display the legacy space reservation stock as components in
Teamcenter.

Where do I find it?

Application Routing Mechanical
Menu Edit®Routing Stock®Convert to Stock as Components

Comos Integration

What is it?

The Comos Integration connects Routing Mechanical with the Comos Process
and Instrumentation Diagram (P&ID) tool. With this integration there are
several useful tools now available in Routing Mechanical

Option Description
Connect Connects Routing Mechanical with the Comos application.
Disconnect Breaks the connection between Routing Mechanical and the Comos

application.
Unassign Breaks the link between a symbol on the Comos P&ID and the

component in your Routing Mechanical assembly.
Navigate To Allows you to jump from a component in your Routing Mechanical

assembly to the P&ID symbol or the 3D object in the Comos
application.

From the Comos P&ID application there are new tools under the NX Viper
menu:

Option Description
Assign Allows you to connect a symbol on the Comos P&ID to a component

in your Routing Mechanical assembly.
Navigate Allows you to jump from the Comos P&ID symbol to the assigned

component in your Routing Mechanical assembly.
Route Allows you to send the information for a route or run from Comos to

Routing Mechanical . Routing Mechanical takes the information
and creates or updates runs in the Run Navigator.
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Why should I use it?

This enhancement creates a tighter coordination between your P&ID and
3D Routing Mechanical assemblies.

Where do I find it?

Application Routing Mechanical
Menu Tools®Schematics

Ship Design

Ship Structure applications

What is it?

The Ship Design application is broken into three new applications based
on user tasks. The new applications are available when you use NX in a
Teamcenter environment.

Ship Structure Basic Design
Use this application to design a high level representation of the ship
structure.

For example, you can define structural systems such as decks and
bulkheads. You can also divide the ship into zones based on strength,
usage, and manufacturing requirements.

Ship Structure Detail Design
Use this application to design the detailed representation of the ship
structure.

For example, you can create steel structure parts, apply detailed cuts
to the ends of stiffeners, add chamfers between plates of different
thicknesses, and add steel insulation.

Ship Structure Manufacturing
Use this application to model the manufacturing shape of the ship
structure and augment that shape with manufacturing information.

For example, you can add material to plates or stiffeners, create rolling
lines on plates to use in a forming process, and create marking lines to
indicate the position of stiffeners for a welding process.

Note Some commands are available in multiple applications.
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Concept Model enhancements

What is it?

The dialog boxes for the Concept Model commands are enhanced to improve
clarity and to be consistent with other NX dialog boxes.

• You can access DesignLogic list options in numeric input boxes to specify
a value based on a formula, a reference to an existing value, or a derived
value from a measurement.

• Some dialog box options and groups are renamed.

• Some dialog box options are organized into new groups.

The Concept Model commands also include the following enhancements:

• In the Main Dimensions dialog box, you can define the Midship plane
location. The default location is the middle of the Aft Perpendicular and
Forward Perpendicular plane locations.

• In the Main Dimensions dialog box, you can specify the Grid ID. This
option was moved from the Export Frame Bar XML dialog box and can be
used in Drafting application to create frame bar objects.

• In the Transverse Frame dialog box, you can specify sets of frames in
the –X direction.

• In the Bulkheads dialog box, you can create bulkheads along the Y-axis
to reference longitudinal Y frames.

Where do I find it?

Application
Ship Structure Basic Design,
Ship Structure Detail Design

Toolbar

Ship Structure Basic Design®Concept Model
Drop-down list®All commands

Ship Structure Detail Design®Concept Model
Drop-down list®All commands

Menu Insert®Concept Model®All commands
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Ship Coordinates

Use the Ship Coordinates command to quickly obtain or specify the location
of a point relative to ship grid reference planes, ship coordinates, and absolute
coordinates without having to manually capture and convert coordinate
values.

You can:

• Select a point or a port on a routing component and obtain the absolute
coordinates and ship coordinates.

• Specify a location using absolute coordinates and obtain the ship grid
coordinates.

• Specify a location using ship grid coordinates and obtain the absolute
coordinates.

• Select reference planes along the X, Y, and Z axes of the ship grid.

• Create a point feature by specifying a location with absolute coordinates
or ship grid coordinates.

Note The part file must contain existing ship grid planes created with the
Main Dimension command.

Where do I find it?

Application

Ship Structure Basic Design,
Ship Structure Detail Design,
Ship Structure Manufacturing

Menu Tools®Ship Design®Ship Coordinates

Planar Ship Grid

Use the Planar Ship Grid command to create a planar set of selectable grid
lines on a specified base plane. Each grid line represents a datum plane
that intersects the base plane.

This command saves time by making it easier to select datum planes when
you are placing components. If the datum plane you want to select is not
located in the area you are working, you can select the corresponding grid line.
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You can:

• Create grid lines for all or selected datum planes.

• Select a grid line instead of the corresponding datum plane.

• Specify line and color style for the grid lines.

• Display labels and specify the label color on the grid lines.

• Use filters to select, show, and hide the grid.

Where do I find it?

Application

Ship Structure Basic Design,
Ship Structure Detail Design,
Ship Structure Manufacturing

Menu Tools®Ship Design®Planar Ship Grid

Ship Container

Use the Ship Container command to identify a parent assembly for new
steel feature components. This ensures you add components in the correct
hierarchy in a manufacturing block assembly without having to change the
work part.

• A container part is required when you create the following types of
features:

o Plates
o Stiffeners and edge reinforcements
o Pillars
o Steel insulation
o Standard parts
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If there is no container part identified in the displayed assembly, the
Ship Container dialog box is automatically displayed when you create
the features.

• You can select any write-accessible part in the displayed part hierarchy
as a container part except:

o Steel feature components.
o Components identified as piece parts using the Enforced Piece Part
command.

• A SHIP_CONTAINER attribute is assigned to the container part so it can
be identified in other NX sessions.

Where do I find it?

Application

Ship Structure Basic Design,
Ship Structure Detail Design,
Ship Structure Manufacturing

Menu Tools®Ship Design®Ship Container

The dialog box may also be displayed automatically when you create steel
features.

Application Ship Structure Detail Design

Prerequisite
A container part has not already been identified among
the displayed parts.

Toolbar

Ship Structure Detail Design®Plate or

Stiffener/Edge Reinforcement or Pillar or

Steel Insulation or Add Standard Part

Menu

Insert®Steel Features®Plate or Stiffener/Edge
Reinforcement or Pillar or Steel Insulation or Add
Standard Part

Plate

Use the Plate command to create structural plates and to carry the
manufacturing information from boundary curves to plate edges during the
design process. You can quickly create hull and bulkhead plates without
having to use other modeling commands to trim and thicken sheet bodies.
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You can:

• Define the boundary of a plate by using construction curves such as butt
and seam lines or by using faces and datum planes.

• Offset the plate from a selected face or datum plane.

• Create multiple plates at one time when inputs have multiple regions.

• Assign attributes to plates, edges, and bodies to identify common edges,
molding line faces, opposing molding line faces, and calculate the mass,
area, and volume of the solid body.

• Specify material and manufacturing information as attributes for process
planning and weld specifications.

• Adopt an existing body as a plate.

Where do I find it?

Application Ship Structure Detail Design

Toolbar Ship Structure Detail Design®Plate
Menu Insert®Steel Features®Plate

Plate Chamfer

Use the Plate Chamfer command to create a chamfer on a plate where it
adjoins a thinner plate.
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You can:

• Select plates from different components in an assembly.

• Associate the chamfer to the geometry and thicknesses of the adjacent
plates.

• Specify start and end limiting planes.

• Chamfer both sides of a plate.

Where do I find it?

Application Ship Structure Detail Design

Toolbar Ship Structure Detail Design®Plate Chamfer
Menu Insert®Steel Features®Plate Chamfer

Stiffener/Edge Reinforcement

What is it?

The Profile/Plate command is enhanced and replaced by a new Stiffener/Edge
Reinforcement command. The new command has additional methods to
place and limit geometry.
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• The profile sketch library is now driven by spreadsheets.

• You can select datum planes to define guide curves. The feature is swept
along the intersection of the selected datum planes and placement faces.

• When placing a profile, you can choose a predefined anchor point from the
profile sketch. The anchor point will be aligned on the guide curve.

• The Reverse Direction option takes the inferred thickness into account.
The feature is offset by the thickness so that it is located on the opposite
face.

• You can define limits to trim or extend the feature by selecting geometry
such as bodies, faces, or datum planes. Use the Path Limits options to
control how the feature will be modeled when the limiting geometry is
at an angle to the profile.

• You can orient stiffeners using the placement face normal, an orientation
vector, a tilt angle, or multiple datum coordinate systems.

• You can select connected guide curves that are not G1 continuous to
create knuckled profiles.

Where do I find it?

Application Ship Structure Detail Design

Toolbar

Ship Structure Detail Design®Stiffener/Edge

Reinforcement
Menu Insert®Steel Features®Stiffener/Edge Reinforcement
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Pillar

What is it?

The Steel Support command is enhanced and replaced by a new Pillar
command.

• The dialog box layout and terminology are consistent with the other new
steel feature commands.

• In the dialog box, the Support Caps group is renamed to Pillar Caps.

• The section sketch library and pillar cap sketch library are now driven
by spreadsheets.

Where do I find it?

Application Ship Structure Detail Design

Toolbar Ship Structure Detail Design®Pillar
Menu Insert®Steel Features®Pillar

Copy Parts between Planes

Use the Copy Parts between Planes command to copy multiple component
parts by selecting a reference and destination object.

This is useful for copying existing plates and stiffeners to a different plane
or mold face.

• The new components are added to the current work part.

• In the new components, geometry associated to the selected reference
object, such as WAVE links, are re-parented to the destination object.
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• The WAVE links not associated with the reference object remain linked to
the original parent geometry.

• Attributes are maintained in the new component parts.

Where do I find it?

Application Ship Structure Detail Design

Toolbar

Ship Structure Detail Design®Copy Parts between

Planes
Menu Insert®Steel Features®Copy Parts between Planes

Split Profile/Plate

Use the Split Profile/Plate command to split existing profile and plate
parts into more manageable pieces. You can also split parts when adjacent
structural parts have different thicknesses.

You can:

• Define the split location using a new or existing datum plane, faces, or by
projecting curves to the split body in a specified direction.

• Select multiple profiles and plates to split at one time.

• Automatically select attached profiles on the plate to split at one time.

• Split profiles and plates using a direction that is perpendicular to the
plate mold face, or orthogonal to both the profile base and mold face.

• Use the Remove Split Feature command to remove a split feature and the
associated parts. The profiles and plates revert to their original size.
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Where do I find it?

Application Ship Structure Detail Design

Toolbar Ship Structure Detail Design®Split Profile/Plate
Menu Insert®Steel Features®Split Profile/Plate

End Cut enhancements

What is it?

The End Cut command is enhanced so you can:

• Use the new Inherit option to copy the parameters from an existing end
cut and apply them to one or more end cuts.

• Select multiple end faces.

• Create end cuts that are driven by flange, web, and bevel parameters.

• Tilt, shear, and offset the end of a profile before the end cut parameters
are applied. The new Shear Angle box replaces the Taper option in the
Type list under Draft.
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• Apply the shoulder and toe cuts for the web with a single sketch or with
two separate sketches. The sketch library is now driven by spreadsheets.

In this example, separate sketches are used for the shoulder (1) and toe (2).

Why should I use it?

These enhancements save time by allowing you to quickly copy parameters of
an existing end cut to multiple end cuts. You can also create end cuts driven
by flange, web and bevel parameters, and tilt, shear and offset the end of a
profile before the end cut parameters are applied.

Where do I find it?

Application Ship Structure Detail Design

Toolbar Ship Structure Detail Design®End Cut
Menu Insert®Steel Features®End Cut

Steel Insulation

Use the Steel Insulation command to define, model, and evaluate insulation
in a ship design for fire proofing, noise reduction, and heat retention. This
command creates a feature that contains one or more solid bodies.
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You can:

• Apply the insulation to one or more sets of boundaries on selected faces.

• Choose the type of insulation from a list of materials with thickness,
density, colors, and attributes.

• Analyze the mass and area properties of the insulation.

• Unform the insulation to create a template for manufacturing.

Where do I find it?

Application Ship Structure Detail Design

Toolbar Ship Structure Detail Design®Steel Insulation
Menu Insert®Steel Features®Steel Insulation

Flange enhancements

What is it?

You can create a sheet metal Flange feature on a Plate feature that was
created in the Ship Structure Detail Design application.

• You can access the Flange command in the Ship Structure Detail Design
application.

• You can create a table to allow multiple thicknesses for each material and
multiple bend radii for each thickness. These standards apply only to
flanges created in the Ship Structure Detail Design application.
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• Before adding a flange, you must convert the plate feature to a sheet
metal feature. You can use the Convert to Sheet Metal command which is
now available in the Ship Structure Detail Design application.

• You can specify a neutral factor for each material in the table.

Why should I use it?

Use this command to add flanges to plates without changing applications.
You can also specify standard material thicknesses and bend radii that apply
only to flanges created in the Ship Structure Detail Design application.

Where do I find it?

Application Ship Structure Detail Design

Toolbar

Ship Structure Detail Design®Flange

Ship Structure Detail Design®Convert to Sheet Metal

Menu

Insert®Steel Features®Flange

Insert®Steel Features®Convert to Sheet Metal

Standard parts

What is it?

You can use the standard parts capabilities to define and add standard ship
structural parts based on intelligent rules with minimal interaction.

You can:

• Add different standard parts with a consistent user interface.

Note NX provides standard part templates for tripping brackets,
stiffener end brackets, and collar plates. The Bracket and Collar
Plate commands are removed and replaced by categories in the Add
Standard Part command.

• Select reference geometry to define the location and orientation of a
standard part.

• Use commands to quickly edit and delete standard parts.
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• Add standard parts with embedded design knowledge for your site. For
example, a tripping bracket can have a rule to include a stiffener if the
length exceeds a specified value.

If you create and maintain standard part templates, you can:

• Specify new categories and types of standard parts in a spreadsheet.

• Specify the parameters of a standard part in a spreadsheet.

• Define the configuration for the user interaction and attribute mapping of
the standard part in an XML file.

• Define knowledge rules to provide intelligence for the parameters,
location, and orientation of the standard part in an XML file.

• Specify the location of the spreadsheet, configuration file, and knowledge
rules file using the Standard Part Framework customer defaults.

Where do I find it?

Adding standard parts

Application
Ship Structure Basic Design,
Ship Structure Detail Design

Toolbar

Ship Structure Basic Design®Add Standard Part

Ship Structure Detail Design®Add Standard Part
Menu Insert®Steel Features®Add Standard Parts
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Editing and deleting standard parts

Application
Ship Structure Basic Design,
Ship Structure Detail Design

Prerequisite Select a standard part component.

Menu
Edit®Steel Features®Edit Standard Part or Delete
Standard Part

Graphics window
Right-click standard part component and choose Edit
Standard Part or Delete Standard Part.

Assembly
Navigator

Right-click standard part and choose Edit Standard
Part Component or Delete Standard Part Component.

Specifying standard part spreadsheets and configuration files

Menu File®Utilities®Customer Defaults
Location in dialog
box Ship Design®Standard Part Framework

Spreadsheets driving steel feature libraries

What is it?

You can incorporate your standard steel feature tables in spreadsheets to
drive parametric sketches in NX steel feature libraries.

You can now configure libraries for the following types of features:

• Stiffeners
• Edge reinforcements
• End cuts
• Pillars
• Profile cutouts
• Cutouts

You use several different types of files to implement a steel feature library:

Registration
spreadsheet

Coordinates the libraries and specifies the locations
of the parameter and model files for each section
type.

Parameter spreadsheet Configures the parameters and attributes of a
section type and the name of the associated legend
images.

Model file A part file containing a single, parametric sketch
for a section type.
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Legend image Displays the shape and key dimensions of the
section type.

You choose the available section types and sizes in the dialog boxes of the
appropriate steel feature commands.

Why should I use it?

Using a standard spreadsheet reduces the set up time and effort required
to create a parametric sketch for each family of steel features. When you
create a steel feature, performance is improved because NX only needs to
load a single sketch.

Where do I find it?

To specify or change the location of the registration spreadsheet:

Menu File®Utilities®Customer Defaults
Location in dialog
box

Ship Design®Steel Features®Qualify Sketch tab

You specify the names and locations of the other
supporting files in the registration spreadsheet.

To access a library when creating the steel features:

Application Ship Structure Detail Design
Toolbar Ship Structure Detail Design®Stiffener/Edge

Reinforcement or Pillar or Profile Cutout

or End Cut or Cutout
Menu Insert®Steel Features®Stiffener/Edge Reinforcement

or Pillar or Profile Cutout or End Cut or Cutout
Location in dialog
box

Stiffener/Edge Reinforcement®Stock group

Pillar®Section group and Pillar Caps group

Profile Cutout®Cutout group

End Cut®End Cut Options group

Cutout®Sketch group

4-186 What’s New in NX 8



CAD (Design)

Qualify Sketch

Use the Qualify Sketch command to help build, maintain, and validate sketch
libraries used to create steel structures.

You can use this tool to:

• Open template parts and spreadsheets that define the sketch libraries.

• Validate a sketch to make sure it follows all design rules.

o Verify the sketch defines a valid cross section.
o Verify required attributes are assigned to the appropriate geometry.
o Verify attributes have valid values.

• Identify reference, variable, and fixed dimensions.

• Select sketch curves required for placing the steel feature in downstream
operations such as marking line locations.

• Add anchor points to define placement locations for sketches.

Why should I use it?

Use this command to make sure that the rules required for the input data of
steel features are followed.

Where do I find it?

Application

Ship Structure Basic Design,
Ship Structure Detail Design,
Ship Structure Manufacturing

Menu Tools®Ship Design®Qualify Sketch

Custom attributes for steel features

What is it?

Use a custom attribute catalog to define standard attributes for a site or a
project and add them to steel features.

You can:

• Define a set of attributes for each type of steel feature. The attribute
catalog is an XML file you edit outside of NX and specify in the customer
defaults.

• Specify default values for attributes.

• Make attributes required or optional.
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• Assign attributes automatically without additional interaction or display
the Attributes dialog box when you create or edit steel features. Use the
dialog box to edit attribute values or delete optional attributes.

Why should I use it?

Implement a standard set of attributes to ensure consistency for an
enterprise, a site, or a project. The attributes associated with steel features
can be used in downstream applications.

Where do I find it?

Adding standard attributes to steel features.

Application Ship Structure Detail Design

Prerequisite
Define the attribute catalog and attributes for a steel
feature.

Dialog box

If the options to show the Attribute dialog box are
selected in the customer defaults, click OK or Apply
after you edit or create a steel feature.

Specifying the attribute catalog and controlling the display of the Attributes
dialog box.

Menu File®Utilities®Customer Defaults
Location in dialog
box

Ship Design®Project Settings®Customizable
Attributes tab

Cutting Side Face enhancements

What is it?

To improve functionality and performance, the following enhancements to the
Cutting Side Face command are available.

• A new Automatic option allows NX to automatically detect and select all
of the cutting side faces for the objects in the current study or assembly.
Appropriate attributes are then assigned to the solids.

Note The option to manually select cutting side faces is still available.

• The ability to flip the assignment of the cutting side attributes to the
opposite face.

• Additional options for more precise control over the automatic selection
of tangential and coplanar faces.
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Where do I find it?

Application Ship Structure Manufacturing

Toolbar Ship Structure Manufacturing®Cutting Side Face
Menu Insert®Manufacturing®Cutting Side

Marking Line enhancements

What is it?

The Marking Line command is improved with the following enhancements:

• You can create attachment marks for complex end attachments and
canted profiles.

• Attachment marks for canted profiles on planar placement faces include
angle template marks.

• There are four different attachment indicator types: Bubble Shape,
Bridge Shape, Triangle Shape, and End Bracket. You choose the
attachment indicator type in Customer Defaults.

• You can create match mark lines to show how two parts are aligned along
the attachment mark. You specify the Match Mark parameters in the
Customer Defaults.

• You can select ship grid planes to use for reference lines.
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Why should I use it?

Use this command to produce marking lines accurately and consistently and
provide information to drive downstream processes for drawing automation
and manufacturing output.

Where do I find it?

Application Ship Structure Manufacturing

Toolbar Ship Structure Manufacturing®Marking Line
Menu Insert®Manufacturing®Marking Line

Reference Line enhancements

What is it?

To improve functionality and performance, the following enhancements to
reference line features are made.

• The Reference Line command now creates core NX curve feature objects.

• The reference line object can be a single curve feature or multiple curve
features.

Where do I find it?

Application Ship Structure Manufacturing

Toolbar Ship Structure Manufacturing®Reference Line
Menu Insert®Manufacturing®Reference Line

Rolling Line enhancements

What is it?

To improve functionality and performance, the Rolling Line command
generates a core NX feature for each rolling line, using a standardized NX
dialog box.
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New options for the Rolling Line command let you do the following.

• Specify the type of rolling line to create. You can create the following
types of lines.

o A single manual line using a specified construction method. Available
methods let you create a line derived from the surface curvature, or
from an intersecting plane.

o A geodesic line derived from a specified point and flow direction.

o A series of pressure lines separated by an angular deviation.

• Specify a planar radius limit that lets NX ignore roughly planar regions.

• Use an analysis option to temporarily display a geometric and numerical
representation of the surface curvature at a specified point on the surface
face.

Why should I use it?

Use the different rolling line options to create more precise rolling lines.
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Where do I find it?

Application Ship Structure Manufacturing

Toolbar Ship Structure Manufacturing®Rolling Line
Menu Insert®Manufacturing®Rolling Line

Plate Preparation enhancements

What is it?

The following enhancements are provided to improve your productivity when
performing plate preparations.

• The Plate Preparation command handles generic formed surfaces in
addition to straight break sheet metal parts.

• All plates are unformed using the Metaform tool.

Where do I find it?

Application Ship Structure Manufacturing

Toolbar Ship Structure Manufacturing®Plate Preparation
Menu Insert®Manufacturing®Plate Preparation

Template enhancements

What is it?

To improve functionality and performance, the following enhancements to
template features are made.

• The Template command creates an NX feature of editable sheet bodies
using a standardized NX dialog box.

• A new Infer Coordinate System option allows NX to derive the template
coordinate system based on selected surfaces and specified planes.

Note The option to manually specify the template coordinate system is
still available.

• New options to generate offset datum planes used to create the template
sheet bodies.

• New options for specifying an optional thickness for the sheet bodies.
Thickness is applied evenly to both sides of each sheet body.

4-192 What’s New in NX 8



CAD (Design)

Where do I find it?

Application Ship Structure Manufacturing

Toolbar Ship Structure Manufacturing®Template
Menu Insert®Manufacturing®Template

Inverse Bending Lines enhancements

What is it?

The Inverse Bending Lines command is redesigned and improved with the
following enhancements:

• An inverse bending line feature is created, and is associated to the
defining profile. When the profile changes the bending line feature, which
includes the bending lines, diagrams and tables, is also updated.
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• The dialog box is redesigned and provides you with immediate control
over more of the parameters used to calculate the bending lines.

NX automatically detects the number of bent profiles in your assembly or
study, and then uses dialog box settings to calculate the inverse bending
lines, diagrams, and tables, for all the bent profiles.

• You can create inverse bending lines for twisted profiles.

• Bending line representations are more accurate.

• You can restrict users from manually changing the parameters used to
calculate the bending lines and drawing data. You can set all parameters
in the Ship Design customer defaults.

• You can create custom application programs using the Application
Programming Interface (API) for C++, Java, and .NET.

Where do I find it?

Application Ship Structure Manufacturing

Toolbar

Ship Structure Manufacturing®Inverse Bending Lines

Menu Insert®Manufacturing®Inverse Bending Lines

Manufacturing view for ship design

Manufacturing view tools

You can use a set of manufacturing tools to place one or more 3D ship design
elements into a manufacturing setting, and add manufacturing changes
while keeping the design data intact. When you are in the manufacturing
mode you can create, edit, and delete manufacturing modifications as needed
for assembling and installing the design elements.

The manufacturing tools are comprised of a group of commands that let you
do the following.

• Place a 3D design element into either a design mode or a manufacturing
mode so that only those features applicable to the current mode are
displayed.

• Identify and tag feature data, known as Metal To Metal features, which
are used to modify a steel element, such as a stiffener or plate, so that no
material gaps or material collisions exist between parts. These features
are suppressed in the manufacturing mode.
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• Compare the model differences between the manufacturing definition of
one or more elements and the design definition of those elements.

• Synchronize the options and dimensions of a manufactured end cut to
the original design end cut.

• List the design elements in a design study that contain design data,
manufacturing data, or those which have not yet been through the
manufacturing mode process.

Where do I find it?

Application
Ship Structure Detail Design,
Ship Structure Manufacturing

Menu Tools®Ship Design®Manufacturing

Manufacturing Data

Use Manufacturing Data to create a manufacturing version of one or more
design elements. While in the manufacturing mode, all subsequent model
changes are saved as manufacturing only data.

When the design element is in a manufacturing mode, you can add, delete
or modify manufacturing features and details on the 3D design. The data
you create when you are in the manufacturing mode is used to produce
manufacturing information such as manufacturing drawings, assembly plans
and flat patterns.

Stiffener in design mode Stiffener in manufacturing mode

The changes you make when you are in the manufacturing mode are
saved and stored with each element. In the manufacturing mode, the
manufacturing data for the element is visible, and in the design mode, only
the design data is visible.
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Where do I find it?

Application
Ship Structure Detail Design,
Ship Structure Manufacturing

Menu
Tools®Ship Design®Manufacturing®Manufacturing
Data

Compare

The Compare command lets you display both the manufacturing definition
and the design definition for one or more design elements in a study or
assembly so you can compare them. When you compare the two definitions,
you can choose to emphasize either the design mode or the manufacturing
mode. The emphasized mode is displayed as a solid body, and the alternate
mode is displayed as a wireframe body.

In this example, the manufacturing mode is displayed as a solid body and the
design mode is displayed as a wireframe body.

Note The Translucency option on the Visual tab of the Visualization
Preferences dialog box must be set in order to see the wireframe body.

When you access another command, the comparison display is removed.

You can use the Compare command in a study that contains multiple design
elements, or directly in the design element.

Where do I find it?

Application
Ship Structure Detail Design,
Ship Structure Manufacturing

Menu Tools®Ship Design®Manufacturing®Compare

Set Mode

Use Set Mode to change the state of one or more design elements. When
you change the state of a design element, any subsequent changes you
make to that element are placed in the current feature group (Design or
Manufacturing).
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Design mode Manufacturing mode

If you want features to show up in both modes, you must make sure you
reorder the feature so that it occurs before the manufacturing group of
features was created.

Where do I find it?

Application
Ship Structure Detail Design,
Ship Structure Manufacturing

Prerequisite

The design element must have both a Design and
Manufacturing feature group. These groups are created
when the Manufacturing Data command is used.

Menu Tools®Ship Design®Manufacturing®Set Mode

Rebase

Use the Rebase command to reset all the manufacturing parameters of an
end cut back to the parameters of the design end cut. This command is
useful when changes are made in the end cut of the original design after the
manufacturing end cut is created.
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You can use the Rebase command in a specific design element, or in a study
or assembly if you want to rebase multiple design elements.

Where do I find it?

Application
Ship Structure Detail Design,
Ship Structure Manufacturing

Menu Tools®Ship Design®Manufacturing®Rebase

List

Use the List command to create a visual report that helps you identify the
elements in your study or assembly that are in a manufacturing mode,
those that are in a design mode, and those that have not been through the
manufacturing mode process yet.

The data is displayed in the Resource bar in the HD3D Tools tab.
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Where do I find it?

Application
Ship Structure Detail Design,
Ship Structure Manufacturing

Menu Tools®Ship Design®Manufacturing®List

Tag Metal to Metal Features

Use the Tag Metal to Metal Features command to identify features added
to a steel element, such as a stiffener or plate, so that no gaps or material
overlap between the steel element and its adjacent object are shown. These
added features are suppressed when the steel element is placed in the
manufacturing mode.

Note You must tag any feature on a steel element that you do not want to
appear in the manufacturing mode first, before you place the element in
the manufacturing mode.

In this example, a stiffener has added features which obscure the end cuts
(end cuts are highlighted)

After the features are tagged, NX suppresses the tagged faces and displays
only the original steel element when it is placed in the manufacturing mode.
This allows the manufacturing engineer to alter the parameters of the
original element, or replace it completely with a manufacturing feature.

Where do I find it?

Application
Ship Structure Detail Design,
Ship Structure Manufacturing

Menu
Tools®Ship Design®Manufacturing®Tag Metal to
Metal Features
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Ship Drafting

Shipbuilding standards for Drafting

What is it?

A new shipbuilding drafting standards file is available that lets you
automatically set drafting and annotation preferences and customer defaults
in accordance with shipbuilding requirements.

Like other drafting standards files, you can customize the shipbuilding
standards file to reflect company-specific drafting preferences.

Why should I use it?

Use the shipbuilding standard file to automatically set all your drafting and
annotation preferences and defaults for your NX session.

Where do I find it?

To set the standard for the current NX session

Application Drafting and PMI
Menu Tools®Drafting Standard
Location in dialog
box

Standard to Load group®Standard
list®Shipbuilding(Shipped)

To set the shipbuilding standard as the default standard, or to customize
the standard

Menu File®Utilities®Customer Defaults
Location in dialog
box

Drafting®General®Standard tab®Drafting Standard
list®Shipbuilding(Shipped)

Frame Bar enhancements

What is it?

The following enhancements are provided to improve and optimize your
interaction with the frame bar functionality.

• The frame bar is now generated from core NX data derived from Concept
Model information, rather than from an external XML file. You no longer
need to set environment variables or create the XML file.
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• Horizontal and Vertical frame bar options, available on the View Style
dialog box, let you automatically create one or both frame bars while
creating your view.

Note These options are only available when you create the view. They
are not available when you edit a view. To create a frame bar on an
existing view, you must use the Frame Bar command. Note that you
can only add frame bars to views with orientations that are parallel to
one of the primary X, Y, or Z ship axes.

• Frame bars are specifically linked to the drawing view for which they are
created. If you delete or move the view, the frame bar will be deleted or
moved also.

• The frame bar is displayed using standard NX drafting objects, so normal
NX commands can be used to edit the frame bar display.

• The frame bar is a single collection of objects. You cannot delete individual
components of the frame bar.

• You can control the visibility, color, font and width of the different frame
bar components. You can also set preferences for the default display of
a frame bar.

• From a shortcut menu you can add tic marks, edit the style of the
frame bar, and flip the tic marks and labels of the frame bar so they are
displayed on the opposite side of the bar.

• The frame bar is automatically updated when you update the concept
model.

• Frame bars can be created for all drafting views except Drawing views,
Broken views, Revolved Section views, or Unfolded Section views,

Where do I find it?

Frame Bar command

Application Drafting

Toolbar Shipbuilding Drafting®Frame Bar
Menu Tools®Shipbuilding®Frame Bar
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To set frame bar preferences

Application Drafting
Toolbar Annotation®Annotation Preferences
Menu Preferences®Annotation
Location in dialog
box Frame Bar tab

Inverse Bending Lines Auto-Drawing

Use Inverse Bending Line Auto-Drawing to create inverse bending line detail
drawings for all profile parts which have inverse bending lines in the current
assembly. The drawings are derived from an existing drawing template, and
are saved as a booklet of individual files in a specified directory in native NX,
and as a single booklet in Teamcenter.

• Each drawing sheet contains up to two separate inverse bending line
drawings.

• Profiles that have the same shape and size, but different locations, are all
represented by a single drawing.

• The drawing template files, template file notations, and the output
location for the completed drawings are specified by options in the Ship
Drafting customer defaults.
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Where do I find it?

Application Drafting

Toolbar

Shipbuilding Drafting®Inverse Bending Lines

Auto-Drawing

Menu
Tools®Shipbuilding®Inverse Bending Lines
Auto-Drawing

Bending Lines Auto-Drawing customer defaults

Menu File®Utilities®Customer Defaults
Location in dialog
box

Ship Drafting®Inverse Bending Lines® Inverse
Bending Lines Auto-Drawing tab

Dimension enhancements

• You can now display the true length of geometry in a projected view.
True length is the distance between two picked points. If a single linear
edge/curve is selected, the true length is equal to the distance between
edge/curve end points.

Note True length dimensions are available in the Drafting environment
for horizontal, vertical, and parallel dimensions only.

When flagged as true length, the dimension nominal value will be
displayed with the flag T.L.; this flag text is customizable. You also have
the option of displaying the flag text either before or after the dimension.
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• The Arrows in Same Direction option lets you create a dimension with
dimension line arrows that both point in the same direction for linear and
angular dimensions.

Note The Arrows in Same Direction option is available for Drafting and
PMI dimensions.

Where do I find it?

True Length options in the Annotation Preferences dialog box

Application Drafting

Toolbar Annotation®Annotation Preferences
Menu Preferences®Annotation

Location in dialog
box

Dimensions tab®True Length group®True Length
List

Dimensions tab®True Length group®Text box

True Length option in the Dimension Style dialog box

Application Drafting

Toolbar

Dimension®click any dimension type ®Dimension

Style on the Dimension dialog bar

Drafting Edit®Edit Style ® select one or more
annotation objects

Menu Edit®Style®select one or more annotation objects

Location in dialog
box

Dimensions tab®True Length group®True Length
List

Dimensions tab®True Length group®Text box
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Arrows in Same Direction option

Application Drafting and PMI

Toolbar

In the Drafting application:

Annotation®Annotation Preferences

Menu

In the Drafting and PMI applications:

Preferences®Annotation
Location in dialog
box

Dimensions tab®Dimension Placement list®Manual
Placement – Arrows in Same Direction

Sheet Metal

NX Sheet Metal

Flange length measurement enhancements

What is it?

The Inside and Outside flange length options are now specified in a manner
that is standard in the straight brake industry. A new Web flange length
option is added to measure the distance from the end of the adjacent bend to
the end of the flange.

• The Inside flange length option now measures the distance from the
virtual intersection of the tab faces that are adjacent to the inner bend
face, to the top of the flange.
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• The Outside flange length option now measures the distance from the
virtual intersection of the tab faces that are adjacent to the outer bend
face, to the top of the flange.

• The Web length option measures the distance from the bend tangent
line to the top of the flange.

Note This enhancement works for flanges created in NX 8 and later.

Why should I use it?

In previous versions, if the angle of the flange was a value other than 90
degrees, the resulting flange length was not easy to determine and it was
not measurable using methods that are commonly employed in the sheet
metal industry. You can now accurately measure and dimension flange
lengths without using other techniques, such as constructing geometry, to get
accurate dimensions.

4-206 What’s New in NX 8



CAD (Design)

Where do I find it?

Application NX Sheet Metal

Toolbar NX Sheet Metal®Flange
Menu Insert®Bend®Flange
Location in dialog
box

Flange Properties group®Length Reference
list®Inside or Outside or Web

Convert to Sheet Metal enhancement

What is it?

You can now convert imported solid models that have a sharp edge on one
side and a bend on the other side, to sheet metal models. To retain the sharp
edge, select the Maintain Zero Bend Radius check box in the Convert to
Sheet Metal dialog box. If you do not select this check box, NX converts the
sharp edge to a bend, using the bend radius value set for the Bend Radius
NX Sheet Metal preference.

Resulting edge with Maintain Zero Bend Radius selected

Resulting edge with Maintain Zero Bend Radius not selected
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Where do I find it?

Maintain Zero Bend Radius check box

Application NX Sheet Metal

Toolbar

NX Sheet Metal®Convert Drop-down list®Convert

to Sheet Metal
Menu Insert®Convert®Convert to Sheet Metal
Location in dialog
box Settings group®Maintain Zero Bend Radius check box

Bend Radius NX Sheet Metal preference

Application NX Sheet Metal
Menu Preferences®NX Sheet Metal
Location in dialog
box

Part Properties tab®Global Parameters group®Bend
Radius

Unbend enhancements

What is it?

You can now transform specified curves and points on a bend face to their
flattened state, by using the Select Curve or Point option in the Unbend
dialog box. For example, you can flatten a pattern of points on a lofted flange,
as shown.

Use the Hide Original Curves check box to control whether to display or hide
the original curves and points in the output.

With Hide Original Curves selected
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With Hide Original Curves not selected

Why should I use it?

These unbend enhancements let you selectively flatten a set of curves or
points in a particular bend region while you are modeling the sheet metal
body. You can use these curves and points later to create holes and cutouts.
The Flat Solid command can produce similar results, but you typically create
flat solid bodies and flat patterns after you finish modeling the sheet metal
body.

Where do I find it?

Application NX Sheet Metal

Toolbar NX Sheet Metal®Form Drop-down list®Unbend
Menu Insert®Form®Unbend
Location in dialog
box Settings group®Hide Original Curves check box

Export Flat Pattern

Use the Export Flat Pattern command to export flat pattern data to a DXF
file or a Trumpf GEO file from within the NX Sheet Metal application. This
command replaces the Export Trumpf GEO File command, which supported
exporting flat pattern data to Trumpf GEO files only. Now you can export flat
pattern data to both DXF and GEO files.

Flat pattern data can include curves, annotations, and callouts. Only curves
are supported for export. Depending on its type, each flat pattern curve lies
on a specific layer in the exported DXF file.

You can assign each layer in the exported DXF file to the required process
such as etching, cutting, punching, bending, and so on.
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Why should I use it?

The DXF option in the Export Flat Pattern command provides more
sheet metal–specific options than are available when you choose
File→Export→DXF/DWG. You can more easily select geometry and filter
items to export.

Where do I find it?

Application NX Sheet Metal

Toolbar Flat Pattern Drop-down list®Export Flat Pattern
Menu Insert®Flat Pattern®Export Flat Pattern
Location in dialog
box Type group list®DXF or Trumpf GEO

Tab enhancements

What is it?

When you use the Tab command, you can now create secondary tabs by
adding material to bend regions when they are in the unbent state.

You can create secondary tabs on the following areas:

• On bend
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• On bend and adjacent face

• On bend and two adjacent faces

Why should I use it?

These enhancements enable you to add material across established bend
regions.

Where do I find it?

Application NX Sheet Metal
Prerequisite A bend region must be present in the work part.

Toolbar NX Sheet Metal®Tab
Menu Insert®Tab
Location in dialog
box Type group®Secondary
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Flange face enhancements

What is it?

You can now select a planar face or datum plane to control the shape and
position of a flange using the new Match Face and Specify Plane options. In
previous releases, you could only select an edge to specify the location of
a flange.

After you select a plane or planar face as input, NX does the following:

• Extends or limits the flange to the selected plane or face.

• Adjusts the bend angle to that of the selected plane or face.

In this example, a flange that is the full width of the tab edge is extended to
match the face of another solid body.

Flange edge selected

Face to match selected

4-212 What’s New in NX 8



CAD (Design)

Resulting flange

The flange is associative to the
matched face, so if the face changes,
the flange changes with it.

Note This enhancement works for flanges created in NX 8 and above.

Why should I use it?

The ability to create associative flanges is especially useful in the context of an
assembly, where you can use existing geometry to control the extent and angle
of a flange. Bracket-type features are a typical use for this enhancement.

Where do I find it?

Application NX Sheet Metal

Prerequisite
The Specify Plane option is available only when you
select the Until Selected option in the Match Face list.

Toolbar NX Sheet Metal®Flange
Menu Insert®Bend®Flange
Location in dialog
box Flange Properties group®Match Face list
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Aerospace Sheet Metal

Export Flat Pattern

Use the Export Flat Pattern command to export flat pattern data to a DXF file
or a Trumpf GEO file from within the Aerospace Sheet Metal application.

Flat pattern data can include curves, annotations, and callouts. Only curves
are supported for export. Depending on its type, each flat pattern curve lies
on a specific layer in the exported DXF file.

You can assign each layer in the exported DXF file to the required process
such as etching, cutting, punching, bending, and so on.

Why should I use it?

The DXF option in the Export Flat Pattern command provides more
sheet-metal-specific options than are available when you choose
File→Export→DXF/DWG. You can more easily select geometry and filter
items to export.

Because the GEO file format is accepted by Trumpf bending machines
and related software, you can transmit data from NX to Trumpf bending
machines without the need for general translators such as IGES and STEP.
Transmitting data directly into Trumpf machines helps prevent errors and
saves time.

Where do I find it?

Application Aerospace Sheet Metal

Toolbar

Flat Pattern Feature Drop-down list®Export Flat

Pattern
Menu Insert®Flat Pattern®Export Flat Pattern
Location in dialog
box Type group list®DXF or Trumpf GEO

Flexible Printed Circuit Design

Export Flat Pattern

Use the Export Flat Pattern command to export flat pattern data to a DXF
file or a Trumpf GEO file from within the Flexible Printed Circuit Design
application.
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Flat pattern data can include curves, annotations, and callouts. Only curves
are supported for export. Depending on its type, each flat pattern curve lies
on a specific layer in the exported DXF file.

You can assign each layer in the exported DXF file to the required process
such as etching, cutting, punching, bending, and so on.

Why should I use it?

The DXF option in the Export Flat Pattern command provides
more FPCD-specific options than are available when you choose
File→Export→DXF/DWG. You can more easily select geometry and filter
items to export.

Because the GEO file format is accepted by Trumpf bending machines
and related software, you can transmit data from NX to Trumpf bending
machines without the need for general translators such as IGES and STEP.
Transmitting data directly into Trumpf machines helps prevent errors and
saves time.

Where do I find it?

Application Flexible Printed Circuit Design

Toolbar Flat Pattern Drop-down list®Export Flat Pattern
Menu Insert®Flat Pattern®Export Flat Pattern
Location in dialog
box Type group list®DXF or Trumpf GEO

Printed Circuit Design

PCB Exchange

Baseline EDMD baseline schema support

What is it?

You can now import and export IDX files in the PCB Exchange application.
The IDX are neutral formats based on STEP standards and are compatible
with different ECAD programs. The STEP standards are standards for
the exchange of product model data. IDX stands for interdomain design
exchange, and EDMD for electrical design mechanical design

The IDX files contain physical design information for electronic circuit boards.

Incremental import and export operations are not supported.

What’s New in NX 8 4-215



CAD (Design)

Where do I find it?

Application PCB Exchange

Toolbar

PCB Exchange ® Import ECAD Model or Export

ECAD Model

Menu
PCB Exchange ® Import ECAD Model or Export ECAD
Model

New board conductivity calculation algorithm

What is it?

You can now use a new board thermal conductivity calculation algorithm. The
equivalent algorithm provides a calculation point averaged conductivity based
on a pixel discretization of the board conductive and non conductive layers.

Previously, NX used the discretized algorithm that was named Automatic.
This algorithm is now named Discretized.

Why should I use it?

Compared to the discretized algorithm, the equivalent algorithm provides a
faster alternative to calculate the orthotropic board conductivity.

Where do I find it?

Application PCB Exchange

Toolbar

PCB Exchange ® Board Mesh And Thermal Settings

Menu PCB Exchange ® Board Mesh And Thermal Settings
Location in the
dialog box Thermal Conductivity group® Algorithm® Discretized

Usability enhancements in PCB Exchange dialog boxes

What is it?

The following dialog boxes have been reorganized for easier access:

• Board Mesh and Thermal Settings

• Default Component Mesh and Thermal Settings

The order of the options in the dialog boxes changed to improve the workflow.
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In the Create ESC Solution dialog box, you can now set the node and element
IDs for the first node and element in the mesh.

Where do I find it?

Application PCB Exchange

Toolbar

PCB Exchange ® Board Mesh and Thermal

Settings, Default Component Mesh and Thermal

Settings, and Create ESC Solution

Menu

PCB Exchange ® Board Mesh and Thermal Settings,
Default Component Mesh and Thermal Settings, and
Create ESC Solution

New entities created from the Create ESC Solution command

What is it?

When you use the Create ESC Solution command, PCB Exchange creates
new entities in Advanced Simulation to improve the workflow.

Now, the following entities are created:

In the FEM file

• Meshes representing the board and components.

• A 2D Shell mesh collector of type PCB Stack.

• A PCB Stack physical property which defines stacks of layers and vias in
the printed circuit board.

• PCB Layer and PCB Vias modeling objects which define materials and
distributions in the printed circuit board.

• Fields that model the orthotropic board thermal conductivity.

In the Simulation file

• A Printed Circuit Board simulation object which defines friction properties
for the printed circuit board.

• PCB Component simulation objects which represent components, connect
them to the board, define dissipation, and produce reports.
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Previously, for each component, NX PCB Exchange created one Thermal
Coupling simulation object that connected the component to the printed
circuit board and one Thermal Load load. It also created a Property Override
simulation objects that modeled orthotropic board conductivity.

Why should I use it?

PCB Exchange now creates less boundary conditions when creating a
simulation file. You can now easily access and modify the orthotropic board
conductivity entities.

Where do I find it?

Application PCB Exchange

Toolbar PCB Exchange ® Create ESC Solution
Menu PCB Exchange ® Create ESC Solution

PC Design Navigator

What is it?

Use the new PC Design Navigator command to identify, access, and edit
ECAD parameters of the following Printed Circuit Assembly (PCA) entities:

1. Boards

2. Components

3. Areas

4. Holes

For the previous PCA entities you can:

• Select one or more components and observe the highlighted component in
the graphics window.

• Order the list of entities by any of their ECAD attributes.

• Modify the ECAD attributes of one or more components at once.

Previously, you needed to modify the ECAD properties of each entity
individually.

Why should I use it?

The PC Design Navigator provides a faster access to entity attributes in a
single interface window.
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Where do I find it?

Application PCB Exchange

Toolbar PCB Exchange ® PC Design Navigator
Menu PCB Exchange ® PC Design Navigator

Flexible Printed Circuit Design

Export Flat Pattern

Use the Export Flat Pattern command to export flat pattern data to a DXF file
or a Trumpf GEO file.

Flat pattern data can include curves, annotations, and callouts. Due to
technological limitations, only curves are supported for export.

Depending on its type, each flat pattern curve lies on a specific layer in the
exported DXF file.

Type of flat pattern curve Layer number
Bend up center lines 1
Bend down center lines 2
Bend tangent lines 3
Outer mold lines 4
Inner mold lines 5
Exterior curves 6
Interior cutout curves 7
Interior feature curves 8
Center of lightening hole 9
Joggle line between stationary & transition areas 10
Added top curves and points 11
Added bottom curves and points 12
Tool marker 13

You can:

• Select the curves to be exported more easily.

• Assign each layer in the exported DXF file to the required processes such
as etching, cutting, punching, bending, and so on.
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Where do I find it?

Application
NX Sheet Metal, Aerospace Sheet Metal, Flexible
Printed Circuit Design

Toolbar

(NX Sheet Metal) Flat Pattern Drop-down list®Export

Flat Pattern

(Aerospace Sheet Metal) Flat Pattern Feature

Drop-down list®Export Flat Pattern

(Flexible Printed Circuit Design) Flat Pattern

Drop-down list®Export Flat Pattern
Menu Insert®Flat Pattern®Export Flat Pattern
Location in dialog
box Type group list®DXF or Trumpf GEO

Mechatronics Concept Designer

Physics Objects Converter

Use the Physics Objects Converter command to convert physics objects
to motion objects. The conversion makes it possible for the NX Motion
Simulation application to interpret a Mechatronics Concept Designer model.
While the conversion is automatic, you can choose the objects to be included
in the conversion.

Not all physics objects can be converted to motion objects. The following table
shows the physics objects that can be converted and their corresponding
motion object.

Physics object Motion object
Rigid Body Link
Hinge Joint Revolute Joint
Sliding Joint Slider Joint
Cylindrical Joint Cylindrical Joint
Ball Joint Spherical Joint
Fixed Joint Fixed Joint
Gear Two-Joint Coupler
Linear Spring Joint Spring & Damper
Angular Spring Joint Bushing
Speed Control Joint Driver
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Each motion object that is created by this conversion has the same name as
the physics object on which it is based, unless the physics object has a name
that is invalid for motion objects. An invalid name is a name that contains
any special characters other than Dash (-) or Underscore (_).

Note This command can only convert the physic objects when you create a
new simulation. It can not convert objects and add them to an existing
simulation.

Note If your model contains assembly constraints, a warning is displayed
during the conversion that gives you the option to convert the constraints
in addition to the Mechatronics Concept Designer objects. It is
recommended to convert only the Mechatronics Concept Designer
objects into motion objects. Converting the constraints can cause an
over-constrained model.

Where do I find it?

Application Motion Simulation

Prerequisite

You must create a new simulation for a work part
that contains Mechatronics Concept Designer physics
objects.

Replace Assistance

What is it?

Use the Replace Assistance dialog box to migrate the physics objects defined
in a concept model to a detailed model. You can specify geometry references
for each physics object when you replace concept model components with
detailed model components. All related physics objects are automatically
regenerated in the detailed components after you specify the references.

Why should I use it?

It provides the capability to reassign corresponding references from concept
model to detailed model in assembly context.

Where do I find it?

Application Mechatronics Concept Designer

Prerequisite
You must click OK or Apply in the Replace Component
dialog box.

Toolbar Assemblies® Replace Component
Menu Assemblies® Components® Replace Component
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SNAP — New programming tool

What is it?

A new programming tool is added to the NX system for creating custom
programs. Simple NX Application Programming (SNAP) is an easy-to-learn
programming tool intended for mechanical designers and other typical NX
users – not just for programmers. The code is simple, short, readable, and
feels “natural” so it is quicker to learn and easier to apply.

SNAP is useful for automating simple processes that you do repeatedly, or
for creating simple parts that you use frequently.

SNAP is similar to the GRIP language in its purpose, flexibility, and ease of
use. So if you have used GRIP before, you will probably also find SNAP to
be a productive tool.

SNAP is based on the Visual Basic (VB.Net) language and is best used with
Visual Studio, however you can create some simple programs using the NX
Journal Editor.

An example of SNAP code is shown below:

myFunction
length = 8
width = 4
half = width/2
left = Line(-half, 0, —half, length) ‘Left side; Line(x1, y1, x2, y2)
right = Line(half, 0, half, length) ‘Right side
top = Arc(0, length, half, 0, 180) ‘Top semi-circle; Arc(x, y, r, 01, 02)
bottom = Arc(0, 0, half, 180, 360) ‘Bottom semi-circle
Dim outline As NX.Curve() = {left, right, top, bottom}
boss = Extrude(outline, 3)

End

SNAP and NX Open can easily be used together and you may find that many
of your programs will use a mixture of SNAP and NX Open functions. In fact,
SNAP can be regarded as a stepping stone that can lead you into the more
powerful NX Open programming functionality.

In this first release, SNAP is focused on the creation of simple geometry.
Other areas of NX will be covered in future versions.

SNAP is only supported on Windows machines.

Why should I use it?

You can use SNAP to easily automate repetitive NX tasks even if you do not
have any previous programming experience.
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Where do I find it?

A Getting Started with SNAP guide is provided to introduce you to SNAP and
help you learn how to use it as quickly as possible. It also includes a brief
introduction to the Visual Basic language.

An API reference manual (.chm file) provides detailed documentation for all
of the functions in SNAP, plus many examples.

The guide and reference manual (.chm file) are located in the Programming
Tools section of the documentation.
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5 CAM (Manufacturing)

Manufacturing General

Tool library enhancements

What is it?

The parameters in the NX ASCII Tool library now match the parameters in
the NX Create Tool dialog box.

New parameters that are added to the ASCII tool library are:

• Milling tool shank

• Coolant through on mills/drills

• Tip angle on mills

• Flute length on user defined mills

• Corner radius on holemaking tools

• Bell angle and diameter on center drills

• Neck diameter and taper angle on taps and reamers

• Boring bar parameters

• Probe tracking points

• Turning parametric holder

• Boring Diameter, Maximum Reach, and Maximum Depth on Turning tools

• X Mount, Y Mount, and Z Mount

• Milling chamfer
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New classes that are added to ASCII tool library are:

• Chamfer Mills

• Spherical Mills

• Spot facing tools

New Non Cutting Moves engage parameters are available for all milling tools.

• Ramp Angle

• Diameter (helical)

• Minimum Ramp Length

A new cutting parameter (that is currently used by plunge milling), is
available for all milling tools.

• Max Cut Width

The tool classes and parameters are recognized when you export tools to the
Tool library or retrieve them.

You can now:

• Search for tools using a string in their description.

• Export tools with no holding system defined.

• Assign a custom suffix number for the libref when exporting or importing
a tool or holder. A new Starting Number for User Librefs customer default
is available.

Note If you customized the out of the box ASCII libraries tool_database.dat,
you must update your entries to the new format.

When a tool is retrieved, User Defined Events on the tool master in the
library_dialog.prt are added to the tool.

Why should I use it?

These enhancements help you to maintain complete tool definitions and
consistency.

The new customer default will prevent existing libref numbers from being
overwritten when a new libref number is created.

5-2 What’s New in NX 8



CAM (Manufacturing)

Where do I find it?

ASCII Tool library

Application Manufacturing
Menu Insert®Tool

Location in dialog
box

Library group®Retrieve Tool from Library

®Library Class Selection®Search Criteria dialog
box®Search Parameters group®Description

Starting Number for User Librefs customer default

Application Manufacturing
Menu File®Utilities®Customer Defaults
Location in dialog
box Manufacturing®Tools®Tool Library group

Shop Documentation enhancements

What is it?

The following templates are now available:

• HTML templates. These are templates that you can customize in Excel.

• TEXT templates. These are templates that you can customize in TCL.

In order to create Shop Documentation, you must first select an object in
the Operation Navigator. Both types of templates process objects that are
selected in the Operation Navigator.

Note Pre-NX 8 templates are not visible in NX because you can use the
default templates to create a report of machining operations from any
of the four Operation Navigator views. Pre-NX 8 templates generate
reports only for a single view. If you want to use pre NX 8 templates,
remove the comment sign (#) in the shop_doc.dat file . The file is located
in MACH\resource\shop_doc.

When you select an Excel-html template in the Shop Documentation dialog
box, you will create a document that can be displayed in Microsoft Excel™
or web browsers.
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The Excel files used to create the Excel-html templates are stored in the
MACH/resource/shop_doc/excel_templates folder; they can be further
customized to produce new templates. Each Excel file has two sheets. The
second sheet contains MOM variables and descriptions that you can copy and
paste into the appropriate cells in the first sheet. This enables you to edit the
templates even if you are not familiar with MOM.

Why should I use it?

You can customize the template and its contents to better control the Shop
Documentation output based on the specific requirements of the shop.

Where do I find it?

Application Manufacturing
Toolbar Operations toolbar

Location in dialog
box

Shop Documentation dialog box®Report Format
list

CAM Express startup

What is it?

You can now launch CAM Express from the Startmenu on your computer as a
separate product from NX.

Why should I use it?

Launch CAM Express as a separate product to explicitly differentiate it from
NX.

5-4 What’s New in NX 8



CAM (Manufacturing)

Where do I find it?

Application Manufacturing

Menu
Start®All Programs®Siemens NX
8.0®Manufacturing®CAM Express 8

Transferring an IPW across multiple setups

What is it?

You can now transfer an In Process Workpiece (IPW) from one manufacturing
setup to the next manufacturing setup. NX automatically positions the IPW
within and across setups.

Setup 1 Setup 2

Part Part

Initial IPW Input IPW Setup 3 Input
IPW

Output IPW Output IPW
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You can establish the relationship between two setups for the IPW transfer.
The IPW is transferred from the previous part position to the new part
position and the two are associative. You can view the relationship in the
Blank Geometry dialog box.

Why should I use it?

Transfer an IPW from one setup to the next setup when a part cannot be
machined in a single orientation and you need to either reposition the part or
refixture it.

Where do I find it?

Application Manufacturing

Prerequisite
The selected part geometry must reside in the same
assembly component.

Location in dialog
box

WORKPIECE group®Blank Geometry®IPW®Select
Source for IPW

Geometry selection in Manufacturing

What is it?

Face and body selection in Manufacturing is now consistent with face and
body selection in Modeling. This is true for all interactions where you select
geometry except for boundary selection. You can now do the following:

• Use the Selection filters on the Selection bar to filter face and body
selection, and use the Selection Intent rules to select multiple objects.

• Append a new set of objects with a different selection rule to the current

selection. You must click Add New Set in a selection dialog box for
CAM faces and bodies.

• Assign custom data for each set of faces collected by a selection rule.
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• Verify your selections by the same object highlighting that you see in
modeling.

Caution Try to anticipate possible design changes when you specify selection
intent. If the geometry changes, the selection intent rules may modfiy
your operation by adding or removing faces. For example, if you specify
Tangent Faces to collect all faces of a blended pocket, and the designer
later adds a blend at the pocket opening, adjacent faces are added to the
collection. Typically, in such situations, there is an alternative rule that
is better-suited to collect faces according to your intent, such as Feature
Faces, Region Faces, and so on.

You can also select individual faces, just as you did in earlier releases.

The following example shows different custom stock assigned to sets of work
piece faces.

Set Number of Items Custom Data
1 8 Yes
2 9 No
3 1 Yes

Set 1 is assigned custom data. The
on-screen input box shows a Part
Offset value of 1.0 mm.

Face Rule is set to Tangent Faces; the
entire perimeter of the part is selected
with a single click.

Set 2 has the default stock.

Face Rule is set to Tangent Faces; the
entire set of upper faces of the part is
selected with a single click.
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Set 3 has custom data.

The on-screen input box shows a Part
Offset value of 2.0 mm.

For the lower face, Face Rule is set to
Single Face. With this rule, you can
select as many faces as you require,
one by one.

Legacy part updates

• When you open legacy parts, all objects with identical custom data that
have the same stock value are grouped into one set.

• Custom data for gouging is no longer supported.

Why should I use it?

Use selection rules to reduce the number of clicks that you need to select
faces and bodies.

When you modify the selected geometry, the selection rule is reevaluated and
faces or bodies that meet the rule are collected in the set automatically.

In the following example, the upper faces of the body are modified. Because
the Face Rule value for set 2 is Tangent Faces, the additional faces are
automatically selected. The new faces are assigned the Part Offset value for
the set.

Set Number of
Items

Custom
Data

1 8 Yes
2 9 No
3 1 Yes

Set Number of
Items

Custom
Data

1 8 Yes
2 17 No
3 1 Yes
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Dynamic machine tool positioning

What is it?

Your machine tool model is dynamically positioned in your Manufacturing
setup when you use the CSYS tool to:

• Define a tool axis in a fixed-axis or variable-axis operation.

• Edit a milling, drilling, or probing tool.

Note There are two customer defaults to control the dynamic display of the
machine tool. Out of the box the dynamic machine tool is on for setting
the tool axis and off for editing tools.

If you move a machine axis to an over-travel position, you see the following
graphical feedback:

• The machine tool component that has over-travelled is highlighted.

• The drag indicators for the handle that caused the over-travel are
highlighted.

Machine tool components are moved
to match the tool axis

Graphic alerts for over-travel

Why should I use it?

You should use dynamic simulation of machine tool components whenever
you need to visually check machine tool limits.

Where do I find it?

Application Manufacturing

Prerequisite
A library machine must be present in the setup and it
must be properly configured.
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Shank definition for milling and drilling tools

What is it?

When you create milling and drilling tools, you can define the shank between
the cutting tool and the tool holder. You can specify the following shank
parameters:

1. Shank Diameter

2. Shank Length

3. Shank Taper Length

There is a tapered transition from the tool to the shank diameter. The shank
is included in the tool definition in the tool library.

The previous shank diameter found on tools such as T Cutters is now called
Neck Diameter.

Why should I use it?

You can define a more complete and accurate representation of your cutting
tool.

Where do I find it?

Application Manufacturing
Menu Insert®Tool

Toolbar Insert®Create Tool
Location in dialog
box

Tool Subtype group®Mill Tool Parameters dialog
box®Shank tab

5-10 What’s New in NX 8



CAM (Manufacturing)

Taper definition for tool holder steps

What is it?

An Upper Diameter parameter is added to the tool holder parameters. NX
can calculate the Upper Diameter value from the Taper Angle and Length
values or you can specify the Upper Diameter value directly.

The Diameter parameter in previous releases is now called Lower Diameter.

You can specify the following parameters when defining a tool holder:

(L) Length

(OS) Tool Insertion Offset

(UD) Upper Diameter

(LD) Lower Diameter

(B) Taper Angle

(R1) Corner Radius

(1) Step 1

(2) Step 2

Why should I use it?

The improved tool holder interface makes it easier to define tapered holder
steps that align with, and are stacked with, adjacent steps.

Where do I find it?

Application Manufacturing
Menu Insert®Tool
Location in dialog
box

Create Tool dialog box®Tool Subtype®Milling Tool
dialog box Holder tab
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Operation parameters inherited from the tool

What is it?

You can now specify the following Operation Parameters when creating most
milling tools.

• Ramp Angle

• Helical Diameter

• Min Ramp Length

• Max Cut Width

In previous versions, you could only specify these parameters within the
operation.

Note Out of the box, inheritance of these parameters is turned off in the
operations.

Why should I use it?

Because the parameters are saved with the tool, they can be inherited into
the Cutting Parameters and Non-Cutting Moves of operations that use the
tool. This is most useful for example, for tools such as inserted mills where
the engage ramp angle and diameter are a characteristic of the tool.

Where do I find it?

Application Manufacturing
Menu Insert®Tool

Toolbar Insert®Create Tool
Location in dialog
box

Tool Subtype group®Mill Tool Parameters dialog
box®More tab®Operation Parameters group

Tool clearance enhancements

What is it?

Use the new tool and holder clearance parameters to gain additional
clearance control over different segments of the tool.
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1. Tool Holder

2. Tool Shank

3. Tool Neck

Clearance parameters are used in several places, including operation collision
checking, Operation Navigator gouge checking, and tool axis tilting.

Where do I find it?

Application Manufacturing
Menu Insert®Create Operation
Location in dialog
box

Path Settings group®Cutting Parameters®More
tab®Clearance group

Flute length checking

What is it?

The new Check Flute Length and Depth per Cut customer default lets you
check the nominal depth of cut against the flute length of the tool in many
milling operations.
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If this customer default is selected, and the flute length of the tool is less
than the nominal programmed cut depth, a warning is issued with an option
to continue.

Why should I use it?

You can validate that the tool flute length is long enough to cut to the
specified depth per cut.

Where do I find it?

Application Manufacturing
Menu File®Utilities®Customer Defaults

Location in dialog
box

Manufacturing®Tools®Validation tab®Milling
Operations group®Check Flute Length and Depth per
Cut
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Manufacturing Milling

Blank Geometry enhancements

What is it?

The Blank Geometry dialog box has been updated and the following new
options are available for all milling operations that support blank geometry.

Bounding Block

Similar to the legacy Auto Block option. You now have an orientation list,
from which you can select MCS or Specify CSYS.

Bounding Cylinder

Encloses the part outline in a circle and extrudes the shape along the
current MCS to completely enclose the part.

Note Bounding Cylinder provides an optimal blank for cylindrical parts.
You may need to increase the blank size for rectangular parts.

Part Outline

Extrudes the part outline to completely enclose the part.

Part Convex Hull

Connects the extreme points of the part outline to create a convex hull
and extrudes the shape to completely enclose the part.

IPW – In Process Workpiece

Lets you specify the source for the In-process workpiece.
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For the Bounding Cylinder, Part Outline, and Part Convex Hull options,
you can:

• Accept the default extrusion direction, which is parallel to the ZM-axis of
the MCS, or specify a different direction vector.

• Increase the top or bottom limits.

• Offset the circle radius, part outline, or convex hull outline.

The part and convex hull offset outlines roll around corners.

Where do I find it?

Application Manufacturing

Toolbar Insert®Create Geometry
Menu Insert®Create Geometry

Location in dialog
box

Geometry Subtype group®Workpiece or

MILL_GEOM subtype®Workpiece dialog

box®Geometry group®Specify Blank ®Blank
Geometry dialog box®Type group

Feed rate setting improvements

What is it?

Feed rate settings in the Feeds and Speeds dialog box for milling operations
are improved in the following ways.

Rapid motion output mode
In the Feed Rates group, under Rapid, you can set Output to G0 – Rapid
Mode or G1 – Feed Mode.
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Motion types
Under More, you can specify that motions use the rapid output mode or a
percent of the cut feed rate. For example, from the Approach list, you can
choose from the following:

• none

• ipm

• ipr

• Rapid

• %Cut

Zero feed rates
Zero feed rates are no longer permitted with the new rapid and percent of
cut feed rate options.

Where a zero feed rate previously implied a rapid move, you can specify
Rapid to use the current rapid output mode.

Where a zero feed rate previously implied the cut feed rate, you can
specify a percent of the cut feed rate.

Operation Navigator
When you edit feed rates in the Operation Navigator, if multiple
operations of the same type are selected, all applicable feed rates are
available for editing.

Calculation of related values
In the Feeds and Speeds dialog box, each of the Surface Speed, Feed per
Tooth, Spindle Speed, and Cut Feed boxes has a corresponding calculate
button. Each button recalculates the other three values. If only one
button is active, the values are calculated when you click OK. If none of
the buttons are active, all of the values are up-to-date.

Set Machining Data
When you click Set Machining Data:

• Feed rates are set as a percent of the cut feed. Feed values in the feeds
and speeds database are preserved.

• For user-defined milling tools with tracking points, the diameter at
the selected tracking point is used to calculate the spindle speed or
feed rate.
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Part update
Parts from previous versions of NX are automatically updated. Zero feed
rates are converted either to rapid motion or 100% of cut feed, depending
on the rule for the zero value in the earlier release.

Note The preceding changes do not apply to Wire EDM feed rates.

Why should I use it?

In non-interpolated rapid mode, some machines may not move in a direct
path; they might make a dogleg motion. If you need more control, for example
to avoid potential collisions, you can now specify interpolated motion.

Where do I find it?

Application Manufacturing

Prerequisite

Open any dialog box that contains Feeds and Speeds

, or, in the Operation Navigator, select one
operation or multiple operations of the same type.

Variable-axis profiling enhancements

What is it?

You now have the following options to control cutter motion and orientation
in variable-axis profiling.

Automatic Uses the same positioning method as in pre-NX 8
releases. Legacy tool paths are updated to this option.

Align to Edges Aligns the tool tangent to straight edges between the top
and bottom of the wall.

Swarf Base UV Aligns the tool to the UV rulings of the wall.

Automatic Align to Edges Swarf Base UV
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Why should I use it?

Use a variable-axis profile operation to swarf-cut walls. To get the best result,
you must adjust the tool alignment in the lead and lag direction based on
the wall geometry.

• Use the Swarf Base UV option when you have a ruled surface with proper
UV alignment.

• Use the Align to Edges option when there are straight edges that guide
the alignment properly.

• Use the Automatic option in all other cases.

Where do I find it?

Application Manufacturing

Menu

Create Operation®mill_multi-axis®
VARIABLE_CONTOUR®Drive Method®
Contour Profile

Location in dialog
box Axis group®Axis list

Multi Blade Milling

Multi Blade — Interpolate Vector

Use the Interpolate Vector tool axis option to control tool alignment behavior.
You can edit orientation at system points and add or manipulate user points
along the lowest and highest cut levels. NX interpolates along and between
those cut levels to provide a smooth, gouge free tool path.

In the Interpolated Vector dialog box, you can:

• View a list of all control points.

• Change the tool orientation at system defined control points.

• Add, reorient, move, or delete user defined control points.

• Display a preview of tool orientations along the upper and lower rails.

By default, green tool positions are safe positions. Red tool positions are
gouging positions.

• Dynamically rotate a vector and view the impact, including gouging, on
the nearby and surrounding locations.

• Display the interpolated vectors along the upper and lower rails.
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The Interpolate Vector tool axis option creates smooth gouge free tool paths.
Use this option to overcome conditions where the Automatic tool axis option
does not find gouge free orientation.

The Interpolate Vector option mainly controls the tool axis in the lead and
lag directions. The processor also adds side tilt when it is required to avoid
gouges.

Preview of tool orientations showing gouges

Preview of interpolated vectors

Where do I find it?

Application Manufacturing
Prerequisite Requires the NX Turbo Machinery Add-on license.

Toolbar Insert®Create Operation
Menu Insert®Operation

Location in dialog
box

Type group®mill_multi_blade®Operation Subtype

group®MULTI_BLADE_ROUGH , HUB_FINISH

, BLADE_FINISH , or BLEND_FINISH

[Operation] dialog box®Tool Axis group
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Multi Blade Blend Finish operations

Use Multi Blade Blend Finishing operations to finish the blend areas of
multiple blade impellers and blisks. You can finish the blade with a larger
tool, and then finish the area between the blade and the hub with a smaller
tool.

Where do I find it?

Application Manufacturing

Prerequisite
Requires the NX Turbomachinery Milling Add-on
license

Toolbar Insert®Create Operation
Menu Insert®Operation

Location in dialog
box

Type group®mill_multi_blade®Operation Subtype

group®BLEND_FINISH

Additional Multi Blade enhancements

What is it?

You can add tangential extensions to the tool paths for Blade Finish and
Blend Finish operations.

The Blade Finish operation includes the Helical cut pattern.
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Blade Finish — all sides, helical cut pattern

Blade Finish — Left, Right,
Leading Edge, without extensions

Blade Finish — Left, Right,
Leading Edge, with tangential

extensions

Where do I find it?

Application Manufacturing

Prerequisite
Requires the NX Turbomachinery Milling Add-on
license

Toolbar Insert®Create Operation
Menu Insert®Operation

Location in dialog
box

Type group®mill_multi_blade®Operation Subtype

group®BLADE_FINISH or BLEND_FINISH
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Hole Milling

Hole milling operations

What is it?

Use the new HOLE_MILLING operation type to machine holes and
cylindrical bosses with or without using Feature-based Machining. You can:

• Use all currently available tool types.

• Reverse the machining direction without affecting a feature’s orientation.

• Gouge check traverse moves.

• Machine a combination of through and blind holes.

• Extend the start and end of cuts.

• Specify helical and spiral cut patterns.

• Set multiple radial stepover passes.

• Set multiple axial stepovers for the Spiral and Helical/Spiral cut patterns.

The Helical cut pattern creates the
following for a single axial level:

1. A helical cut motion.

2. An optional single turn cleanup
pass at the depth of the hole or
boss.

The Spiral cut pattern creates the
following for each axial level:

1. A spiral cut motion.

2. An optional single turn cleanup
pass at full diameter.
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The Helical/Spiral cut pattern
creates the following:

1. A single helical cut motion, in
the center of the hole, to the
axial cut depth.

2. A spiral cut motion with
increasing diameter for each
axial level.

3. An optional single turn cleanup
pass at full diameter for each
axial level.

Where do I find it?

Application Manufacturing

Toolbar Insert®Create Operation
Menu Insert®Operation

Location in dialog
box

Type®hole_making/drill/planar_mill®Operation

Subtype®HOLE_MILLING

Hole/Boss geometry object

What is it?

The Hole/Boss geometry object helps you to define hole and boss locations
with or without thread data. You can use this geometry object as a parent
geometry object for HOLE_MILLING and THREAD_MILLING operations.

• HOLE_MILLING operations support Hole, Boss, Threaded Hole, and
Threaded Boss geometry.

• THREAD_MILLING operations require thread information and only
support Threaded Hole, and Threaded Boss geometry.
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You can specify hole milling geometry by selecting any of the following:

• Points

• Curves

• Arcs

• Cylindrical edges

• Cylindrical faces

Why should I use it?

The Hole/Boss geometry object allows you to define holes and bosses with
different tool axes, diameters, or depths.

Where do I find it?

Application Manufacturing

Toolbar Insert®Create Geometry
Menu Insert®Geometry

Location in dialog
box

Type group®mill_planar/Drill/hole_making®Geometry

Subtype group®HOLE_BOSS_GEOM

IPW in Surface Contouring

What is it?

You can now use Cutting Parameters options in Surface Contouring
operations to remove tool path segments that do not cut material and connect
the remaining segments of the tool path. To recognize the blank and IPW
from the previous operation, you must set the In Process Workpiece option
to Use 3D.

You can also use other options to eliminate more cutting segments that do
not remove material. The following options are now available for Surface
Contouring:

• Hookup Distance

• Minimum Cut Length

• Minimum Material Removed
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The following options are new:

Apply to Last
Pass

Controls whether blank sensitive trimming is applied on
the last pass.

If the last pass finishes the part, clear this check box to
ensure that the entire area is finished. Otherwise the
finish pass is limited to only the regions where significant
material remains on the IPW.

Minimize Non
Cutting Moves

Optimizes the cutting order to reduce unwanted lifts

Before applying cutting parameters After applying cutting parameters

For more information on the Containment tab options, see the Manufacturing
Milling help.

Why should I use it?

Your machine time is reduced because NX eliminates segments of the tool
path where there is no stock to remove.

Where do I find it?

Application Manufacturing

Prerequisite

You must be in a valid fixed-axis surface contouring
operation.

You must use a Zig, Zig-Zag, or Zig Zag with Lifts cut
pattern.

Location in dialog
box

Cutting Parameters dialog box®Containment
tab®Blank group®In Process Workpiece list®Use 3D
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Customize Generic Motion and Probing operations

You can customize Generic Motion and Probing operations in the following
ways:

• Reorder the list of sub-operation types that are available to create.

• Remove sub-operation types that you do not use from the list of available
sub-operation types.

• Create custom sub-operations with the User Defined Move dialog
item type.

• Add parameters to the standard Probing cycles and Generic Motion
moves.

Note The following apply when you customize a Probing or Generic Motion
dialog box:

• You cannot remove or modify the existing parameters in a standard
sub-operation.

• You cannot modify a sub-operation that is currently used in the
operation that you are customizing. You must delete any instances of
the sub-operation before you can modify the sub-operation template.

• You can remove a sub-operation type that is currently used in the
operation that you are customizing. The existing instances of the
sub-operation remain in the operation.

Where do I find it?

Application Manufacturing
Operation
Navigator

Right-click a Probing or Generic Motion
operation®Object®Customize

Dialog box

Probing or Generic Motion operation dialog

box®Options group®Customize Dialog

Generic Motion enhancements

What is it?

The Generic Motion operation has the following enhancements:

• The Rotary Move To Point suboperation is now called Rotary Point Vector
Move. This suboperation has better defaults for tool positioning. It also
has new tool positioning options.
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• There are two new suboperations: Follow Curve/Edge and Follow Part
Offset.

Rotary Point Vector Move

The Rotary Point Vector Move suboperation lets you dynamically drag the
tool from its last position to a new position and orientation.

By default, the tool is positioned at one of two locations:

• If the tool position from a previous move suboperation is recognized by
NX, the tool is positioned at that location.

• If the tool position from a previous move suboperation is not recognized
by NX, then the tool is positioned at the MCS with the tool axis aligning
with the ZM-axis.

When the operation has geometry specified, you can position the tool

tangential to a selected surface point. The new . Alternate Solution
option selects between the on tool position and any tangent tool positions.
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Follow Curve/Edge

The Follow Curve/Edge suboperation follows a series of directional curves.

You can:

• Select curves or edges for the tool to follow.

• Specify start and end points and tool axes.

• Specify linear tangential extensions at the start and end points.

Follow Part Offset

The Follow Part Offset suboperation follows part cross sections.

You can:

• Specify start and end points.

• Specify the tool axis.

• Specify linear tangential extensions at the start and end points.

Why should I use it?

These enhancements make it easier for you to create tool paths that follow
user specified tool positions when selecting points, tool axis, curves, and edges.
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Where do I find it?

Application Manufacturing

Toolbar Insert® Create Operation

Location in dialog
box

Type group®Mill_Multi_Axis or Probing®Operation

Subtype®GENERIC_MOTION

Tilt Tool Axis

Use the Tilt Tool Axis command to avoid tool holder collisions in Surface
Contouring and ZLevel tool paths. The tool path is analyzed for tool holder
collisions. If a collision is found, the tool axis is tilted to avoid the collision.

If you generate the operation after tilting the tool axis, the tilted tool path
is replaced by the newly generated 3-axis tool path, and you need to repeat
the tool axis tilt command.

Besides giving you the ability to avoid collisions, the Tilt Tool Axis command
also allows tools to reach greater depths using the shortest tools possible
for added rigidity.

In the examples, the tool axis tilts when a tool holder collision is detected,
so that the tool can continue cutting down the wall towards the bottom of
the part.

Where do I find it?

Application Manufacturing

Prerequisites

• The operation must be a Surface Contouring or
Zlevel operation.

• The cutter must be a ball mill cutter with a tool
holder defined.

Operation
Navigator Right-click an operation®Tool Path®Tilt Tool Axis
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Chamfer mill tool type

What is it?

Use the new Chamfer Mill tool type to create a mill tool that allows for
an angular corner chamfer.

You can specify the following parameters for the tool:

(L) Length

(FL) Flute Length

(C) Chamfer Length

(D) Diameter

(R1) Lower Radius

(B) Chamfer Angle

Why should I use it?

This type of tool is useful when you need to define a face mill or chamfered
end mill.

Where do I find it?

Application Manufacturing
Menu Insert®Tool

Toolbar Insert®Create Tool

Location in dialog
box

Type®mill_planar, mill_contour, mill_multi-axis, or
mill_multi_blade®Tool Subtype®CHAMFER_MILL

What’s New in NX 8 5-31



CAM (Manufacturing)

Spherical mill tool type

What is it?

Use the new Spherical Mill tool type to create a ball-shaped tool with
a reduced neck diameter. This type of tool allows you to machine restricted
areas such as ports and undercuts.

You can define the shape of the tool using the following parameters:

(L) Length

(ND) Neck Diameter

(FL) Flute Length

(D) Diameter

Number of Flutes

Where do I find it?

Application Manufacturing
Menu Insert®Tool

Toolbar Insert®Create Tool

Location in dialog
box

Type®mill_planar, mill_contour, mill_multi-axis, or
mill_multi_blade®Tool Subtype®SPHERICAL_MILL
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Manufacturing Turning

Integrated test cut, probe, and finish cut

What is it?

You can create a single finish operation that incorporates the following
sequence:

1. Test cut

2. Tool retracts to a safe position

3. Machine-specific probing cycle or pause for manual measurement

4. Finish cut

You can use the OPSKIP command to control whether the test cut and probing
portion of the tool path is used or omitted.

You must create User Defined Events (UDEs) to manage the measuring
operations.

The following commands are available on the Test Cut tab of the Cutting
Parameters dialog box.

• Start of Test Cut Events

• Measuring Stop Events

• End of Test Cut Events

• Start of Finish Path Events
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The options are available in the Cutting Parameters dialog box, on the new
Test Cut tab.

Where do I find it?

Application Manufacturing

Prerequisite

Create or edit a turning operation

You must have user defined events in place to control
your probing attachment and communicate offset
adjustments to the machine tool.

Toolbar Insert®Create Operation
Menu Insert®Operation
Location in dialog
box

Path Settings group®Cutting Parameters®Cutting
Parameters dialog box®Test Cut tab
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Siemens Sinumerik 840D CYCLE95 Stock Removal

What is it?

The NX turning processor supports output for the Siemens Sinumeric 840d’s
CYCLE95 stock removing cycle in the following operation types:

• FACING
• ROUGH_TURN_OD
• ROUGH_BACK_TURN
• ROUGH_BORE_ID

• ROUGH_BACK_BORE
• FINISH_TURN_OD
• FINISH_BORE_ID
• FINISH_BACK_BORE

Cycle parameters are automatically mapped from NX CAM turning
parameters. Knowledge of specific output parameters is not required.

Note The IPW that is created by existing operations which are capable of
CYCLE95 output is used by subsequent operations. This IPW will be only
an approximation of the actual CYCLE95 results.

The Post Builder template post for the Siemens Sinumerik 840D Controller
has been updated to include support for CYCLE95.

The contour definition for CYCLE95 is output in the form of a subprogram.
You can output the subprogram in one of these ways:

• In-line with the main program

• At the end of main program

• In a separate SPF file
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Why should I use it?

The post created by Post Builder using the Siemens 840D option now supports
the Siemens controls optimally.

On the shop floor, the machine operator can adjust a single line of code, for
example to change the cut depth per pass. To make the same change with
conventional output, many lines of code must be recalculated.

Where do I find it?

Application NX

Prerequisite
Create or edit a turning operation of a type listed in
the preceding article.

Location in dialog
box Machine Control®Motion Output®Machine Cycle

Application Post Builder

Prerequisite
Create or edit a SIEMENS — SinumeriK_840D_lathe
post.

Location dialog
box

Program & Tool Path®Custom
Command®PB_CMD_init_cycle95_output

Manufacturing simulation and verification (ISV)

Controlling animation speed

What is it?

You can now control the animation speed in machine tool simulations by
changing the number of frames that appear in a simulation. You can make a
simulation run slower by increasing the number of animation frames, and
run faster by decreasing the number of animation frames.

The Minimum Simulation Time option in the Simulation Options dialog
box sets the amount of machining time that is required for one frame to
be generated. For example, to increase the number of frames generated,
decrease the Minimum Simulation Time value. This makes the animation
take longer to play.

Note You may need to edit your machine tool definition file to make the
Minimum Simulation Time option available, when the Visualization list is
set to Machine Code Simulate in the Animation group in the Simulation
Control Panel dialog box.
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For the provided example:

…\MACH\samples\nc_simulation_samples\sim01_mill_3ax_cam_fanuc_in.prt,

you would edit the corresponding machine tool definition file,

…\MACH\resource\library\machine\installed_machines\sim01_mill_3ax\sim01_mill_3ax_fanuc_in.dat

insert a number sign (#) to comment out the second line.

MILL_3_AXIS,${UGII_CAM_LIBRARY_INSTALLED_MACHINES_DIR}sim01_mill_3ax\...
#CSE_FILES,${UGII_CAM_LIBRARY_INSTALLED_MACHINES_DIR}sim01_mill_3ax\...

Where do I find it?

Application Manufacturing
Menu File®Utilities®Customer Defaults
Location in dialog
box

Manufacturing®Simulation & Visualization®ISV
Options tab®Simulation Display

IPW simulation options

What is it?

When you visualize material removal, you can now choose between
motion-based IPW updates and length-based IPW.

Why should I use it?

Use motion-based rendering when you want the fastest performance in
rendering the resulting IPW. The tool position may be updated several times
during a motion, but the IPW is updated only after the motion is complete.

Use length-based rendering when you want to see the material removed in
synchronization with the tool motion.

Where do I find it?

Application Manufacturing
Graphics window Right-click on an operation®Tool Path®Simulate
Location in dialog
box Simulation Settings group®Options
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Tool holder gouge checking

What is it?

You can now check for tool holder collision against part geometry when you
simulate a tool path, using the Check for Tool Holder Collision option. In
previous releases, you could only perform this check when you right-clicked an
operation and chose Tool Path®Gouge Check from the Operation Navigator.

Why should I use it?

To find collisions between tool holder and design part during simulation.

Where do I find it?

Application Manufacturing
Prerequisite The part file requires a tool with a holder.
Operation
Navigator Right-click the operation®Tool Path®Simulate

Location in dialog
box

Simulations Options®Other Options ®Check for
Tool Holder Collision.

NX Post

NX Post enhancements

What is it?

In the Postprocess dialog box, you can now change the options for Output
Warning Messages and Activate Review Tool specified with a post in Post
Builder. The default settings are Post Defined. You can set the options to On
or Off. The settings you select persist during your NX session.

You can control whether your users see the review tool options by changing
the Show Review Tool options customer default.

Tip To find a customer default, choose File→Utilities→Customer Defaults,

and click Find Default .

Tolerance resolutions and distance calculations have been improved for better
performance.
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Why should I use it?

The improved user interface makes it easier to set the options for Output
Warning Messages and Activate Review Tool.

Where do I find it?

Application Manufacturing
Operation
Navigator Right-click the selected operation®Post Process
Location in dialog
box Settings group

Standard Sinumerik cycles in supplied machines

What is it?

All installed machines under the
${UGII_BASE_DIR}\MACH\resource\library\machine folder now have
standard Sinumerik cycles that do the following:

• Add Multi spindle, multi-channel mill-turn examples.

• Add machine tool examples that allow machines to change tool heads.

• Allow standard NX simulation drivers to support PLANE SPATILA for the
Heidenhain TNC controller and CYCLE800 for the Sinumerik controller.

Why should I use it?

The standard Sinumerik cycles support the creation of mill turn posts.

Post Builder

Dual units posts in Post Builder

What is it?

You can enable your main post to function as a dual-unit post by using the
Units Only Subpost option. When you select this option and specify a main
post, Post Builder automatically detects the units of the main post and creates
a subpost to output the alternate units.

For example, if your main post is fanuc_3ax, which is in inches, and you select
the Units Only Subpost option, Post Builder creates the fanuc_3ax__MM
subpost. If this subpost exists in the same folder as the fanuc_3ax post, and
you ask for millimeter output in NX, the postprocessor automatically finds
and uses the fanuc_3ax__MM subpost.
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Note If your fanuc_3ax post in is millimeters, then the subpost name would
be fanuc_3ax__IN. There are two underscores in the subpost name before
the uppercase IN or MM.

When you create a new main post, you can use the following options in the
Optional Alternate Units Subpost group.
Default Accepts the default name for a future units-only subpost.

Your new main post will search for this name in the folder
if you specify opposite units in NX. You must create the
units-only subpost.

Specify Lets you specify an existing units-only subpost. The file
must exist, and should have similar parameters to your
new main post.

Why should I use it?

The Units Only Subpost option makes it easy for you to develop posts that
are capable of properly processing output in both inches and millimeters.

Where do I find it?

Creating a new units-only subpost

Application Post Builder

Windows
Start®All Programs®Siemens NX 8.0®Manufacturing
Tools®Post Builder

Location in dialog
box File®New®Units Only Subpost

Identify an existing units-only subpost

Application Post Builder

Windows
Start®All Programs®Siemens NX 8.0®Manufacturing
Tools®Post Builder

Location in dialog
box

Output Settings®Other Options tab®Optional
Alternate Units Subpost group

Post output conditions

What is it?

You can create, edit, or remove custom output conditions for a block or macro
from Post Builder by using the Output Condition command. For example, you
can write Tcl code to enable or suppress output under specified conditions, or
to force the block output into two lines of code. In previous releases you could
only do this by editing the Tcl program.
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You can also prevent the code sequence numbers from appearing in the output
for a block or macro by using the Suppress Sequence Number command.

Default appearance of a block

Block with sequence numbers suppressed

Block with an output condition

Block with sequence numbers suppressed and an output condition

Appearance on the Program tab, where you can create, edit, or remove
conditions.

Why should I use it?

You can easily find the lines of code for output conditions in Post Builder,
instead of searching through a large Tcl program.

Where do I find it?

Application Post Builder

Windows
Start®All Programs®Siemens NX 8.0®Manufacturing
Tools®PostBuilder

Location in dialog
box

Program & Tool Path tab®Program tab®right-click a
block or macro®Set Output Conditions or Suppress
Sequence Number
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User Defined Events enhancements

What is it?

Your post can now inherit user defined events from one or more other posts.

• When you select the Inherit UDE From a Post check box, you can enter
the names of the posts whose user defined events you want the current
post to inherit.

• When you select the Include Own CDL File check box, you can now select
a folder containing .cdl files whose user defined events you want the
current post to include.

If your referenced files contain events with the same names and different
versions or revisions of the event, the order in which you specify posts or
.cdl files is important. Same-named events in the last file to be read are
the version that is used. The software reads the lists starting with the first
entry, and ending with the last entry.

Why should I use it?

You can reuse the code for existing user defined events instead of creating the
code again.

Where do I find it?

Application PostBuilder

Windows
Start®All Programs®Siemens NX 8.0®Manufacturing
Tools®PostBuilder

Location in dialog
box

NC Data Definitions tab®Other Data Elements
tab®User Defined Events group®Include Other CDF
File or Inherit UDE From a Post

Suboperation events

What is it?

A new Miscellaneous page under Tool Path allows you to specify events for
the start and end of suboperations in generic motion or probing operations.
The following events are generated automatically in NX:

• MOM_start_of_subop_path

• MOM_end_of_subop_path
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Why should I use it?

These new event markers make it convenient for you to configure
suboperation event handlers in Post Builder.

Where do I find it?

Application PostBuilder

Windows
Start®All Programs®Siemens NX 8.0®Manufacturing
Tools®PostBuilder

Location in dialog
box

Program & Tool Path tab®Program tab®Tool Path
group®Miscellaneous page®Start of Subop Path and
End of Subop Path

Siemens Sinumerik 840D CYCLE95 Stock Removal

What is it?

The NX turning processor supports output for the Siemens Sinumeric 840d’s
CYCLE95 stock removing cycle in the following operation types:

• FACING
• ROUGH_TURN_OD
• ROUGH_BACK_TURN
• ROUGH_BORE_ID

• ROUGH_BACK_BORE
• FINISH_TURN_OD
• FINISH_BORE_ID
• FINISH_BACK_BORE

Cycle parameters are automatically mapped from NX CAM turning
parameters. Knowledge of specific output parameters is not required.
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Note The IPW that is created by existing operations which are capable of
CYCLE95 output is used by subsequent operations. This IPW will be only
an approximation of the actual CYCLE95 results.

The Post Builder template post for the Siemens Sinumerik 840D Controller
has been updated to include support for CYCLE95.

The contour definition for CYCLE95 is output in the form of a subprogram.
You can output the subprogram in one of these ways:

• In-line with the main program

• At the end of main program

• In a separate SPF file

Why should I use it?

The post created by Post Builder using the Siemens 840D option now supports
the Siemens controls optimally.

On the shop floor, the machine operator can adjust a single line of code, for
example to change the cut depth per pass. To make the same change with
conventional output, many lines of code must be recalculated.

Where do I find it?

Application NX

Prerequisite
Create or edit a turning operation of a type listed in
the preceding article.

Location in dialog
box Machine Control®Motion Output®Machine Cycle

Application Post Builder

Prerequisite
Create or edit a SIEMENS — SinumeriK_840D_lathe
post.

Location dialog
box

Program & Tool Path®Custom
Command®PB_CMD_init_cycle95_output
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Feature-based machining

Show Feature CSYS

What is it?

Use the Show Feature CSYS option to turn on or off the coordinate system
that displays the position and orientation of machining features.

Show Feature CSYS on Show Feature CSYS off

Why should I use it?

This command helps you to control the direction display for machining
features without using a customer default.

Where do I find it?

Application Manufacturing
Machining
Feature Navigator Right-click in the background®Show Feature CSYS

Edit Feature CSYS

What is it?

Use the new Edit Feature CSYS command to edit the position and orientation
of a feature. You can change the CSYS settings either dynamically in the
graphics window or in the Edit Feature CSYS dialog box.
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In the Details panel of the Machining Feature Navigator, the Overriden
column displays a check mark for the modified CSYS attributes.

Attribute Value Overriden Original Value
Y_ORIENTATION_L –0.8660 0.0000
Y_POSITION 2.7500 2.7500

Where do I find it?

Application Manufacturing
Machining
Feature Navigator Right-click the selected feature®Edit Feature CSYS

Hide Undefined Attributes

What is it?

Use this option to hide in the Details panel of the Machining Feature
Navigator, those machining feature attributes that have no defined values.

Parametric recognition adds empty attributes when there are no values to
extract from the model file. For example, there are multiple attributes that
remain empty when side roughness is not completely defined.
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Hide Undefined Attributes off Hide Undefined Attributes on

Why should I use it?

Hide undefined attributes so that you can more easily locate the attributes
that you want.

Where do I find it?

Application Manufacturing
Machining
Feature
Navigator, Details
panel

Right-click in the background®Hide Undefined
Attributes

Teach Features

Use the Teach Features command to define parametric recognition rules for
your new custom feature types. After you select the feature geometry in the
part, the command automatically generates the recognition code and stores
the results in the knowledge library. New feature types are available for
reuse immediately after they are created.

Because you can define your own feature types without manually writing
the feature recognition code, the time needed to create your NC program is
significantly reduced. If you want to automatically generate new machining
rules from existing operations for the new features, use the Teach Machining
Rules command.

What’s New in NX 8 5-47



CAM (Manufacturing)

New feature type

Where do I find it?

Application Manufacturing

Prerequisite
Requires the NX30435 — NX Feature Based Machining
Author license.

Menu Tools®Machining Feature Navigator®Teach Features

Teach Machining Rules

Use the Teach Machining Rule command to automatically generate new
machining rules from existing operations within Manufacturing. The
new machining rules are stored in a machining knowledge library so that
the Machining Knowledge Editor (MKE) can access them. The following
operation parameters are supported:

• Feature parameters

• Tool parameters

• Cutting parameters

• Non-cutting move parameters

• User defined events

• Cycle parameters

• Geometry parent

• KF parameters

The Teach Machining Rule command improves efficiency.

• Because you can generate and test the operations for a feature before you
generate the machining rules, you can speed up the process for defining
new machining rules.
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• Because you can define your own machining rules without manually
writing the rule definition code, you can reduce the time needed to create
your NC program. It can be time consuming to set the right operation
parameters in a machining rule and define the necessary Rule Add-on
items.

To make the rules more general and applicable to features with different
dimensions, it is recommended that you edit the rules in the MKE.

Without editing the machining rules, you can use the Create Feature Process
command to create the same set of operations for features with the same
dimensions. After editing the machining rules, you can create the same set of
operations for features with different dimensions.

New feature type Operations to teach

Where do I find it?

Application Manufacturing

Prerequisites

• The NX30435 — NX Feature Based Machining
Author license.

• An instance of the feature for which the rules will
be applicable.

• Operations defined for the feature.

• A machining knowledge library to store the rules.
Operation
Navigator

Right-click the feature operations®Object®Teach
Operations
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6 CAE (Digital Simulation)

NX 8 Advanced Simulation

Solver version support

For each released version of NX, the following tables list the supported solver
versions for import, export, and the post-processing of results. Note:

• The version listed in the Import ASCII and Import Binary rows is the
solver version that was generally available when the NX version was
released. In general, the import of the solver ASCII and binary files
should be upwards compatible. Therefore, you should be able to import
them into the most recent version of NX. However, in general:

o ASCII files are backwards compatible for import into NX. If you import
an ASCII file from a newer version of the solver than is officially
supported, the software simply ignores any new fields/options that
aren’t supported in the current NX release.

o Binary files are not backwards compatible. For example, you can
import a binary file created by NX Nastran 5.0 into NX 6.0.2, but
you might not be able to import a binary file created by NX Nastran
6.1 into NX 5.

• The version listed in the Export ASCII rows is the solver version that was
available when the NX version was tested. In general, the exported solver
input file is upwards compatible for that solver. Backwards compatibility
is not guaranteed. For NX Nastran, the Model Setup Check function in
Advanced Simulation tries to flag potential version incompatibility issues.

• The version listed in the Post-processing Results rows is the version
of the solver results that was tested in the listed NX version. In general,
results from earlier solver versions are also supported.
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NX 8 releases

Solver File Type NX 8
Import ASCII (.dat) 8

Import Binary (.op2) 8
Export ASCII (.dat) 8NX Nastran

Post-processing of Results (.op2) 8

Import ASCII (.dat) 2011.1
Import Binary (.op2) 2011.1
Export ASCII (.dat) 2011.1MSC Nastran

Post-processing of Results (.op2) 2011.1
Import ASCII (.inp) 6.10
Import Binary N/A
Export ASCII (.inp) 6.10
Post-processing of Results (.fil) 6.11

Abaqus

Post-processing of Results (.odb) 6.10-EF1
Import ASCII (PREP7, CDB) 13
Import Binary (.rst, .rth) 13
Export ASCII (.inp) 13ANSYS

Post-processing of Results 13
Import ASCII 971R5.0
Import Binary N/A
Export ASCII (.k) 971R5.0LS-DYNA

Post-processing of Results 971R5.0

NX7 releases

Solver File Type NX 7 NX 7.5 NX 7.5.1 NX 7.5.2 NX 7.5.3

Import ASCII (.dat) 6.1 7.0 7.0 7.1 7.1

Import Binary (.op2) 6.1 7.0 7.0 7.1 7.1

Export ASCII (.dat) 6.1 7.0 7.0 7.1 7.1NX Nastran

Post-processing of

Results

6.1 7.0 7.1 7.1 7.1

Import ASCII (.dat) 2008r1 2008r1 2008r1 2008r1 2010

Import Binary (.op2) 2008r1 2008r1 2008r1 2008r1 2010

Export ASCII (.dat) 2008r1 2008r1 2008r1 2008r1 2010
MSC
Nastran

Post-processing of

Results

2008r1 2008r1 2008r1 2008r1 2010
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Solver File Type NX 7 NX 7.5 NX 7.5.1 NX 7.5.2 NX 7.5.3

Import ASCII (.inp) 6.8-1 6.9–1 6.9–1 6.9-1 6.10

Import Binary N/A N/A N/A N/A N/A

Export ASCII (.inp) 6.8-1 6.9 6.9 6.9 6.10

Post-processing of

Results (.fil)

6.8-EF2 6.9.2 6.9.2 6.10-1 6.10-1Abaqus

Post-processing of

Results (.odb)

6.8-EF2 6.9-EF1 6.9-EF2 6.9-EF2 6.10-EF1

Import ASCII

(PREP7, CDB)

12 12.1 12.1 12.1 13

Import Binary (.rst,

.rth)

12 12.1 12.1 12.1 13

Export ASCII (.inp) 12 12.1 12.1 12.1 13
ANSYS

Post-processing of

Results

12 12.1 12.1 12.1 12.1

Import ASCII N/A N/A N/A N/A N/A

Import Binary N/A N/A N/A N/A N/A

Export ASCII (.k) 971R3.2.1 971R3.2.1 971R3.2.1 971R3.2.1 971R3.2.1LS-DYNA

Post-processing of

Results

N/A N/A 971R3.2.1 971R3.2.1 971R3.2.1

NX 6 releases

Solver File Type NX 6 NX 6.0.1 NX 6.0.2 NX 6.0.3 NX 6.0.4 NX 6.0.5

Import ASCII (.dat) 6.0 6.1 6.1 6.1 6.1 7.0

Import Binary (.op2) 6.0 6.1 6.1 6.1 6.1 7.0

Export ASCII (.dat) 6.0 6.1 6.1 6.1 6.1 7.0NX Nastran

Post-processing of

Results

6.0 6.0 6.1 6.1 7.0 7.0

Import ASCII (.dat) 2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Import Binary (.op2) 2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Export ASCII (.dat) 2007r1 2008r1 2008r1 2008r1 2008r1 2008r1MSCNastran

Post-processing of

Results

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Import ASCII (.inp) 6.7-1 6.8-1 6.8-1 6.8-1 6.8-1 6.8-1

Import Binary N/A N/A N/A N/A N/A N/A

Export ASCII (.inp) 6.7-1 6.8-1 6.8-1 6.8-1 6.8-1 6.8-1

Post-processing of

Results (.fil)

6.7-5 6.8-1 6.8-3 6.8-EF2 6.8-EF2 6.8-EF2Abaqus

Post-processing of

Results (.odb)

N/A N/A N/A 6.8-EF 6.8-EF2 6.9-EF2
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Solver File Type NX 6 NX 6.0.1 NX 6.0.2 NX 6.0.3 NX 6.0.4 NX 6.0.5

Import ASCII

(PREP7, CDB)

11 11 SP1 11 SP1 11 SP1 12.0 12.0

Import Binary (.rst,

.rth)

11 11 SP1 11 SP1 11 SP1 12.0 12.0

Export ASCII (.inp) 11 11 SP1 11 SP1 11 SP1 12.0 12.0
ANSYS

Post-processing of

Results

11 SP1 11 SP1 11 SP1 11 SP1 12.0 12.1

Import ASCII N/A N/A N/A N/A N/A N/A

Import Binary N/A N/A N/A N/A N/A N/A

Export ASCII (.k) 971R2 971R2 971R3.2.1 971R3.2.1 971R3.2.1 971R3.2.1LS-DYNA

Post-processing of

Results

N/A N/A N/A N/A N/A N/A

NX 5 releases

Solver File Type NX 5 NX

5.0.1

NX 5.0.2 NX 5.0.3 NX

5.0.4

NX

5.0.5

NX 5.0.6

Import ASCII (.dat) 5.0 5.1 5.1 5.1 5.1 5.1 5.1

Import Binary (.op2) 5.0 5.1 5.1 5.1 5.1 5.1 5.1

Export ASCII (.dat) 5.0 5.1 5.1 5.1 5.1 5.1 5.1
NX
Nastran

Post-processing of Results 5.0 5.0 5.1 5.1 5.1 5.1 6.0

Import ASCII (.dat) 2005 2005 2007 2007 2007 2007 2007r1

Import Binary (.op2) 2005 2005 2007 2007 2007 2007 2007r1

Export ASCII (.dat) 2005 2005 2007 2007 2007 2007 2007r1
MSC
Nastran

Post-processing of Results 2005 2005 2007 2007 2007 2007 2008r1

Import ASCII (.inp) 6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.7-1

Import Binary N/A N/A N/A N/A N/A N/A N/A

Export ASCII (.inp) 6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.7-1
Abaqus

Post-processing of Results 6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.8-1

Import ASCII (PREP7,

CDB)

10 10 11 11 11 11 11

Import Binary (.rst, .rth) 10 10 11 11 11 11 11

Export ASCII (.inp) 10 10 11 11 11 11 11
ANSYS

Post-processing of Results 10 11 11 11 11 11 11 SP1
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NX 4 releases

Solver File Type NX 4 NX 4.0.1 NX 4.0.2 NX 4.0.3 NX 4.0.4

Import ASCII (.dat) 4.0 4.1 4.1 5.0 5.0

Import Binary (.op2) 4.0 4.1 4.1 4.1 4.1

Export ASCII (.dat) 4.0 4.1 4.1 5.0 5.0NX Nastran

Post-processing of

Results

4.0 4.1 4.1 5.0 5.0

Import ASCII (.dat) 2005 2005 2005 2005 2005

Import Binary (.op2) 2005 2005 2005 2005 2005

Export ASCII (.dat) 2005 2005 2005 2005 2005
MSC
Nastran

Post-processing of

Results

2005 2005 2005 2005 2005

Import ASCII (.inp) 6.5-1 6.5-1 6.5-1 6.6 6.6

Import Binary N/A N/A N/A N/A N/A

Export ASCII (.inp) 6.5-1 6.5-1 6.5-1 6.6 6.6Abaqus

Post-processing of

Results

6.5-1 6.5-1 6.5-1 6.6 6.6-3

Import ASCII

(PREP7, CDB)

8 9 9 10 10

Import Binary (.rst,

.rth)

8 9 9 10 10

Export ASCII (.inp) 8 9 9 10 10
ANSYS

Post-processing of

Results

9 9 9 10 10

Advanced Simulation Help improvements

This release contains a number of enhancements to the Advanced Simulation
Help.

Advanced Simulation help reorganization and improvements

The Advanced Simulation Help has been reorganized to make navigation
more logical and relevant information easier to find.

• Help for all Advanced Simulation dialog boxes is now available in a new
Command reference section. Dialog boxes are listed in alphabetical order.

• Help topics that cover the process of modeling contacting or glued surfaces
are now located in a new Contact and Glue Conditions section.

• Each solver environment now has a separate section in the Advanced
Simulation Help.
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CAE videos with audio

The video examples available in the Advanced Simulation Help now include
voice-over narration. This narration provides important information about
the steps being demonstrated as well as additional details about complex
tasks.

For each video, you can use the options on the play bar to display closed
caption text or to mute the narration.

To access the CAE video examples, see Video examples.

NX Open documentation for CAE

This release includes new NX Open documentation specifically for CAE.

• It includes information about the NX Advanced Simulation solver
language and the NX Advanced Simulation mesh properties

• It supplements the complete API definitions found in the NX Open
Reference manuals.

For more information, see Open CAE documentation overview.

General capabilities

Browsing to results files

What is it?

Use the new Browse command to open the directory containing the files
generated by the solver, including the input and results files.

Why should I use it?

This command is useful if you need to review the solver-generated files or
examine them to troubleshoot problems with the solution.

Where do I find it?

Application Advanced Simulation

Prerequisite An active Simulation file

Simulation
Navigator

Right-click the solution container®Browse
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New default file names

What is it?

In this release, when you create a new FEM, Simulation, or Assembly FEM
file from the Simulation Navigator, the default file name has changed. The
new file name uses the master part file name as a prefix, as follows:

• The default FEM file name uses the format
CADpartname_fem(number).fem. For example, a FEM file created
from the CAD part adjust_arm.prt has the default name of
adjust_arm_fem1.fem.

• The default Simulation file name uses the format
FEMpartname_sim(number).sim, because the FEM is the
master part for the Simulation file. For example, a Simulation file
created from the FEM file adjust_arm_fem1.fem has the default name of
adjust_arm_fem1_sim1.sim.

• The default assembly FEM file name uses the format
CADpartname_assyfem(number).afm. For example, an assembly FEM
file created from the CAD part adjust_arm.prt has the default name of
adjust_arm_assyfem1.afm.

When you click New from the Standard toolbar or choose File®New, the
default file names do not use the master part file name as a prefix, because
the master part has not yet been defined.

To modify the default name of the files that you create from the Simulation
Navigator, select Prefix Part Name with Master Part Name on the Customer
Defaults dialog box. If you deselect this option, the file names are the
customer defaults defined for the File New dialog box.

Where can I find it?

Creating a new FEM, Simulation, or Assembly FEM file from the Simulation
Navigator:

Application Advanced Simulation

Simulation
Navigator

Right-click the part or ipart name®New FEM

Right-click the part or ipart name®New FEM and
Simulation

Right-click the part name®New Assembly FEM

Right-click the FEM name®New Simulation
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Setting a different default file name:

Application Advanced Simulation

Menu File®Utilities®Customer Defaults®Simulation
category®General subcategory®FE Model and
Simulation Create tab®Prefix Part Name with Master
Part Name

Update Agent

What is it?

You can use the Add Update Agent command to identify particular solutions
within a simulation to re-solve automatically when the solid geometry or the
points, curves, or coordinate systems in the master CAD part are modified.
The mesh, boundary conditions, and solutions can be updated.

Part modifications that you make while the FEM, idealized part, or
Simulation file are displayed do not trigger a re-solve.

This feature works with the FEM object in the Product Template Studio
application.

For steps, see Set up an Update Agent for use with Product Template Studio.

Where do I find it?

Update Agent customer defaults

Menu
File®Utilities®Customer
Defaults®Simulation®General

Location in dialog
box Allow UpdateAgent Creation

Update Agent command

Simulation
Navigator

Right-click the solution®Add Update Agent

Right-click the solution®Remove Update Agent

Persistent element quality displays

What is it?

In this release, the Model Display preference includes new options for
displaying elements that fail element shape quality checks.

In previous releases, when you wanted to identify problems in your mesh, you
used the Model Checks command to check element shapes. When you use
this command, the problem elements are displayed until you choose another
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command. In this release, in addition to using Model Checks, you can also
generate a persistent display of the problem elements. To do this, use Model
Display and set the Color Basis option to Element Quality Checks.

The element quality model display options let you control colors for elements
that pass or fail quality checks. You can also use translucency to display
elements. The Threshold Values option opens the Threshold Values dialog
box, where you can modify the values for the element shape checks.

The figure shows two element quality displays. The top image shows 2D
elements, and the bottom image shows 3D elements with translucency.
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Where do I find it?

Application Advanced Simulation
Menu Preferences®Model Display

Units conversion for scalar values

What is it?

When you enter scalar values to define parameters for your model, the
DesignLogic list now provides automatic units conversion. When you specify
units and enter a value, click to choose a conversion value.

This option is available throughout Advanced Simulation whenever you enter
a scalar value with units in a dialog box, including but not limited to:

• Material property tables

• Physical property tables

• Global and local element lengths

• Element- and mesh-associated data

• Loads, constraints, and simulation objects

The following example shows how to convert pressure entered in pounds
per square inch to pascals.
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(1) Select the input units. (2) Enter a value. (3) Select the conversion
value.

Why should I use it?

Use this feature to convert input parameters into consistent model units.
This feature is especially useful when specifications that define your analysis
problem, such as material data or loading conditions, are not provided in
units consistent with your model.
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Where do I find it?

Application Advanced Simulation
Location in dialog
box DesignLogic list

Polygon geometry and geometry abstraction

Suppressing holes in sheet bodies

What is it?

Some models may contain holes that have little impact on its overall stiffness.
In analyses in which you are interested in the overall behavior of a structure
and not the stresses in the vicinity of the holes, you may want to ignore
selected holes to eliminate unnecessary mesh density. You can use the
new Suppress Hole command to remove holes from sheet bodies, such as
midsurface sheet bodies. You can remove:

• Selected holes or all holes whose diameter is smaller than a specified
threshold value.

• Holes contained within a single face.

• Holes that span multiple faces.

• Both circular and non-circular holes.

When the software removes the hole, you can choose to create either a point
or a mesh point at the centroid of the hole. You may want to create a mesh
point at the hole’s centroid, for example, so you can later create an FE-based
connection element, such as an RBE2, at that location.

You can use the Suppress Hole command either before or after you create a
mesh on the part. If you use Suppress Hole to remove holes from a face that
you have already meshed, you must use the Update Finite Element Model
command to update the mesh.

The following graphic shows an example of how you can use Suppress Hole
to automatically remove a number of holes at one time. (A) shows a 2D mesh
on a midsurface sheet body that contains a series of 4 mm holes. (B) shows
the updated mesh on the sheet body after the Suppress Hole command was
used to remove all holes with a diameter smaller than 5 mm.
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For more information, see Suppressing holes in sheet bodies.

Unsuppressing holes

After you suppress a hole, you can use other Model Cleanup commands to
unsuppress that hole. You first use the Split Face command with the Split
face by suppressed edges option to unsuppress the edge that defines the
perimeter of the hole. You then can use the Repair Face command to remove
the face inside the perimeter of the hole.

The following graphic shows an example of unsuppressing holes. (A) shows
the edges that are currently suppressed. The Split Face command with
the Split face by suppressed edges option was to unsuppress the two
highlighted edges. (B) shows the updated mesh with the unsuppressed edges.
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(C) shows the updated mesh after the Repair Face command was used to
remove the face on the inside of each hole’s perimeter.
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Replaying automatic hole suppression after geometry updates

The software stores information about suppressed holes in the CAE Geom
Recipes node in the Simulation Navigator. If the CAD geometry in either the
master or the idealized part is updated, the software uses the recipe to try to
re-suppress the holes when the FEM file is updated.

CAE Geom Recipes

1 – holes in belt top side
2 – holes in belt bottom side

Note The software can only store information about suppressed holes in the
Simulation Navigator if the CAD part associated with your FEM file is
loaded at the time you use the Suppress Hole command.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file active
Toolbar

Advanced Simulation®Suppress Hole
Menu Model Cleanup®Suppress Hole

Tools for identifying and repairing polygon body problems

What is it?

When you create a FEM file, if you select the Associate to Part option
in the New FEM dialog box, the software automatically creates polygon
geometry from the geometry in your CAD model. As you work with that
polygon geometry, polygon bodies may develop data consistency or corruption
problems. In other cases, you may make unintended modifications to that
polygon geometry.

This release includes new tools that you can use to:

• Identify polygon bodies that have inconsistent or corrupt data and repair
those inconsistencies.

• Recover from unintended modifications to the polygon geometry.
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Identifying problematic polygon bodies

This release includes a new CAE Model Consistency option in the Model
Check dialog box. You can use this option to check all polygon bodies in
your FEM file for issues. If the software identifies problems, it lists the
affected polygon bodies by name and stores the modified bodies in an output
group. As a best practice, you should use the CAE Model Consistency option
periodically while you are building your finite element model.

Note Before you use this option, you must have the CAD part that is
associated with the current FEM file loaded.

Repairing polygon bodies

If the software identifies polygon bodies with consistency issues, and the CAD
part that is associated with the current FEM file is loaded, you can use new
options in the Simulation Navigator to fix those issues.

When you right-click a polygon body in the Simulation Navigator, there are
three new options.

• The Recreate and Update option deletes the selected polygon body
and creates a new polygon body using the original CAD geometry. The
software then updates the body so that any mesh mating conditions,
meshes, loads, boundary conditions, or CAE geometry recipes are
preserved and updated. Use this option when you want to recreate the
problematic polygon body and preserve as much of the data that was
associated with that body as possible.

• The Recreate Only option deletes the selected polygon body and creates
a new polygon body using the original CAD geometry. The software also
deletes any:

o Mesh mating conditions.

o Modifications made with commands on the Model Cleanup toolbar.

o Meshes.

o Loads or boundary conditions associated with the deleted polygon body.

• The Delete option removes the selected polygon body from your FEM
file. You may want to use the Delete option to exclude a particular body
from your analysis.

When you delete a polygon body from your model, the software moves that
body into a new Excluded Polygon Geometry folder in the Simulation
Navigator.
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Excluded Polygon Geometry

Polygon Body

If you later decide to include the body in your analysis, right-click the body
in the Excluded Polygon Geometry folder and select Create Polygon
Body to create a new polygon body.

Note Although you can use the Delete option to delete polygon bodies that
were created by the Face from Mesh command, you cannot use the
Recreate and Update or Recreate Only options on those bodies.

Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file active
Simulation
Navigator

Right-click an existing polygon body and select Recreate
and Update, Recreate Only, or Delete

Advanced control for polygon body tessellation

What is it?

When you create a FEM file, you can use the new High Resolution Polygon
Bodies option to have the software use a finer level of tessellation to create
the edges in the polygon bodies.

• To turn this capability on in your current NX session, use the High
Resolution Polygon Bodies option in the Meshing Preferences dialog
box.

• To turn this capability on by default, use the High Resolution Polygon
Bodies customer default.

Using a finer level of tessellation is helpful when you want to ensure that
software accurately represents the curvature of surfaces in a very thin body.
In some cases, using the standard resolution for polygon bodies on thin,
curved (though nearly flat) surfaces from different bodies can cause problems
when you try to create Mesh Mating Conditions between them.
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This graphic shows the subtle differences between polygon geometry that was
created with standard resolution (A) and polygon geometry that was created
with the High Resolution Polygon Bodies option turned on (B). In (B), notice
how the overlap between the blue and the gray faces has been eliminated and
how the gap between the blue and the yellow faces is smaller.

Because the High Resolution Polygon Bodies option increases the number of
facets in a polygon body, the size of the associated FEM file also increases.

Where do I find it?

Meshing Preferences option

Application Advanced Simulation
Menu Preferences®Meshing

Customer default

Application Advanced Simulation
Menu File®Utilities®Customer Defaults
Location in dialog
box

Simulation®Meshing®General tab
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Measure Bodies improvements for polygon bodies

What is it?

This release includes improvements to the Measure Bodies command for
polygon bodies. In previous releases, the Measure Bodies listing was not
accurate or complete for polygon bodies.

• In the Measurement Mass Properties section of the listing, the listed
values are now correct for polygon bodies.

o If the selected polygon bodies have an assigned material, Measure
Bodies calculates their weight and mass based on the specified
density for the material.

o If the selected polygon bodies do not have an assigned material, the
software uses a density of 1.0 in the current units to calculate the
mass properties, such as volume and area.

• In the Detailed Mass Properties section of the listing, the software now
calculates all properties for polygon bodies. These properties include,
for example, radii of gyration, moments and products of inertia, as well
as principal moments. In previous releases, when you used Measure
Bodies to analyze polygon bodies, the software did not calculate any of
the properties listed in the Detailed Mass Properties section.

Additionally, if you select the Associative option in the Measure Bodies
dialog box, the software creates a Measures feature in the associated FEM
file. You can view this feature from the Part Navigator:

Measures

Body Measurement

Where do I find it?

Application Advanced Simulation
Menu Analysis®Measure Bodies
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Meshing

Enhancements to Nastran spot weld connections

What is it?

When you select the Point on Curve/Edge option in the CFAST/CWELD
Connection dialog box, you can now create a series of CFAST or CWELD
connections along an edge or curve. In this release, you can create a series
of CFAST or CWELD connections:

• That are located along an edge or curve or are offset from a selected edge
or curve.

• In a specified pattern that repeats along the length of the edge or curve.

These improvements allow you to more easily replicate spot weld or fastener
point patterns from the manufacturing process in your CAE model.

The graphic below shows an example of the new CFAST and CWELD
connection capabilities. The model is comprised of several individual sheet
bodies that will be welded together during the manufacturing process. (A)
shows the locations of the CWELD connections that are offset from one
edge on the top body. Notice that the CWELD connections were created in a
pattern, with one inch between each individual connection and three inches
between each group of connections.

For more information, see CWELD and CFAST Connections (Nastran).

6-20 What’s New in NX 8



CAE (Digital Simulation)

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file with NX Nastran or MSC Nastran

as the specified solver
Toolbar Advanced Simulation®CFAST/CWELD Connection

Menu Insert®Mesh®CFAST/CWELD Connection

Ability to project nodes directly onto CAD geometry

What is it?

When you create a 2D mesh, you can now have the software project nodes
directly onto the underlying CAD geometry rather than onto the CAE polygon
geometry.

• To turn this capability on in your current NX session, use the new Project
Nodes to CAD Geometry option in the Meshing Preferences dialog box.

• To turn this capability on by default, use the new Project Nodes to CAD
Geometry customer default.

The Project Nodes to CAD Geometry option is most useful when you need
to create a mesh for a contact analysis and want to ensure the accuracy of
node locations in regions of contact.

Note If you select the Project Nodes to CAD Geometry option, you must have
the idealized part loaded before you can generate a mesh.

In previous releases, you could use the Node Proximity to CAD Geometry and
Adjust Node Proximity options in the Model Check dialog box to evaluate
and modify the proximity of nodes relative to the CAD geometry. However,
you could only use this option after you had already meshed the model.

Where do I find it?

Meshing Preferences option

Application Advanced Simulation
Menu Preferences®Meshing
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Customer default

Application Advanced Simulation
Menu File®Utilities®Customer Defaults
Location in dialog
box

Simulation®Meshing®General tab

Beam section reuse in managed mode

What is it?

NX 7.5.2 introduced the capability to define a standard, General Geometry,
or Face of Solid type of beam cross section and save it as a template in the
NX Reuse Library. This capability is now supported in managed mode. For
more information, see **Unsatisfied xref title**.

Element Extract enhancements

What is it?

Beginning with this release, when you use the Element Extract command, the
extracted mesh retains the mesh associated data and display properties of the
source mesh. In previous releases, the extracted mesh used default settings
for mesh associated data and display properties.

The graphic shows the meshes listed in the Simulation Navigator before
and after using Element Extract. The source mesh includes all of the pink
elements in 3d_mesh(1). The new mesh is 3d_extracted_mesh(1).
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Where do I find it?

Application Advanced Simulation

Prerequisite A FEM file with meshes displayed.

Toolbar Element Operations toolbar®Element Extract
Menu Edit®Element®Extract

Merge Meshes enhancements

What is it?

Beginning with this release, when you use the Merge Meshes command, the
first mesh that you select becomes the merged mesh. The software adds
the remaining selected meshes to the first mesh. The merged mesh retains
characteristics of the first mesh, including the mesh name, mesh associated
data, and mesh display settings.

In previous releases, merged meshes were placed in a new Simulation
Navigator node that had a unique name. The merged mesh display used
default settings.
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The graphic shows the mesh names and display colors before and after three
extracted meshes are merged.

Where do I find it?

Application Advanced Simulation

Prerequisite Meshes that are not associated with geometry and are
located in the same mesh collector.

Simulation
Navigator

Select multiple meshes®right-click a selected
mesh®Merge Meshes

Shell element thickness contour displays

What is it?

Use the Plot Thickness Contours command to generate a contour plot of
shell element thicknesses as a standard post view. When you generate a
thickness plot, the Post-Processing toolbar is enabled, and you can use the
commands on this toolbar to view and interrogate element thicknesses.
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Clockwise from top: A midsurface on a thin, sculpted part. A 2D
mesh on the midsurface. A thickness contour plot. Thickness values

extracted using Identify Results.

Why should I use it?

You can use Plot Thickness Contours to verify your mesh, to generate
high-quality visualizations for reports or presentations, and to interrogate
and extract thickness data.

You can use Edit Post View to modify the thickness display, and you

can use Identify Results to probe thickness values at nodes and write
thickness information to a spreadsheet or comma-separated-value file.
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Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file containing one or more 2D meshes.

Simulation
Navigator

Right-click a 2D mesh collector node® Plot Thickness
Contours

Right-click a 2D mesh node® Plot Thickness Contours

New meshing customer defaults

What is it?

This release includes several new meshing customer defaults.

Default available for pyramid element transitions

You can use the new Transition with Pyramid Elements customer default to
control the default setting of the Transition with Pyramid Elements option
in the 3D Tetrahedral Mesh dialog box. In the NX Nastran and ANSYS
solver environments, you use the Transition with Pyramid Elements option to
create pyramid elements to transition between a tetrahedral mesh and an
adjacent hexahedral mesh.

Default available to allow minor modifications to 2D seed meshes during
tetrahedral meshing

This release also includes a new Allow Changes to 2D Seed Meshes During
Tetrahedral Meshing customer default that allows the software to make
adjustments to existing 2D seed meshes during tetrahedral meshing.

In previous releases, when you created a 3D mesh on a body that already
had an existing 2D mesh on one or more faces, the software could only split
edges to facilitate mesh generation on cylinders. This meant that during
tetrahedral meshing, the software could not merge any sliver faces or portions
of faces into a face with an existing 2D mesh.

When you set the Allow Changes to 2D Seed Meshes During Tetrahedral
Meshing customer default, the software can perform a greater level of
abstraction during 3D meshing.

• If you select this customer default, the software will eliminate sliver faces
or the sliver portions of previously meshed faces to facilitate a higher
quality tetrahedral mesh.

• If you do not select this customer default, the software will not merge
sliver faces. However, as in previous releases, the software will continue
to split the edges in existing 2D meshes to facilitate tetrahedral meshes
through cylinders.
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Note If you select the new default, you can use the Lock command in the
Simulation Navigator to prevent the software from modifying selected
2D meshes.

Where do I find it?

Application Advanced Simulation
Menu File®Utilities®Customer Defaults
Location in dialog
box

Simulation®Meshing®General tab

Ability to create multiple 0D elements

What is it?

In the Element Create dialog box, when you select 0D from the Element
Family list, you can now use Smart Selection options to quickly create a
number of 0D elements. For example, you can:

• Use the Related Nodes option to create 0D elements on all nodes related
to a selected polygon face.

• Use the Nodes by Group option to create 0D elements on all nodes in an
existing group that you select from the Simulation Navigator.

In previous releases, you had to select locations for 0D element creation one
at a time.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file
Toolbar

Element Operations®Element Create
Menu Insert→Element→Create

Improved handling of sheet bodies for 2D meshing

What is it?

When you use the Polygon Body option in the selection filter to create a 2D
mesh, the software now stores information about the associated CAD sheet
body with your mesh definition. If you make modifications to the associated
CAD sheet body, such as adding a new face, the software automatically adds
that new face into the 2D mesh.
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Note If you use the Polygon Face option in the selection filter to create the
2D mesh, the software does not store information about the CAD sheet
body with the mesh definition.

In previous releases, the software only stored information about the faces
from the sheet body and not about the sheet body itself. Modifications that
you made to the associated CAD sheet body were not reflected in the mesh.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file
Toolbar

Advanced Simulation®2D Mesh
Menu Insert®Mesh®2D Mesh

More comprehensive information for meshes

What is it?

When you use the Information command to list information about a selected
mesh, the software generates a more comprehensive listing of information for
geometry-based meshes. The information report now includes a new Mesh
Recipe section, which lists all the options you selected or defined when you
created the mesh. For example, for a mesh you created with the 2D Mesh
command, the software lists the element type and specified size as well as the
settings for options including Match Edges and Export Mesh to Solver.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file
Simulation
Navigator

Right-click an existing mesh and select Information

Menu Information®Advanced Simulation®Mesh

Boundary conditions

Pressure and temperature contour displays

What is it?

Use the Plot Contour command to generate a contour plot of pressure, nodal
pressure, or temperature loading as a standard post view.
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When you generate a contour plot of pressure or temperature, the
Post-Processing toolbar is enabled, and you can use these the commands on
this toolbar to view and interrogate your loading conditions.

Top: A parametric spatially varying pressure load. Bottom: The same
load as a spherical marker plot.

Pressure values on an edge extracted using the Identify Results
command.
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Why should I use it?

You can use the Plot Contour command to verify your loading conditions,
to generate high-quality visualizations for reports or presentations, and to
interrogate and extract loading data.

You can use the Edit Post View command to modify the loading display,

or you can use the Identify Results to probe loading values at nodes and
write them to a spreadsheet or comma-separated-value (CSV) file.

For time-varying pressure or temperature, you can plot the loading conditions
at any arbitrary point in time.

Where do I find it?

Application Advanced Simulation

Prerequisite
A Simulation file containing one or more temperature
or pressure loads.

Simulation
Navigator

Right-click a pressure, nodal pressure, or temperature
load node ® Plot Contour

Axial deformation loads for 1D elements

What is it?

In the Nastran environment, you can now use the new 1D Axial Deformation
command to apply an enforced axial deformation (deflection) to CBAR,
CBEAM, CONROD, CROD, and CTUBE type elements.

In NX, you can use the 1D Axial Deformation command to apply axial
deflections in Solution 101, 105, and 200 type analyses. Enforced deflections
are useful, for example, when you analyze misfit or misalignment conditions
in structures.

The 1D Axial Deformation command does not enforce a strain or apply an
extensional length to the 1D element. Rather, it applies a force to the element
that produces the specified extension if that element is free to expand without
generating internal forces. The software adds the computed force to the
other forces in your model. Because most elements in a model are not free
to expand, the extension value that you specify in the 1D Axial Deformation
dialog box may not be achieved during the analysis.

The 1D Axial Deformation command corresponds to the Nastran DEFORM
bulk data entry.

This graphic shows an example of an axial deformation load. (A) shows the
1D Axial Deformation load that was defined on each of the 1D bar elements.
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(B) shows the nodal displacement results. Notice the deformation that occurs
at the bar element locations.

For more information, see Enforced axial deformations for 1D elements
(Nastran).
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Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran or MSC

Nastran as the specified solver
Toolbar

Advanced Simulation®1D Axial Deformation
Simulation
Navigator

Under the active solution, right-click Loads®New
Load®1D Axial Deformation

Nodal pressure loads

What is it?

In the Nastran and ANSYS environments, you can use the new Nodal
Pressure command to create pressure loads where the magnitude of the
pressure varies at each node. This new command complements the existing
Pressure command which you can use to define a single pressure value for
each element face.

You can use the options in the Nodal Pressure dialog box to:

• Create a pressure load that is either normal to the surface of the element
or a load that contains a traction component and is not normal to the
surface

• apply a nonuniform pressure. You can define a different pressure value at
each of the corner nodes to create a spatially varying pressure load.

The Nodal Pressure command corresponds to the Nastran PLOAD4 bulk
data entry and to the ANSYS SFE,,,PRES command.

This graphic shows an example of a spatially varying nodal pressure load in
the Nastran environment. Here, the pressure load varies linearly according
to the X coordinate of each corner node.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran, MSC

Nastran, or ANSYS as the specified solver
Toolbar

Advanced Simulation®Nodal Pressure
Simulation
Navigator

Under the active solution, right-click Simulation
Objects®New Load®Nodal Pressure

Improved support for temperature definition in Nastran analyses

What is it?

This release includes several enhancements that improve the support for
temperature definition in Nastran analyses.

New Material Temperatures command

You can use the new Material Temperatures command to specify
the temperature or temperatures at which the software evaluates
temperature-dependent material properties (MATTi bulk data entries).

When you include a Material Temperatures simulation object in a solution,
Nastran evaluates any material properties for the selected nodes at the
temperature you specify in the Material Temperatures dialog box rather than
at the material’s specified reference temperature.

• You can include only one Material Temperatures simulation object in a
solution.
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• You cannot include a Material Temperatures and an Initial Temperatures
simulation object in the same solution.

The Material Temperatures command corresponds to the Nastran
TEMPERATURE(MATERIAL) case control command.

In previous releases, there was no direct way to define a material temperature
in NX.

New options for setting default temperatures in a solution

This release includes new options in the Solution and Solution Step dialog
boxes that let you specify default initial, material, and load temperatures for
all other nodes in your model for which you have not defined a temperature
load. These options correspond to the TEMPD bulk data entry. You can use
these new options to apply different temperature loads in each subcase.

Support for time-dependent default temperature loads in advanced
nonlinear analyses

In NX Nastran advanced nonlinear solution steps, you can now define default
temperature loads as being time-dependent. In the Solution Step dialog box,
when you define the Temperature Load Default (TEMPD), you can select the
new Field option to use field to specify how the default temperature varies
with time.

Where do I find it?

Material Temperature command

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran or MSC

Nastran as the specified solver
Toolbar

Advanced Simulation®Material Temperatures
Simulation
Navigator

Under the active solution, right-click Simulation
Objects®New Simulation Object®Material
Temperatures

Temperature Load Default solution option

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran or MSC

Nastran as the specified solver
Location in dialog
box

In the Solution dialog box, click the General tab and
enter a value in the Initial Temperatures Default or
Material Temperatures Default boxes.
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Temperature Load Default solution step option

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran or MSC

Nastran as the specified solver
Location in dialog
box

In the Solution Step dialog box, click the General tab
and enter a value in the Temperature Load Default box.

New process and interface for resolving constraint conflicts

What is it?

Conflicting constraints occur when redundant constraints are defined for a
given DOF. The process and user interface for resolving conflicting constraints
has been simplified in NX 8 and the user interface has been redesigned.

Beginning in this release, the software only checks for constraint conflicts at
the DOF level rather than at the nodal level. This ensures that only actual
conflicts are reported. When a constraint conflict occurs, an icon now appears
at the solution level in the Simulation Navigator:

Solution 1

Simulation Objects
Constraints
User Defined (1)
Enforced (1)

To resolve the conflict, you can right-click the solution and choose the
new Resolve Constraints command. You can then use the options in the
Constraint Resolution Manager dialog box to resolve the conflict. The
available options depend on the nature of the conflict. For example, you can:

• Specify which of the conflicting constraints you want to use.

• Create a constraint with new values at the point of conflict.

• Average or add the values between the conflicting constraints.

• Keep the overlapping constraints.

After you resolve a constraint, the software removes it from the Conflicting
Constraints list and updates the associated constraints.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file and existing constraints
Simulation
Navigator

Right-click the active solution and select Resolve
Constraints

Adding boundary conditions to the active solution

What is it?

In this release, you can use the new Add to active solution or step command
to quickly add loads, constraints, or simulation objects to the active solution
or solution step. In previous releases, you had to drag individual loads and
constraints into the appropriate solution or step Simulation Navigator, which
could be cumbersome in larger models.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file, an existing solution, and

multiple existing constraints, loads, or simulation objects
Simulation
Navigator

Right-click one or more constraints and select Add to
active solution or step

ANSYS thermal boundary condition enhancements

What is it?

This release includes several enhancements to the boundary conditions in the
ANSYS thermal solver environment.

Heat Flux enhancements

The Type list in the Heat Flux dialog box has the following changes:

• The Elemental option now allows you to apply a heat flux to selected
elements.

• The new Element Face option, which was erroneously labeled as
Elemental in previous releases, allows you to apply a heat flux directly
to the faces of selected elements.
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Applying certain thermal boundary conditions to ANSYS surface effect
elements

Beginning in this release, you can now have the software apply certain
thermal boundary conditions to ANSYS surface effect elements (SURF151
and SURF 152) rather than to the regular thermal elements in your mesh. For
example, you can use surface effect elements to model radiation between the
surface and a point (an optional node for the SURF151 or SURF152 element).

Now, when you define a Heat Flux, Heat Generation, or Convection boundary
condition, you can use the new Add Surface Effect Elements option to apply
the loads to SURF151 or SURF152 elements instead of the existing thermal
elements. When you export or solve your model, the software automatically
creates the SURF151 and SURF152 elements.

See **Unsatisfied xref title** for more details on SURF151 and SURF152
element support.

Connecing certain thermal boundary conditions to a coupled thermal-fluid
pipe element

If you select the new Add Surface Effect Elements option in the Heat Flux,
Heat Generation, or Convection dialog box, you can also select the new
Connect to FLUID116 elements option to attach the SURF151 or SURF152
elements to FLUID116 elements.

A FLUID116 element is an ANSYS 3D element with the ability to conduct
heat and transmit fluid between its two primary nodes. You can use
FLUID116 elements in steady-state or transient thermal analyses. For
example, you can use surface effect elements to generate film coefficients and
bulk temperatures from FLUID116 elements.

See **Unsatisfied xref title** for more details on FLUID116 element support.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with ANSYS as the specified

solver and Thermal as the specified analysis type
Toolbar

Advanced Simulation®Heat Flux or Heat

Generation or Convection
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External superelement system modeling

What is it?

Beginning with this release, you can replace individual components in your
assembly FEM with external superelements to define a system model.To do
this, you modify the component attributes to reference the binary results
file (*_0.op2) from an NX Nastran SOL101 – Superelement or SOL103 –
Superelement analysis.

NX visually represents a superelement in your assembly FEM using either a
lightweight, transparent, non-selectable approximation of the base FEM, or a
generic superelement symbol showing the attachments nodes and center of
mass. Any remaining components or connection elements in the assembly
FEM constitute the residual of the system model.

Solving a system model

When you solve a system model, NX automatically recognizes that it
references external superelements, and submits the Nastran input file with
the appropriate statements to perform a system run.

Post-processing a system model

When you solve the system model, results for the residual are listed for
the solution in the Post-Processing Navigator. Additional results for
each superelement are shown as children of the residual results. When
plotting residual results, choose the Plot and Overlay Loaded SE command
to automatically overlay loaded superelement results, with consistent
deformation and color bar scaling, in the same viewport.
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Clockwise from top: An assembly FEM; a solar panel component
replaced by a superelement; the completed system model – all solar
panels and payload modules are represented by superelements;

results from the solved system model.
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Why should I use it?

Using external superelements, you can reduce the number of DOFs, and
consequently the number of equations, to a more manageable number in
an arbitrarily large model.

Where do I find it?

Representing a component FEM with a superelement:

Application Advanced Simulation

Prerequisite

NX Nastran 8.

An assembly FEM of the system being modeled.

Static or modal reductions (*_0.op2 files) of components
to be modeled as superelements.

Simulation
Navigator

Component FEM or subassembly FEM node ®
right-click ® Edit Attributes.

Location in dialog
box

FE Model Occurrence Attributes dialog box ®
Representation ® Super Element

Import, export, and solve enhancements

New customer default to control units for import and export

What is it?

This release includes new Exporter and Importer customer defaults. Use
these new customer defaults se to control the default unit system the
software uses to import and export solver input files for all supported solvers.
Additionally, in the NX Nastran and MSC Nastran environments, the
Exporter customer default controls the default unit system in the Advanced
Solver Options dialog box.

Where do I find it?

Application Advanced Simulation
Menu File®Utilities®Customer Defaults

Location in dialog
box

Simulation®General®Environment tab
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Controlling whether a solve aborts when the Model Setup Check detects errors

What is it?

You can now control whether a solve continues or aborts when the Model
Setup Check command detects errors. In some cases, models can contain
errors, such as incompletely defined data, and still be valid to solve. Now, you
can use the new Abort Solve on Model Setup Check Errors customer default
to control how the software handles detected errors.

• If you select this customer default, the software does not proceed with a
solve when errors are present in the input file.

• If you clear the check box, the software tries to proceed with the solve
even when errors are present in the input file.

This customer default applies to the Nastran, Abaqus, ANSYS, and LS-DYNA
solver environments.

Where do I find it?

Application Advanced Simulation
Menu File®Utilities®Customer Defaults

Location in dialog
box

Simulation®General®Environment tab

Nastran support enhancements

Additional solve options available

What is it?

You can use the new Edit Advanced Solver Options button in the Solve
dialog box to access a number of options that let you control how the software
writes out the Nastran input file. For example, you can:

• Specify the unit system in which to solve the model.

• Control the specific data that NX includes in the Nastran input file. You
can, for example, choose to exclude entire sections, such as the entire file
management section, from the input file. Within the bulk data section,
you can use the By card name option in the Filter Method list to exclude
selected bulk data entries from the solver input file.

• Specify offset values for the different IDs in the input file, such a grids or
physical properties.
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• Use the Model Orientation option to export the model in a different
coordinate system than the one used in the Simulation file. This allows
you to re-orient the model when you solve to a specified coordinate system.

Note If you modify any of the settings in the Output Options or Bulk Data
Section group, the software does not perform a Model Setup Check before
the solve.

In previous releases, these options were only available from the Export
Simulation dialog box.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran or MSC

Nastran as the specified solver
Menu Analysis®Solve
Simulation
Navigator

Right-click a solution and choose Solve

Support for Nastran transient heat transfer analyses

You can now perform Nastran transient heat transfer analysis in Advanced
Simulation. When you create a thermal solution, you can use the new
NLTCSH 159 option in the Solution dialog box to create a SOL 159 solution. A
SOL 159 analysis is similar to a SOL 153 analysis but allows you to analyze
the temperatures and heat transfer as a function of time.

For more information, see the NX Nastran Thermal Analysis User’s Guide.

New output requests

This release also includes new output options in the Thermal Output
Requests dialog box to support SOL 159 analyses.

• You can use the options on the new Enthalpy tab to request enthalpy
output. The options correspond to the describers for the ENTHALPY
case control command.

• You can use the options on the new Rate of Enthalpy Change tab to
request the rate of change of enthalpy output. The options correspond to
the describers for the HDOT case control command.
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Where do I find it?

Solution 159

Application Advanced Simulation

Prerequisite An active Simulation file with NX Nastran or MSC
Nastran as the specified solver

Simulation
Navigator

Right-click the Simulation®New Solution

Menu Insert®Solution

Additional thermal output requests

Application Advanced Simulation

Prerequisite An active Simulation file with NX Nastran or MSC
Nastran as the specified solver

Toolbar
Advanced Simulation®Modeling Objects ®Type
list®Thermal Output Requests

Menu Insert®Modeling Objects®Type list®Thermal Output
Requests

New checks for unintentional grounding and mass reduction

You can use the new Rigid Body Checks modeling object to check the motion
grounding and mass reduction of rigid bodies in your solution.

Note If you include a Rigid Body Checks modeling object in your solution,
you must use the Nastran sparse solver.

In the Rigid Body Checks dialog box, you can:

• Use the Grounding Check options to evaluate selected DOF sets and
identify unintentional constraints and ill-conditioning in the stiffness
matrix. The options on the Grounding Check tab correspond to the
describers for the Nastran GROUNDCHECK case control command.

• Use the Mass Reduction Check options to compute the rigid body mass
at each stage of the mass matrix reduction and compare it with the rigid
body mass of the g-set. The options on the Mass Reduction Check tab
correspond to the describers for the Nastran WEIGHTCHECK case
control command.
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Where do I find it?

Application Advanced Simulation

Prerequisite An active Simulation file with NX Nastran or MSC
Nastran as the specified solver

Toolbar
Advanced Simulation®Modeling Objects ®Type
list®Rigid Body Checks

Menu Insert®Modeling Objects®Type list®Rigid Body
Checks

Improved support for printing bulk data in output

Use the new Bulk Data Echo Request modeling object to control whether
Nastran prints the bulk data section of your input file in the results file.
For example, you can control:

• Whether the software prints the bulk data to the .f06 results file, to the
ASCII punch (.pch) file, or to both files.

• Whether the software prints updated bulk data from optimization (SOL
200) analyses.

For example, if you use a Bulk Data Echo Request to print out the updated
bulk data output from a SOL 200 analysis, you can then merge that bulk data
into the input file for a subsequent analysis.

The options in the Bulk Data Echo Request dialog box correspond to the
describers for the Nastran ECHO case control command.

Where do I find it?

Application Advanced Simulation

Prerequisite An active Nastran solution
Toolbar

Advanced Simulation®Modeling Objects ®Type
list®Bulk Data Echo Request

Menu Insert®Modeling Objects®Type list®Bulk Data Echo
Request
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Support for glue results

What is it?

This release includes improved support for results of analyses that include
glue boundary conditions. In this release, you can now:

• Request the output of NX Nastran glue results directly from NX.

• Post-process NX Nastran glue results.

Requesting glue results output

Use the options on the new Glue Result tab in the Structural Output
Requests dialog box to recover glue surface forces and tractions for solid and
shell elements. When you create a Glue Result output request, the software
creates a BGRESULTS case control command in your NX Nastran input file.

• For Surface-to-Surface Gluing conditions, you can recover forces or
tractions.

• For Edge-to-Surface Gluing conditions, you can only recover forces, not
tractions.

You can use a Glue Result output request to obtain glue results in SOL 101,
103, and 105 analyses.

The BGRESULTS command is available in the NX Nastran 8.0 release and
is similar to the BCRESULTS command for recovering contact forces. With
the BGRESULTS command, NX Nastran calculates and stores glue tractions
at the nodes that are located on the glued surfaces. The new glue tractions,
which are similar to the existing contact results, are calculated and stored
at the nodes that are located on the glue surfaces. The normal component of
the tractions is a scalar value while the in-plane (tangential) tractions are
output in the basic coordinate system.

Note For surfaces on which you have created an Edge-to-Surface Gluing
definition, NX Nastran recovers only point forces and not surface tractions.

You can use the new Glue Result customer default to control whether the
Enable BGRESULTS Request option on the Glue Result tab is selected by
default.

Post-processing support for glue results

This release also includes post-processing support for glue forces and surface
tractions. This graphic shows an example of a contour plot display of glue
traction results.
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Where do I find it?

Glue Result output request

Application Advanced Simulation
Prerequisite An active FEM or Simulation file with NX Nastran as

the specified solver
Toolbar

Advanced Simulation®Modeling Objects ®Type
list®Structural Output Requests

Menu Insert®Modeling Objects ®Type list®Structural
Output Requests

Glue Result customer default

Application Advanced Simulation
Prerequisite An active FEM or Simulation file with NX Nastran as

the specified solver
Menu File®Utilities®Customer Defaults
Location in dialog
box

Simulation®NASTRAN®Solution tab
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Enhancements for specifying units on import

What is it?

In the Nastran environment, the Import Solution dialog box contains
enhancements to how you specify the units used in the .dat or .op2 file you
are importing.

Improved presentation for the input file’s structural units

In the Import Simulation dialog box, use the Default Units list to specify the
unit system used in the input file that you are importing. When NX imports
the file, the software automatically converts these units to the appropriate
CAE base units.

In previous releases, the different Default Units options listed the force and
length units for the unit system. In this release, the options now also list the
mass units for the unit system. This makes it easier for you to differentiate
between the available choices.

Ability to import temperatures in a different unit system

This release also includes a new Specify Temperature Units check box.

• If you select the check box, you can then specify a different unit system
for the temperatures in your model. This option is useful when the
temperature values in your model are defined in a different unit system
than the structural unit system.

• If you do not select the check box, the software imports the temperature
values in the unit system you specified in the Default Units list.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM or Simulation file with NX Nastran or

MSC Nastran as the specified solver
Menu File®Import®Simulation

NX Nastran subcase manager

This release includes a new Subcase Association Manager for NX Nastran
solutions. You can use the Subcase Association Manager to view and
manage the loads used in each subcase. From the Subcase Association
Manager dialog box, you can activate and deactivate individual loads. As you
make changes to the loads, constraints, or simulation objects assigned to each
subcase, the Simulation Navigator updates to reflect the changes.
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Where do I find it?

Application Advanced Simulation

Prerequisite An active Simulation file with NX Nastran as the
specified solver

Simulation
Navigator

Right-click a selected solution®Subcase Manager

Improved round-trip capabilities for bulk data

The term round-trip refers to the process of data conversion that occurs when
you import a solver data file into NX, and then export the same file out of NX.
This release offers some initial improvements to how NX preserves the order
and format of Nastran data through the round-trip process.

For this release, the round-trip capabilities are limited to:

• ASCII format files, such as .dat files.

• Selected entries within the bulk data section of the Nastran input file.

Round-trip process

When you import an ASCII format Nastran file, you can use the new Create
Round Trip Parameters modeling object option in the Import Simulation
dialog box to indicate that you want to preserve the format of your data
for future export. If you select this option, the software then creates a
Round Trip Parameters modeling object which stores round trip data in the
associated FEM file.

The Round Trip Parameters modeling object is primarily used by NX to
store data about the input file. You cannot edit the content of a Round Trip
Parameters modeling object or create a new one. However, you can use the
Round Trip Parameters dialog box to specify a limited number of options that
control how the software uses the data. You can specify, for example:

• Whether you want to preserve the sequence of the bulk data entries.

• Whether you want to preserve the field format of the bulk data entries.

The software associates the Round Trip Parameters modeling object with the
related solution. On the general Tab of the Solution dialog box, the Round
Trip Parameters option lists the associated modeling object.

When you export the model, the Export Simulation dialog box lists the related
Round Trip Parameters modeling object in the Formatting Options section.
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Bulk data entries supported

Currently, not all bulk data entries can be preserved exactly through the data
round trip process. In general, this release supports the round trip of the
following types of bulk data entries:

• GRID entries

• Element entries

• Material entries

• Physical property entries

• BSURF, BSURFS, and BLSEG entries

For a complete list of bulk data entries that are supported for the round
trip process, see Preserving the order and format of bulk data through the
round-trip process.

Customer default

This release also includes a new customer default that you can use to set the
default state of the Create Round Trip Parameters modeling object option
in the Import Simulation dialog box.

Where do I find it?

Round Trip Parameters modeling object

Application Advanced Simulation

Prerequisite An active FEM or Simulation file with NX Nastran or
MSC Nastran as the specified solver

Toolbar
Advanced Simulation®Modeling Objects ®Type
list®Round Trip Parameters

Menu Insert®Modeling Objects®Type list®Round Trip
Parameters

Round Trip Parameters customer default

Application Advanced Simulation

Menu File®Utilities®Customer Defaults
Location in dialog
box

Simulation®General®Environment tab
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Descriptions now exported as comments

When you enter text in the Description box in the loads, constraints,
and simulation object dialog boxes, NX now exports those descriptions as
comments in your Nastran input file.

Where do I find it?

Application Advanced Simulation

Prerequisite An active Simulation file with Nastran as the specified
solver

Menu File®Export®Simulation or Analysis®Solve

Changes to SOL 103 and 106 solutions

This release includes changes to the SOL 103 and SOL 106 solutions within
NX.

SOL 103 changes

When you create an SEMODES 103 type solution, NX now automatically
creates a Subcase-Eigenvalue Method type of solution step. This
solution step is intended to contain the Real Eigenvalue-Lanczos or Real
Eigenvalue-Householder modeling object. You use those modeling objects
to specify the real eigenvalue extraction parameters for the METHOD case
control command.

By default, each Subcase-Eigenvalue Method has aReal Eigenvalue-Lanczos
modeling object automatically assigned to it. However, you can modify
the modeling object to specify different options or specify a Real
Eigenvalue-Householder modeling object instead. Additionally, you can still
specify an eigenvalue modeling object at the solution level if you want to
specify a global eigenvalue method for multiple dynamic subcases.

Note This enhancement was first introduced in NX 7.5.2 but was not
documented.

SOL 106 changes

In this release, the NLSTATIC 106 solution type has been divided into two
different solution types:

• NLSTATIC 106–Single Constraint, which lets you create subcases with
unique loads but with identical constraints for each subcase in the
solution.

• NLSTATIC 106–Multi Constraint, which lets you create subcases with
unique loads and unique constraints.
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Where do I find it?

Application Advanced Simulation

Prerequisite An active Simulation file with NX Nastran or MSC
Nastran as the specified solver

Simulation
Navigator

Right-click the Simulation®New Solution

Menu Insert®Solution

Axial deformation loads for 1D elements

What is it?

In the Nastran environment, you can now use the new 1D Axial Deformation
command to apply an enforced axial deformation (deflection) to CBAR,
CBEAM, CONROD, CROD, and CTUBE type elements.

In NX, you can use the 1D Axial Deformation command to apply axial
deflections in Solution 101, 105, and 200 type analyses. Enforced deflections
are useful, for example, when you analyze misfit or misalignment conditions
in structures.

The 1D Axial Deformation command does not enforce a strain or apply an
extensional length to the 1D element. Rather, it applies a force to the element
that produces the specified extension if that element is free to expand without
generating internal forces. The software adds the computed force to the
other forces in your model. Because most elements in a model are not free
to expand, the extension value that you specify in the 1D Axial Deformation
dialog box may not be achieved during the analysis.

The 1D Axial Deformation command corresponds to the Nastran DEFORM
bulk data entry.

This graphic shows an example of an axial deformation load. (A) shows the
1D Axial Deformation load that was defined on each of the 1D bar elements.
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(B) shows the nodal displacement results. Notice the deformation that occurs
at the bar element locations.

For more information, see Enforced axial deformations for 1D elements
(Nastran).
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Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran or MSC

Nastran as the specified solver
Toolbar

Advanced Simulation®1D Axial Deformation
Simulation
Navigator

Under the active solution, right-click Loads®New
Load®1D Axial Deformation

Nodal pressure loads

What is it?

In the Nastran and ANSYS environments, you can use the new Nodal
Pressure command to create pressure loads where the magnitude of the
pressure varies at each node. This new command complements the existing
Pressure command which you can use to define a single pressure value for
each element face.

You can use the options in the Nodal Pressure dialog box to:

• Create a pressure load that is either normal to the surface of the element
or a load that contains a traction component and is not normal to the
surface

• apply a nonuniform pressure. You can define a different pressure value at
each of the corner nodes to create a spatially varying pressure load.

The Nodal Pressure command corresponds to the Nastran PLOAD4 bulk
data entry and to the ANSYS SFE,,,PRES command.

This graphic shows an example of a spatially varying nodal pressure load in
the Nastran environment. Here, the pressure load varies linearly according
to the X coordinate of each corner node.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran, MSC

Nastran, or ANSYS as the specified solver
Toolbar

Advanced Simulation®Nodal Pressure
Simulation
Navigator

Under the active solution, right-click Simulation
Objects®New Load®Nodal Pressure

Improved support for temperature definition in Nastran analyses

What is it?

This release includes several enhancements that improve the support for
temperature definition in Nastran analyses.

New Material Temperatures command

You can use the new Material Temperatures command to specify
the temperature or temperatures at which the software evaluates
temperature-dependent material properties (MATTi bulk data entries).

When you include a Material Temperatures simulation object in a solution,
Nastran evaluates any material properties for the selected nodes at the
temperature you specify in the Material Temperatures dialog box rather than
at the material’s specified reference temperature.
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• You can include only one Material Temperatures simulation object in a
solution.

• You cannot include a Material Temperatures and an Initial Temperatures
simulation object in the same solution.

The Material Temperatures command corresponds to the Nastran
TEMPERATURE(MATERIAL) case control command.

In previous releases, there was no direct way to define a material temperature
in NX.

New options for setting default temperatures in a solution

This release includes new options in the Solution and Solution Step dialog
boxes that let you specify default initial, material, and load temperatures for
all other nodes in your model for which you have not defined a temperature
load. These options correspond to the TEMPD bulk data entry. You can use
these new options to apply different temperature loads in each subcase.

Support for time-dependent default temperature loads in advanced
nonlinear analyses

In NX Nastran advanced nonlinear solution steps, you can now define default
temperature loads as being time-dependent. In the Solution Step dialog box,
when you define the Temperature Load Default (TEMPD), you can select the
new Field option to use field to specify how the default temperature varies
with time.

Where do I find it?

Material Temperature command

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran or MSC

Nastran as the specified solver
Toolbar

Advanced Simulation®Material Temperatures
Simulation
Navigator

Under the active solution, right-click Simulation
Objects®New Simulation Object®Material
Temperatures
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Temperature Load Default solution option

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran or MSC

Nastran as the specified solver
Location in dialog
box

In the Solution dialog box, click the General tab and
enter a value in the Initial Temperatures Default or
Material Temperatures Default boxes.

Temperature Load Default solution step option

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran or MSC

Nastran as the specified solver
Location in dialog
box

In the Solution Step dialog box, click the General tab
and enter a value in the Temperature Load Default box.

Import and export support enhancements

What is it?

This release includes support enhancements for Nastran:

• Bulk data entries and case control commands

• Parameters

• System cells

Bulk data and case control command support updates

The following table details the changes in bulk data and case control
command support for this release.

Name NX Nastran

import/export

support

MSC Nastran

import/export

support

Notes

BGRESULTS case

control command

Yes No See **Unsatisfied xref title** for more

information.
DEFORM bulk data

entry

Yes Yes See **Unsatisfied xref title** for more

information.
ENTHALPY case

control command

Yes No See **Unsatisfied xref title** for more

information.
GROUNDCHECK case

control command

Yes No See **Unsatisfied xref title** for more

information.
HDOT case control

command

Yes No See **Unsatisfied xref title** for more

information.
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MATCID bulk data

entry

Yes No The BY field is not supported for

import or export.
MATFT Yes No When you import into NX, you can

have a single MATFT definition per

material. In Nastran, you can use

the MATFT entry to define different

allowable values for the various failure

theories. In NX, only the first one is

retained.

Additionally, for import, the F13 and

F23 fields are unsupported. If MATFT

corresponds to MAT9 then entries

F12, Xc, Yc, Zc, Xt, Yt, Zt, S12, S13

and S23 are also unsupported.
PCOMPS Yes No When you import into NX, if

SOUT=YES for any one ply, then

SOUT=YES for all plies. TFLAG REL

is not supported.
PLOAD4 Yes Yes See **Unsatisfied xref title** for more

information.
WEIGHTCHECK case

control command

Yes Yes See **Unsatisfied xref title** for more

information.

Parameters

The following table details the changes in parameter support for this release.

Parameter Description Notes

CNTASET When contact conditions
are defined in a SOL
101 analysis, CNTASET
determines whether a
static condensation
reduction (A-set)
occurs with the contact
degrees-of-freedom.

This parameter is now
supported for import and
export.

LMDYN, LMSTAT With Lagrange RBE3
elements, these parameters
scale the artificial stiffness
term ck.

This parameter is now
supported for import and
export.

OEPT Disables the output of the
EPT data block to the .op2
file.

This parameter is now
supported for import and
export.

OMPT Disables the output of the
MPT data block to the .op2
file.

This parameter is now
supported for import and
export.
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RMXPANEL When the RMAXMIN case
control command is defined
in a SOL 112 solution, this
parameter can be used to
process the data recovery
in a series of smaller
“panels” rather than the
entire output set at once.
This will reduce the overall
amount of scratch disk
space required for the run.

This parameter is now
supported for import and
export.

SDAMPUP In a modal frequency
response solution (SOL
111), this parameter
determines whether modal
damping is updated for
the response calculation at
each frequency.

This parameter is now
supported for import and
export.

XFLAG Controls the equation that
Nastran uses to calculate
the element strain energy
for linear elements.

The XFLAG parameter
now defaults to a value of
2.

System cell support updates

The following table details the changes in system cell support for this release.

System Cell
Name

Description Notes

422 ENFMOTN Controls which
formulation is used
for enforced motion
response analysis (and
mode acceleration, if
requested).

The default value for
this cell is now 0:
the constraint mode
method of enforced
motion formulation
(and new mode
acceleration method).

492 Determines whether
the factor caching
for the Lanczos real
eigensolver is used.

This system cell is now
supported for import
and export.
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503 On the ACSRCE bulk
entry, determines if
the scale factor A is
included inside or
outside of the radical.
See the ACSRCE bulk
entry for the source
strength equation.

This system cell is now
supported for import
into NX.

516 When gluing solid
element faces,
determines if the solid
element face normal
check occurs. See the
remarks for the BGSET
case control command
for more information.

This system cell is now
supported for import
into NX.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran or MSC

Nastran as the specified solver
Menu File®Import®Simulation

File®Export®Simulation

Abaqus support enhancements

Keyword support enhancements

What is it?

This release includes support for a number of new Abaqus keywords as well
as enhancements to previously supported keywords.

Keyword Supported parameters
Import

support

Export

support
Notes

*CHANGE FRICTION All parameters are supported for

import and export.

Yes Yes In the NX 7.5.2 release,

*CHANGE FRICTION was

only supported for

export.
*CREEP All parameters are supported for

import and export.

Yes Yes In previous releases,

*CREEP was only

supported for export.
*ELCOPY All parameters supported. Yes No
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Keyword Supported parameters
Import

support

Export

support
Notes

*FILM The FPOS and FNEG parameters are

now supported

Yes Yes For more information,

see **Unsatisfied xref

title**.
*FREQUENCY All parameters except AMS are

supported.

Yes Yes The NORMALIZATION

parameter is now

supported for import.
*SHEAR TEST DATA All parameters are supported for

import and export.

Yes No Support for *SHEAR

TEST DATA has been

added in conjunction

with support for

*VISCOELASTIC so that

you can use shear

test data to define

viscoelastic materials.
*SHELL SECTION The parameters POISSON, STACK

DIRECTION=ORIENTATION, and

THICKNESS MODULUS are now

supported for import and export.

Yes Yes For more information

on the STACK

DIRECTION=ORIENTATION

enhancement, see

**Unsatisfied xref

title**.
*SURFACE BEHAVIOR The PRESURE-OVERCLOSURE=LINEAR

parameter is now supported for

export.

Yes Yes

*VISCOELASTIC All parameters are supported for

import and export.

Yes Yes In previous releases,

*VISCOELASTIC was only

supported for export.

Where do I find it?

Application Advanced Simulation

Prerequisite
An active Simulation file with Abaqus as the specified
solver

Menu File→Import→Simulation

Enhancements for Abaqus element-based film conditions

What is it?

In the Abaqus environment, you can use the new Free Convection on
2D Element Faces option in the Convection dialog box to define sink
temperatures and film convection coefficients for a heat transfer analysis.
In Abaqus, film conditions define heating or cooling due to convection by
surrounding fluids.
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With the new Free Convection on 2D Element Faces option, you define a
sink temperature value, Θ0, and a film coefficient, h, on the faces of 2D
elements. You can also use the new Film Type option to control the direction
in which the software applies the film condition.

• The FPOS option applies the film condition to the top face of the element
in the positive normal direction.

• The FNEG option applies the film condition to the bottom face of the
element in the negative normal direction.

In previous releases, although you could use the Convection command to
apply a film condition to the faces of 2D elements, you could not control the
direction in which the condition was applied. Previously, the software always
applied the condition in the elements’ positive normal direction.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with Abaqus as the specified

solver and Thermal as the specified Analysis Type
Toolbar

Advanced Simulation®Convection
Simulation
Navigator

Right-click Constraints ® New Constraint ®
Convection

Laminates stacking direction now based on a local orientation

What is it?

Beginning in this release, NX now supports the STACK DIRECTION=ORIENTATION

parameter for the Abaqus *SHELL SECTION keyword. This means that in
a laminates model in the Abaqus environment, you can now specify a
user-defined orientation for a laminate stacking sequence. In previous
releases, NX only supported a stacking direction that was based on an
element’s isoparametric directions.

To specify a local orientation for a laminate from the Basic Laminate physical
property dialog box:

1. On the General tab, in the Continuum Shell list, select Yes.

2. In the Stack Direction Method list, select Local Orientation.

3. Select the Set Material Orientation option and specify the material
orientation.
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To specify a local orientation for a laminate from the Laminate Modeler
dialog box:

1. In the Properties group, in the Continuum Shell list, select Yes.

2. In the Stack Direction Method list, select Local Orientation.

3. Select the Set Material Orientation option and specify the material
orientation.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file with Abaqus as the specified solver
Toolbar

Laminates ® Laminate Physical Property
Menu Insert ® Laminate ® Physical Property

Improvements for isotropic plastic material support

What is it?

This release includes extended support of temperature-dependent
stress-strain data for isotropic plastic materials in the Abaqus environment.

In previous releases, NX correctly wrote out temperature-dependent plastic
materials with isotropic hardening to the Abaqus input file only when the
hardening curve was defined with stress vs. plastic strain data points.

In this release, if the material’s definition includes stress vs. strain data
at various temperatures and a yield strength vs. temperature curve, NX
processes both sets of data and writes out the temperature-dependent stress
vs. plastic strain data to the Abaqus input file.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file with Abaqus as the specified Solver

Environment
Toolbar

Advanced Simulation®Manage Materials

Import support improvements for output variables

What is it?

This release includes improved import support for the Abaqus output
variables that you can select from the Abaqus Structural Output Requests
and Abaqus Structural Output Requests dialog boxes. Now, when you import
an Abaqus input file, the software imports:

• All Abaqus output variables that are supported in NX. In previous
releases, all the output variables were supported for export, but only a
small subset were supported for import.

• Any group references (defined with the Abaqus *ELSET and *NSET keywords)
that are associated with those output variables.

Where do I find it?

Application Advanced Simulation

Prerequisite
An active Simulation file with Abaqus as the specified
solver

Menu File→Import→Simulation

ANSYS support enhancements

Support for additional thermal element types

What is it?

NX now supports additional types of ANSYS thermal elements.

Support for FLUID116 elements

In the ANSYS thermal environment, you can now create FLUID116
elements from the 1D Mesh dialog box. The FLUID116 element is a coupled
thermal-fluid pipe element. It can conduct heat and transmit fluid between
its primary (required) nodes.

The FLUID166 element has two required nodes and two additional optional
nodes that are necessary to define convection. In NX, when you create a
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mesh of FLUID116 elements from the 1D Mesh dialog box, the software
automatically creates the two required nodes for each element. You can then
define the optional nodes (K and L) in the Mesh Associated Data dialog box.

In ANSYS, you can define additional properties for FLUID116 elements with
real constants and KEYOPTS. In NX, you define these additional properties
with:

• The new FLUID116 ET type of modeling object, which lets you set the
KEYOPTS.

NX currently does not support specification of the following coefficients as
material properties.

o The film coefficient (MP, HF or TB, HFLM).

o The fluid conductance coefficient (TB, FCON)

o The coefficient of friction (MP, MU).

Therefore, in the FLUID116 ET dialog box, in the KEYOPT(4), KEYOPT(6),
and KEYOPT(7) lists, if you select an option that depends on those
material property values, you must manually add those properties to your
ANSYS input file with a User Defined Text modeling object.

• The new FLUID116 physical property table, which lets you set the real
constants for the element.

Support for SURF151 and SURF152 elements

NX now supports both SURF151 and SURF152 type elements. SURF151 and
SURF152 elements are thermal surface effect elements.

In ANSYS, surface effect elements are overlaid like a skin on top of the faces
of other 2D or 3D thermal elements. You can use surface effect elements, for
example, to generate film coefficients and bulk temperatures from FLUID116
elements and to model radiation to a point.

SURF151 and SURF152 elements also have an optional node that you can
use to connect those elements with a FLUID116 element. This allows you
to base the bulk temperature in convection calculations on a simplified
representation of the fluid flow.

You do not directly create SURF151 and SURF152 elements in NX. When you
define a Heat Flux, Heat Generation, or Convection boundary condition, you
can specify whether you want the software to apply the loads to SURF151
or SURF152 elements instead of the existing thermal elements. When you
export or solve your model, the software automatically creates the SURF151
and SURF152 elements.
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In ANSYS, you can define additional properties for SURF151 and SURF152
elements with real constants and KEYOPTS. In NX, you define these
additional properties with:

• The new SURF151 ET and SURF152 ET modeling objects, which let you
set the KEYOPTS for the elements.

• The new SURF151 Real Constants and SURF152 Real Constants types of
modeling object, which let you set the real constants.

Note If you import and ANSYS input file into NX that contains SURF151
or SURF152 elements, NX does not import them into the FEM file as
thermal element. Rather, NX imports them into the Simulation file and
associates the SURF151 or SURF152 elements with the appropriate Heat
Flux, Heat Generation, or Convection boundary condition.

Support for PLANE55 and PLANE77 elements in the thermal environment

PLANE55 and PLANE77 elements are now supported in the ANSYS thermal
environment. In previous releases, they were supported only in the ANSYS
axisymmetric thermal environment. You can use the Add Surface Effect
Elements option in the Heat Flux, Heat Generation, or Convection dialog
boxes to overlay PLANE55 and PLANE77 elements with SURF151 or
SURF152 elements.

Note When you create PLANE55 and PLANE77 elements in the thermal
environment rather than the axisymmetric thermal environment, you
must still create the elements on the XY plane. If you do not create the
PLANE55 and PLANE77 elements, you will not be able to solve the model
in ANSYS.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file with ANSYS as the specified solver

and Thermal as the specified analysis type

ANSYS thermal boundary condition enhancements

What is it?

This release includes several enhancements to the boundary conditions in the
ANSYS thermal solver environment.
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Heat Flux enhancements

The Type list in the Heat Flux dialog box has the following changes:

• The Elemental option now allows you to apply a heat flux to selected
elements.

• The new Element Face option, which was erroneously labeled as
Elemental in previous releases, allows you to apply a heat flux directly
to the faces of selected elements.

Applying certain thermal boundary conditions to ANSYS surface effect
elements

Beginning in this release, you can now have the software apply certain
thermal boundary conditions to ANSYS surface effect elements (SURF151
and SURF 152) rather than to the regular thermal elements in your mesh. For
example, you can use surface effect elements to model radiation between the
surface and a point (an optional node for the SURF151 or SURF152 element).

Now, when you define a Heat Flux, Heat Generation, or Convection boundary
condition, you can use the new Add Surface Effect Elements option to apply
the loads to SURF151 or SURF152 elements instead of the existing thermal
elements. When you export or solve your model, the software automatically
creates the SURF151 and SURF152 elements.

See **Unsatisfied xref title** for more details on SURF151 and SURF152
element support.

Connecing certain thermal boundary conditions to a coupled thermal-fluid
pipe element

If you select the new Add Surface Effect Elements option in the Heat Flux,
Heat Generation, or Convection dialog box, you can also select the new
Connect to FLUID116 elements option to attach the SURF151 or SURF152
elements to FLUID116 elements.

A FLUID116 element is an ANSYS 3D element with the ability to conduct
heat and transmit fluid between its two primary nodes. You can use
FLUID116 elements in steady-state or transient thermal analyses. For
example, you can use surface effect elements to generate film coefficients and
bulk temperatures from FLUID116 elements.

See **Unsatisfied xref title** for more details on FLUID116 element support.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with ANSYS as the specified

solver and Thermal as the specified analysis type
Toolbar

Advanced Simulation®Heat Flux or Heat

Generation or Convection

Nodal pressure loads

What is it?

In the Nastran and ANSYS environments, you can use the new Nodal
Pressure command to create pressure loads where the magnitude of the
pressure varies at each node. This new command complements the existing
Pressure command which you can use to define a single pressure value for
each element face.

You can use the options in the Nodal Pressure dialog box to:

• Create a pressure load that is either normal to the surface of the element
or a load that contains a traction component and is not normal to the
surface

• apply a nonuniform pressure. You can define a different pressure value at
each of the corner nodes to create a spatially varying pressure load.

The Nodal Pressure command corresponds to the Nastran PLOAD4 bulk
data entry and to the ANSYS SFE,,,PRES command.

This graphic shows an example of a spatially varying nodal pressure load in
the Nastran environment. Here, the pressure load varies linearly according
to the X coordinate of each corner node.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with NX Nastran, MSC

Nastran, or ANSYS as the specified solver
Toolbar

Advanced Simulation®Nodal Pressure
Simulation
Navigator

Under the active solution, right-click Simulation
Objects®New Load®Nodal Pressure

LS-DYNA support enhancements

Including comments or files in an LS-DYNA input file

What is it?

When you export an LS-DYNA input file from NX, you can now insert specific
comments, commands, or include files. Use the new User Defined Text
modeling object to add either text or an entire file to a particular solution or
step. If you choose to include a file, the software uses the LS-DYNA *INCLUDE

keyword to insert the file:

• At the beginning of the input file, after the *KEYWORD keyword.

• At the end of the input file, before the *END keyword.

For example, you can use the User Defined Text modeling object to insert an
external file that contains a portion of your LS-DYNA input file. The file can
contain, for example, model definition data, comment lines, or other references
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to external files. You can also use a User Defined Text modeling object to add
LS-DYNA keywords to your input file that are not currently supported in NX.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM or Simulation file with LS-DYNA as the

specified solver
Toolbar

Advanced Simulation®Modeling Objects
Menu Insert®Modeling Objects

Support for solution options and output requests

What is it?

This release includes enhancements that allow you to define the first input
block of an LS-DYNA input file from NX. In an LS-DYNA input file, you use
the first input block to define solution control options and output parameters.
This complements the LS-DYNA enhancements that were included in the
NX 7.5.2 release, which allowed you to define the second input block of an
LS-DYNA input file (the model geometry, mesh, and material data).

Defining solution control options

NX now supports the following LS-DYNA keyword control cards:

• *CONTROL_TERMINATION, which you can use to specify options that control
the termination time of a time step.

• *CONTROL_ENERGY, which you can use to control the computation of energy
dissipation.

• *CONTROL_HOURGLASS, which you can use to specify an hourglass formulation
that is different from the defaults.

You can use the new Controls modeling object to specify parameters for the
keyword control cards. You can then use the new *CONTROL option in the
Solution dialog box to include that modeling object in a specific solution.

Specifying output parameters

This release also includes support for several *DATABASE keyword cards. You
use the *DATABASE keyword to create the output files that contain the LS-DYNA
results information. NX now supports the following *DATABASE keyword cards:

• *DATABASE_HISTORY, which controls the nodes and elements that the
software outputs to the D3THDT binary history file, as well as to the various
ASCII files, such as NODOUT, ELOUT, SPHOUT.
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• *DATABASE_BINARY, which controls the creation of binary output data. In
NX, you can currently create D3PLOT and D3THDT binary files.

• *DATABASE_GLSTAT, which contains global statistics.

• *DATABASE_NODOUT, which contains nodal point data.

• *DATABASE_RWFORC, which contains wall forces.

After you create a Database modeling object, you can then use the new
Output Requests (*DATABASE) option in the Solution dialog box to include
that modeling object in a specific solution.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM or Simulation file with LS-DYNA as the

specified solver
Toolbar

Advanced Simulation®Modeling Objects
Menu Insert®Modeling Objects

Post-processing

General post-processing enhancements

What is it?

This release includes several enhancements to post-processing to improve the
appearance of post views and to facilitate working with multiple post views.

Scalable fonts for headers, color bars, and markers

Post-processing displays now use standard NX scalable fonts for the post view
header and color bar, and for marker displays. These fonts scale for optimal
readability when you resize the graphics window.

You can also apply a scale factor to the standard font size. In the Post View
dialog box, on the Annotation tab, specify a Scale Factor between 0.5 and 2.0.

Select and edit multiple post views

You can now apply post view settings to multiple post views simultaneously.
The post views may be overlaid in a single viewport, or in separate viewports.

In the Post-Processing Navigator, use Shift-click or Ctrl-click to select
multiple post views. You can then use the commands in the Post-Processing
toolbar to apply the same settings to all post views simultaneously. For
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example, you can quickly apply consistent deformation scaling to all selected
post views.

Use the new Get min/max for all selected postviews button on the
Legend tab of the Post View dialog box to scale to provide a consistent color
bar scale across all displayed post views.

A multiple viewport display showing displacements from three
different static load cases for the same model. The color bar and

deformation are scaled independently for each post view.
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Consistent color bar and deformation scaling applied to all three
load cases. The relative displacements for the three load cases are

more clearly displayed.

If you have multiple post views overlaid in the same viewport, you can
use Combined Viewport Result and Combined Viewport Displayed to
automatically scale the color bar across all post views overlaid in the current
viewport.

Why should I use it?

Consistent, scalable fonts in post-processing ensures the readability of post
view legends regardless of the size of the display. This is especially useful
when capturing images for reports or presentations.

The ability to select and edit multiple post views is useful whenever you
are overlaying or comparing results. It is especially convenient when
post-processing external superelement system models containing a large
number of superelement results sets. For more information, see **Unsatisfied
xref title**.

Where do I find it?

Changing the font scaling:

Application Advanced Simulation

Prerequisite
Analysis results loaded; one or more post views
displayed.

Toolbar Post-Processing ® Edit Post View
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Location in dialog
box

Annotation tab ® Automatic Font Scaling ® Scale
Factor

Applying a single color bar scale to multiple post views:

Application Advanced Simulation

Prerequisite

Analysis results loaded.

Multiple post views displayed in one or more viewports.

Multiple post views selected in the Simulation
Navigator.

Toolbar Post-Processing ® Edit Post View

Location in dialog
box

Legend tab ® Color and Value Control group ®
Specified ® Get min/max for all selected postviews

Legend tab ® Color and Value Control group ®
Combined Viewport Result

Legend tab ® Color and Value Control group ®
Combined Viewport Displayed

3D axisymmetric displays

What is it?

Use the 3D Axi-symmetric option on the Post View dialog box to render
axisymmetric results as a virtual solid model.

• You can set the angle of resolution. Set the Revolve Angle to 360 to
render the full 3D part. Specify a number smaller than 360 to render the
model as a cutaway, wedge, and so on.

• You can specify the number of sections to generate for the rendering.
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Axisymmetric results displayed on free element faces.

The same results as a 270-degree 3D axisymmetric cutaway display.
Edges are set to Feature.

Why should I use it?

You can generate high-quality, realistic 3D renderings of 2D axisymmetric
results. Such displays enhance reports and presentation, and can improve
communication with colleagues.
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Where do I find it?

Application Advanced Simulation
Prerequisite A solved model using axisymmetric elements.

Toolbar Post-Processing ® Edit Post View
Location in dialog
box Display tab® Display on ® 3D Axi-symmetric

Export a result quantity to an expression

What is it?

After solving your model, you can now identify specific result quantities
that are exported to named expressions. The maximum result value is
exported to the expression. You can then use the expression to validate
model requirements.

For example, you can create an elemental stress result measure for your
solution for the von Mises component from subcase 1. An expression is
created that contains the maximum value of von Mises stress from subcase 1.
In the Requirements Validation dialog box, you could then associate the new
expression with a stress requirement. For more information about associating
an expression with a requirement, see the Requirements Validation online
Help.

You can manage defined result measures in the Result Measure Manager
dialog box. If you change the model and re-solve it, you must update the
result measure in the Result Measure Manager dialog box.

Note If you solve the model with the Run Solve in Foreground option selected
in the solution attributes, the result measure updates automatically.

For steps, see Create a result measure.

Where do I find it?

Toolbar Advanced Simulation toolbar®Result Measures
Menu Insert®Result Measures
Simulation
Navigator Right-click the simulation file®Result Measures
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New options for results overflow/underflow

What is it?

In previous releases, you could specify a color to represent results that fall
outside a specified range. In addition to this shaded display, you can now
specify that overflow or underflow results values are shown as Translucent
or Clipped (hidden).

(1) Material density results from a topology optimization. (2)
Underflow results (below 0.05) set to Clipped. (3) Underflow set to

Translucent.

Why should I use it?

Use Clipped to hide parts of your model where the results fall outside a
specified range. Use Translucent to view only results within a specified range
in the context of the full model.
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These options are especially useful when viewing material density results
from a topology optimization, to help you visualize the smoothed model.

Where do I find it?

Application Advanced Simulation

Prerequisite
Analysis results loaded; one or more post views
displayed.

Toolbar Post-Processing ® Edit Post View

Location in dialog
box

Legend tab ® Color and Value Control group ®
Specified ® Overflow.

Legend tab ® Color and Value Control group ®
Specified ® Underflow.

Optimization

Geometry Optimization update

What is it?

The Optimization product has been rewritten in the latest NX architecture,
using a wizard-like user interface that guides you through the definition
of the optimization problem. The optimization algorithm has also been
improved to provide a greater degree of accuracy.
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Where do I find it?

Application Design Simulation, Advanced Simulation
Menu Insert®Geometry Optimization
Simulation
Navigator

Right-click the simulation®New Solution
Process®Geometry Optimization

NX Topology Optimization

What is it?

This release introduces the ability to define a topology optimization using the
Tosca Topology Optimization solver by FE Design.

NX Topology Optimization can help you to design a new component by
providing you with an optimal design suggestion. The software generates this
suggestion based on analysis results from your Advanced Simulation finite
element model and the solution load cases that are solved in NX Nastran.

To set up the topology optimization, you define the following:

• A design area, which specifies the elements in the model that the
optimization can modify.

• A design objective, such as maximizing stiffness.

You can define design constraints, such as volume, and also manufacturing
constraints to ensure that the component can be produced. Working within
these bounds, the optimization determines an optimal material distribution
by adjusting the material density of the elements in the design area.
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The optimization assigns to each element a relative density between 0 and
1. Elements with densities closer to 0 are soft elements, and elements with
densities closer to 1 are hard elements. The resulting model has a block-like
material distribution. The software then creates transitions to smooth the
model, which result in a more continuous distribution of material. You can
import this smoothed model into NX Modeling to use as a starting point for
creating your new component.

(1) Design area for optimization; (2) optimized model; (3) smoothed
model; (4) final CAD design

Supported solution types, design objectives, and constraints include:
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Nastran Solution Supported Design
Objective

Supported Design
Constraints

SESTATIC 101 – Single
Constraint

Volume

Stress/Strain (stiffness)

Displacement

Volume

Displacement

Reaction Force
SEMODES 103 Volume

Frequency

Volume

Frequency

The following NX Nastran element types are supported:

• CHEXA, CTETRA, CPENTA

• CQUAD, CQUAD4, CQUAD8, CQUADR, CSHEAR, CQUADX

• CTRIA3, CTRIA6, CTRIAR, CTRIAX, CTRAX6

• CBAR, CBEAM, CBEND, CBUSH, CGAP, CONM1, CMASS1

The following limitations apply:

• With SESTATIC 101 solutions, you can constrain a maximum of 5 nodes
with your optimization design constraints. For example, you can have
5 design constraints that each specify a single node, or you can have 1
design constraint that specifies 5 nodes, or any such combination.

• Only the standard SEMODES 103 solution is supported. Response
Simulation, Flexible Body Analysis, and Superelement solutions are
not supported.

• With SEMODES 103 solutions, you can include only one subcase in the
optimization.

• Enforced Displacement constraints and Temperature loads are not
supported.

• Displacement design constraints can only be defined at nodes to which
loads have been applied.

• Reaction Force design constraints can only be defined at nodes that are
constrained with an SPC constraint.

For steps, see NX Topology Optimization workflow.
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Where do I find it?

Application Advanced Simulation
Prerequisite NX Nastran SESTATIC 101 or SEMODES 103 solution
Menu Insert®Topology Optimization
Simulation
Navigator

Right-click the simulation®New Solution
Process®Topology Optimization

Durability

Laminate support for Durability

What is it?

Durability now supports stress and strain results from models with defined
laminate physical property tables. NX calculates durability results from the
top and bottom ply stress or strain results.

If your laminate has at least one non-isotropic material, you must override
the material by an isotropic material in the Static/Transient Durability Event
dialog box. In that case, all plies have the same isotropic material.

Durability does not support the following laminates:

• Laminates that have plies with material type set to Ply Materials.

• Laminates that are defined by using global layups.

• Laminates that are defined by using the solid laminate physical property
table.

For more information, see Supported solvers and solutions for durability
analysis.

Analyzing strain gage rosette data

What is it?

Use the new Analyze Strain Gage command to create durability functions
from strain gage rosette data. You can obtain the strain gage rosette data
from either of the following:

• A Response Simulation solution process. You can select the strain gage
data from a list or in the graphics window.

• An AFU file. You can obtain the strain gage data stored in the AFU file
from a test setup.

The durability functions are saved to a target AFU file. You can view the
durability functions by using the XY Function Navigator.
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The following durability functions can
be obtained:

• Biaxiality ratio history

• Effective stress and strain as
functions of time

• Maximum and absolute maximum
principal strain as functions of
time

• Maximum and absolute maximum
shear strain as functions of time

• Maximum and absolute maximum
principal stress as functions of
time

• Maximum and absolute maximum
shear stress as functions of time

• Von Mises and signed Von Mises
stress as functions of time

• Non-proportionality indicator
functions: maximum and absolute
maximum principal angle as
functions of time

For more information, see Analyzing strain gage rosette data.

Why should I use it?

The Analyze Strain Gage command calculates and stores stress and strain
functions for a specified strain gage. You can produce a spreadsheet that
contains damage information for the strain gage location, by using the
Evaluate Damage command.

The Analyze Strain Gage command also provides biaxiality ratio and
non-proportionality indicators that can help you decide which fatigue life
criteria to use for the damage evaluation.
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Where do I find it?

Application Advanced Simulation

Toolbar Durability ® Analyze Strain Gage
Menu Insert ® Durability ® Analyze Strain Gage

Durability damage evaluation

What is it?

Use the new Evaluate Damage command to perform cycle counting to identify
all stress or strain cycles in a duty cycle and to calculate the damage due to
identified cycles. This command uses stress or strain functions that are saved
in AFU files. The AFU files must be loaded in the XY Function Navigator.

The fatigue damage histogram results can be stored either in a spreadsheet
or a CSV file.

You must specify the following:

• One or more stress or strain functions. NX cumulates fatigue damage
results from all specified functions.

• Nominal range bin definition and mean bin definition. These definitions
are automatically calculated from the specified functions, but you can
modify their values.

• Fatigue life criterion. All fatigue life criterion available for the durability
events are available, including the new Title not found.

• The cyclic stress-strain model.

• The material to which the specified stress or strain functions are applied.

The stress and strain functions can be obtained from strain gage data using
the new Analyze Strain Gage command.

For more information, see Durability damage evaluation.

Why should I use it?

When you use the Evaluate Damage command, you can compute damage at
a location without having an FE model with stress or strain results. The
durability damage evaluation is an alternative to the event-based fatigue
damage evaluation.
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Where do I find it?

Application Advanced Simulation

Toolbar Durability ® Evaluate Damage
Menu Insert ® Durability ® Evaluate Damage

Durability damage report

What is it?

Use the new Report Durability Damage command to export fatigue damage
results from the durability solution process to the following output formats:

• An Excel spreadsheet using the Export to Spreadsheet option.

• A CSV file using the Export to CSV File option.

These options are available only if the durability results node exists in the
Simulation Navigator, and if you select the Event Damage check box for at
least one event. The Event Damage check box is located on the Fatigue tab of
the Static/Transient Durability Event dialog box.

For more information, see Durability results for the event-based analysis.

Why should I use it?

You can efficiently post process fatigue damage data that is computed by NX
Advanced Durability.

Where do I find it?

Application Advanced Simulation

Toolbar Durability ® Report Durability Damage
Menu Insert ® Durability ® Solution ® Report Damage
Simulation
Navigator

Right-click the Durability solution process node ®
Report Damage
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TWI fatigue life criterion

What is it?

The TWI fatigue life criterion extends the BWI fatigue life criterion into the
low cycle and high cycle fatigue regimes.

Schematic of TWI S-N curve: the blue curve is the BWI S-N curve,
the red curve is the TWI extension into the low cycle, and the green

curve is the TWI extension into the high cycle

For the TWI life criterion, you need to specify the same parameters that you
specified for the BWI life criterion:

• The weld class.

• The number of standard deviations below the mean value of the stress
range or the probability of failure.

In addition, you also need to specify the following unique TWI parameters:

• For the extension of the BWI criterion into the high cycle region, you must
specify the non-propagating stress range, NNP, and its slope change, d.

• For the extension of the BWI criterion into the low cycle region, you must
specify the low cycle stress range cutoff, ΔsI, and its extension, ΔsII, as a
proportion of the yield stress.

For more information, see TWI fatigue life criterion.
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Where do I find it?

Application Advanced Simulation

Toolbar

Durability ® Static Durability Event or Transient

Durability Event
Menu Insert ® Durability ® Event ® Static or Transient

Simulation
Navigator

Right-click the Durability solution process node® New
Event ® Static or Transient

Right-click the static event or transient event node®
Edit

Location in dialog
box

Fatigue tab ® Fatigue Life group ® Fatigue Life
Criterion list

BWI fatigue life criterion enhancement

What is it?

For the BWI fatigue life criterion, you can now set the probability of failure
value instead of the number of standard deviations. NX converts the
probability of failure value into the number of standard deviations below the
mean of the BWI S-N curve.

The probability of failure, Pf, and the number of standard deviations, d, are
related by the following equation:

The erf function is the Gauss error function that is defined as:

For more information, see BWI fatigue life criterion.
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Where do I find it?

Application Advanced Simulation

Toolbar

Durability ® Static Durability Event or Transient

Durability Event
Menu Insert ® Durability ® Event ® Static or Transient

Simulation
Navigator

Right-click the Durability solution process node® New
Event ® Static or Transient

Right-click the static event or transient event node®
Edit

Location in dialog
box

Fatigue tab ® Fatigue Life group ® Fatigue Life
Criterion list® BWI ® Weld Data subgroup® Option
list

I-deas durability material library

What is it?

You can now use materials for which durability properties are predefined.
These materials come from the I-deas durability material library.

For more information, see Material properties for durability analysis.

Where do I find it?

Application All
Menu Tools ® Material Library Manager

Toolbar Advanced Simulation toolbar® Manage Materials

Location in dialog
box

Select the Site MatML Library or User

MatML Library checkbox ® Browse ®
[NX_installation]/NXCAE_EXTRAS/advancedduarbility/AdvancedDurabilityMaterialsLibraryMetric.xml

Performance enhancement when solving transient events

What is it?

NX Advanced Durability can now calculate the durability results from the
stress or strain results that are saved in the SORT2 format in the OP2 file.

The access to SORT2 stress and strain data is available only for NX Nastran
SOL 109 and SOL 112 solutions.

Note The OP2 file size must be less than 1 GB.
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Why should I use it?

When you solve transient events for durability results, accessing SORT2
stress and strain data could improve performance for solutions with a large
number of iterations.

Where do I find it?

Application Advanced Simulation
Prerequisite A transient structural solution

Toolbar Durability ® Transient Durability Event
Menu Insert ® Durability ® Event ® Transient
Simulation
Navigator

Right-click the Durability solution process node® New
Event ® Transient

Location in dialog
box Use SORT2 Stress/Strain Data

Obsolete status for the event result node

What is it?

When a durability event is modified, its node is now flagged as obsolete in
the Simulation Navigator. The obsolete results icon appears in front of
the event result node.

In previous releases, the cumulated durability result node was flagged as
obsolete only if you added an event or deactivated an event whose results
are cumulated. Now, it is also flagged when an event whose results are
cumulated is modified.

Durability 1
Static Event 1 Active
Load Pattern 1
Static Event 1 Obsolete
Transient Event 1 Active
Transient Event 1

Durability 1 Obsolete

For more information, see Simulation Navigator for Durability.

Why should I use it?

You can quickly detect durability events with outdated settings.
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Where do I find it?

Application Advanced Simulation
Prerequisite A durability solution process with a solved event

Durability analysis in the Modeling application

What is it?

The Durability Wizard is now available from the Modeling application. To
run the Durability Wizard, you need to have a Simulation file that contains
stress or strain results from a static stress analysis solution. To obtain this
Simulation file, use the Stress Wizard.

Why should I use it?

You can test your parts for fatigue damage directly in the Modeling
application by doing a durability analysis.

Where do I find it?

Durability Wizard

Application Modeling, Design Simulation, Advanced Simulation
Prerequisite Results from a static stress analysis solution
Menu Tools ® Durability Wizard

Stress Wizard

Application Modeling, Design Simulation, Advanced Simulation
Resource bar Process Studio ® NX CAE Stress Wizard

NX FE Model Correlation and NX FE Model Updating

Exciters in pre-test solution processes

What is it?

You can now select exciters when you create a pre-test solution process. You
must specify a sensor DOF set, a candidate DOF set, and the settings for the
exciter selection configuration. NX uses an exciter selection algorithm to find
the optimum number of exciters and the optimum location for these exciters.

• Use the new Edit Sensor DOF for Exciters command to define the sensor
DOF set that contains the sensor locations with appropriate sensor
translational DOFs. You can obtain the sensor DOF set from the sensor
selection configuration, or you can manually choose sensor DOFs.
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• Use the new Edit Candidate DOF for Exciters command to define the
candidate DOF set that contains the possible location for the exciters.

• Use the new New Exciter Configuration command to specify the settings
for the exciter selection algorithm.

When you create a pre-test solution process, the exciter selection nodes are
created automatically in the Simulation Navigator. The Configurations [#]
node can contain multiple exciter selection configurations that you can solve
either simultaneously or one by one. The new exciter selection nodes are
shown with a red arrow in the following graphic.

Pre-Test 1 Active
Solution 1 Results Active
Sensor Selection
Exciter Selection
Sensor DOF [29]
Candidate DOF [885]
Configurations [3]
Automatic 1
Automatic 2
Automatic 3 Active

In the graphics window, the exciter locations are shown in red and the sensor
DOFs in blue.

For more information, see Exciter selection configuration.

Why should I use it?

NX now allows you to obtain optimal number of exciters and exciter locations
before performing your modal testing in a testing facility. Previously, this
was not possible in NX.
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Where do I find it?

Application Advanced Simulation

Prerequisite
A pre-test solution process must
exist.

Toolbar

Pre-Test Planning ® Edit Sensor

DOF for Exciters or Edit

Candidate DOF for Exciters or

New Exciter Configuration

Menu

(Sensor DOF set) Tools ® Pre-Test
Planning ® Exciter ® Edit Sensor
DOF

(Candidate DOF set) Tools ®
Pre-Test Planning ® Exciter ® Edit
Candidate DOF

(Exciter Configuration) Tools
® Pre-Test Planning ® Exciter
Configurations ® New

Simulation Navigator

(Sensor DOF set) Exciter Selection
node ® right-click the Sensor DOF
[#] node ® Edit

(Candidate DOF set) Exciter
Selection node ® right-click the
Candidate DOF [#] node® Edit

(Exciter Configuration) Exciter
Selection node ® right-click the
Configurations [#] node® New

Exciter configuration commands

What is it?

Use the new exciter configuration commands to create, edit, or solve exciter
selection configurations.

• Use the New Exciter Configuration command to create a new exciter
selection configuration. The new configuration node is created in the
Simulation Navigator under the Configurations [#] node. The updated
icon appears in front of the configuration node to indicate that you
need to solve it.
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• Use the Edit Active Exciter Configuration command to edit the active
exciter selection configuration. You can modify the damping ratio, the
threshold for the normal mode indicator function (NMIF), the off-axis
angles for the exciter direction, and the name of the exciter selection
configuration.

• Use the Solve Active Exciter Configuration command to solve the active
exciter selection configuration for the optimal number of exciters and
exciter locations.

• Use the Solve All Exciter Configurations command to simultaneously
solve all exciter selection configurations when you select or deselect the
solution’s normal modes, or when you edit either the sensor DOF set or
the candidate DOF set.

• Use the Information right-click command on an exciter selection
configuration to display the details for an exciter set. Details can include
the number of excited modes in the configuration, and the modes that
are excited by each exciter.

• Use the Information right-click command on the Configurations [#] node
to display the exciter selection settings for all the configurations.

For more information, see Exciter selection configuration.

Where do I find it?

Application Advanced Simulation
Prerequisite A pre-test solution process must exist.

Creating or editing a configuration

Toolbar

Pre-Test Planning ® New Exciter Configuration

or Edit Active Exciter Configuration

Menu
Tools ® Pre-Test Planning ® Exciter Configurations
® New or Edit Active

Simulation
Navigator

(Create configuration) Exciter Selection node ®
right-click the Configurations [#] node® New

(Edit configuration) Exciter Selection node ®
Configurations [#] node ® right-click an Automatic
node ® Edit

6-92 What’s New in NX 8



CAE (Digital Simulation)

Solving configurations

Toolbar

Pre-Test Planning ® Solve Active Exciter

Configuration or Solve All Exciter Configurations

Menu
Tools ® Pre-Test Planning ® Solve for Exciters ®
Active or All

Simulation
Navigator

Exciter Selection node ® Configurations [#] node ®
right-click an Automatic node ® Solve

Exciter Selection node® right-click the Configurations
[#] node ® Solve All

Getting exciter selection configuration information

Simulation
Navigator

Exciter Selection node ® Configurations [#] node ®
right-click an Automatic node® Information

Exciter Selection node® right-click the Configurations
[#] node ® Information

New supported design variables for NX FE Model Updating

What is it?

The DESOPT 200 — Model Update solution now supports the following new
design variable types:

• PCOMP

• Laminate

The following table shows which physical fields can be optimized for these
two design variables.

Physical Field (PNAME) Description

Z0 Distance from the reference plane to
the bottom surface

NSM Non-structural mass per unit area
SB Allowable interlaminar shear stress
TREF Reference temperature
GE Damping coefficient
Ti Thickness of ply i

THETAi
Orientation angle of the longitudinal
direction of ply i with the material
axis of the element.
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For each PCOMP or Laminate design variable, you can optimize the thickness
and the orientation angle for one or more plies.

For more information, see Supported design variables for Model Update
solution process.

Why should I use it?

NX FE Model Updating allows the definition of design variables for models
with composite materials.

Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation ® Modeling Objects ®
Design Variable — Composite Property ® Create

Menu
Insert ® Modeling Objects ® Design Variable —
Composite Property ® Create

NX Laminate Composites

Import layup using lamination shorthand format

What is it?

Use the new Import Layup Using Shorthand Format option to quickly
define a layup using the lamination shorthand format. You can specify a
thickness and a material for each ply.

You enter the shorthand notation in the Shorthand String box in the
Shorthand Format dialog box. The shorthand notation has the following
conventions:

• A ply layup is contained inside [] (square brackets).

• Ply angles are separated by / (forward slash).

• Ply groups are contained inside () (parentheses).

• Symmetry is indicated by the suffix _s (underscore and s). For a symmetric
layup, the suffix is placed after the square brackets. For a symmetric
group, the suffix is placed after the parentheses.

• The core ply is indicated by ‘ (apostrophe).

• A repeated layup, group, or ply is indicated by _# (underscore and number
sign) where # indicates the number of repetitions.
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• + (plus) and – (minus) in front of a number indicate the positive and
negative angles.

Example When you enter [(+-45)_s(0/90)_3], your ply layup is composed of
10 plies and 5 groups as shown in the following graphic. Group 2 is a
symmetric repeat of group 1. Groups 4 and 5 are non-symmetric repeats
of group 3.

The following table shows you additional examples of the shorthand format.

Shorthand format [-45/0/45/90]_2 [0/+-45/90’]_s

Ply layup with angles
and ply numbers

Shorthand format [45_3/+-30_2] [+-60/- -45/+-++- -5]
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Ply layup with angles
and ply numbers

For more information, see Defining a layup using the lamination shorthand
format.

Why should I use it?

This command lets you create complicated ply layups quickly and efficiently.

Where do I find it?

Application Advanced Simulation
Prerequisite You must work in the FEM.

Toolbar

Laminates ® Laminate Physical Property or

Global Layup

Menu
Insert ® Laminate ® Physical Property or Global
Layup

Location in the
dialog box

Ply Layup group ® Import Layup Using Shorthand

Format

Solid Laminate physical property

What is it?

In the Nastran environment, you can now create a Solid Laminate physical
property that is attached to a 3D mesh collector. The Solid Laminate physical
property is the 3D equivalent of the Laminate physical property.

6-96 What’s New in NX 8



CAE (Digital Simulation)

You can use the Solid Laminate Modeler dialog box to:

• Create plies and ply groups. Use the new Import Layup Using Shorthand
Format option to quickly define a layup using the lamination shorthand
format.

• Define a ply stacking sequence and a stacking recipe.

• Define laminate-specific and solver-specific options.

For each ply, you must specify the following parameters:

• Material

• Thickness

• Angle

• Ply failure theory

You can also specify the inter-laminar failure theory separately between
consecutive plies.

The solid laminate is exported to the PCOMPS bulk data entry card.

The 3D mesh must consist of either CHEXA or CPENTA elements.

For more information, see Creating a laminate physical property.

Where do I find it?

Application Advanced Simulation

Prerequisite
You must work in the FEM within the Nastran solver
environment.

Toolbar Advanced Simulation ® Physical Properties
Menu Insert ® Physical Properties
Simulation
Navigator Right-click a 3D collector node ® Edit

Location in dialog
box

(Physical Properties command) Type list ® Solid
Laminate ® Create

(Right-click command) Type list ® Solid Laminate ®

Create Physical
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Nastran support for Extrude Laminate and Fill Laminate commands

What is it?

The Extrude Laminate and Fill Laminate commands are now supported in the
Nastran environment.

Only CQUAD8 and CTRIA6 2D Nastran elements are supported. The
extruded 3D mesh consists of either CHEXA or CPENTA elements, and the
ply drop-offs consist of CPENTA, CTETRA, or CPYRAM elements.

For both commands, NX creates a 3D mesh collector that has a Solid
Laminate physical property assigned to it. NX sets the Stacking Recipe in
the Solid Laminate Modeler dialog box to Extruded.

All the plies of the extruded solid laminate have the same ply failure theory
and inter-laminar failure theory that you selected in the Laminate Modeler
dialog box.

The 3D mesh collector contains one mesh per ply. At solve time, each mesh is
exported using a PCOMPS card that contains a single ply.

For more information, see Inflating laminates.

Where do I find it?

Application Advanced Simulation

Prerequisite
You must work in the FEM within the Nastran solver
environment.

Toolbar

Laminates ® Extrude Laminate or Fill Laminate

Menu Insert ® Laminate ® Extrude or Fill

Material orientation of extruded and filled 3D elements

What is it?

NX Laminate Composites now exposes material orientation vectors for
extruded elements in both Nastran and ANSYS environments.

For more information, see View material orientation graphically.
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Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation ® Finite Element Model Check

Simulation
Navigator

Right-click a 3D extruded mesh node ® Check ®
Material Orientation

Location in the
dialog box Element Material Orientation

Exporting laminate physical properties to FiberSIM

What is it?

Use the Export to FiberSim command to export laminate physical properties
to the FiberSIM PDI format in either of the following files:

• An Excel spreadsheet

• A tab separated text file

Note The layups are not exported when you use this command. To export
layups, you must use the Export Plies to FiberSim command.

For more information, see Creating a laminate physical property.

Why should I use it?

Because the Excel spreadsheet and the tab separated text file follow
the FiberSIM PDI format, you can import the laminate to the FiberSIM
application and apply the simulation laminate to CAD geometry.

Where do I find it?

Application Advanced Simulation
Prerequisite You must work in the FEM.
Menu Insert ® Laminate ® Export to FiberSim

Exporting global layup to FiberSIM

What is it?

Use the Export Plies to FiberSim command to export global plies in a
global layup to FiberSIM using the HDF5 format. HDF5 is a general use
hierarchical data format designed to store large amounts of numerical data.
The exported file has the .h5 extension.
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The exported FiberSIM HDF5 file contains the ply stacking sequence and the
following data for each ply:

• The ply number

• The material name

• The ply angle

• A coordinate system, which is located at the starting point of the draping
and whose X-axis is aligned with the 0° alignment of the fibers. For plies
that are created using the projection draping solver or that are imported
from a FiberSIM XML file, the starting point and the direction of the
draping are created at export. Each coordinate system becomes a separate
Rosette in FiberSIM.

• The mesh that contains node coordinates. All stored elements have either
three nodes or four nodes. FiberSIM computes a ply boundary from the
mesh.

The ply thickness is not exported. FiberSIM extracts the ply thickness from
the material definition.

Note Laminate physical properties are not exported when you use this
command. To export laminate physical properties, you must use the
Export to FiberSim command.

For more information, see Creating a global layup.

Why should I use it?

Because the global plies are stored in the FiberSIM HDF5 file, you can import
them to the FiberSIM application.

Where do I find it?

Application Advanced Simulation
Prerequisite You must work in the FEM.
Simulation
Navigator

Right-click a global layup node ® Export Plies to
FiberSim

Laminate post processing enhancements

What is it?

A new Advanced Post Report command is available on the Advanced
Simulation toolbar. This command unifies and replaces the following three
commands:
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• Spreadsheet Post Report

• Graphical Post Report

• Quick Post Report

Within the current Simulation file, the Advanced Post Report command
lets you select one or more results sets with a specific solution, loadcase,
and iteration. The result sets can include imported results. After you select
the result sets, a laminate post report node is created in the Simulation
Navigator. From the laminate post report node, you can create the
spreadsheet report, the graphical report, or the quick report.

Laminate Post Report 1
Spreadsheet Report 1
Graphical Report 1
Results

Quick Report 1

The following commands appear when you right-click the laminate post
report node in the Simulation Navigator.

Icon Command name Description
Edit Lets you modify the input selection for

the laminate post report metasolution.
Clone Clones the laminate post report

metasolution and all its reports.
Delete Deletes the laminate post report node

and the attached reports.
Create Spreadsheet
Report

Creates a spreadsheet report node from
which you can export the laminate
results to an Excel spreadsheet or to a
CSV file.

Create Graphical Report Creates a graphical report node from
which you can generate laminate
results that you can display in the Post
Processing Navigator.

Create Quick Report Creates a quick report node from which
you can export the laminate results to
an Excel spreadsheet or to a CSV file.

Information Opens the Informationwindow that lists
the selected result sets, spreadsheet
report settings, graphical report
settings, and quick report settings.
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Make Active Appears only if the laminate post report
metasolution is not active.

Activates the laminate post report
metasolution.

Make Inactive Appears only if the laminate post report
metasolution is active.

Deactivates the laminate post report
metasolution.

For more information, see Advanced post processing of laminate results.

Where do I find it?

Application Advanced Simulation
Prerequisite You must work in the Simulation file.

Toolbar Laminates ® Advanced Post Report
Menu Insert ® Laminate ® Advanced Post Report

Support for PSHELL in Advanced Post Report

What is it?

Laminate post processing now has the ability to compute ply stress for
laminates that were exported using the PSHELL output format. Previously,
you needed to change the output format from PSHELL to PCOMP in the
Laminate Modeler dialog box.

Selecting disconnected faces and elements with the projection draping solver

What is it?

When you drape global plies using the projection draping solver, you can now
select faces or 2D elements that are not contiguous.

In previous NX versions, the Projection option was called None.

For more information, see Draping solvers.
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Where do I find it?

Application Advanced Simulation
Prerequisite You must work in the FEM.
Simulation
Navigator Right-click one or more global ply nodes® Edit
Location in the
dialog box Solver ® Projection

NX Thermal and Flow, Electronic Systems Cooling, and Space Systems
Thermal

Surface Wrap Fluid Domain

What is it?

Use the Create Surface Wrap Fluid Domain command to generate polygon
fluid body geometry using a surface wrapping algorithm. The wrapping
algorithm is based on the selected bodies that define its surface boundaries
and embedded bodies. The created polygon fluid body geometry has the same
characteristics as a regular NX polygon body.

The wrapping algorithm overlays an octree Cartesian triangular mesh onto
the geometry and refines the octree mesh as it intersects the geometry until
an octree mesh with a target resolution is obtained. An airtight envelope,
called surface wrapping, is created by projecting nodes onto the geometry
surfaces, edges, and points. The polygon fluid body geometry is generated
using the surface wrapping.

Original geometry
comprised of multiple
polygon bodies

One fluid body wrapped
around all the bodies
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To create polygon fluid body geometry, you must:

1. Select polygon bodies that define the fluid domain boundaries.

2. Specify whether you want to create an interior fluid domain or a fluid
body that wraps around the exterior of all the selected bodies. You can
create an interior fluid domain by specifying either an interior point or a
face and the normal vector toward the interior region.

3. Specify a global surface wrapping resolution. The Auto Calculate
option calculates a global resolution for you.

Note When you create an interior fluid domain body, if your original geometry
has holes or cracks that are bigger than the global resolution, the
wrapping algorithm stops with an error message and displays the leaking
path. The leaking path is the path that links the internal point to the
outside region that goes through the hole. To create the fluid body, you
must close the holes or choose a bigger resolution.

In the Surface Wrap Fluid Domain dialog box, you can also select the
following advanced options:

Snap to Source
Edges

Makes the fluid body edges snap to the edges of the source
polygon bodies.

Facet Decimation Controls how planar surfaces are defined.

In the Simulation Navigator, NX creates the Fluid Domain Recipes container
node, a fluid body recipe node, and a fluid body node under the Polygon
Geometry container node.

Polygon Geometry
Polygon Body_1
Polygon Body_2
Polygon Body_3
Fluid Body_4

Fluid Domain Recipes
Fluid Body_4_recipe

The fluid body recipe node lets you access the Surface Wrap Fluid Domain
dialog box which contains options of the specified fluid body.

NX updates the fluid body automatically whenever you make changes to any
of the source polygon bodies or to the fluid body recipe.
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In the Customer Defaults dialog box, you can control:

• The colors of the hole faces, regular faces, and stitch faces.

• The translucency of the fluid body.

• The factor that is used to compute the suggested value of global resolution

when you click Auto Calculate in the Surface Wrap Fluid Domain
dialog box.

For more information, see Surface Wrap Fluid Domain.

Why should I use it?

The Create Surface Wrap Fluid Domain command helps you to easily create
polygon geometry for your fluid domain, such as the air volume of models that
comprise many solid parts and complicated geometry.

Supported solvers and analysis types

Solver Analysis Type
NX Electronic Systems Cooling Coupled Thermal-Flow

FlowNX Thermal and Flow
Coupled Thermal-Flow

Where do I find it?

Application Advanced Simulation
Prerequisite You must work in the FEM.

Toolbar

Fluid Domain ® Create Surface Wrap Fluid Domain

Menu
Insert ® Fluid Domain ® Create Surface Wrap Fluid
Domain

Simulation
Navigator

Right-click the fluid body recipe node under Fluid
Domain Recipes node ® Edit

Solving flow analysis in parallel

What is it?

You can now run flow analyses and coupled thermal and flow analyses in
parallel on a single workstation using up to 8 processes with Advanced Flow
and NX Electronic Systems Cooling products.
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Note With the new NX Thermal and Flow DMP product, you can extend
this parallel processing capability to multiple workstations and more
than 8 processes.

The following basic boundary conditions are available:

• Deactivation Set

• Flow Blockage

• Flow Boundary Condition

• Flow Surface

• Fluid Domain

• Report

• Screen

• Selective Results

• Symmetry Plane

• Thermal Loads

• Initial Conditions

• Mapping

• Temperature

Steady-state and transient analyses are supported for forced and natural
convection problems. Models with disjoint meshes are not supported.

For more information, see Parallel processing in thermal and flow analyses.

Why should I use it?

Use the parallel processing option of the flow solver to solve your flow
analysis more quickly.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

Flow Advanced FlowNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
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Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation ® Solve ® Edit Solution
Attributes

Menu Analysis ® Solve ® Edit Solution Attributes
Simulation
Navigator Right-click the solution node ® Edit
Location in dialog
box

Solution Details tab® Solver Selection list® Parallel
Solver

NX Thermal and Flow DMP

What is it?

NX Thermal and Flow DMP is a new add-on product to the NX Thermal
and Flow, NX Electronic Systems Cooling, and NX Space Systems Thermal
products.

NX Thermal and Flow DMP removes any software limitations on the number
of solver processes per run for parallel processing, and provides access to
more computing power for thermal and flow analyses. It also enables parallel
solutions over networks and clusters.

Without the new DMP license, access to up to 8 processes per run, on a single
workstation, is possible if you have advanced thermal or flow licenses.

The following modules can be run in parallel:

• Flow solver

• View factor calculations

Two-phase, immiscible fluid simulation

What is it?

You can now model two-phase, immiscible fluid simulation problems in NX,
such as water sloshing in a bottle or fuel levels in a gas tank.
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To model sloshing, you must do the following:

1. Create two separate bodies, one for the gas region and one for the liquid
region.

2. Mesh the two regions using either of the following:

• Two 3D meshes in a single 3D mesh collector. One mesh is for the gas
region and one mesh is for the liquid region. You use NX meshing
tools to create the meshes.

• A Fluid Domain simulation object.

3. Create a Heterogeneous Gas-Liquid Mixture modeling object in the 3D
mesh collector or in the Fluid Domain simulation object.

4. Create an Initial Gas-Liquid Mixture — 3D Flow type of Initial Conditions
constraint to define the liquid region.

5. Define a time-varying acceleration using a Translating Frame of
Reference simulation object for the heterogeneous gas-liquid mixture.

For more information, see Two-phase, immiscible fluid simulation.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

Flow Advanced FlowNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow
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Heterogeneous Gas-Liquid Mixture modeling object

What is it?

Use the Heterogeneous Gas-Liquid Mixture modeling object to model a
gas-liquid mixture with a clear interface between the gas and the liquid. You
need to specify one gas material and one liquid material.

Both gases and liquids are materials for which the Type option is set to Fluid.
The flow solver differentiates between a gas and a liquid as follows:

• When the gas constant, Rs, is defined in the Fluid Material dialog box,
the fluid material is a gas.

• When the gas constant, Rs, is not defined in the Fluid Material dialog
box, the fluid material is a liquid.

You can define a Heterogeneous Gas-Liquid Mixture modeling object in
either of the following places:

• The 3D mesh collector which contains meshes for both the gas and liquid
regions.

• The Fluid Domain simulation object.

For more information, see Heterogeneous Gas-Liquid Mixture.

Why should I use it?

You need to specify a Heterogeneous Gas-Liquid Mixture modeling object
when you want to model sloshing problems.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

Flow Advanced FlowNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation ® Modeling Objects ®
Heterogeneous Gas-Liquid Mixture ® Create

Menu
Insert ® Modeling Objects ® Heterogeneous
Gas-Liquid Mixture ® Create
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Initial Gas-Liquid Mixture — 3D Flow constraint

What is it?

Use the new Initial Gas-Liquid Mixture — 3D Flow type of Initial Conditions
constraint to define the liquid region in a gas-liquid mixture.

For more information, see Initial Conditions.

Why should I use it?

When you model sloshing, you must define an Initial Gas-Liquid Mixture —
3D Flow type of Initial Conditions constraint to differentiate the liquid region
from the gas region.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

Flow Advanced FlowNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar Advanced Simulation ® Initial Conditions
Simulation
Navigator

Right-click the Constraint Set container node ® New
Constraint ® Initial Conditions

Location in dialog
box Type ® Initial Gas-Liquid Mixture — 3D Flow

Acceleration boundary condition

What is it?

Use the new Translating Frame of Reference type of Moving Frame of
Reference simulation object to define an acceleration on the fluid domain.
The fluid must be a heterogeneous gas-liquid mixture. The acceleration that
you define is a function of time.

For more information, see Moving Frame of Reference.

Why should I use it?

Define the time-varying acceleration when you want to model sloshing
problems.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

Flow Advanced FlowNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation ® Moving Frame of Reference

Simulation
Navigator

Right-click the Simulation Objects node ® New
Simulation Object ® Moving Frame of Reference

Location in dialog
box Type ® Translating Frame of Reference

Defining printed circuit board and electronic components

What is it?

In an Electronic Systems Cooling solution, you can now more easily define the
conductive and convective properties of a printed circuit board (PCB), and
the thermal models of the electronic components.

• In the FEM, you model the PCB using a Shell type of 2D collector that
points to a PCB Stack physical property table. The PCB Stack physical
property table lets you define all board information, whether your PCB is
a simple one-layer model or a complex multi-layer model.

• In the Simulation file, you model the PCB conductive and convective
properties using the Printed Circuit Board simulation object and the
electronic components using the PCB Component simulation object. The
PCB Component simulation object lets you define thermal models and
heat loads on the components, generate reports, and retrieve component
thermal data from a component catalog.
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Why should I use it?

These new features let you prepare a printed circuit assembly model quickly,
easily, and directly inside the Advanced Simulation application. Through NX
PCB Exchange, you can easily import ECAD information or update existing
PCB and component data.

In addition, NX provides a sample electronic components catalog to which
you can add your custom components.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

PCB Stack physical property table

What is it?

Use the new PCB Stack physical property table to define physical
characteristics of 2D shell elements that represent a printed circuit board
(PCB). The PCB Stack physical property table lets you define all board
information, whether your PCB is a simple one-layer model or a complex
multi-layer model.

In the PCB Stack dialog box, you can specify:

• One or more layers using the PCB Layer modeling object. You must define
at least one layer to create the PCB Stack physical property table.

• One or more thermal connection between signal layers due to vias using
the PCB Via modeling object.

• The stacking order of all PCB layers.

For more information, see PCB Stack physical property table.
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Why should I use it?

You can model a printed circuit board’s complex in-plane conductivity in each
layer and across layers without using 3D solid elements.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation ® Physical Properties ®
PCB Stack ® Create

Menu Insert ® Physical Properties ® PCB Stack ® Create

Simulation
Navigator

Right-click the 2D mesh collector node® Edit ® Type
list ® PCB Stack ® PCB Stack Property row ® Edit
or Create Physical

PCB Layer modeling object

What is it?

Use the new PCB Layer modeling object to define the orthotropic thermal
conductivity of one layer of a printed circuit board (PCB). You can define a
PCB Layer modeling object only from a PCB Stack physical property table.

In the PCB Layer dialog box, you specify:

• The trace material for the PCB layer.

• The dielectric material for the PCB layer.

• The thickness of the PCB layer.

• The coverage of the trace material with respect to the PCB layer area.
The coverage can be a value between 0 and 1 or a spatial field.
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• The calculation method of the layer’s orthotropic thermal conductivity.
The thermal conductivity can be calculated either from the material and
trace coverage or as a thermal conductivity spatial field. When you define
the thermal conductivity as a spatial field, you also need to specify the
material orientation.

Note You can access the PCB Layer modeling object only through the PCB
Stack physical property table. You cannot access it through the Modeling
Object Manager.

For more information, see PCB Layer modeling object.

Why should I use it?

A PCB Layer modeling object lets you easily define the variability of the PCB
layer’s orthotropic thermal conductivity.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation ® Physical Properties ®
PCB Stack ® Create

Menu Insert ® Physical Properties ® PCB Stack ® Create

Simulation
Navigator

Right-click the 2D mesh collector node® Edit ® Type
list ® PCB Stack ® PCB Stack Property row ® Edit
or Create Physical

Location in dialog
box Stack Definition tab ® Create

PCB Via modeling object

What is it?

Use the new PCB Viamodeling object to define additional thermal connections
between layers of a printed circuit board (PCB). You can define a PCB Via
modeling object only from a PCB Stack physical property table.
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In the PCB Via dialog box, you specify:

• The PCB layer from which the PCB via starts.

• The PCB layer to which the PCB via extends.

• The PCB via material.

• The fraction of the board area that is occupied by the vias. The fraction
can be a value between 0 and 1 or a spatial field.

Note You can access the PCB Via modeling object only through the PCB
Stack physical property table. You cannot access it through the Modeling
Object Manager.

For more information, see PCB Via modeling object.

Why should I use it?

A PCB Via modeling object lets you model the thermal conductivity across
layers in a PCB.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation ® Physical Properties ®
PCB Stack ® Create

Menu Insert ® Physical Properties ® PCB Stack ® Create

Simulation
Navigator

Right-click the 2D mesh collector node® Edit ® Type
list ® PCB Stack ® PCB Stack Property row ® Edit
or Create Physical

Location in dialog
box Vias Definition tab ® Create
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Printed Circuit Board simulation object

What is it?

Use the new Printed Circuit Board simulation object to define how the heat
from a printed circuit board (PCB) is transferred to the environment.

You must define a Printed Circuit Board simulation object on a Surface
Region type of simulation region.

The Printed Circuit Board simulation object lets you define wall friction and
convection properties for top and bottom surfaces. In particular, when you
set Wall Friction to Rough – From Mounted Components, NX automatically
takes into account all the electronic components that are mounted on the PCB.

For more information, see Printed Circuit Board simulation object.

Why should I use it?

When you analyze thermal response for a printed circuit assembly, you can
easily define and modify convection properties for the PCB.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

Where do I find it?

Application Advanced Simulation

Toolbar Advanced Simulation ® Printed Circuit Board
Simulation
Navigator

Right-click the Simulation Objects node ® New
Simulation Object ® Printed Circuit Board

Electronic component boundary condition

What is it?

The PCB Component simulation object lets you define the thermal models
and dissipation of the electronic component, generate reports, and retrieve
thermal information from a component catalog. You can include the electronic
component in a Radiation simulation object or a Radiation to Environment
constraint when you define the emissivity of the electronic component.
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For each component, you must create a separate PCB Component simulation
object and specify the following:

• The Component Region that contains 2D elements that represent the top
surface of the electronic component.

• The Mounting Region that points to the two-dimensional simulation
region on which the component is mounted. The mounting region can be
the printed circuit board that is referenced by a Printed Circuit Board
simulation object.

• The thermal model of the electronic component that you can define
manually or get from your component catalog.

You can track the temperature during the solution and create a temperature
report.

The following thermal models of the electronic component are available:

• The Zero-Resistor model connects the electronic component with the
PCB using a merge thermal coupling, with the top face as the primary
region and the board as the secondary region. A dissipation is applied to
the top surface.

• The One-Resistor model connects the electronic component to the PCB
using the case board resistance value that you specify. A dissipation is
applied to the top surface.

• The Two-Resistor model connects the electronic component with the PCB
using the JEDEC two-resistor model. A dissipation is applied to a lumped
mass at the center of the electronic component. This lumped mass, which
represents the junction, is created internally by the solver.

In all three models, you can specify the coupling resolution between the PCB
and the electronic component.

For more information, see PCB Component simulation object.

Why should I use it?

The PCB Component simulation object lets you easily define all thermal
properties for each electronic component in your model.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

Where do I find it?

Application Advanced Simulation

Toolbar Advanced Simulation ® PCB Component
Simulation
Navigator

Right-click the Simulation Objects node ® New
Simulation Object ® PCB Component

PCB Component catalog

What is it?

You can now create your own component catalog for PCB components with
zero-resistor, one-resistor, and two-resistor thermal models. The sample
component catalog is stored in the component.xml file that is located
in the [NX_installation]\NXCAE_extras\tmg\if\catalogs folder. The
component.xml file that you create can be located in another folder. This
folder must be specified in the MAYA_TMG_CATALOG_DIR environment variable.

To add a new component to the catalog, you must define:

• The name of the component in the XML tag.

• All the required record XML tags with their corresponding XML tags.

Note All values must be entered in SI units and temperature values in
Celsius.

For more information, see PCB Component catalog.

Why should I use it?

You can customize your component catalog to include your company’s PCB
components, and you can access them in the PCB Component dialog box
when you model thermal analysis of printed circuit assemblies.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

Where do I find it?

Application Advanced Simulation

Toolbar Advanced Simulation ® PCB Component
Simulation
Navigator

Right-click the Simulation Objects node ® New
Simulation Object ® PCB Component

Location in dialog
box Component Catalog

Duct with mass flow network

What is it?

Use the new Duct with Mass Flow or Duct with Mass Flow Axisymmetric
type of 1D duct mesh collector to define fluid networks with fixed mass flows.
In such fluid networks, the pressure solution that is done for normal duct
elements is disabled.

As with normal duct elements, you can couple ducts with mass flow with a
thermal mesh and capture the advective and convective effects.

To model a duct with mass flow network, you do the following:

1. Mesh edges, curves, and lines that represent the duct network with 1D
elements.
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2. Create a Duct with Mass Flow or Duct with Mass Flow Axisymmetric
type of 1D duct mesh collector that contains the 1D element meshes. This
mesh collector lets you define the fluid material for your network.

3. Define boundary conditions:

• Use the Duct Fan/Pump type of the Duct Flow Boundary Conditions
simulation object to define mass flow on a duct network branch.

• Use the Temperature constraint or the Duct Opening type of the
Duct Flow Boundary Conditions simulation object to define the
temperature on desired elements or nodes in the duct network.

• Use the Convection Coupling type of the Thermal Coupling —
Convection simulation object to model the convective heat transfer
from the fluid ducts to the convective regions of the thermal model.

4. Solve and post-process results.

For more information, see 1D duct flow networks.

Why should I use it?

A network of ducts with mass flow simplifies the modeling of complicated
duct networks where the mass flow in branches is known and for which the
pressure computation is not needed. This modeling method is useful for a
number of industrial applications.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Advanced Thermal
Flow Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Advanced Thermal-Flow
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Where do I find it?

Application Advanced Simulation

Toolbar Advanced Simulation ® Mesh Collectors
Simulation
Navigator Right-click the 1D Collectors node® New Collector
Location in dialog
box

Collector Type ® Duct ®Type ® Duct with Mass Flow
or Duct with Mass Flow Axisymmetric

Convection Coupling type of Thermal Coupling — Convection

What is it?

Use the new Convection Coupling type of the Thermal Coupling —
Convection simulation object to model the convective heat transfer from the
fluid ducts to the convective regions of the thermal model.

You specify a constant, time-dependent, or temperature-dependent heat
transfer coefficient. The heat transfer coefficient can also have a spatial
distribution.

You can also correct the heat transfer coefficient using the new Duct
Convection Correction modeling object.

For more information, see Thermal Coupling — Convection simulation object.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Advanced Thermal
Flow Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Advanced Thermal-Flow
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Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation ® Thermal Coupling —

Convection
Simulation
Navigator

Right-click the Simulation Objects node ® New
Simulation Object ® Thermal Coupling — Convection

Location in dialog
box Type ® Convection Coupling

Duct Convection Correction modeling object

What is it?

Use the new Duct Convection Correction modeling object to correct the
convective heat transfer coefficient that you specify when creating the
new Convection Coupling type of the Thermal Coupling — Convection
simulation object.

You can store your duct convection corrections in a correction catalog. Use the

Correction Catalog option to add the parameters in the Duct Convection
Correction dialog box.

A template for the correction catalog is stored in the
[NX_installation]\NXCAE_extras\tmg\if\catalogs folder.

For more information, see Duct Convection Correction modeling object.

Why should I use it?

The Duct Convection Correction modeling object allows you to locally correct
the convective heat transfer coefficient in a duct with mass flow network.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Advanced Thermal
Flow Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Advanced Thermal-Flow
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Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation ® Modeling Objects ®
Duct Convection Correction ® Create

Menu
Insert ® Modeling Objects ® Duct Convection
Correction ® Create

Film Cooling

What is it?

Use the new Film Cooling constraint to implicitly model the cooling of a
surface by a fluid film. To create a Film Cooling constraint, you must specify
the following:

• A convection region that is the cooled surface.

• A film reference region that contains duct elements or model edges or
curves. The solver calculates the film temperature from this region.

• The convection coefficient that can vary with time and space.

• The film effectiveness coefficient that can vary with time and space.

• The free stream temperature that can vary with time.

Film cooling schematic

Free stream region with
temperature Tfs

Fluid film region with
temperature Tf

Convection region with
temperature Tw

The film cooling constraint is similar to the convection to environment
constraint, except that the adiabatic wall temperature is computed as a
mixture of the free stream temperature, Tfs, and the fluid film temperature,
Tf. The heat transfer for a convection region with a Film Cooling constraint is
calculated as follows:

Q = h A (hTf + (1–h)Tfs – Tw)
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where:

• h is the specified convection coefficient.

• A is the area of the specified convection region.

• h is the specified film effectiveness coefficient.

• Tw is the surface temperature.

For more information, see Film Cooling.

Why should I use it?

When you want to model surface temperature change due to film cooling
using the Film Cooling constraint, you need not model all the complex
interactions between the environment, the fluid film, and the geometry.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar Advanced Simulation ® Film Cooling
Simulation
Navigator

Right-click the Constraint Set container node ® New
Constraint ® Film Cooling
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Thermal cyclic symmetry using perfect contact thermal coupling

What is it?

You can now specify a rotational periodicity when you model conduction.
Instead of modeling the complete geometry, you simplify it to only a small
portion of the model on which you specify a Perfect Contact type of the
Thermal Coupling — Advanced simulation object. You must also specify:

• The primary region and the revolved secondary region.

• The axis of revolution that is defined by a vector and a point.

Rotationally periodic portion
indicating primary (1) and
secondary (2) regions

Meshed solid with the Thermal
Coupling — Advanced simulation
object defined and showing the

axis of revolution (3)

While calculating the conduction, the thermal solver revolves the secondary
region (2) around the axis of revolution (3) to be in contact with the primary
region (1).

For more information, see Thermal cyclic symmetry using perfect contact
thermal coupling.

Why should I use it?

When you have a model that is rotationally periodic, you can reduce the
number of elements by only modeling the conduction on a portion of the
model. This reduces the solve time.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation ® Thermal Coupling —

Advanced
Simulation
Navigator

Right-click the Simulation Objects node ® New
Simulation Object ® Thermal Coupling — Advanced

Location in dialog
box

Type ® Perfect Contact ® Connection Method list®
Primary – Revolved Secondary

Support of axisymmetric thermal elements in non-axisymmetric solutions

What is it?

You can now use axisymmetric elements in a thermal or coupled thermal-flow
solution that also contains regular element types.

Note Only thermal elements can be axisymmetric or non-axisymmetric
elements. Flow elements are always 3D elements.
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Temperature distribution on an axisymmetric light bulb and a
non-axisymmetric filament

Axisymmetric elements are differentiated from non-axisymmetric elements
by their parent mesh collector. In the axisymmetric mesh collectors, you
must specify:

• The axis of revolution

• The number of axisymmetric segments

Note Axisymmetric elements cannot be connected to non-axisymmetric
elements by node sharing. You must use thermal couplings to make the
connection.

For more information, see Axisymmetric modeling in non-axisymmetric
solution.

Why should I use it?

When you model thermal effects on complex geometry, you can save
computational time by using axisymmetric and non-axisymmetric elements
together.

Supported solvers and analysis types

Solver Analysis Type
NX Electronic Systems Cooling Coupled Thermal-Flow
NX Space Systems Thermal Thermal

ThermalNX Thermal and Flow
Coupled Thermal-Flow
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Where do I find it?

Application Advanced Simulation

Toolbar Advanced Simulation ® Mesh Collectors
Simulation
Navigator

Right-click the 0D Collectors, 1D Collectors, or 2D
Collectors node ® New Collector

Location in dialog
box

(0D collector) Type ® Lumped Mass Axisymmetric

(1D collector) Type ® Beam Axisymmetric, Duct
Axisymmetric, or Duct with Mass Flow Axisymmetric

(2D collector) Type ® Shell Axisymmetric

Variable thermal boundary conditions

What is it?

You can now use new independent variables when you define the magnitude
of select boundary conditions.

Independent variable

Boundary condition Types
Dependent

variable Time Temp

Heat

Flow

Rate

Temp

Diff

Thermal

Capacitance

Spatial

dist

Temp constraint N.A. Temp Exist N.A. New N.A. New Exist

Heat Load
Heat flow

rate
Exist New N.A. N.A. New Exist

Heat Flux Heat flux Exist New N.A. N.A. New ExistThermal Loads load

Heat Generation
Heat

generation
Exist New N.A. N.A. New Exist

Current
Electric

current
Exist Exist New N.A. New N.A.

Voltage Voltage Exist Exist New N.A. New N.A.

Electrical Coupling

® Total Resistance

Electrical

resistance
Exist Exist New N.A. New N.A.

Joule Heating

simulation object

Electrical Coupling

® Conductance

Gap

Electrical

resistivity
Exist Exist New N.A. New N.A.

Override Set —

Thermal Properties

simulation object

Electrical

Resistivity

Electrical

resistivity
Exist Exist New N.A. New Exist
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Independent variable

Boundary condition Types
Dependent

variable Time Temp

Heat

Flow

Rate

Temp

Diff

Thermal

Capacitance

Spatial

dist

Total Conductance
Thermal

conductance
New New New New New N.A.

Total Resistance
Thermal

resistance
New New New New New N.A.

Heat Transfer

Coefficient

Convection

coefficient
New New New New New N.A.

Surface-to-Surface

Contact simulation

object

Conductive Gap
Thermal

conductivity
New New New New New N.A.

Total Conductance
Thermal

conductance
Exist Exist New Exist New Exist

Total Resistance
Thermal

resistance
Exist Exist New Exist New Exist

Heat Transfer

Coefficient

Convection

coefficient
Exist Exist New Exist New Exist

Edge Contact

Conductance

per unit

length

Exist Exist New Exist New Exist

Thermal Coupling

simulation object

Conductive Gap
Thermal

conductivity
Exist Exist New Exist New Exist

1 Way®Total

Conductance

Thermal

conductance
Exist Exist New Exist New ExistThermal Coupling

— Advanced

simulation object
1 Way ® Heat

Transfer Coefficient

Convection

coefficient
Exist Exist New Exist New Exist

Why should I use it?

The new fields give you more flexibility in modeling thermal analyses.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal
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Solver Analysis Type Solution Type
Thermal Thermal

Advanced Thermal

Axisymmetric Thermal

Advanced Axisymmetric
Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation
Location in dialog
box Specify Field list

Calculating total conductance and total resistance thermal coupling

What is it?

The way in which the thermal solver calculates the coupling value of the total
conductance or the total resistance thermal coupling on the overlap region is
changed. When you select the Only Connect Overlapping Elements check
box for the Thermal Coupling or Thermal Coupling — Advanced simulation
object and you specify a total conductance or total resistance value, the
thermal solver now uses the total specified coupling values on the overlap
area if the overlap area is not zero.

In previous releases, the thermal solver used a coupling value that was
adjusted by the fraction of the overlap area over the area of the primary
region.
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Supported solvers and analysis types

Thermal Coupling simulation object

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Thermal Coupling — Advanced simulation object

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation ® Thermal Coupling or

Thermal Coupling — Advanced

Simulation
Navigator

Right-click the Simulation Objects node ® New
Simulation Object ® Thermal Coupling or Thermal
Coupling — Advanced

Location in dialog
box

(Thermal Coupling simulation object) Type list® Total
Conductance or Total Resistance

(Thermal Coupling — Advanced simulation object)
Type group®1 Way ® Type list® Total Conductance
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New thermal coupling options in Surface-to-Surface Contact

What is it?

When you use a Surface-to-Surface Contact simulation object to simulate
a thermal contact between two face meshes, you can now use the following
Conduction Type options to specify the conduction between the surfaces:

• Total Conductance

• Total Resistance

• Heat Transfer Coefficient

• Conductive Gap

In previous releases, you could specify only a constant heat transfer
coefficient.

For more information, see Surface-to-Surface Contact simulation object.

Why should I use it?

The new options give you more flexibility when you model complex thermal
surface-to-surface contacts.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow
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Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation ® Surface-to-Surface Contact

Simulation
Navigator

Right-click the Simulation Objects node ® New
Simulation Object ® Surface-to-Surface Contact

Location in dialog
box

Magnitude group ® Type list ® Specify ® Account
for list® Conduction or Conduction and Radiation ®
Conduction Type list

View factor calculation based on view factor residual

What is it?

You can now calculate view factors based on a target view factor residual for
each element when you select the Deterministic calculation method for the
following simulation objects:

• Orbital Heating

• Radiative Heating

• Solar Heating

• Solar Heating Space

You can also calculate view factors based on a target view factor residual for
each element when you select the Hemicube Rendering calculation method
for the Radiation simulation object.

Why should I use it?

This method gives you more flexibility when solving complex thermal models.

Supported solvers and analysis types

Orbital Heating and Solar Heating Space simulation objects

Solver Analysis Type Solution Type
NX Space Systems
Thermal

Thermal Space Systems Thermal
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Radiation simulation object

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Radiative Heating simulation object

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Solar Heating simulation object

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

Thermal Advanced ThermalNX Thermal and Flow
Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation ® Orbital Heating or

Radiation or Radiative Heating or Solar

Heating or Solar Heating Space

Simulation
Navigator

Right-click the Simulation Objects node ® New
Simulation Object ® Orbital Heating or Radiation or
Radiative Heating or Solar Heating or Solar Heating
Space
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Location in dialog
box

Parameters or Advanced Options group ® Element
Subdivision list® Based on Error Criterion

Catalog environment variable

What is it?

You can now store the catalogs that are used by NX Thermal and Flow, NX
Electronic Systems Cooling, and NX Space Systems Thermal in any folder.

Your folder must be specified by the MAYA_TMG_CATALOG_DIR environment
variable for NX to use it. If you set the environment variable, the catalog
files must have the same names as the catalog files in the default location.
The names are:

• component.xml which contains the PCB components catalog

• correction.xml which contains the duct correction catalog

• fan.xml which contains the fan catalog

The default location for the catalog files is the
[NX_installation]\NXCAE_extras\tmg\if\catalogs folder.

Why should I use it?

This environment variable lets you locate the catalog files on a computer
drive or network drive where you have permissions to modify files, so that
you can customize the catalogs.

NX Thermal and Flow, NX Electronic Systems Cooling, and NX Space Systems
Thermal customer defaults

What is it?

You can now define customer defaults for options in the Solution and Solver
Parameters dialog boxes. New Solution and Solver Parameters tabs are
available in the Customer Defaults dialog box for NX Thermal and Flow, NX
Electronic Systems Cooling, and NX Space Systems Thermal.

On the Solution tab, you can set the defaults for the following solution options:

• Run directory and location

• Solution solve-time units

• Ambient conditions for absolute pressure, fluid temperature, and the
radiative environment temperature

• Output results

What’s New in NX 8 6-135



CAE (Digital Simulation)

On the Solver Parameters tab, you can set defaults for the new thermal
element properties.

Why should I use it?

You can customize the thermal solver options and the solution options to
follow your company standards and to best suit your analyses.

Where do I find it?

Application Advanced Simulation
Menu File ® Utilities ® Customer Defaults

Location in the
dialog box

Simulation ® NX Thermal / Flow or NX ELECTRONIC
SYSTEMS COOLING or NX SPACE SYSTEMS
THERMAL

Mesh controls for Fluid Domain meshes

What is it?

When you mesh the fluid domain using the Fluid Domain simulation object,
you can now better control the size, shape metric, and rate of transition
between the boundary layer mesh and internal mesh structures.

• Use the 2D Element Shape Threshold option to control the shape of the
surface mesh elements. You must modify the values for the aspect ratio,
the skewness, or the maximum angle.

• Use the 3D Element Shape Threshold option to control the shape of the
volume mesh elements. You must modify the values for the aspect ratio,
the skewness, or the maximum angle.

• Use the Element Shape Threshold Refinement Factor option to control
how the mesh generator refines the mesh in order to satisfy the prescribed
mesh shape metrics.

• Use the Element Growth Rate Through Volume option to control the rate
of transition of the mesh size from finer regions to coarser regions.

• Use the Surface Curvature Based Size Variation option to control the level
of geometric approximation of the surface to generate the mesh structure.

For more information, see Fluid Domain mesh quality.

Why should I use it?

You can generate quality meshes, including boundary layer meshes, for
aerodynamic applications.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Coupled Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation toolbar® Solution

Advanced Simulation toolbar ® Solve ® Edit
Solution Attributes

Menu

Insert ® Solution

Analysis ® Solve ® Edit Solution Attributes

Simulation
Navigator

Right-click the Simulation file node® New Solution

Right-click the solution node ® Edit
Location in dialog
box 3D Flow tab® Fluid Domain Mesh Parameters group

Global flow imbalance fraction

What is it?

Use the new Global Flow Imbalance Fraction Option check box to ensure
that the mass and momentum imbalances are within a specified fraction. You
specify the fraction in the Global Flow Imbalance Fraction box.

For more information, see the Global heat and flow imbalance fractions
section of Setting flow solver parameters.

Why should I use it?

This option is an additional convergence criterion for the flow solver.

What’s New in NX 8 6-137



CAE (Digital Simulation)

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation ® Solve ® Edit Solver
Parameters

Menu Analysis ® Solve ® Edit Solver Parameters
Simulation
Navigator Right-click the solution node® Edit Solver Parameters
Location in dialog
box

3D Flow Solver tab® Convergence Control group®
Global Flow Imbalance Fraction Option check box

Exponential advection method for duct thermal discretization

What is it?

A new exponential advection method is available for duct thermal
discretization. This method assumes an exponential temperature profile
along the length of a duct element. The exponential temperature profile is
used to calculate the element average temperature and the element outlet
temperature. The element outlet temperature is then used as the inlet
temperature of the next downstream element in the duct network.

In previous releases, only the advection and conduction method was available.
The advection and conduction method assumes a constant temperature
profile along the length of the duct element equal to the center of gravity
temperature. In this method, the effects of conduction and external heat are
accounted for at the element inlet, where the temperature drops abruptly
from the inlet temperature to the constant center of gravity temperature.

For more information, see the Duct thermal discretization section of Setting
thermal solver parameters.

6-138 What’s New in NX 8



CAE (Digital Simulation)

Customer Defaults

You can set the exponential advection method as the default method by
setting the Duct Thermal Discretization option to Exponential Advection.
This option is located in the Customer Defaults dialog box, under Simulation
® NX Thermal / Flow or NX ELECTRONIC SYSTEMS COOLING or NX SPACE
SYSTEMS THERMAL, on the Solver Parameters tab.

Why should I use it?

When you solve models with pronounced variations of fluid temperature
along duct networks, you can obtain more accurate temperatures without
using very large number of duct elements.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

Axisymmetric Thermal

Advanced Axisymmetric
Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation ® Solve ® Edit Solver
Parameters

Menu Analysis ® Solve ® Edit Solver Parameters
Simulation
Navigator Right-click the solution node® Edit Solver Parameters

Location in dialog
box

Thermal Solver tab ® Element Properties group
® Duct Thermal Discretization list ® Exponential
Advection
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Element properties in Thermal Solver Parameters

What is it?

You can now access the element discretization methods in the Element
Properties group. In previous releases, in order to access most of these
methods, you had to use advanced parameters or use generic entities to
modify the INPF file.

• The element discretization methods Element Center Method and Element
CG Method are available from the Element Discretization list. Use these
methods to calculate element conductances between beam, shell, and
solid thermal elements.

• The duct thermal discretization methods Advection and No Conduction,
Advection and Conduction, and Exponential Advection, are available
from the Duct Thermal Discretization list. Use these methods to
calculate temperature of the duct elements. See Title not found for more
information on the new exponential advection method.

Element Center
Method

Creates conductances between element centers.

Element CG
Method

(Default method in NX 8) Creates conductances between
boundary elements and between the element CG and its
boundary elements. When you select this method, you
can also specify the methods that you want to use for
Shell Accuracy, Solid Element Capacitance Distribution,
and Element Convention for Temperature Constraint.

Boundary elements are created on each 3D solid element surface, each 2D
planar element edge, and each 1D element end except when the surface of
the solid element or the edge of a planar element is already occupied by
another element. Boundary elements are only created for elements that have
non-zero thermal conductivity.

Triangular element
Triangular element
with its three 1D
boundary elements

Conductances
between the CG of the
triangular element
and its three 1D
boundary elements
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For more information, see the Element discretization and Boundary elements
sections of Setting thermal solver parameters.

Customer Defaults

You can set customer defaults to specify the methods that are selected by
default in the Solver Parameters dialog box. These options are located in the
Customer Defaults dialog box, under Simulation ® NX Thermal / Flow or NX
ELECTRONIC SYSTEMS COOLING or NX SPACE SYSTEMS THERMAL, on
the Solver Parameters tab.

Why should I use it?

The options in the Element Properties group give you more control over the
thermal solver to adjust parameters that suits your thermal problem.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

Axisymmetric Thermal

Advanced Axisymmetric
Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation ® Solve ® Edit Solver
Parameters

Menu Analysis ® Solve ® Edit Solver Parameters
Simulation
Navigator Right-click the solution node® Edit Solver Parameters
Location in dialog
box Thermal Solver tab® Element Properties group
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Export orbit animations to videos

What is it?

You can now export videos of the orbits you animate in the Orbit Visualizer.
You can manipulate the orbit display while the video is being exported. The
videos can be saved in the following formats:

• ASF

• AVI

• FLV

• MOV

• MPG

• SWF

• WMV

For more information, see Using the Orbit Visualizer.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Space Systems
Thermal

Thermal Space Systems Thermal
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Where do I find it?

Prerequisites A model with elements and an Orbit modeling object.
Application Advanced Simulation

Toolbar Advanced Simulation ® Orbital Heating
Simulation
Navigator

Right-click the Simulation Objects Container ® New
Simulation Object ® Orbital Heating

Location in dialog
box Display ® Animation group® Record

Initial condition enhancement

What is it?

When the initial conditions for the current model solution are taken from
another model’s solution in a different directory, the mesh and boundary
conditions of the two models need not be identical. This applies both to
thermal models and flow models.

For more information, see Initial conditions.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal
Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow
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Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation toolbar® Solution

Advanced Simulation toolbar ® Solve ® Edit
Solution Attributes

Menu

Insert ® Solution

Analysis ® Solve ® Edit Solution Attributes

Simulation
Navigator

Right-click the Simulation file node® New Solution

Right-click the solution node ® Edit
Location in dialog
box

Initial Conditions tab® Initial Conditions list® From
Results in Other Directory

Transverse temperature gradient results set

What is it?

You can now recover transverse temperature gradient results on multi-layer
shells.

After solving the thermal model, in the Post Processing Navigator, the
following result types appear under the Solution node:

• Transverse Temperature Gradient — Nodal

• Transverse Temperature Gradient — Elemental
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Transverse Temperature Gradient — Nodal result set

When you want to map the transverse temperature gradient results from a
thermal solution with multi-layer shells to a structural solution, you need to
select the Transverse Temperature Gradients check box.

For more information, see Solution dialog box — Thermal Results Options.

Why should I use it?

You can visualize the transverse temperature gradient results, which you can
map to Nastran, Abaqus, or ANSYS solutions for use in structural analyses.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow
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Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation toolbar® Solution

Advanced Simulation toolbar ® Solve ® Edit
Solution Attributes

Menu

Insert ® Solution

Analysis ® Solve ® Edit Solution Attributes

Simulation
Navigator

Right-click the Simulation file node® New Solution

Right-click the solution node ® Edit
Location in dialog
box

Results Options tab ® Thermal group ® Transverse
Temperature Gradients check box

Transverse temperature gradient mapping to structural solutions

What is it?

The mapping solver can now write transverse temperature gradient results
to the Nastran, Abaqus, and ANSYS input files.

• In addition to the TEMP card, the Nastran input file now contains the
TEMPP1 card. For every transverse gradient element, the TEMPP1 card
contains the element’s temperature, which is mapped to the element’s
center of gravity, the elemental linear thermal gradient, and the top
elemental and bottom elemental temperature.

• For every transverse gradient target node, the Abaqus input file contains
the nodal temperature and the nodal linear thermal gradient.

• In addition to the BF card, the ANSYS input file now contains the BFE
card. For every transverse gradient element, the BFE card contains the
top and bottom elemental temperature for all N nodes on the element.

Note The transverse gradient target nodes are all the nodes selected from
the Destination Nodes group of the Transverse Gradient Target Set
dialog box and all the nodes connected to the elements selected from the
Destination Elements group.

The transverse gradient target elements are all the elements selected for
the Destination Elements group.
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When you want to map the transverse temperature gradient results from a
thermal solution with multi-layer shells to a structural solution, you need
to select the Transverse Temperature Gradients check box in the Solution
dialog box of the thermal source solution.

For more information, see Mapping results data to another model.

Why should I use it?

You can now easily map transverse temperature gradients to Nastran,
Abaqus, or ANSYS solutions for use in structural analyses, such as thermal
contact modeling and thermo-elastic distortion analysis.

Supported solvers and analysis types

Solver Analysis Type Solution Type
Coupled Thermal-Flow Advanced Thermal/Flow

with ESC
NX Electronic Systems
Cooling

Mapping Thermal-Flow
Thermal Space Systems ThermalNX Space Systems

Thermal Mapping Thermal
Thermal Thermal

Advanced Thermal
Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

NX Thermal and Flow

Mapping Thermal-Flow

Where do I find it?

Defining a transverse gradient pair in the source model

Application Advanced Simulation

Prerequisite
A solution with Analysis Type set to Thermal or
Coupled Thermal-Flow.

Toolbar Advanced Simulation ® Mapping
Simulation
Navigator

Right-click the Constraint Set container node ® New
Constraint ® Mapping

Location in dialog
box Type ® Transverse Gradient Pair
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Defining a transverse gradient target set in the target model

Application Advanced Simulation
Prerequisite A solution with Analysis Type set to Mapping.

Toolbar

Advanced Simulation ® Transverse Gradient Target

Set
Simulation
Navigator

Right-click the Constraint Set container node ® New
Constraint ® Transverse Gradient Target Set

Relaxation of mapped temperature bounds

What is it?

When you map the temperatures of the source model onto the target model,
you can now relax the extrapolation limits for mapped temperatures.

The maximum and minimum temperatures in the target model can now
be limited by the following bounds:

Upper limit = Tmax + percentage · abs(Tmax – Tmin)

Lower limit = Tmin – percentage · abs(Tmax – Tmin)

where Tmax and Tmin are the bounds of the entire source model. The
percentage is the relaxation of the mapped temperature limits that you specify
in the Relaxation of Mapped Temperature Limits, % (Tmax–Tmin) box.

Why should I use it?

When there are target nodes outside the geometric bounds of the source
model, you can relax the temperature limits to help extrapolate temperatures
to these target nodes.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Mapping Thermal-Flow

NX Space Systems
Thermal

Mapping Thermal

NX Thermal and Flow Mapping Thermal-Flow
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Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation toolbar® Solution

Advanced Simulation toolbar ® Solve ® Edit
Solution Attributes

Menu

Insert ® Solution

Analysis ® Solve ® Edit Solution Attributes

Simulation
Navigator

Right-click the Simulation file node® New Solution

Right-click the solution node ® Edit
Location in dialog
box Mapping Details tab ® Settings group

NX 8 Design Simulation

Mesh Control command now available

The Mesh Control command is now available from the Design Simulation
application. You can use the Mesh Control command to more precisely control
the number and distribution pattern of elements that the software creates
along a selected edge or face. Edge and face densities give you local control
over the number and distribution pattern of elements along a particular edge
or across a particular face. You can use Mesh Control to create edge and face
densities either before or after you have generated the mesh.

For example, you can use the Size on Face option in the Mesh Control
dialog box to specify the approximate element size for the selected face. The
following graphic shows the previewed nodal distribution (A) and resulting
mesh (B) for a Size on Face density with an element size of 1mm.
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Where do I find it?

Application Design Simulation
Toolbar

Design Simulation®Mesh Control
Menu Insert®Mesh®Mesh Control

Post-processing group support

What is it?

You can now use the Identify command to output groups for further
post-processing.

You use Identify to probe and display nodal and elemental information for
the post view display. When you have identified those nodes or elements

that meet your specified criteria, click Save selection in group in the
Identify dialog box.

The software creates a temporary group named PostGroupn, where n is an
integer incremented for each group you create. Expand the post view node in
the Post Processing Navigator to control the display of post groups.
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(1) Stress results in post processing. (2) Identify nodes and elements
with maximum stress, and save to a group. (3) Display the post group

using Show Only.
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Post groups are listed under the post view node in the Post
Processing Navigator.

Where do I find it?

Application Design Simulation
Prerequisite Analysis results loaded and a post view displayed.

Toolbar Post-Processing ® Identify
Location in dialog
box Save selection in Group

Geometry Optimization update

What is it?

The Optimization product has been rewritten in the latest NX architecture,
using a wizard-like user interface that guides you through the definition
of the optimization problem. The optimization algorithm has also been
improved to provide a greater degree of accuracy.
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Where do I find it?

Application Design Simulation, Advanced Simulation
Menu Insert®Geometry Optimization
Simulation
Navigator

Right-click the simulation®New Solution
Process®Geometry Optimization
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NX 8 Motion Simulation

Unit and expression support

In many Motion Simulation dialog boxes, you can now change the unit of
measure for many parameters. The new list options also allow you to:

• Select a recently used value for an entry field. You can edit the value
that you select.

• Select a recently used formula for an entry field. You cannot edit the
formula.

• Use the DesignLogic list to select a measurement, formula, or function.

Units list

Options list

Parameters in the following motion objects do not yet support this new
functionality:

• Gear

• Rack and Pinion

• Cable

• 2–3 Joint Coupler
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• Interference packaging

• Motor

• Signal Chart

• Solution

Checking the mechanism for errors

You can now check your motion simulation for various problems prior to
solving the model, using the Model Check command.

The Information window displays messages indicating any problems with
the mechanism. Explanations of typical warning and error messages are
provided in the following table.

Motion object Error message Additional
information

Geometry missing

The geometry on which
the link was created is
no longer available. This
issue may occur if the
master model geometry
was deleted.

Link

Invalid mass properties
Check the Mass
Properties definition
in the link.

Flexible link Referenced .rfi/.op2 file
cannot be located

The .rfi file and/or
the .op2 file from
the original Nastran
solution associated
with this flexible body
solution is missing.

I/J marker is not
associated with
geometry

The I marker (action
link) or J marker (base
link) is not associative.
For example, this
warning may appear
if you defined an
orientation by specifying
a fixed vector rather
than inferring it from
geometry. If you move
the component in the
master model, the joint

Joint
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Motion object Error message Additional
information

will not be updated in
the Motion simulation.

Cannot find the function
for driver

The function that was
defined for the joint
driver is missing.

Couplers (gear, rack and
pinion, cable, 2–3 joint
coupler)

More than one joint has
a motion driver

Only one of the joints
in the coupler definition
can have a motion driver
defined.

Spring, Damper,
Bushing

Spring stiffness function
not found

Damper coefficient
function not found

Force stiffness/force
damping/torque
stiffness/torque damping
function not found

The function that was
defined for the connector
is missing.

Curve on curve Curves are not planar The selected curves in
the set are not planar.

Point on curve No curve specified.
Curve geometry lost.

The curve on which the
point on curve is based
is no longer available in
the master model.

Point on surface Face invalid

The software could not
find the surface for
the point on surface,
or the surface is too
complicated.

Scalar force

Scalar torque

Vector object

Signal chart

Driver

Function not found. The function defined for
this object is missing.

Marker Marker is not smart
associative.

The geometry on which
the marker was created
is no longer available in
the master model.

Plant Plant output function
not found.

The function defined for
the plant is missing.
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Motion object Error message Additional
information

Function is not loaded.

Function
Function is invalid.

The syntax for the
function expression
failed.

Loss of the .mdl file.
The software could not
find the .mdl file for the
solution.Solution

Duplicated IDs or names
are found.

Where do I find it?

Application Motion Simulation

Toolbar Motion®Model Check
Menu Information®Mechanism Check®Model Check

Exporting an animation as a movie

You can now use the Export to Movie command to capture your motion
animation as a movie in AVI format.

For steps, see Capture an animation as a movie.

Where do I find it?

Application Motion Simulation

Prerequisite
A solved Normal Run, Articulation, or Spreadsheet Run
solution.

Toolbar Motion toolbar®Export to Movie
Menu Tools®Animation®Export to Movie

Animation legend

An animation legend now appears automatically when you animate the
mechanism. The legend shows the current time and step during animation.
The legend is interactive, so you can type in the time or step to jump to in
the animation.

You can use the Animation Legend Motion preference to turn the legend
on or off.
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Where do I find it?

Application Motion Simulation

Prerequisite
A solved Normal Run, Articulation, or Spreadsheet Run
solution.

Copying and pasting bushing and contact parameters

You can now copy the parameters of a bushing, 2D contact, or 3D contact, and
paste the parameters to another object of the same type.

1. Define the parameters of the source bushing or contact.

2. In the Motion Navigator, right-click the source bushing or contact and
select Copy Parameters.

3. In the Motion Navigator, select the target contact or bushing and choose
Paste Parameters.

Stiffness and Damping coefficients of bushing (1) being copied to
bushing (2)

Improvements to Flexible Body Analysis

Packaging options are supported

You can now define packaging options, including Interference, Measure, and
Trace, in a Flexible Body analysis.

For more information about flexible body analysis, see Flexible body analysis.
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Trace packaging on a flexible link

Modal coordinates can be plotted

You can now plot the modal degrees of freedom vs. time using the Modal
Coordinates setting in the Graph dialog box. You can select one or more
modes of the flexible body and then plot the modal displacement, acceleration,
or velocity.
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Data recovery solve can be limited to only relevant steps

You can now use the Skip Steps option on the Solution dialog box to specify
steps in the solution to skip in the data recovery portion of the solve. You can
greatly improve the performance of the solve by limiting the data recovery
solve to only those solution steps that are relevant to the analysis.

Post View settings are persistent

During a flexible body analysis in Motion Simulation, the Post View settings
that you define are now preserved as long as the motion simulation is open
in NX. In previous releases, the default settings were restored after each
animation run.

Other user interface enhancements

Easier definition of Joint and Bushing orientation

The process for specifying the orientation of a joint or bushing has been
improved. You can now:

• Use the Vector Orientation Type to specify the orientation by selecting
or defining a vector. You can select geometry to infer the vector or use
the NX vector tools to specify the vector. The directions are in terms of
the Work coordinate system.

• Use the CSYS Orientation Type to specify all three directions of the joint
or bushing coordinate system using the NX coordinate system tools.

Point on Curve and Point on Surface now require link definition

When you create a Point on Curve or Point on Surface constraint, the dialog
box now requires you to select the link on which to define the constraint.
This link specification avoids issues with the location of the point in the
constraint definition.

Curve Parameterization added to Point on Curve dialog box

The Curve Parameterization method has been added to the Point on Curve
dialog box. In previous versions, this method was available only as a customer
default. The customer default is no longer available.
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When you solve a mechanism that contains a Point on Curve constraint, NX
passes the data for the curve to the solver as a group of points, using one of
the following methods:

• User-defined spacing (Default) — Calculates the number of points based
on a fixed user-defined spacing between every two points along the curve.
In most cases, the default value of 2 mm is appropriate. However, if the
curve has a large curvature or there is a large shift between different
segments of curvature, and you have problems solving the mechanism,
you may need to use a smaller value. Note that using a smaller value
will slow solve performance.

The software calculates the number of points using this formula:

number of points = curve length / (user-defined spacing +1)

• Curvature-based— Calculates the number of points based on the curve
itself. To check the number of points that NX uses to represent a curve,
choose Information®Object and select the curve. The Information window
includes the line Number of Segments [number] and the graphics window
shows the point locations, as shown in this example.

Note In most situations, the default User-defined spacing option is
recommended, especially if the Point on Curve constraint contains
a motion driver. Use the Curvature-based method only if you have
problems solving the mechanism and have already tried using a smaller
user-defined spacing.

Improved 2D Contact and 3D Contact dialog boxes

To improve usability and simplify the definition of contact problems, the
parameters on the 2D Contact and 3D Contact dialog boxes have been
reorganized into a Basic tab and Advanced tab. For most cases, you can
define the options on the Basic tab and use the default settings on the
Advanced tab.
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User-specified names for Motion Simulations

In the Environment dialog box, you can now specify a name for the
motion simulation. In previous releases, motion simulations were named
automatically.

NX 7.5.2 Advanced Simulation

Solver version support

For each released version of NX, the following tables list the supported solver
versions for import, export, and the post-processing of results. Note:

• The version listed in the “Import ASCII” and “Import Binary” rows is the
solver version that was generally available when the NX version was
released. In general, the import of the solver ASCII and binary files
should be upwards compatible. Therefore, you should be able to import
them into the most recent version of NX. However, in general:

o ASCII files are backwards compatible for import into NX. If you import
an ASCII file from a newer version of the solver than is officially
supported, the software simply ignores any new fields/options that
aren’t supported in the current NX release.

o Binary files are not backwards compatible. For example, you can
import a binary file created by NX Nastran 5.0 into NX 6.0.2 , but
you might not be able to import a binary file created by NX Nastran
6.1 into NX 5.

• The version listed in the “Export ASCII” rows is the solver version that
was available when the NX version was tested. In general, the exported
solver input file is upwards compatible for that solver. Backwards
compatibility is not guaranteed. For NX Nastran, the Model Setup
Check function in Advanced Simulation tries to flag potential version
incompatibility issues.

• The version listed in the “Post-processing Results” rows is the version of
the solver results that was tested in the listed NX version. In general,
results from earlier solver versions are also supported.
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NX 8 releases

Solver File Type NX 8
Import ASCII (.dat) 7.1

Import Binary (.op2) 7.1
Export ASCII (.dat) 7.1

NX Nastran

Post-processing of Results 7.1
Import ASCII (.dat) 2008r1
Import Binary (.op2) 2008r1
Export ASCII (.dat) 2008r1MSC Nastran

Post-processing of Results 2008r1
Import ASCII (.inp) 6.9-1
Import Binary N/A
Export ASCII (.inp) 6.9
Post-processing of Results (.fil) 6.10-1

Abaqus

Post-processing of Results (.odb) 6.9-EF2
Import ASCII (PREP7, CDB) 12.1
Import Binary (.rst, .rth) 12.1
Export ASCII (.inp) 12.1ANSYS

Post-processing of Results 12.1
Import ASCII N/A
Import Binary N/A
Export ASCII (.k) 971R3.2.1LS-DYNA

Post-processing of Results 971R3.2.1

NX7 releases

Solver File Type NX 7 NX 7.5 NX 7.5.1 NX 7.5.2
Import ASCII
(.dat)

6.1 7.0 7.0 7.1

Import Binary
(.op2)

6.1 7.0 7.0 7.1

Export ASCII
(.dat)

6.1 7.0 7.0 7.1
NX
Nastran

Post-processing
of Results

6.1 7.0 7.1 7.1

Import ASCII
(.dat)

2008r1 2008r1 2008r1 2008r1

Import Binary
(.op2)

2008r1 2008r1 2008r1 2008r1

Export ASCII
(.dat)

2008r1 2008r1 2008r1 2008r1
MSC
Nastran

Post-processing
of Results

2008r1 2008r1 2008r1 2008r1
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Solver File Type NX 7 NX 7.5 NX 7.5.1 NX 7.5.2
Import ASCII
(.inp)

6.8-1 6.9–1 6.9–1 6.9-1

Import Binary N/A N/A N/A N/A
Export ASCII
(.inp)

6.8-1 6.9 6.9 6.9

Post-processing
of Results (.fil)

6.8-EF2 6.9.2 6.9.2 6.10-1
Abaqus

Post-processing
of Results (.odb)

6.8-EF2 6.9-EF1 6.9-EF2 6.9-EF2

Import ASCII
(PREP7, CDB)

12 12.1 12.1 12.1

Import Binary
(.rst, .rth)

12 12.1 12.1 12.1

Export ASCII
(.inp)

12 12.1 12.1 12.1ANSYS

Post-processing
of Results

12 12.1 12.1 12.1

Import ASCII N/A N/A N/A N/A
Import Binary N/A N/A N/A N/A
Export ASCII (.k) 971R3.2.1 971R3.2.1 971R3.2.1 971R3.2.1LS-DYNA
Post-processing
of Results

N/A N/A 971R3.2.1 971R3.2.1

NX 6 releases

Solver File Type NX 6 NX 6.0.1 NX 6.0.2 NX 6.0.3 NX 6.0.4 NX 6.0.5

Import ASCII

(.dat)

6.0 6.1 6.1 6.1 6.1 7.0

Import Binary

(.op2)

6.0 6.1 6.1 6.1 6.1 7.0

Export ASCII

(.dat)

6.0 6.1 6.1 6.1 6.1 7.0
NX
Nastran

Post-processing of

Results

6.0 6.0 6.1 6.1 7.0 7.0

Import ASCII

(.dat)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Import Binary

(.op2)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Export ASCII

(.dat)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1
MSC
Nastran

Post-processing of

Results

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1
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Solver File Type NX 6 NX 6.0.1 NX 6.0.2 NX 6.0.3 NX 6.0.4 NX 6.0.5

Import ASCII

(.inp)

6.7-1 6.8-1 6.8-1 6.8-1 6.8-1 6.8-1

Import Binary N/A N/A N/A N/A N/A N/A

Export ASCII

(.inp)

6.7-1 6.8-1 6.8-1 6.8-1 6.8-1 6.8-1

Post-processing of

Results (.fil)

6.7-5 6.8-1 6.8-3 6.8-EF2 6.8-EF2 6.8-EF2

Abaqus

Post-processing of

Results (.odb)

N/A N/A N/A 6.8-EF 6.8-EF2 6.9-EF2

Import ASCII

(PREP7, CDB)

11 11 SP1 11 SP1 11 SP1 12.0 12.0

Import Binary

(.rst, .rth)

11 11 SP1 11 SP1 11 SP1 12.0 12.0

Export ASCII

(.inp)

11 11 SP1 11 SP1 11 SP1 12.0 12.0
ANSYS

Post-processing of

Results

11 SP1 11 SP1 11 SP1 11 SP1 12.0 12.1

Import ASCII N/A N/A N/A N/A N/A N/A

Import Binary N/A N/A N/A N/A N/A N/A

Export ASCII (.k) 971R2 971R2 971R3.2.1 971R3.2.1 971R3.2.1 971R3.2.1LS-DYNA

Post-processing of

Results

N/A N/A N/A N/A N/A N/A

NX 5 releases

Solver File Type NX 5 NX 5.0.1 NX

5.0.2

NX

5.0.3

NX

5.0.4

NX

5.0.5

NX

5.0.6
Import ASCII

(.dat)

5.0 5.1 5.1 5.1 5.1 5.1 5.1

Import Binary

(.op2)

5.0 5.1 5.1 5.1 5.1 5.1 5.1

Export ASCII

(.dat)

5.0 5.1 5.1 5.1 5.1 5.1 5.1
NX Nastran

Post-processing

of Results

5.0 5.0 5.1 5.1 5.1 5.1 6.0

Import ASCII

(.dat)

2005 2005 2007 2007 2007 2007 2007r1

Import Binary

(.op2)

2005 2005 2007 2007 2007 2007 2007r1

Export ASCII

(.dat)

2005 2005 2007 2007 2007 2007 2007r1
MSC
Nastran

Post-processing

of Results

2005 2005 2007 2007 2007 2007 2008r1
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Solver File Type NX 5 NX 5.0.1 NX

5.0.2

NX

5.0.3

NX

5.0.4

NX

5.0.5

NX

5.0.6
Import ASCII

(.inp)

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.7-1

Import Binary N/A N/A N/A N/A N/A N/A N/A

Export ASCII

(.inp)

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.7-1Abaqus

Post-processing

of Results

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.8-1

Import ASCII

(PREP7, CDB)

10 10 11 11 11 11 11

Import Binary

(.rst, .rth)

10 10 11 11 11 11 11

Export ASCII

(.inp)

10 10 11 11 11 11 11
ANSYS

Post-processing

of Results

10 11 11 11 11 11 11 SP1

NX 4 releases

Solver File Type NX 4 NX 4.0.1 NX 4.0.2 NX 4.0.3 NX 4.0.4

Import ASCII (.dat) 4.0 4.1 4.1 5.0 5.0

Import Binary (.op2) 4.0 4.1 4.1 4.1 4.1

Export ASCII (.dat) 4.0 4.1 4.1 5.0 5.0NX Nastran

Post-processing of

Results

4.0 4.1 4.1 5.0 5.0

Import ASCII (.dat) 2005 2005 2005 2005 2005

Import Binary (.op2) 2005 2005 2005 2005 2005

Export ASCII (.dat) 2005 2005 2005 2005 2005
MSC
Nastran

Post-processing of

Results

2005 2005 2005 2005 2005

Import ASCII (.inp) 6.5-1 6.5-1 6.5-1 6.6 6.6

Import Binary N/A N/A N/A N/A N/A

Export ASCII (.inp) 6.5-1 6.5-1 6.5-1 6.6 6.6Abaqus

Post-processing of

Results

6.5-1 6.5-1 6.5-1 6.6 6.6-3

Import ASCII

(PREP7, CDB)

8 9 9 10 10

Import Binary (.rst,

.rth)

8 9 9 10 10

Export ASCII (.inp) 8 9 9 10 10
ANSYS

Post-processing of

Results

9 9 9 10 10
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General capabilities

Selecting multiple edges or faces on an element

What is it?

With commands in which you can select element edges or faces, you can now
select all the free faces or free edges on an element. In previous releases, you
could select only one edge or face per element.

Also, in the Type filter (which appears in the Selection bar in the toolbar area),
the Element filter has been renamed to Element Face for certain commands.

Some commands in which you can select all free edges or faces are:

• Pressure load

• Region (Surface type)

• Element Associated Data

• Element Extrude

• Node/Element Information

• Surface Coat

In previous releases, the element free faces indicated by arrows
could not be selected.
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In this release, all element free faces can be selected.

Where do I find it?

Application Advanced Simulation

Design Simulation

Simulation Navigator enhancements

What is it?

This release includes several usability enhancements to the Simulation
Navigator.

Paging through large numbers of objects

Using the new Paging option, you can now limit the number of objects that
display in the navigator, such as coordinate systems, loads, and constraints.
You can then page through the list of objects using the Next and Previous
buttons. This option improves performance when displaying a long list (for
example, 1000 coordinate systems in the CSYS folder).

In the Customer Defaults dialog box, under
Simulation®Extras®Miscellaneous, you can control the number of options
to display using the Number of nodes per navigator page option. The
default value is 1000 objects per page.
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CSYS folder with Paging turned on, with Number of nodes per
navigator page set to 10

Search by entity name

Using the new Find Object command, you can now search for an entity by
name in Simulation Navigator folders. When an object is found, it is selected
in the Simulation Navigator and in the graphics window.

You can search on a partial string. For example, you can search for SHELL to
find a mesh collector named PSHELL_1.

Note The search string is case sensitive. Wildcards are not supported.

Where do I find it?

Navigator Paging

Application Advanced Simulation

Simulation
Navigator

Right-click a folder®Paging®On

Find Object command

Application Advanced Simulation

Simulation
Navigator

Right-click a folder®Find Object
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Displaying geometry free edges on the model

What is it?

You can now display free edges on geometry using the Model Display
command. The new Display Free Edges check box is available in the Polygon
Geometry tab, which also lets you define the color, thickness, and style of
the free edge lines, as well as the marker that represents the endpoints of
the edges.

Geometry free edges shown in magenta

Where do I find it?

Application Advanced Simulation

Design Simulation
Menu Preferences®Model Display
Location in dialog
box

Polygon Geometry tab

Solid properties check enhancements

What is it?

When you use the Solid Properties Check command to verify the properties
of the elements in your model, the software now also reports:

• The total surface area of selected 2D elements in your model.

• The total length of selected 1D elements in your model.
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The ability to calculate the total surface area of the 2D elements is helpful,
for example, when you want to tune the mass of your model. For instance, if
you have a 2D mesh on a panel, and you know that the total mass of the panel
should be slightly higher, you can use the Solid Properties Check command
to query the surface area of the 2D elements in the panel. You can then use
that information to adjust the specified Non Structural Mass value that you
specified in the Physical Property Table that you assigned to the mesh.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM or Simulation file

Menu Information®Advanced Simulation®Solid Properties
Check

Creating a field from an AFU function

What is it?

From the XY Function Navigator, you can save an XY table function in an
AFU file to a table field.

After the field is created, it is listed in the Simulation Navigator in Advanced
Simulation. You can then use this field, for example, to apply results data
to a model as a boundary condition.

Where do I find it?

Application Advanced Simulation

Prerequisite
One or more functions in an AFU file loaded or
imported.

XY Function
Navigator

Associated AFU®file name®right-click the record
name®Create Table Field

Teamcenter Integration for Simulation

CAE migration utility

What is it?

In the traditional data model, CAE data is stored as datasets referenced by a
CAD item revision. In the Teamcenter for Simulation data model, CAE data
is stored as CAE-specific item revisions. In previous releases, to migrate
legacy CAE data stored under the traditional data model to the Teamcenter
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for Simulation data model, you opened the legacy data in NX and resaved it
to the new data model.

Beginning in this release, you can use the command-line utility
ugnx_caemigrate_tc to migrate legacy CAE data to the new data model.

Using this utility, users and administrators can:

• Migrate all legacy CAE models they own.

• Specify naming conventions for migrated CAE models.

In addition, administrators can:

• Migrate all legacy CAE models across the database.

• Clean up legacy data for all users following migration.

Why should I use it?

Use the ugnx_caemigrate_tc command-line utility to ensure a consistent
data model for all CAE data, to improve performance on opening and saving
legacy CAE data in NX. Working with migrated data, you can also take
advantage of the features of the Teamcenter for Simulation data model, such
as improved searching and reuse.

Where do I find it?

Theugnx_caemigrate_tc utility in located in your%UGII_BASE_DIR%\ugii
folder.

Material and physical properties

New dialog boxes for managing and assigning materials

What is it?

Beginning with this release, you manage your materials and assign them to
parts using separate dialog boxes.

• Assign Material— Lets you select existing materials and assign them to
selected bodies or all bodies in your part. You can also view the properties
of a selected material.

• Manage Materials— Lets you create new materials, copy library material
definitions, view and edit material properties, and load library materials
into the current FEM or part file.

In previous releases, you performed these tasks using a single dialog box.

When the FEM file is displayed in Advanced Simulation, you use the Material
List dialog box to assign a material to a physical property table, as in previous
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releases. The Material List dialog box has the same capabilities as the
Manage Materials dialog box.

Also, beginning with this release, the Material Library Manager dialog box
is now also available when the Simulation file is displayed in Advanced
Simulation. You continue to use this dialog box to edit library material
definitions, export local materials to a material library, and delete library
material definitions.

Where do I find it?

Application All
Menu Tools®Materials®Manage Materials or Assign Material

New material types for NX Nastran solutions

What is it?

This release adds support for several new material types for use in NX
Nastran solutions.

Sussman-Bathe hyperelastic material

Sussman-Bathe rubber is a nearly incompressible hyperelastic material
model for NX Nastran ADVNL 601,106, ADVNL 601,129, and ADVNL 701
solutions. This model uses uniaxial stress-strain data directly instead of
material constants.

For more information, see the MATHE bulk data entry (with Model
field=SUSSBAT) in the NX Nastran Quick Reference Guide.

Shape Memory Alloy material

Shape Memory Alloy is a new material for NX Nastran ADVNL 601,106
solutions. This material can simulate the superelasticity behavior of
shape memory alloy material due to the reversible phase transformation
of austenite and martensite. You can use this material with the PSHELL,
PSOLID, PROD, CONROD, and PCOMP physical property tables.

For more information, see the MATSMA bulk data entry in the NX Nastran
Quick Reference Guide.

3D Orthotropic materials

You can now apply orthotropic materials to the CHEXA, CPENTA, CPYRAM,
and CTETRA solid elements, for all solutions except ADVNL 601 and 701.

For more information, see the MAT11/MATT11 bulk data entries in the NX
Nastran Quick Reference Guide.
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2D Axisymmetric materials

You can now apply orthotropic materials to the CTRAX3, CTRAX6,
CQUADX4, CQUADX8, and CTRIAX6 axisymmetric elements.

For more information, see the MAT3/MATT3 bulk data entries in the NX
Nastran Quick Reference Guide.

Where do I find it?

Application Advanced Simulation
Menu Tools®Materials®Manage Materials
Location in dialog
box

New Material group®Type list®select the material type
(such as Sussman-Bathe)

New material properties

What is it?

As part of ongoing support for advanced analysis types such as nonlinear,
laminates, and durability, this release adds several new material properties.

Creep properties

When Nastran, Abaqus, or ANSYS is the selected solver, the following
properties for modeling creep strain are now available on the Creep tab in the
Materials dialog box for isotropic, orthotropic, and anisotropic materials:

• Kelvin-Maxwell (Rheological) Constants — Supports Nastran creep
laws 111, 112, 121, 122, 211, 212, 221, and 222 as well as Abaqus creep
law HYPERB.

• Time Hardening (Norton-Bailey) Power Law— Supports Nastran creep
law 300, Abaqus creep law TIME, and ANSYS creep law Time Hardening.

• Strain Hardening Power Law— Supports Abaqus creep law STRAIN and
ANSYS creep law Modified Strain Hardening.

• Uniaxial (Rheological) Tabular Input— Supports input of creep as table
data or definition of linear viscoelastic behavior for Nastran.

Viscoelastic properties

When Abaqus is the selected solver, you can define frequency-dependent or
time-dependent properties for representing the dynamic behavior of materials
such as glasses, rubbers, and high polymers under stress. For isotropic,
orthotropic, anisotropic, and hyperelastic materials, Time and Frequency
options are available on the new Viscoelasticity tab in the Materials dialog
box.
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These types of material properties let you analyze situations in which the
strain rate has a significant effect on the material response.

The following domains are supported:

• Time— Creep Test Data, Frequency Data, Prony Series, and Relaxation
Test Data definition options.

• Frequency— Creep Test Data, Power Formula, Prony Series, Relaxation
Test Data, and Tabular definition options.

The Viscoelastic properties correspond to the parameters for the
*VISCOELASTIC, *SHEAR TEST DATA, *VOLUMETRIC TEST DATA, and
*COMBINED TEST DATA keywords in Abaqus. For more information, see
the Abaqus Keywords Reference Manual.

Laminate orthotropic strength properties

In support of the Laminates capability, the following strength properties have
been added for the orthotropic material type:

• Transverse shear stress limit

S13 and S23 in Nastran

FC,,S, XZ and FC,,S,YZ in ANSYS

• Transverse shear strain limit

X13 and X23 in Nastran

FC,,EPEL, XZ and FC,,EPEL,YZ in ANSYS

• Tsai-Wu interaction coefficient

F12 in Nastran

Failure criteria in ANSYS: This value is converted to XYCP (coupling
coefficient in the FC command) by the following formula:

XYCP = 2 * F12 * sqrt[ST1* SC1 * ST2 * SC2]

Where ST1, ST2, SC1, and SC2 are tensile/compressive stress limits in
X and Y respectively.

The new properties are located on the Strength tab in the Materials dialog
box, in the Shear Stress Limits and Shear Strain Limits groups.
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Advanced Durability Failure Theory properties

In the Materials dialog box, the Durability and Formability tab has been
divided into two tabs: Durability and Formability. A new Dang Van
Parameters group has been added to the Durability tab. You can define
these properties:

• Fatigue Limit Strength in Bending

• Fatigue Limit Strength in Torsion

For more information about the Dang Van parameters, see **Unsatisfied
xref title**.

Where do I find it?

Application Advanced Simulation
Menu Tools®Materials®Manage Materials
Location in dialog
box

New Material group®Type list®select the material type
(such as Sussman-Bathe)

Temperature-dependent stress-strain curves for Isotropic materials

What is it?

When Nastran, Abaqus, or ANSYS is the selected solver, when you use the
nonlinear elastic (NLELAST) nonlinearity type for an Isotropic material and
define the tabular field data for a stress-strain curve, you can now define
temperature as another independent variable. The new Temperature-Strain
domain lets you define a table field in which each row consists of a
temperature, strain, and stress value.
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When you plot the field, the new Field XY Graph dialog box lets you specify
the independent variable (either Strain or Temperature) and then specify the
constant value to use in the graph.

What’s New in NX 8 6-177



CAE (Digital Simulation)

Where do I find it?

Application Advanced Simulation
Prerequisites Isotropic material with Type of Nonlinearity option set

to NLELAST.
Menu Tools®Materials®Manage Materials
Location in dialog
box

Table Field dialog box®Independent
tab®Domain=Temperature-Strain

Specify a directory of material library XML files

What is it?

You can now use a set of several MatML XML files as your custom material
library. The new Material Library Format customer default controls whether
the User and Site MatML libraries are single XML files or a folder containing
several XML files. In the Manage Materials and Assign Material dialog boxes,
the list of material definitions will include all definitions from all MatML files
in the directory specified for Site MatML Library and/or User MatML Library.
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Where do I find it?

Application All
Menu File®Utilities®Customer Defaults
Location in dialog
box

Customer Defaults dialog
box®Gateway®General®Materials tab®Material
Library Format list = Directory of MatML Files

You can then specify a default directory under Site
MatML Library and/or User MatML Library.
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Finding bodies with no material assignment

What is it?

When you manage or assign materials, you can now quickly determine which
bodies in your part have no assigned material. In the Manage Materials and
Assign Material dialog boxes, when you click Highlight bodies without a

material assigned , all bodies with no assigned material are highlighted
in the graphics window.

In previous releases, when a body had no material assigned, the software
assigned a default density (typically that of Steel), which caused invalid mass
properties in your model. This enhancement lets you ensure that the model
has the correct mass properties.

Where do I find it?

Application All
Menu Tools®Materials®Manage Materials or Assign Material
Location in dialog
box

Manage Materials and Assign Material dialog
boxes®Highlight bodies without a material assigned
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Synchronizing loaded materials with library definitions

What is it?

You can now ensure that the material loaded into a FEM or part file always
has the same properties as the library definition. In the Material Library
Manager dialog box, when you use the Edit Library Material command to
make changes to a library definition that is currently loaded into the FEM
or part file, you can use the new Synchronize Loaded Materials with the
Modified Library Definitions option to synchronize those editing changes
back to the loaded material.

In previous releases, when you edited a library definition, the loaded material
would no longer have the same properties as the library material.

Where do I find it?

Application All
Menu Tools®Materials®Manage Library Materials

Location in dialog
box

Material Library Manager dialog box®Edit Library
Material®Synchronize Loaded Materials with the
Modified Library Definitions

Library location reference for exported materials

What is it?

You can now track where your material records are stored when you use the
Export Material to Library command to export a local material to a material
library file.

Beginning with this release, you can use the new Update Library Reference
on Exported Materials option to have the export command add the name of
the target library file to the material record. The reference to the target
library file appears in the Library column in the Material Library Manager,
Manage Materials, and Assign Material dialog boxes.
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Where do I find it?

Application All
Menu Tools®Materials®Manage Library Materials
Location in dialog
box

Material Library Manager dialog box®Export Library
Material®Update Library Reference on Exported
Materials

Support for MatML databases from Matereality

What is it?

The NX materials functionality can now read MatML files from databases
provided by Matereality®.

Where do I find it?

Application All
Menu Tools®Materials®Manage Library Materials
Location in dialog
box

Source Material List group®Location subgroup®Site
MatML Library or User MatML Library
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Geometry abstraction

Creating a face from an existing mesh

What is it?

In some analyses, you may need to modify finite element models that either
have no geometry or which are not associated to geometry. In previous
releases, making changes to models that did not have associated geometry
was challenging. You could use the tools on the Node Operations and Element
Operations toolbars to make limited modifications, but those changes would
not persist through a part update.

Beginning in this release, you can use the new Face from Mesh command to
create a new polygon face from a selected set of 2D elements or 3D element
faces. The elements you select to create the new face become the initial
mesh on that face. You can then make modifications to the new face or its
associated mesh.

The Face from Mesh command is helpful when you need to:

• Associate an existing finite element model to new geometry

• Connect shell meshes that are not associated with any geometry.

• Locally refine a region of a mesh that is not associated with any geometry.

The following graphic shows a very simple use of the Face from Mesh
command. (A) shows a FEM file that was created from Nastran bulk data.
The model contains only 2D PSHELL elements. (B) shows the face that was
created from those elements. Those elements become the initial mesh on that
new face. (C) shows the new face (with the mesh display turned off).
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Where do I find it?

Application Advanced Simulation
Prerequisite A FEM file active

Toolbar Advanced Simulation®Face from Mesh
Menu Model Cleanup®Face from Mesh

Meshing

Reusing a beam cross section in other parts

What is it?

You can now define a standard, General Geometry, or Face of Solid type of
beam cross section and save it as a template in the NX Reuse Library so that
it can be used in other FEM files for creating new beam cross sections.

For the General Geometry and Face of Solid types of cross sections, the
template includes the cross sections and their user-defined stress recovery
points. Values are converted to the units of the FEM in which the cross section
is reused, and all association with the original sketch or solid face is removed.

When you reuse a Face of Solid type of cross section, the type is changed
to General Geometry.

Where do I find it?

Saving a cross section as a reusable object:

Application Advanced Simulation

Prerequisite Cross section type must be standard, General Geometry,
or Face of Solid.

Toolbar Reuse Library®Define Reusable Object
Menu Tools®Reuse Library®Define Reusable Object
Reuse Library

navigator

Right-click library node®Define Reusable Object
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Using a cross section reuse object in another FEM file:

Application Advanced Simulation

Reuse Library

navigator

Member Select group®click Beam Section Template

Search group®enter name of reuse object and click

Search in tree above

Local remeshing for 2D meshes

What is it?

For 2D meshes that are associated with geometry, you can use the new 2D
Local Remesh command to refine the elements in a very specific region
without regenerating the entire mesh. For example, you may discover after
you solve your model that the applied loads and structural response require
that you refine the elements in a region within a face. You can then use 2D
Local Remesh to reduce the size of the elements in that region.

With 2D Local Remesh, you select the elements to refine. You then use the
options in the 2D Local Remesh dialog box to control how the software refines
the mesh. For example, you can specify a new element size or you can have
the software reduce the size of the selected elements by a specified factor.

The graphic below shows a 2D mesh on the midsurface of a bracket. (A)
shows the elements around one bolt hole that we selected for refinement
using the 2D Local Remesh command. (B) shows the refined mesh. Here,
the selected elements were refined by a specified Element Scale Factor of 0.3
of their original size.
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New transition method for 2D local remeshing

The 2D Local Remesh command uses a new transition algorithm to control
the rate of transition between the size of the elements in the region you refine
and the size of the elements adjacent to that region. This new transition
algorithm is more robust and predictable than the transition algorithm
currently used by the 2D Mesh command. You can use the Transition option
in the 2D Local Remesh dialog box to control the size gradient.

Note To compare the differences between the transition algorithm used by
the 2D Mesh command and the algorithm used by the 2D Local Remesh
command, you can use 2D Local Remesh to remesh an entire existing
mesh with the Transition option set to 1.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file
Toolbar

Advanced Simulation®2D Local Remesh
Menu Insert®Mesh®Local Remesh

Sweeping a 3D mesh between bodies

What is it?

Use the new 3D Sweep Between command to sweep a structured 3D mesh
between two solid bodies. For example, you can use 3D Sweep Between
to create a mesh of brick or wedge elements even if you do not have any
geometry to define a body. With the 3D Sweep Between command, the
software sweeps a mesh of elements from a source face to a target face. For
example, if you have a set of assembly components that you need to connect
but you do not have any geometry to represent the connection, you can sweep
a mesh of hexahedral elements between the components.

In the following graphic, (A) shows a pressure vessel that contains a void
between the outer housing and the inner volumes. Because there is no
geometry in the void space, we used the 3D Sweep Between command to
manually sweep a mesh from the interior face of the outer housing to the
inner volumes. (B) shows the two layers of hexahedral elements that the
software generated in that void.
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3D Sweep Between generates a non-associative mesh

The mesh that you create with the 3D Sweep Between command is not
associated to any geometry. The software does not update non-associative
meshes if the adjacent geometry changes or remeshes. Additionally, you
cannot modify a mesh that you create with the 3D Sweep Between command.
If you need to make changes to an existing manual swept mesh, you must
delete the mesh and recreate it.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file
Toolbar

Element Operations®3D Sweep Between
Menu Insert®Mesh®3D Sweep Between
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Support for NX Nastran spot weld connections

What is it?

Use the new CFAST/CWELD Connection command to create NX Nastran
CFAST and CWELD type connections in Advanced Simulation. In NX
Nastran, you use CFAST and CWELD elements to model connections, such as
fasteners, spot welds, or rivets, between multiple sheet bodies. You can use
CFAST and CWELD elements to connect elements either within a single FE
model or between FE models in an assembly FEM.

CFAST and CWELD connections:

• Are not actual elements. They are simply connection definitions. NX
Nastran internally generates the constraint equations that define the
stiffness for the CFAST or CWELD connections when you solve the model.

• Provide alternatives to traditional NX Nastran connection methods, such
as CBAR, RBE2, or RBE3 elements or MPC constraints. In general,
CWELD and CFAST connections are easier to create and use.

For more information on connection elements in NX Nastran, see Special
Element Types in the NX Nastran Element Library Reference Manual.

In the following graphic, (A) shows the location of the rivets which represent
the points on which to create the CWELD elements. (B) shows the two
different meshes (physical property table IDs) that are connected by the
CWELD elements. (C) shows the CWELD connections that the software
creates at those locations.
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Defining a CFAST or CWELD connection

In the new CFAST/CWELD Connection dialog box, you select the point or
points at which you want to create the connection. Typically, these points
represent the locations of spot weld or rivets. You then specify a search
distance from that point. When you click OK or Apply in the dialog box,
the software finds the meshes to connect by searching for unique physical
property table IDs that lie within the specified distance.

In NX Nastran, you use the PFAST and PWELD bulk data entries to control
the properties of the weld or fastener, including the material and diameter
of the fastener or weld. In NX, you specify the properties in the new PFAST
or PWELD physical property table dialog boxes.

CFAST and CWELD connections in the Simulation Navigator

The software places all CWELD and CFAST connections in the 0D
Connections node in the Simulation Navigator. For example:

0D Connections
CWeld_Collector(1)
CWeld_Mesh_1
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You cannot edit an existing CFAST or CWELD connection. If you need to
modify an existing CFAST or CWELD connection, you must delete the
connection and recreate it.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file with NX Nastran as the specified

solver
Toolbar Advanced Simulation®CFAST/CWELD Connection

Menu Insert®Mesh®CFAST/CWELD Connection

Manual element creation enhancements

What is it?

You can now use the Element Create command to manually create the
following additional element types:

• Linear and parabolic tetrahedrons (Tet4 and Tet 8 elements)

• Linear and parabolic hexahedrons (Hex8 and Hex20 elements)

• Parabolic pentahedrons (Wedge15 elements)

When you create these new element types, you select the nodes and, in the
case of parabolic elements, the midnodes that define the element’s topology.
Messages in the cue line help you select the nodes in the appropriate order.

In previous releases, you could only create these types of elements using one
of the geometry-based, automatic meshing commands, such as 2D Mesh or
3D Swept Mesh. The ability to create these types of elements manually can
be helpful in cases in which your model either does not contain any CAD
geometry or contains regions without any CAD geometry.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file
Toolbar

Element Operations®Element Create
Menu Insert®Element®Create
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Element Modify Connectivity enhancements

What is it?

You can use new options in the Element Modify Connectivity dialog box to:

• Modify the leg nodes of a spider-type connection, such as a Nastran
RBE3 element. For example, you can add additional leg nodes or remove
existing leg nodes.

• Swap the end nodes of any two-noded 1D element.

In the new Elements to Modify list:

• Select Single Element to modify the connectivity of a single element. For
example:

o For 2D or 3D elements, you can replace a node with another node that
is not already associated with that element.

o For two-noded 1D elements, you can either replace a node or swap
the two end nodes.

o For 1D connection elements, such as Nastran RBE2 or RBE3 elements,
you can either replace a node or modify the leg nodes.

• Select Elements Attached to Selected Node to modify the connectivity of
all elements attached to a single node by replacing that node with another
node. In previous releases, this was the only available option.

The following graphic shows an example of how you can use Element Modify
Connectivity to add additional leg nodes to an RBE3 element. In (A), the node
at the center of the RBE3 is not connected to one of the nodes around the hole.
We used the Spider Leg Nodes option in the Element Modify Connectivity
dialog box to select the missing node. (B) shows the modified RBE3 element.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file
Toolbar Element Operations®Element Modify Connectivity

Menu Edit®Element®Modify Connectivity

Import and export

Importing a solver input file into an existing FEM or Simulation file

What is it?

For all solvers supported in Advanced Simulation, you can now import a
solver input data file into an existing FEM or Simulation file and append
the solver data to the existing data.

All FEM and Simulation file entities are imported and appended:

• Nodes

• Elements

• Coordinate systems

• Physical properties

• All other entities, including materials, loads, constraints, regions, degree
of freedom sets, solver-specific simulation objects, solver-specific modeling
objects, and groups.

To avoid conflicts between the IDs of imported data and existing data, you
specify numerical offsets to control how the ID for each type of imported
entity is generated. The software generates the default offset for each type of
entity by using the next valid ID (the highest ID + 1).

When you import a universal (.unv) file, units will be converted to the units of
the target FEM or Simulation file.

This command is not supported for assembly FEMs.

Where do I find it?

Application Advanced Simulation
Menu File®Append
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Nastran support enhancements

Support for surface-to-surface contact

Beginning with this release, Surface-To-Surface Contact is available in NX
Nastran solution SEBUCKL 105.

For more information, see Surface-to-Surface Contact in the Advanced
Simulation online Help.

Where do I find it?

Application Advanced Simulation

Prerequisite An active NX Nastran solution SEBUCKL 105.
Toolbar

Advanced Simulation®Surface-to-Surface Contact
Simulation
Navigator

Right-click the Simulation Object Container®New
Simulation Object®Surface-to-Surface Contact

Edge-to-Surface gluing

What is it?

Use the Edge-to-Surface Gluing simulation object to connect an edge to a
surface to prevent relative motion in all directions.

To glue an edge to a surface, you must first define the source and target
regions where you want to create glue elements. Glue elements are stiff
springs that connect and constrain the edges and surfaces. A region is a
collection of element edges or free faces in a section of the model where you
expect gluing or contact to occur. You can create the source or edge region
using edges of shell or solid elements. You can create the target or surface
region using shell elements or free faces of solid elements.
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From the Edge-to-Surface Gluing dialog box, select a source region and target
region in the Simulation model. Specify a search distance and additional
glue parameters.

When you solve or export your model, the options in the Edge-to-Surface
Gluing dialog box define a BGSET bulk data entry in your NX Nastran input
file.

Supported analysis types

Edge-to-Surface Gluing is available for all structural NX Nastran solution
sequences except for SOL 601 and 701. It is not supported in axisymmetric
solutions.

Using a Glue Parameters modeling object to control the glue algorithm

If you include an Edge-to-Surface Gluing simulation object in your solution,
you can use the options in the Glue Parameters dialog box to locally override
NX Nastran’s global glue parameters. You set global glue parameters using
the Global Glue Parameters option on the Case Control page of the Solution
dialog box. The glue parameter overrides correspond to the BGPARM bulk
data entry in your NX Nastran input file.

For more information, see Glue Parameters overview in the Advanced
Simulation online Help.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file with an NX Nastran solution active
Toolbar

Advanced Simulation®Edge-to-Surface Gluing

Creating edge regions

What is it?

When the solution type is NX Nastran, you can now create edge regions and
surface regions when you work with glue commands. In previous releases, you
only needed to create surface regions when you worked with glue commands.

A new Edge Region option is available in the Simulation Regions dialog box.

Why should I use it?

You can use the Edge Region option to define the source edges for the new
Edge-to-Surface Gluing command.
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Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file with an NX Nastran solution active
Toolbar

Advanced Simulation®Simulation Region ®Type
list®Edge Region

Enhancements to DDAM event in Response Simulation

What is it?

In NX Response Simulation, when you use the Dynamic Design Analysis
Method (DDAM) capability, you can now:

• Specify a DDAM excitation with explicit coefficients for calculating the
reference acceleration and reference velocity.

• Change the minimum acceleration (minimum g) value used in the
equation that calculates the shock design value of acceleration.

In previous releases, you could only specify multipliers against the standard
coefficients (which adhere to the DDS-072-1 specification) and the standard
minimum g value was hard-coded at 6 g.

In addition, other design issues have been fixed.

• You can select only a single component direction for the DDAM excitation.

• You can create a DDAM event only if there is a single enforced motion
node in the model.

Where do I find it?

Application Advanced Simulation

Prerequisite Solved NX Nastran SEMODES 103 – Response
Simulation solution and a Response Simulation solution
process

Toolbar
Response Simulation toolbar®New Event
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Support for static subcases to define differential stiffness

What is it?

You can now create a static subcase in each of these NX Nastran dynamic
solution types:

• SEMODES 103

• SEMFREQ 111

• SEMTRAN 112

The static subcase corresponds to the NX Nastran case control command
STATSUB. This case control command selects the static solution to use in
forming the differential stiffness for the solution types listed above. For more
information, see STATSUB in the NX Nastran Quick Reference Guide.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file with an NX Nastran 103, 111, or 112

dynamic solution active
Simulation
Navigator

Right-click an existing Solution®New Subcase

Importing loads as field data

What is it?

If you are working in the Nastran or Abaqus solver environment, the
Import Selective Loads as Field Data option has been added to the Import
Simulation dialog box. In previous releases, this option was available as
a Customer Default.

You can select the Import Selective Loads as Field Data option to import
certain types of loads, such as Nastran PLOAD2 pressure loads or Abaqus
DLOAD distributed loads, as spatial fields

When you import complex models with many different boundary conditions,
the Import Selective Loads as Field Data option improves performance and
usability. Clearing the Import Selective Loads as Field Data option may
result in slower import processing and a very extensive listing of boundary
conditions in the Simulation Navigator.
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Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation active with Nastran or Abaqus as the

specified solver
Menu File®Import®Simulation

Import and export support enhancements

What is it?

This release includes a number of improvements to the import and export
support for Nastran input files.

Selective import and export

You now have more granular control over the Nastran input file syntax that
NX imports and exports.

• When you import a Nastran input file, you can use the new Selective
Import options in the Import Simulation dialog box to control which bulk
data entries that NX imports. You can choose to selectively import the
entries either by their By card name or By card family (such as loads,
boundary conditions, or DOFs).

If you choose the By card name option, you can also choose to import
selected entries as either commented or uncommented User Defined Text.
Importing selected bulk data entries as uncommented User Defined
Text can be helpful if you need to import an entry that is only partially
supported for import (not all fields are supported). If you import the entry
as uncommented User Defined Text, NX imports all fields.

Note With this capability, do not to make modifications to the unsupported
commands or bulk data entries. If you make changes to unsupported
syntax, Nastran may either fail to solve the file with a FATAL error
message or generate incorrect results.

• When you export a Nastran input file, you can use the new By card name
option in the Filter Method list to selectively exclude certain bulk data
entries from export.
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Auxiliary file import

In the Import Simulation dialog box, when you import an ASCII input file,
you can use the new Auxiliary File Import support option to import a second
ASCII format file. NX includes the auxiliary input file with the primary input
file. For example, if you have a group of parameters that you typically use for
all analyses, you could save those parameters in a separate file. You could
then use the Auxiliary File Import option to include that parameter file each
time you import a .dat file.

Control over the import of unsupported syntax

If your Nastran input file contains syntax that is not supported in NX,
you can use the new Import unsupported cards option in the Import
Simulation dialog box to control whether the software imports that syntax as
a commented or uncommented User Defined Text modeling object.

For example, you can use this option if your model contains an element, such
as the RTRPLT bulk data entry, that is not supported in NX. If you import
the element as an uncommented User Defined Text modeling object and then
solve in NX, Nastran should solve the file and produce correct results.

Note With this capability, do not to make modifications to the unsupported
commands or bulk data entries. If you make changes to unsupported
syntax, Nastran may either fail to solve the file with a FATAL error
message or generate incorrect results.

Case control and bulk data entry support enhancements

The following table lists the support improvements for Nastran bulk data
entries and case control commands.

Name NX Nastran

import/export

support

MSC Nastran

import/export

support

Notes

BOLTLD Yes No

CFAST Yes No See **Unsatisfied xref title**

When you import from an .op2 file, PIDA

and PIDB are not supported.
CREEP Yes No

CWELD Yes No See **Unsatisfied xref title**

When you import from an .op2 file, PIDA

and PIDB are not supported.
EIGB Yes Yes Only METHOD=SINV is currently

supported.
MAT11 Yes No See **Unsatisfied xref title** for more

information.
MATSMA Yes No
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MBDEXPORT

Case Control

command

Yes Yes

PFAST Yes No The following fields are not currently

supported:

• GE

• MCID=-1

• MFLAG

See **Unsatisfied xref title** for more

information.
PWELD Yes Yes The following fields are not currently

supported:

• LDMIN

• LDMAX

• MCID=-1

• MSET

• TYPE

See **Unsatisfied xref title** for more

information.
SKIPOFF Case

Control command

Yes (for import only) Yes (for import

only)
SKIPON Case

Control command

Yes (for import only) Yes (for import

only)
SWLDPRM Export support only

for NX Nastran

No Only the PRTSW field is currently

supported.

See **Unsatisfied xref title** for more

information.
TABLED2 Yes Yes In general, NX converts TABLED2 entries

to TABLED1 entries on import. In NX, the

value for the independent variable can only

be specified once.

NX does not convert TABLED2 entries to

TABLED1 entries if:

• The TABLED2 entry is used in a SOL

601 or SOL 701 solution.

• The TABLED2 entry is applied to an

SPCD entry.
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TABLED3 Yes Yes In general, NX converts TABLED2 entries

to TABLED1 entries on import. In NX, the

value for the independent variable can only

be specified once.

NX does not convert TABLED2 entries to

TABLED1 entries if the TABLED2 entry is

used in a SOL 601 or SOL 701 solution.
TABLEST Yes Yes

TEMPD Yes Yes Currently:

• NX only supports a single TEMPD

entry per solution, not per subcase.

• NX expands the TEMPD entry into

TEMP bulk data entries on import.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation with NX Nastran or MSC Nastran

as the specified solver
Menu File®Import®Simulation

File®Export®Simulation

Abaqus support enhancements

Assigning boundary conditions to individual steps

What is it?

When Abaqus is the selected solver, use the new Step Manager command if
you want to use a table to select the loads, constraints, and simulation objects
assigned to each step in the Abaqus solution. After you make the changes,
the load, constraint, and simulation object assignments are displayed in the
Simulation Navigator. As in previous releases, you can continue to assign
loads, constraints, and simulation objects using the Simulation Navigator.

From the Step Manager, you can export the boundary condition settings to
a spreadsheet or a browser window.
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Solution-level simulation objects

In previous releases, you could assign simulation objects only to the solution.
In this release, you can assign simulation objects to either the solution or
to steps.

Boundary conditions that are assigned to the entire solution, rather than to
steps, do not appear in the Step Manager. These boundary conditions include
Automatic Coupling, Manual Coupling, Tie Surface, and Surface-based
Coupling in a General solution.

Step-level simulation objects

In this release, the following simulation objects are now assigned to steps:

• Surface-to-Surface Contact

• Contact with Clearance

• Bolt Contact with Clearance

• Surface-to-Surface Thermal Conductance

• Element Removal (new in NX 7.5.2)

You can use the Step Manager to select or deselect the simulation objects
for each step.
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If you migrate a model from a previous release, the simulation objects for
contact and thermal conductance are written to each step.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation file with Abaqus as the specified

solver
Simulation
Navigator

Right-click an existing Solution®Step Manager

Removing elements from an analysis step

What is it?

During an Abaqus structural analysis, you may need to add or remove
portions of a structure from the finite element model. Use the Element
Removal simulation object to selectively remove elements from one or more
steps in the analysis. In subsequent steps, you can use the Element Removal
command to reactivate elements, either with or without strain. You can use
this simulation object only in General Analysis steps.

The Element Removal simulation object corresponds to the *MODEL CHANGE

keyword.

Why should I use it?

The ability to deactivate and reactivate elements is useful, for example, for
analyzing excavation and construction of tunnels.

Where do I find it?

Application Advanced Simulation

Prerequisite An active Abaqus General Analysis solution
Toolbar

Advanced Simulation®Element Removal
Simulation
Navigator

Right-click the Simulation Objects node under a
step®New Simulation Object®Element Removal

Changing friction properties

What is it?

In a multi-step Abaqus solution, you can now change the friction properties of
contact pair interactions and change the friction definition for each solution
step.
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Use the new Abaqus Change Friction Definition modeling object to change
the friction properties of contact pair interactions. You can define:

• Surface interaction (the contact pair)

• Amplitude

• Friction parameters

Abaqus Change Friction Definition corresponds to the parameters for the
*CHANGE FRICTION and *FRICTION keywords.

From the Solution Step dialog box, you can change the friction definition
for each solution step.

Where do I find it?

To change the friction properties of contact pair interactions:

Application Advanced Simulation

Prerequisite An active Abaqus solution
Toolbar

Advanced Simulation®Modeling Objects ®Type
list®Abaqus Change Friction Definition

Menu Insert®Modeling Objects®Type list®Abaqus Change
Friction Definition

To change the friction definition at a solution step:

Application Advanced Simulation

Prerequisite An active Abaqus solution with a General solution step
Simulation
Navigator

Right-click the General solution step®Edit®Change
Friction tab®Create Change Friction ®Create

New solution control parameters

Use the new Abaqus Step Control Parameters type of modeling object to
control:

• The convergence control in a nonlinear solution.

• The time incrementation scheme.

The options in the Abaqus Step Control Parameters dialog box correspond
to the parameters for the *CONTROLS keyword. For example, you can use
the Set Analysis=Discontinuous option to set parameters that generally
improve efficiency for severely discontinuous behavior, such as frictional
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sliding or concrete cracking. The Set Analysis=Discontinuous option allows
the solver to complete a number of iterations before it begins any checks on
the convergence rate.

In most nonlinear analyses, you should not need to adjust the options in
the Abaqus Step Control Parameters dialog box. However, if your solution
contains extreme nonlinearities, you may need to adjust some of these options.

Where do I find it?

Application Advanced Simulation

Prerequisite An active Abaqus solution
Toolbar

Advanced Simulation®Modeling Objects ®Type
list®Abaqus Step Control Parameters

Menu Insert®Modeling Objects®Type list®Abaqus Step
Control Parameters

Importing loads as field data

What is it?

If you are working in the Nastran or Abaqus solver environment, the
Import Selective Loads as Field Data option has been added to the Import
Simulation dialog box. In previous releases, this option was available as
a Customer Default.

You can select the Import Selective Loads as Field Data option to import
certain types of loads, such as Nastran PLOAD2 pressure loads or Abaqus
DLOAD distributed loads, as spatial fields

When you import complex models with many different boundary conditions,
the Import Selective Loads as Field Data option improves performance and
usability. Clearing the Import Selective Loads as Field Data option may
result in slower import processing and a very extensive listing of boundary
conditions in the Simulation Navigator.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation active with Nastran or Abaqus as the

specified solver
Menu File®Import®Simulation
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Import and export support enhancements

What is it?

This release includes improved import and export support for a number of
Abaqus keywords.

Keyword support enhancements

This release includes support for a number of new Abaqus keywords.

Keyword Supported

parameters

Import

support

Export

support

Notes

*CHANGE

FRICTION

All except

ELEMENT

No Yes For more information, see

**Unsatisfied xref title**.
*CONTACT

INTERFERENCE

All Yes Yes *CONTACT INTERFERENCE

was only supported for export in

previous releases

*CONTROLS All No Yes
For more information, see

**Unsatisfied xref title**.
*COUPLING All Yes Yes *COUPLING was only

supported for export in previous

releases
*CREEP All No Yes For more information, see

**Unsatisfied xref title**.
*DISTRIBUTING All Yes Yes *DISTRIBUTING was only

supported for export in previous

releases
*MODEL CHANGE TYPE=ELEMENT

TYPE=CONTACT

PAIR

No Yes For more information, see

**Unsatisfied xref title**.

*OUTPUT All parameters

except OP

Yes

(partial)

Yes

*SECTION POINTS All Yes Yes *SECTION POINTS is used in

conjunction with the *BEAM

GENERAL SECTION keyword.

It locates the points in the beam

section for which stress and

strain output are required.
*TIE All Yes Yes *TIE was only supported for

export in previous releases
*VISCOELASTIC All No Yes For more information, see

**Unsatisfied xref title**.
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Support for temperature-dependent stress strain data

Temperature-dependent stress-strain curve data is now supported for both
import and export.

Where do I find it?

Application Advanced Simulation
Menu File→Import→Simulation

ANSYS support enhancements

Import support improvements

What is it?

This release includes improvements to the import support for ANSYS input
files.

Import support for nodal thickness values on 2D elements

When you import an ANSYS input file that contains a 2D mesh, NX now
imports the individual nodal thickness values associated with that mesh. In
ANSYS, you define nodal thickness values with real constants that have four
thickness values for each element. In previous releases, NX computed the
average thickness value for each 2D element in an ANSYS input file. Now,
NX imports the nodal thickness values for each 2D element. If the nodal
thickness values for an element vary, NX imports the individual values as
Element Associated Data.

Importing material orientation vectors as spatial fields

You can now control how the software imports material orientation vectors for
solid elements in the ANSYS solver environment. In the Import Simulation
dialog box:

• Select the Import 3D MOVs as field data check box to import any material
orientation vector data for solid elements as a single spatial field.

• Clear the Import 3D MOVs as field data check box to import material
orientation vector data for solid elements as physical property table data.
In NX, there is a one to one relationship between physical property
tables and mesh collectors. If your model contains a large number of
material orientation vector physical property definitions, the software
creates a large number of corresponding mesh collectors in the Simulation
Navigator. This can make your model difficult to manage.

What’s New in NX 8 6-207



CAE (Digital Simulation)

Note If a coordinate system is only used in a solver input file to provide the
orientation for the 3D material orientation vector, the software does not
import the coordinate system into NX. This ensures that the software
does not import numerous coordinate systems that are not required for
the analysis.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file with ANSYS as the specified solver
Menu File®Import®Simulation

LS-DYNA support enhancements

Basic import support now available

What is it?

NX now offers basic import support for LS-DYNA models. Beginning in this
release, you can now import an LS-DYNA keyword file into NX. NX currently
supports the import of a subset of LS-DYNA keywords. Keywords supported
for import include those for:

• LS-DYNA parts

• Nodes

• Elements (*ELEMENT_INERTIA_, *ELEMENT_DISCRETE,
*ELEMENT_SHELL, *ELEMENT_TSHELL)

• Coordinate systems

• Materials (such as isotropic, orthotropic, anisotropic, and
*MAT_COMPOSITE_DAMAGE)

• Groups of nodes (*SET_NODE)

• LS-DYNA sections
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Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file with LS-DYNA as the specified

solver
Menu File®Import

Import support enhancements

What is it?

This release includes import support for the LS-DYNA keywords listed in
the following sections.

Coordinate systems

*DEFINE_COORDINATE_NODES

*DEFINE_COORDINATE_SYSTEM

*DEFINE_COORDINATE_VECTOR

*DEFINE_SD_ORIENTATION (imported as the orientation vector for
*ELEMENT_DISCRETE type elements

Elements

*ELEMENT_BEAM

*ELEMENT_BEAM_OFFSET

*ELEMENT_BEAM_ORIENTATION

*ELEMENT_BEAM_ORIENTATION_OFFSET

*ELEMENT_BEAM_PID

*ELEMENT_BEAM_SCALAR
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*ELEMENT_BEAM_THICKNESS

*ELEMENT_DISCRETE (spring-damper)

*ELEMENT_INERTIA

*ELEMENT_INERTIA_OFFSET

*ELEMENT_MASS (non-distributed mass in NX)

*ELEMENT_MASS_NODE_SET (distributed mass in NX)

*ELEMENT_SHELL

*ELEMENT_SHELL_BETA

*ELEMENT_SHELL_MCID

*ELEMENT_SHELL_OFFSET

*ELEMENT_SHELL_THICKNESS

*ELEMENT_SOLID

*ELEMENT_SOLID_DOF

*ELEMENT_SOLID_ORTHO

*ELEMENT_SOLID_TET4TOTET10

*ELEMENT_TSHELL

Groups

The following keywords are imported into NX as groups of nodes:

*SET_NODE_(_TITLE)

*SET_NODE_COLUMN_(_TITLE)

*SET_NODE_GENERAL_(_TITLE)

*SET_NODE_LIST_(_TITLE)

*SET_NODE_LIST_GENERATE_(_TITLE)

The following keywords are imported into NX as groups of elements:

*SET_BEAM_(_TITLE)

*SET_BEAM_GENERAL_(_TITLE)

*SET_BEAM_GENERATE_(_TITLE)

*SET_DISCRETE_(_TITLE)

*SET_DISCRETE_GENERAL
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*SET_DISCRETE_GENERAL_(_TITLE)

*SET_DISCRETE_GENERATE_(_TITLE)

*SET_DISCRETE_GENERATE_TITLE_(_TITLE)

*SET_SHELL_(_TITLE)

*SET_SHELL_COLUMN_(_TITLE)

*SET_SHELL_GENERAL

*SET_SHELL_GENERAL_TITLE_(_TITLE)

*SET_SHELL_LIST_(_TITLE)

*SET_SHELL_LIST_GENERATE_(_TITLE)

*SET_SOLID_(_TITLE)

*SET_SOLID_GENERAL_(_TITLE)

*SET_SOLID_GENERATE_(_TITLE)

*SET_TSHELL_(_TITLE)

*SET_TSHELL_GENERAL_(_TITLE)

*SET_TSHELL_GENERATE_(_TITLE)

Materials

The following materials are imported into NX but are not currently referenced
by elements in NX. In NX, elements only refer to the LSDYNA Material ID.
• *MAT_001_(_TITLE)

• *MAT_002_(_TITLE)

• *MAT_002_ANIS_(_TITLE)

• *MAT_022_(_TITLE)

• *MAT_ANISOTROPIC_ELASTIC_(_TITLE)

• *MAT_COMPOSITE_DAMAGE_(_TITLE)

• *MAT_ELASTIC_(_TITLE)

• *MAT_ORTHOTROPIC_ELASTIC_(_TITLE)
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Nodes

• *NODE

• *NODE_RIGID_SURFACE (imported into NX as the *NODE keyword)

• *NODE_SCALAR_VALUE (imported into NX as the *NODE keyword)

LS-DYNA Part

In NX, all *PART keywords with options are imported as *PART in NX, except
for *PART_COMPOSITE, which is imported as a physical property table in the
Advanced Laminates module.

Spring constants for the *ELEMENT_DISCRETE keyword

These spring constant keywords are imported as modeling objects:

• *MAT_SPRING_ELASTIC_(_TITLE)

• *MAT_S01_(_TITLE)

Note Options such as _ALE, and _EFG are parsed but are not used in NX.

Section keywords

Section keywords are imported as modeling objects and used in conjunction
with the *PART physical property table in NX.

• *SECTION_BEAM_(_TITLE)

• *SECTION_DISCRETE_(_TITLE) (spring constants for
*ELEMENT_DISCTRETE, are imported as Modeling objects)

• *SECTION_SHELL_(_TITLE)

• *SECTION_SOLID_(_TITLE)

• *SECTION_TSHELL(_TITLE)

Note Options such as _ALE, and _EFG are parsed but are not used in NX.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file with LS-DYNA as the specified

solver
Menu File®Import
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Post-processing

Customizable header and color bar

What is it?

Beginning in this release, you can customize the header text that appears in
a post view, and you can assign custom ranges and colors to the color bar.

When customizing the header text, you can:

• Add or remove lines of text.

• Edit the default text.

• Replace text.

When customizing the color bar, you can:

• Modify the range of values assigned to a color band.

• Replace colors to draw attention to a particular range of values or define
a custom spectrum.

Why should I use it?

You can customize the header text to be more meaningful to the audience for
your analysis, to include project or product information, or to conform to
your company’s policies and standards.
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Where do I find it?

Application Advanced Simulation
Prerequisite Results loaded; post view displayed.

Toolbar Post Processing® Edit Post View
Menu Tools®Results®Edit Post View
Location in dialog
box Post View dialog box®Legend tab

Reference node deformation

What is it?

By default, when you create a deformed model display, nodal displacements
are transformed and scaled with respect to the origin of the current coordinate
system. Beginning in this release, you can transform and scale deformations
with respect to a selected node on the model.

You specify a reference node in the Deformation dialog box. You can select a
node from the model, or enter a node ID in the dialog box.

The following figure shows three rigid body modes transformed with respect
to the origin of the absolute rectangular coordinate system. The mode shapes
are displayed alongside the undeformed model.

You can select a node on the model to serve as a consistent reference node
for deformations. The same three rigid body modes now appear transformed
with respect to the selected reference node.
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Where do I find it?

Application Advanced Simulation
Prerequisite Results loaded; post view displayed.

Toolbar Post Processing® Edit
Menu Tools®Results®Edit Post View
Post-Processing
Navigator Right-click a post view®Set Deformation
Location in dialog
box

Post View dialog box®Display
tab®Deformation®Result®Reference Node

Results manipulation

What is it?

Use Results Manipulation to create new results by performing operations
on one or more existing results sets. Choose from two methods for
manipulating results:

• Envelope compares two or more results of the same type and component,
and returns the minimum or maximum value as a unitless, scalar
quantity. The selected components may belong to different load cases,
iterations, or solutions, but must be of the same result type (displacement
or stress) and be defined at the same output location (nodal, elemental, or
element-nodal).

• Combination uses standard NX expression syntax to perform operations
on one or more results of the same type. The selected results may belong to
different load cases, iterations, or solutions, but must be the same in terms
of result type, output location, and solution type (either real or complex).
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Both methods collect results across the selected types or components based on
element or node IDs. Therefore, the underlying FE models must be compatible
in terms of the number of nodes and elements, IDs, and element types.

New results are saved as universal (.unv) files. Optionally, you can include
model data (nodes and elements) in addition to results values. You can
automatically import results into NX for further post-processing or save them
as a companion result to an existing solution.

Where do I find it?

Application Advanced Simulation
Prerequisite One or more solution results loaded or imported.

Toolbar Post Processing® Results Manipulation
Menu Tools®Results®Results Manipulation

Durability

BWI fatigue life criterion

What is it?

The BWI fatigue life criterion predicts the fatigue failure in welded joints.
This criterion takes into account local stress concentrations which may be due
to the weld itself. The weld equation relates the number of stress cycles until
failure occurs to the stress range of a stress cycle for a particular weld class.

BWI is based on the British Welding Institute’s (BWI) formulation which
uses the weld class as the basis for the fatigue life estimate. Because the
BWI weld classes in NX are defined by the British Standard BS 5400, you
need to be familiar with the weld class definitions to use the BWI fatigue life
criterion accurately.

The weld criterion does not use the material properties. You need to specify:

• The weld class in the BWI Weld Class list.

• The number of standard deviations below the mean value of the stress
range in the Number of Standard Deviations field.

The BWI fatigue life criterion is recommended for both high-cycle and
low-cycle applications.
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This criterion can also:

• Model the mean stress effect using a method that you specify in the
Equivalent Stress Method list.

• Correct for the plate thickness when you select Use Plate Thickness
Correction. See **Unsatisfied xref title** for more information.

See BWI fatigue life criterion in the NX 7.5.2 Maintenance Release for more
information.

Where do I find it?

Application Advanced Simulation

Toolbar

Durability ® Static Durability Event / Transient

Durability Event
Menu Insert ® Durability ® Event ® Static / Transient

Simulation
Navigator

Right-click the Durability solution process node® New
Event ® Static / Transient

Right-click the static event or transient event node®
Edit

Location in dialog
box

Fatigue tab ® Fatigue Life group ® Fatigue Life
Criterion list

Dang Van fatigue safety factor output

What is it?

You can now use the new Dang Van method to calculate the fatigue safety
factor and failure index result sets. The Dang Van method is a new high
cycle multiaxial fatigue safety factor method that is based on the mesoscopic
approach.

The Dang Van method is recommended for high-cycle fatigue.

To use the Dang Van method, you need to specify the following new material
properties:

• Fatigue Limit Strength in Bending

• Fatigue Limit Strength in Torsion

These material properties are available in the Dang Van Parameters group
on the Durability tab of the Isotropic Material dialog box
See Dang Van fatigue safety factor in the NX 7.5.2 Maintenance Release
for more information.
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Why should I use it?

Use the Dang Van fatigue safety factor output to determine whether fatigue
load paths cause crack initiation.

Where do I find it?

Application Advanced Simulation

Toolbar

Durability ® Static Durability Event / Transient

Durability Event
Menu Insert ® Durability ® Event ® Static / Transient

Simulation
Navigator

Right-click the Durability solution process node® New
Event ® Static / Transient

Right-click the static event or transient event node®
Edit

Location in dialog
box

Fatigue tab® Fatigue Safety Factor group® Fatigue
Safety Factor Output ® Output list

Thickness correction for BWI and Stress Life criteria

What is it?

The new Use Plate Thickness Correction option lets you correct the stress
amplitude or stress range for the plate thickness in the following fatigue
life criteria:

• BWI

• Stress Life

To correct for the plate thickness, you need to specify the values for the
Plate Thickness Ratio and Plate Thickness Exponent. See Plate thickness
correction in the NX 7.5.2 Maintenance Release for more information.

Why should I use it?

In general, the fatigue strength of welds decreases as the joint thickness
increases. This effect is more pronounced for welds that are oriented
transverse to the applied stress direction. Use the plate thickness correction
to account for this effect.
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Where do I find it?

Application Advanced Simulation

Toolbar

Durability ® Static Durability Event / Transient

Durability Event
Menu Insert ® Durability ® Event ® Static / Transient

Simulation
Navigator

Right-click the Durability solution process node® New
Event ® Static / Transient

Right-click the static event or transient event node®
Edit

Location in dialog
box

Fatigue tab ® Fatigue Life group ® Plate Thickness
Correction subgroup

Advanced Durability tutorial

What is it?

A getting started tutorial is now available to help you learn how to use the
functionality of Advanced Durability. See Getting started with the Durability
solution process to access the activity in the NX 7.5.2 Maintenance Release.

NX FE Model Correlation and NX FE Model Updating

Export to UNV overview

What is it?

Use the Export to UNV command to export the active sensor selection
configuration to a UNV file. The UNV file also contains coordinate systems
and node coordinates.
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The following table lists the UNV datasets that are written.

UNVdataset number Content Additional information

151 Header

164 Units

2400 Model Header

2420 Coordinate Systems The origin is always written in SI units.

2411 Nodes
Nodes are written in the unit system defined by dataset

164. Node values are in double precision.

1802 Coordinate Trace Coordinate traces contain the active sensor directions.

Why should I use it?

Use this command to export the sensor locations to an UNV file that you can
use with a third-party software to obtain experimental modal test data.

Where do I find it?

Application Advanced Simulation
Prerequisite An active sensor selection configuration
Simulation
Navigator

Right-click the Pre-Test Planning solution process node
® Export to UNV

Automatic node map size reduction

What is it?

An Allow Size Reduction option is now available in the Correlation dialog box.
Use this option to limit the size of the node map that is created between the
work solution and the reference solution by the Correlation solution process.

You specify the node map size in the Size Limit option that becomes available
when you select the Allow Size Reduction check box.

NX reduces the node map to the specified size by dropping paired nodes.
Only nodes that are in close proximity to others are recursively dropped in
order to maintain a good overall coverage of the entire correlation domain.
Nodes that are part of the work solution’s Analysis Set (ASET) or Degree of
Freedom Set (USET,U2) are never dropped. This ensures that any nodes
important to you are always retained.
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The final node map size may be smaller than the specified Size Limit value
when:

• The reference model has fewer nodes than the specified size.

• NX finds fewer node pairs than the specified size due to the node matching
tolerance.

Why should I use it?

You can reduce memory requirements and the computation speed of the
correlation metrics, when you correlate two solutions that have large-scale
meshes with a large number of modes and paired nodes.

You can also create a matching DOF set from the resulting Node Map node
when correlating the same analysis solution. The created DOF set has the
number of nodes specified by the Size Limit value, and is evenly distributed
across the model.

Where do I find it?

Application Advanced Simulation

Toolbar Correlation ® New Correlation
Menu Insert ® Correlation ® New Correlation
Simulation
Navigator Right-click the Correlation solution process node® Edit
Location in dialog
box

Node Map Settings group ® Allow Size Reduction
check box

Mode shape data handling improvements

What is it?

The Pre-Test, Correlation, and Model Update solution processes now handle
large sets of mode shape data more efficiently. NX defers the loading of mode
shape data until it performs the needed computation. Only data at nodes that
are part of the correlation domain or of a pre-test DOF set are loaded. The
data is then cached in memory for subsequent computations.

U-Set DOF node supported for SEMODES 103 solution

What is it?

The U-Set DOF [#] node is now also supported for NX Nastran SEMODES
103 solution. This node is displayed in the Simulation Navigator under the
work solution results node when an Degree of Freedom (USET,U2) DOF set
exists in the OP2 result file.
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Correlation 1
Solution 2 Results
Normal Modes [10]
Sensors [30]

Solution 1 Results
U-Set DOF [20]
Normal Modes [10]

The U-Set DOF [#] node is shown for information only. U-Set DOFs do not
affect correlation results, but they are taken into account for the node map
size reduction. See Title not found for more information.

Correlation and Model Update related solution sequences supported in NX
Nastran 7.1

What is it?

NX Nastran version 7.1 or later now executes the following solution sequences
on all NX Nastran architectures:

• DESOPT 200 - Model Update solution sequence

• The optional reduced system matrices computation for the SEMODES
103 solution sequence

In previous releases, NX had to use a DMAP alter in order for Nastran to
execute these solution sequences. Because the DMAP alter is no longer
required, NX ignores theModel Update Database Generation and Correlation
Database Generation options on the General tab in the Solution dialog box.

Correlation tutorial

What is it?

A getting started tutorial is now available to help you learn how to use the
Correlation solution process in NX FE Model Correlation. See Getting started
with the Correlation solution process to access the activity in the NX 7.5.2
Maintenance Release.

6-222 What’s New in NX 8



CAE (Digital Simulation)

NX Laminate Composites

Fill Laminate overview

What is it?

Use the Fill Laminate command to create a 3D laminate between a set of
ANSYS 2D dependent meshes.

The global layup must be defined on the master mesh of the 2D dependent
meshes.

NX creates the following:

• A 3D mesh collector, for each 2D mesh collector referred to by the filling
operation, that contains meshes for the 3D plies. The 3D mesh collectors
point to laminate physical properties, with stacking recipes set to Inherit
from Layup.

• One mesh collector that contains ply drop-off meshes, and is called
Extrusion Resin. The Extrusion Resin collector points to a solid property
and to the isotropic Epoxy material from the NX library. You can change
this material.

• One 3D mesh, for each combination of ply and 2D mesh collector, that
contains bricks and wedges.

• Drop-off meshes that contain combinations of wedge, tetrahedron, and
pyramid elements. These meshes are called Resin Elements.
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2D dependent meshes and transparent polygon body

3D laminate created between the set of 2D dependent meshes

The 3D elements are extruded to fill the void between the two sets of 2D
dependent meshes. NX computes the thickness of each layer by taking into
account the thickness of the plies of the global layup and the distance between
the set of 2D dependent meshes.

Note The Fill Laminate command currently creates 3D meshes only in the
ANSYS solver environment.

The following 2D ANSYS element types are supported:

• SHELL91 (6)

• SHELL91 (8)

• SHELL99 (6)

• SHELL99 (8)

The 3D mesh consists of SOLID186 elements.

You cannot view the material orientations of the 3D elements. These
material orientations are computed by the ANSYS solver using the material
orientation of the base 2D mesh.

You cannot view the fiber orientations of the 3D elements.

Warning If the active layup for the base 2D mesh changes, the 3D meshes
are not automatically updated. You must delete the 3D meshes, and use
the Fill Laminate command again.

Why should I use it?

Using solid meshes provides better results in the ply out-of-plane direction.
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Where do I find it?

Application Advanced Simulation
Prerequisite ANSYS solver environment

Toolbar Laminates ® Fill Laminate
Menu Insert ® Laminate ® Fill

Output laminate physical property table to Nastran’s PCOMPG

What is it?

You can now output the laminate physical property table to Nastran’s
PCOMPG card.

The Nastran’s PCOMPG card is similar to Nastran’s PCOMP card. In
addition to defining PCOMP quantities for the Nastran solver, PCOMPG
also defines the global ply ID.

Note You cannot output the laminate physical property table to Nastran’s
PCOMPG card if the Stacking Recipe is set to Symmetric or Symmetric
with core in the Laminate Modeler dialog box.

Why should I use it?

When you export the laminate to the PCOMPG card, you can more easily
track the results for the same ply across different elements in the Post
Processing Navigator.

Where do I find it?

Application Advanced Simulation

Toolbar Laminates toolbar® Laminate Physical Property
Menu Insert ® Laminate ® Physical Property
Location in dialog
box

Solver Properties group ® Output Format list ®
PCOMPG

New unidirectional ply material properties

What is it?

In support to the new Puck failure theory, the following properties have been
added for the unidirectional type of ply materials:

• Mean Stress Magnification Factor
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• Shear Strain Coefficient is the constant term of the empirical shear
correction term that is a function of shear strain.

• Inclination Parameter + is the slope of the fracture envelope at zero
normal transverse stress, in tension side.

• Inclination Parameter – is the slope of the fracture envelope at zero
normal transverse stress, in compression side.

These properties are not common material properties and their value must
be found with a set of experiments. The default values were determined
for an unidirectional ply material of epoxy and carbon fiber with 60% fiber
volume fraction.

See Title not found for more information.

Where do I find it?

Application Advanced Simulation

Toolbar Laminates toolbar® Ply Materials
Menu Insert ® Laminate ® Ply Materials
Location in dialog
box Type list® Unidirectional ® Create ® Puck group

Additional failure theories

What is it?

Two new failure theories are now available in the Laminate Modeler dialog
box:

• Puck

• LaRC02

Both theories apply only to ply materials with unidirectional fibers.

Unlike existing failure theories which only have one failure index per theory,
these new theories calculate multiple failure indices:

• Fiber failure index

• Matrix failure index

Same consideration as for the failure index applies to margin of safety and
strength ratio.

When you graphically post process failure theory results, the enveloping rule
that you defined in the Laminate Graphical Post Report dialog box are used.
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Thus, for example, if you want to display failure index results for a laminate
that has the LaRC02 failure theory selected and the enveloping rule is set
to Abs. Max, the displayed failure index for each element will be the failure
index that is the absolute maximum between the fiber failure index at that
element and the matrix failure index at that element.

See Puck failure theory and LaRC02 failure theory for more information.

The Puck failure theory needs additional ply material properties that you
define in the Laminate Ply Material dialog box. See Title not found for more
information.

Why should I use it?

These theories take into account both the fiber and the matrix so they can
determine if the failure occurs due to the fiber or the matrix. The other
theories cannot determine that.

Where do I find it?

Application Advanced Simulation

Toolbar Laminates toolbar® Laminate Physical Property
Menu Insert ® Laminate ® Physical Property
Location in dialog
box Laminate Properties group® Failure Theory list

FiberSIM ply name in Ply Description field

What is it?

When you import FiberSIM layups using the Imported Layup command, NX
reads the FiberSIM ply ID from the FiberSIM XML file and stores the IDs
in the Description cell in the Layup Modeler dialog box for each ply in the
imported layup.

Why should I use it?

This improvement allows you to know which NX ply corresponds to which
FiberSIM ply.
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Where do I find it?

Application Advanced Simulation
Prerequisite Import at least one FiberSIM layup.
Simulation
Navigator Right-click the layup node ® Edit
Location in dialog
box Description column

Improved performance for importing plies

What is it?

When you import ply using the Import Layup command, NX does it quicker
and more efficiently than in the previous releases.

Automatic grouping of layups and global plies

What is it?

You can now create groups that contain elements, polygon faces, or both that
are referenced by a given layup or a given ply in a layup.

The following table describes the new right-click commands.

Node Right-click command Description

Layups Auto-create
Layup FE Groups

Creates one or more groups. Each group contains

the elements, polygon faces, or both in one layup

and has the name of that layup.
Auto-create
Layup FE Group

Creates one group. The group contains the

elements, polygon faces, or both in the selected

layup and has the name of that layup.

Individual layup

node

Auto-create
Ply FE Groups

Creates one or more groups. Each group contains

the elements, polygon faces, or both in one ply of

the selected layup and has the name of that layup

followed by the name of that ply.
Individual ply node Auto-create

Ply FE Group
Creates one group. The group contains the

elements, polygon faces, or both in the selected

ply and has the name of ply’s corresponding layup

followed by the name of that ply.

Where do I find it?

Create one or more element groups, one for each layup.

Application Advanced Simulation
Simulation
Navigator

Right-click the Layups node® Auto-create Layup FE
Groups
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Create one layup element group.

Application Advanced Simulation
Simulation
Navigator

Right-click the individual layup node ® Auto-create
Layup FE Group

Create one or more element groups, one for each ply in a given layup.

Application Advanced Simulation
Simulation
Navigator

Right-click the individual layup node ® Auto-create
Ply FE Groups

Create one ply element group.

Application Advanced Simulation
Simulation
Navigator

Right-click the individual ply node® Auto-create Ply
FE Group

Command name change

What is it?

The following table shows the old and new names of the following right-click
commands.

Node Icon Old right-click
command name

New right-click
command name

Zones Create Element Groups Auto-create Zone FE
Groups

Name of physical
property

Create Element Groups Auto-create Zone FE
Groups

Individual zone
node

Create Element Groups Auto-create Zone FE
Group

Where do I find it?

Application Advanced Simulation

Simulation
Navigator

Right-click the Zones node or node with the name of
the physical property® Auto-create Zone FE Groups

Right-click the individual zone node ® Auto-create
Zone FE Group
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NX Thermal and Flow, Electronic Systems Cooling, and Space Systems
Thermal

Create a board mesh with orthotropic thermal conductivity in a new Simulation file

What is it?

You can now create a Simulation file that also takes into account the
orthotropic thermal conductivity behavior of a PCB. This behavior is modeled
using:

• Thermal conductivity fields, one each layer of the PCB.

• Thermal resistance fields, one between each layer of the PCB due
connections given by vias and dielectric layers.

• Override Set simulation objects that replace the mesh thermal
conductivity value with the thermal conductivity field values.
Boards with multiple layers are supported using multi-layer shells, in
this case one Override Set simulation object is created for each layer of
the multi-layer shell mesh.

• Thermal Coupling simulation objects that connect each layer of the PCB
using the thermal resistance fields.

PCB Exchange uses the board thermal conductivity XML file to create the
thermal conductivity and thermal resistance fields. You specify the board
thermal conductivity XML file in the Create ESC Solution dialog box.

Why should I use it?

You can model your electronic systems more accurately. Complex heat
conduction paths exist in PCBs due to dielectrics, traces, vias, and other
entities. These paths have a strong impact on the thermal model. These
are best represented by discretazing each layer of the PCB and using this
information in the thermal mesh.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled
Thermal-Flow

Electronic Systems Cooling

Advanced Thermal/Flow with
ESC

6-230 What’s New in NX 8



CAE (Digital Simulation)

Where do I find it?

Application PCB Exchange
Prerequisite An XML Board Thermal Conductivity file.

Toolbar PCB Exchange ® Create ESC Solution

Menu
PCB Exchange ® Thermal/Flow Simulation® Create
ESC Solution

Freeze and reactivate flow field calculation at specified times

What is it?

In addition to the already existing freeze flow conditions, you can now set
specified times at which you want to:

• Freeze the flow field calculation. In this case, only energy and scalar
equations are solved.

• Reactivate the flow field calculation. In this case, all flow solver equations
are solved.

All freeze flow conditions are cumulative.

Supported solvers and analysis types

Solver Analysis Type Solution Type

NX Electronic Systems

Cooling

Coupled Thermal-Flow Electronic Systems Cooling

Advanced Thermal/Flow with ESC
Flow Flow

Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar
Advanced Simulation toolbar ® Solve ® Edit
Solver Parameters

Menu Analysis ® Solve ® Edit Solver Parameters
Simulation
Navigator Right-click the solution node® Edit Solver Parameters
Location in dialog
box

3D Flow Solver tab® Freeze Flow Field for Transient
group® Freeze Flow Field at Specified Times checkbox
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Track the convergence of the thermal solver during the solve

What is it?

During the solve, in addition to tracking the convergence of the flow solver in
the Solution Monitor, you can now also track the convergence of the thermal
solver. In a thermal or coupled steady state solution, you can display the
maximum temperature difference between two consecutive iterations as a
function of iterations.

In a thermal or coupled transient solution, in addition to the previously
shown graph, you can also display the number of iterations per time step
required for convergence as function of the time.

• The maximum temperature difference as function of iterations in
Maximum temperature difference.png.

• The number of iterations per time step as function of time in Iterations
vs Time.png.

Why should I use it?

Use this option to monitor the convergence of the maximum temperature
difference between two iterations in your model during the solve.

Supported solvers and analysis types

Solver Analysis Type Solution Type

Electronic Systems Cooling

Advanced Thermal/Flow with ESC

NX Electronic Systems

Cooling

Coupled Thermal-Flow

Thermal-Flow

NX Space Systems

Thermal

Thermal Space Systems Thermal
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Solver Analysis Type Solution Type

Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar Advanced Simulation toolbar®Solution

Menu

Insert®Solution

Analysis®Solve ®Edit Solution Attributes

Simulation
Navigator

Right-click the Simulation file node®New Solution

Right-click the solution node®Edit
Location in dialog
box Solution Monitor window®Graphs®Convergence

Track the results from the full model during the solve

What is it?

During the solve, in the Solution Monitor, you can now display the following
graphs:

• For a thermal and coupled steady state solution, the solid temperature as
function of iterations.

• For a thermal and coupled transient solution, the solid temperature as
function of time.

• For a flow and coupled steady state solution:

o The fluid temperature as function of iterations

o The fluid velocity as function of iterations

o The fluid pressure as function of iterations

• For a flow and coupled transient solution:

o The fluid temperature as function of time

o The fluid velocity as function of time
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o The fluid pressure as function of time

Solid temperature as a function
of iterations

Fluid temperature as a function
of iterations

Fluid velocity as a function of
iterations

Fluid pressure as a function of
iterations

After the solve, the software saves the previous graphs in the run directory,
in PNG format.

Why should I use it?

Use this option to monitor flow velocity, pressure, and temperature during
flow or coupled analysis and solid temperature during thermal or coupled
solution.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar Advanced Simulation toolbar®Solution

Menu

Insert®Solution

Analysis®Solve ®Edit Solution Attributes

Simulation
Navigator

Right-click the Simulation file node®New Solution

Right-click the solution node®Edit
Location in dialog
box

Solution Monitor window®Graphs®Track
Results®Full Model

Track during solve report

What is it?

You can now track during a thermal or coupled solution, the following
temperatures of the thermal region of your model for the selected elements:

• Average temperature as function of time in a transient solution or
function of iterations in a steady state solution.

• Minimum temperature as function of time in a transient solution or
function of iterations in a steady state solution.

• Maximum temperature as function of time in a transient solution or
function of iterations in a steady state solution.
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In previous versions, you could only track flow quantities of the flow region of
your model.

After the solve, the software saves the graphs and the data in the run
directory. The thermal data is stored in TrackReportThermal.csv and the flow
data is stored in TrackReportFlow.csv.

Why should I use it?

Use this option to monitor the temperature during the thermal analysis on
selected elements of your model.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation
Toolbar Advanced Simulation toolbar®Report
Simulation
Navigator

Right-click the Simulation Object container node®New
Simulation Object®Report

Location in dialog
box Type list®Track During Solve

Select initial condition time step from a previous solution

What is it?

In this release, the usability of defining the time step from another solution
as the initial condition for the current solve is improved.

Use the new Results to Use for Initial Conditions list in the new Initial
Conditions Selection group on the Initial Conditions tab of the Solution
dialog box to set the initial condition time step to:
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• The start time of the current solution by selecting At Start Time.

• Any other time by selecting At Specified Time and specify the time in the
Initial Conditions Use Results at Time box.

Previously, you needed to specify the start time to be the same as the time
step that has the results you want to use as the initial condition.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal
Flow Flow

Advanced Flow
Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

NX Thermal and Flow

Axisymmetric Thermal Axisymmetric Thermal

Advanced Axisymmetric
Thermal

Where do I find it?

Specify the initial condition time step while creating a solution

Application Advanced Simulation

Toolbar Advanced Simulation toolbar® Solution
Menu Insert ® Solution
Simulation
Navigator Right-click the Simulation file node® New Solution
Location in dialog
box

Initial Conditions tab® Initial Conditions list® From
Results in Other Directory or From File (TEMPF format)
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Specify the initial condition time step while editing an existing solution

Application Advanced Simulation

Toolbar
Advanced Simulation toolbar ® Solve ® Edit
Solution Attributes

Menu Analysis ® Solve ® Edit Solution Attributes
Simulation
Navigator Right-click the solution node ® Edit
Location in dialog
box

Initial Conditions tab® Initial Conditions list® From
Results in Other Directory or From File (TEMPF format)

Specify duct flow solver options

What is it?

You can now specify the following duct flow solver options in the new Duct
Flow Solver group on the Thermal Solver tab in the Solver Parameters
dialog box:

• Pressure Convergence Criteria box sets the value for the pressure
convergence of the duct flow network equations.

• Iteration Limit box sets the maximum number of iterations for the
hydraulic loop.

• Relaxation Factor box sets the damping parameter for the duct network.

• Convergence Trace check box defines whether you want a summary of
duct network convergence printed for each hydraulic loop iteration.

You can now specify the following duct flow option in the new Duct Flow
Parameters group on the Thermal tab in the Solution dialog box:

• Compressible Flow check box sets if the flow in the ducts is compressible
or not. If the flow is compressible, the density and static pressure
calculations take into account compressible effects for all elements with
Mach number greater than 0.1.

Why should I use it?

You can now easily define necessary duct flow options in the Solution and
Solver Parameters dialog boxes. Previously you could only define them
through Advanced Parameters modeling objects.
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Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Advanced Thermal
Flow Advanced Flow

NX Thermal and Flow

Coupled Thermal-Flow Advanced Thermal-Flow

Where do I find it?

Solver Parameters dialog box

Application Advanced Simulation

Toolbar
Advanced Simulation toolbar ® Solve ® Edit
Solver Parameters

Menu Analysis ® Solve ® Edit Solver Parameters
Simulation
Navigator Right-click the solution node® Edit Solver Parameters
Location in dialog
box Thermal Solver tab® Duct Flow Solver group

Solution dialog box

Application Advanced Simulation

Toolbar

Advanced Simulation toolbar® Solution

Advanced Simulation toolbar ® Solve ® Edit
Solution Attributes

Menu

Insert ® Solution

Analysis ® Solve ® Edit Solution Attributes

Simulation
Navigator

Right-click the Simulation file node® New Solution

Right-click the solution node ® Edit
Location in dialog
box Thermal tab® Duct Flow Parameters group
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Spatial vector field for orthotropic thermal conductivity override

What is it?

When you specify an override for the orthotropic thermal conductivity, you
can now specify a spatial vector field on your model or part of the model.

Previously, you could only specify a spatial scalar field even if the orthotropic
thermal conductivity has three components.

Supported solvers and analysis types

Solver Analysis Type Solution Type
NX Electronic Systems
Cooling

Coupled Thermal-Flow Electronic Systems
Cooling

Advanced Thermal/Flow
with ESC

NX Space Systems
Thermal

Thermal Space Systems Thermal

Thermal Thermal

Advanced Thermal

NX Thermal and Flow

Coupled Thermal-Flow Thermal-Flow

Advanced Thermal-Flow

Where do I find it?

Application Advanced Simulation

Toolbar

Advanced Simulation ® Override Set — Thermal

Properties

Simulation
Navigator

Right-click the Simulation Object Container node or
the Simulation Objects node® New Simulation Object
® Override Set — Thermal Properties

Location in dialog
box

Type list ® Orthotropic Thermal Conductivity ®
Distribution group® Method list® Spatial
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Text changes in dialog boxes

What is it?

The following table lists the text changes in dialog boxes.

Dialog box name Location in the

dialog box

Old text New text

Concentrated Mass Properties group,
Properties subgroup

Mass Non-Structural Mass

Beam Properties group,
Non-Structural Mass
subgroup

Mass per Length Non-Structural Mass

Multi-Layer Shell
Non-Uniform

Properties group, Stack
Definition subgroup

Stack Layers Stack Layers (First
Layer is Top Layer)

Solver Parameters 3D Flow Solver tab,
Freeze Flow Filed for
Transient group

Freeze Flow Field Freeze Flow Field
Based on Solution
Evaluation

Kx K1
Ky K2

Override Set — Thermal
Properties

Type ® Orthotropic
Thermal Conductivity,
Magnitude group Kz K3

Report Type list Track During Flow
Solve

Track During Solve

NX 7.5.2 Motion Simulation

Results manipulation in Flexible Body analysis

What is it?

During a Flexible Body analysis, after solving for transient results, you
can now highlight the step in which the minimum or maximum stress,
displacements, or other result types occurred, using the new Results
Manipulation command. This command lets you create new results by
performing operations on one or more existing results sets.

For more information, see **Unsatisfied xref title**.
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Where do I find it?

Application Motion Simulation
Prerequisite A solved Flexible Body solution.
Menu Tools®Results®Results Manipulation

NX 7.5.1 Advanced Simulation

Solver version support

For each released version of NX, the following tables list the supported solver
versions for import, export, and the post-processing of results. Note:

• The version listed in the “Import ASCII” and “Import Binary” rows is the
solver version that was generally available when the NX version was
released. In general, the import of the solver ASCII and binary files
should be upwards compatible. Therefore, you should be able to import
them into the most recent version of NX. However, in general:

o ASCII files are backwards compatible for import into NX. If you import
an ASCII file from a newer version of the solver than is officially
supported, the software simply ignores any new fields/options that
aren’t supported in the current NX release.

o Binary files are not backwards compatible. For example, you can
import a binary file created by NX Nastran 5.0 into NX 6.0.2 , but
you might not be able to import a binary file created by NX Nastran
6.1 into NX 5.

• The version listed in the “Export ASCII” rows is the solver version that
was available when the NX version was tested. In general, the exported
solver input file is upwards compatible for that solver. Backwards
compatibility is not guaranteed. For NX Nastran, the Model Setup
Check function in Advanced Simulation tries to flag potential version
incompatibility issues.

• The version listed in the “Post-processing Results” rows is the version of
the solver results that was tested in the listed NX version. In general,
results from earlier solver versions are also supported.
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NX7 releases

Solver File Type NX 7 NX 7.5 NX 7.5.1
Import ASCII (.dat) 6.1 7.0 7.0

Import Binary (.op2) 6.1 7.0 7.0
Export ASCII (.dat) 6.1 7.0 7.0NX Nastran
Post-processing of
Results

6.1 7.0 7.1

Import ASCII (.dat) 2008r1 2008r1 2008r1
Import Binary (.op2) 2008r1 2008r1 2008r1
Export ASCII (.dat) 2008r1 2008r1 2008r1MSC Nastran
Post-processing of
Results

2008r1 2008r1 2008r1

Import ASCII (.inp) 6.8-1 6.9–1 6.9–1
Import Binary N/A N/A N/A
Export ASCII (.inp) 6.8-1 6.9 6.9
Post-processing of
Results (.fil)

6.8-EF2 6.9.2 6.9.2Abaqus

Post-processing of
Results (.odb)

6.8-EF2 6.9–EF1 6.9–EF2

Import ASCII
(PREP7, CDB)

12 12.1 12.1

Import Binary (.rst,
.rth)

12 12.1 12.1

Export ASCII (.inp) 12 12.1 12.1
ANSYS

Post-processing of
Results

12 12.1 12.1

Import ASCII N/A N/A N/A
Import Binary N/A N/A N/A
Export ASCII (.k) 971R3.2.1 971R3.2.1 971R3.2.1LS-DYNA
Post-processing of
Results

N/A N/A 971R3.2.1

NX 6 releases

Solver File Type NX 6 NX
6.0.1

NX
6.0.2

NX
6.0.3

NX
6.0.4

NX
6.0.5

Import ASCII

(.dat)

6.0 6.1 6.1 6.1 6.1 7.0

Import Binary

(.op2)

6.0 6.1 6.1 6.1 6.1 7.0

Export ASCII

(.dat)

6.0 6.1 6.1 6.1 6.1 7.0
NX Nastran

Post-processing

of Results

6.0 6.0 6.1 6.1 7.0 7.0
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Solver File Type NX 6 NX
6.0.1

NX
6.0.2

NX
6.0.3

NX
6.0.4

NX
6.0.5

Import ASCII

(.dat)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Import Binary

(.op2)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Export ASCII

(.dat)

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1
MSC
Nastran

Post-processing

of Results

2007r1 2008r1 2008r1 2008r1 2008r1 2008r1

Import ASCII

(.inp)

6.7-1 6.8-1 6.8-1 6.8-1 6.8-1 6.8-1

Import Binary N/A N/A N/A N/A N/A N/A

Export ASCII

(.inp)

6.7-1 6.8-1 6.8-1 6.8-1 6.8-1 6.8-1

Post-processing

of Results (.fil)

6.7-5 6.8-1 6.8-3 6.8-EF2 6.8-EF2 6.8-EF2

Abaqus

Post-processing

of Results (.odb)

N/A N/A N/A 6.8-EF 6.8-EF2 6.9-EF2

Import ASCII

(PREP7, CDB)

11 11 SP1 11 SP1 11 SP1 12.0 12.0

Import Binary

(.rst, .rth)

11 11 SP1 11 SP1 11 SP1 12.0 12.0

Export ASCII

(.inp)

11 11 SP1 11 SP1 11 SP1 12.0 12.0
ANSYS

Post-processing

of Results

11 SP1 11 SP1 11 SP1 11 SP1 12.0 12.1

Import ASCII N/A N/A N/A N/A N/A N/A

Import Binary N/A N/A N/A N/A N/A N/A

Export ASCII

(.k)

971R2 971R2 971R3.2.1 971R3.2.1 971R3.2.1 971R3.2.1LS-DYNA

Post-processing

of Results

N/A N/A N/A N/A N/A N/A

NX 5 releases

Solver File Type NX 5 NX 5.0.1 NX 5.0.2 NX 5.0.3 NX 5.0.4 NX 5.0.5 NX 5.0.6

Import ASCII

(.dat)

5.0 5.1 5.1 5.1 5.1 5.1 5.1

Import Binary

(.op2)

5.0 5.1 5.1 5.1 5.1 5.1 5.1

Export ASCII

(.dat)

5.0 5.1 5.1 5.1 5.1 5.1 5.1
NX Nastran

Post-processing

of Results

5.0 5.0 5.1 5.1 5.1 5.1 6.0
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Solver File Type NX 5 NX 5.0.1 NX 5.0.2 NX 5.0.3 NX 5.0.4 NX 5.0.5 NX 5.0.6

Import ASCII

(.dat)

2005 2005 2007 2007 2007 2007 2007r1

Import Binary

(.op2)

2005 2005 2007 2007 2007 2007 2007r1

Export ASCII

(.dat)

2005 2005 2007 2007 2007 2007 2007r1
MSC
Nastran

Post-processing

of Results

2005 2005 2007 2007 2007 2007 2008r1

Import ASCII

(.inp)

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.7-1

Import Binary N/A N/A N/A N/A N/A N/A N/A

Export ASCII

(.inp)

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.7-1Abaqus

Post-processing

of Results

6.6 6.6 6.7-1 6.7-1 6.7-1 6.7-1 6.8-1

Import ASCII

(PREP7, CDB)

10 10 11 11 11 11 11

Import Binary

(.rst, .rth)

10 10 11 11 11 11 11

Export ASCII

(.inp)

10 10 11 11 11 11 11
ANSYS

Post-processing

of Results

10 11 11 11 11 11 11 SP1

NX 4 releases

Solver File Type NX 4 NX 4.0.1 NX 4.0.2 NX 4.0.3 NX 4.0.4

Import ASCII (.dat) 4.0 4.1 4.1 5.0 5.0

Import Binary (.op2) 4.0 4.1 4.1 4.1 4.1

Export ASCII (.dat) 4.0 4.1 4.1 5.0 5.0NX Nastran

Post-processing of

Results

4.0 4.1 4.1 5.0 5.0

Import ASCII (.dat) 2005 2005 2005 2005 2005

Import Binary (.op2) 2005 2005 2005 2005 2005

Export ASCII (.dat) 2005 2005 2005 2005 2005
MSC
Nastran

Post-processing of

Results

2005 2005 2005 2005 2005

Import ASCII (.inp) 6.5-1 6.5-1 6.5-1 6.6 6.6

Import Binary N/A N/A N/A N/A N/A

Export ASCII (.inp) 6.5-1 6.5-1 6.5-1 6.6 6.6Abaqus

Post-processing of

Results

6.5-1 6.5-1 6.5-1 6.6 6.6-3
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Solver File Type NX 4 NX 4.0.1 NX 4.0.2 NX 4.0.3 NX 4.0.4

Import ASCII

(PREP7, CDB)

8 9 9 10 10

Import Binary (.rst,

.rth)

8 9 9 10 10

Export ASCII (.inp) 8 9 9 10 10
ANSYS

Post-processing of

Results

9 9 9 10 10

General capabilities

Create groups of meshes automatically from common attributes

What is it?

You can use the new Automatic Group command to group your meshes by
common attribute. You can group meshes by these attributes:

• Material

• Physical property

• Color

• Beam cross-section

• Laminate physical property

• Element family and mesh type

• Mesh collector type

For example, suppose you have the following 1D and 2D meshes that use
different materials and display colors.
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1D Collectors
Solar_Bracket(Graphite)
1d_mesh(1)

2D Collectors
Dish_Reverse(Gold-Copper)
2D_mesh(7)
2D_mesh(3)

Bus2_Surfaces(Aluminum)
2D_mesh(1)
2D_mesh(2)
2D_mesh(4)

Science_Equipment(Aluminum)
2D_mesh(6)

Dish_Front(Gold-Copper)
2D_mesh(5)

Using the Automatic Group command, you can group these meshes by
material, by color, and by mesh type:

Groups
1 – MAT-ALUMINUM
2 – MAT-GOLD-COPPER
3 – MAT-GRAPHITE
4 – Color-Pale Gray
5 – Color-Medium Orange Yellow
6 – Color-Obscure Gray
7 – FE_TYPE-Beam
8 – FE_TYPE-Quad4 Thin Shell
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Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file.
Simulation
Navigator

Right-click the Groups node®Automatic Group

Simulation Navigator enhancements

What is it?

This release includes several enhancements to the Simulation Navigator.

Sort and filter enhancements

You can now sort and filter the contents of the following containers in the
Simulation Navigator:

• Polygon Geometry

• Mesh collectors

• Groups

• DOF Sets

• Fields

• CSYS (first level of hierarchy only)

• Regions

• Simulation Object Container

• Load Container

• Constraint Container

Use the new sort and filter capabilities to manage the display of Simulation
Navigator data when you work with complex models.

• With the Sort command, you can organize the contents of a container by
name or type. Within a mesh collector, you can also organize meshes
according to the number of nodes or elements in the mesh or according
to the element size.

• With the Filter command, you can use a wildcard string to limit which
contents in the container display in the Simulation Navigator. Wildcards
are case sensitive.
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For example, in the Load Container:

o To list only the loads with names beginning with the letters Fo, enter
the wildcard Fo*.

o To list only the loads with names ending with the characters (1), enter
the wildcard *(1).

In the Polygon Geometry container, you can also use the Filter command
to display only the bodies that are either meshed or unmeshed.

The Status column in the Simulation Navigator indicates whether the
contents of a container are filtered or sorted. When you apply a filter to a
selected container, the software appends the string (Filtered) to the name
of the container.

Note Changes you make to the visibility of data in the Simulation Navigator
with the Filter and Sort commands only apply to your current NX session.

The following example shows how the listed contents of the Solid(1) mesh
collector change depending on the current filter and sort options.

Mesh collectors, Filter
and Sort turned off

Mesh collectors sorted
by name

Mesh collectors,
wildcard filter = B*,
sorted by name

3D Collectors
Solid(1)
PPT
BTZ
ALT
NAN
BTM
LER
BOL
BOT

3D Collectors
Solid(1)
ALT
BOL
BOT
BTM
BTZ
LER
NAN
PPT

3D Collectors
Solid(1)

(Filtered)
BOL
BOT
BTM
BTZ

New icons to indicate different types of bodies

The Simulation Navigator now uses icons to help you distinguish between:

• Solid bodies

• Sheet bodies

• Midsurface sheet bodies
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These icons help you quickly differentiate between regular sheet bodies and
sheet bodies created with the Midsurface by Face Pairs or User Defined
Midsurface commands.

Where do I find it?

Application Advanced Simulation
Simulation
Navigator

Right-click a supported container®Filter or Sort

Mesh Color Basis enhancements

What is it?

Two new options have been added to the Color Basis model display option
that was introduced in NX 7.5. Now, you can define the Color Basis by Mesh
Collector and by Mesh.

• The Mesh Collector option assigns the same color to all meshes that
reference the same mesh collector.

• The Mesh option assigns a different color to each mesh. Colors are
assigned arbitrarily.

In the Customer Defaults dialog box, under Simulation®Extras, you can
change the number of colors to use and you can specify the colors.

(1) Default colors; (2) Colors with Mesh Collector selected; and (3)
Colors with Mesh selected
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Also, beginning with this release, after you apply the Color Basis setting,
you can apply the new colors to the meshes permanently by clicking the Set
Mesh Colors button.

Where do I find it?

Application Advanced Simulation
Menu Preferences®Model Display
Location in dialog
box

Element tab®Color Basis list

Tangent-continuous edge selection method

What is it?

A new selection method named Tangent Continuous Edges has been added
to let you more easily select polygon edges when you define geometry-based
objects such as loads, constraints, and regions (for example, see the Force
command). This method selects all the edges that are tangent-continuous to
the initial edge that you select.

At each vertex of the initial edge you select, the software calculates the
tangent vector for all edges that share that vertex. The adjacent edges are
considered tangent-continuous if the angle between their tangent vectors
is less than the Tangent Angle Tolerance specified in the Smart Selector
Options dialog box.
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In the following example, the angle between the tangent vectors for edges

and is 46 degrees.

With the default Tangent Angle Tolerance of 2 degrees, when you select

edge , only that edge is selected.
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However, when you change the Tangent Angle Tolerance to 47 degrees, all
edges are selected except for the edge that is adjacent to the 87-degree angle

at .

Where do I find it?

Application Advanced Simulation
Toolbar Selection bar®Method list®Tangent Continuous

Edges

Control over default names of polygon bodies

What is it?

This release includes a new Customer Default that you can use to control
whether the software uses the names of existing assembly components to
name the related polygon bodies.

• If you select this default, the software uses the assembly component’s
name as the root name for the associated polygon bodies.

• If you do not select this default, the software uses the root name POLYGON
BODY for all polygon bodies.

Although you can always later rename polygon bodies with more descriptive
strings, you can use the new option to give the bodies more meaningful
default names.
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To access this option:

1. From the File menu, choose Utilities→Customer Defaults.

2. In the Customer Defaults dialog box, choose Simulation→Extras.

3. On the Miscellaneous tab, either select or clear the Assign assembly
component names for polygon bodies option.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM or Simulation file

Midsurface enhancements

Additional display capabilities

What is it?

This release includes two new display options in the Midsurface by Face
Pairs dialog box.

• Select the Show Pairing Faces as Transparent option to have the software
display all paired faces as transparent.

• Select the Show Midsheets as Transparent option to have the software
display the individual mid-sheets as transparent.

Both of these new options allow you to manage your display while you create
and modify face pairs in the Midsurface by Face Pairs dialog box. You can
use these two options separately or simultaneously to better visualize which
faces in your model have been paired. In the following example:

• (A) shows the solid body.

• (B) shows the body after the initial set of face pairs has been created.
Here, the Show Pairing Faces as Transparent option is selected. The blue
faces are the mid-sheets that the software generated for the face pairs.
The green faces are faces that are not currently in a pair.

• (C) shows the body with both the Show Pairing Faces as Transparent
and the Show Midsheets as Transparent options selected. Notice how
you can easily identify the faces that still need to be paired to complete
the midsurface.
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These new display options only temporarily change the translucency of the
faces in your model. Once you exit the Midsurface by Face Pairs dialog box,
the software changes the display of the faces and mid-sheets back to shaded.

Where do I find it?

Application Advanced Simulation
Prerequisite A part or idealized part displayed
Toolbar

Midsurface®Midsurface by Face Pairs

Additional trimming control for replacement mid-sheets

What is it?

When you use the Replacement Mid-Sheet option in the Midsurface by
Face Pairs dialog box, you can now control whether the software trims that
replacement mid-sheet. In the Advanced Trimming Tools options, if you

select the new Skip Trimming method, the software does not trim the
replacement mid-sheet against the solid body, the faces in the pair, or against
the neighboring mid-sheets. Use Skip Trimming when you want to use the
replacement mid-sheet body without any modifications to its size or shape.
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Where do I find it?

Application Advanced Simulation
Prerequisite A part or idealized part displayed
Toolbar

Midsurface®Midsurface by Face Pairs

Material and physical properties

Define 3D element material orientation using element faces

What is it?

For Nastran and Abaqus solvers, the new Element Free Face Proximity
option has been added to the Material Orientation Method list in the Mesh
Associated Data dialog box.

This option lets you define the first direction of the material orientation for a
mesh of 3D elements by selecting the free face of one or more of the elements.

• If you select a face in a single element, the software uses the normal of
the selected face for all elements in the mesh.

• If you select a face in multiple elements, the software uses the normal of
the selected face that is closest to a given element in the mesh.

In the following example, the first direction of the current material orientation
is in the X direction of the global coordinate system.
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Using the new material orientation method, suppose you select element
facess (1), (2), and (3):

For each element in the mesh, the resulting first direction of the material
orientation depends on the element’s proximity to the three element faces
that you selected:

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file.
Simulation
Navigator

Right-click a mesh®Edit Mesh Associated Data

Location in dialog
box

Material Orientation Method®Element Free Face
Proximity
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Preview material orientation vector graphics

What is it?

A new Preview button has been added to the Mesh Associated Data dialog
box. You can use this button to temporarily display the material orientation
vector graphics on the elements before you apply material orientation
changes in a mesh.

You can edit the colors and displayed directions of the previewed material
orientation vector graphics using the Element Material Orientation options in
the Finite Element Model Check dialog box.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file.
Simulation
Navigator

Right-click a mesh®Edit Mesh Associated Data

Location in dialog
box

Preview button
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New workflow for editing attributes of multiple meshes

What is it?

The workflow for editing the attributes of multiple meshes has changed. The
Mesh Associated Data dialog box now includes icons that indicate whether
the attribute values of the selected meshes are either mixed or identical. You
can then apply new attribute values to all selected meshes simultaneously.

For more information, see Edit the mesh associated data for multiple meshes.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file.
Simulation
Navigator

Right-click more than one mesh®Edit Mesh Associated
Data

Default stress recovery points for beam cross sections

What is it?

Beginning with this release, when you create a beam cross section using
the Face of Solid and General Geometry section types, the software now
provides default stress recovery points.

Also, a Reset to Defaults button has been added to the Beam Section
dialog box. When you add, remove, or change the stress recovery points for a
cross section, clicking this button restores the default stress recovery points
calculated by the software.
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Where do I find it?

Application Advanced Simulation
Toolbar

Advanced Simulation®1D Element Section
Location in dialog
box

Create Section®Type=Face of Solid or General
Geometry

Meshing

Target face smoothing option for 3D swept meshes

What is it?

A new Smooth Nodes option has been added to the 3D Swept Mesh dialog
box. You can use the Smooth Nodes option to control whether the software
smooths the nodes in the mesh on the target face. If you select the Smooth
Nodes check box, the software makes minor modifications to the position of
the nodes on the target face to achieve a more regular mesh. However, the
resulting mesh on the target face will not exactly match the mesh on the
source face.

The following graphic shows the effect of the Smooth Nodes option on the
target face of a hexahedral mesh.

• (A) shows the mesh on the source face. Notice the distribution of elements
in the highlighted region.

• (B) shows the mesh on the target face when the Smooth Nodes option is
cleared. Here, the software propagates the mesh from the source to the
target with no refinement on the target face. Notice that the elements
in the highlighted area follow the same pattern as the elements on the
source face.

• (C) shows the mesh on the target face when the Smooth Nodes option is
selected. Here, the software refines the mesh on the target face. Notice
that the elements in the highlighted area do not follow the same pattern
as the elements on the source face. However, the mesh in the highlighted
region now appears more regular
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Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file
Toolbar

Advanced Simulation®3D Swept Mesh
Menu Insert®Mesh®3D Swept Mesh
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Split Shell enhancements

What is it?

This release includes several enhancements to the Split Shell command.

Ability to interactively define the location of the split line

Use the new Interactive Location option in the Based on list to have the
software interactively preview possible split patterns as you move your
mouse over the selected element. The following graphic shows an example
of the four possible split patterns that the software previews for the Quad
to 4 Quads type.

When you are satisfied with the previewed split pattern, click the mouse.
The software then immediately splits the element. Because you do not have
to click OK or Apply with the Interactive Location option, you can quickly
split an element.

You can use the new Interactive Locationmethod with all options on the Type
menu except Quad to 3 Quads and Triangle to 4 Triangles.

New method for dividing triangular elements

A new Triangles to 2 Triangles option has been added to the Type list in the
Split Shell dialog box. Use the Triangles to 2 Triangles option to divide a
selected triangular element into two smaller triangular elements.

In the following graphic, (A) shows a small section of a mesh of triangular
elements. (B) shows the same elements after they have been divided with
the Triangles to 2 Triangles option.
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Option for splitting elements based on their warp value

For the Quad to 2 Triangles and Quad to 3 Triangles types of splits, you can
use the new Element Quality option to divide selected quadrilateral elements
whose warp values exceed a specified warp threshold value. This allows you
to eliminate highly warped elements from your model. How the software
splits any warped elements depends on whether you want to divide the
quadrilateral element into two or three triangular elements.

• With the Quad to 2 Triangles type, the software divides a warped element
along the shorter of the element’s two diagonal edges.

• With the Quad to 3 Triangles type, the software divides a warped element
by inserting a new node in the middle of the element’s longest edge.

New option to control the merging of new nodes

You can use the Merge New Nodes option to control whether the software
merges any new nodes the software creates when it divides the elements. In
previous releases, the software always merged any duplicate nodes created by
the Split Shell command. If you clear the Merge New Nodes check box, the
software retains all new nodes created by the Split Shell command.

Note If you clear the Merge New Nodes check box, you should use the Nodes
option in the Model Check dialog box to search for duplicate nodes before
you solve the model.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file
Toolbar

Element Operations®Split Shell
Menu Edit®Element®Split Shell

Ability to create a node at the center of a hole

What is it?

You can now use the Node Between Nodes command to create a node at
the center of three existing nodes. With the new At Center of Three Nodes
option on the Type list, the software uses the three nodes that you select to
define an arc. The software then creates the new node at the center of that
arc. The At Center of Three Nodes option is helpful, for example, when you
need to create a new node at the center of a hole in a model that does not
contain any geometry.
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The graphic below shows an example of the new At Center of Three Nodes
option. (A) shows the three selected nodes. (B) shows the new node the
software creates at the center of the selected nodes.

The At Center of Three Nodes option, is useful, for example, when you want
to use a spider-type connection, such an RBE2 or RBE3 element, to connect
the center of a hole to the nodes in the surrounding mesh, as shown below.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM file
Toolbar

Node Operations®Node Between Nodes
Menu Insert®Node®Node Between Nodes
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Merging meshes

What is it?

Use the new Merge Meshes command to merge manually created, extracted,
or imported meshes in the Simulation Navigator. The meshes to be merged
must:

• Not be associated with any geometry.

• Be located in the same mesh collector.

When you merge the meshes, the software places the meshes in a new node
the Simulation Navigator. The software appends the string _merged_mesh to
the name of the new mesh.

The merged mesh assumes:

• The mesh associated data of the first mesh you select.

• The mesh display properties of the parent mesh collector.
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Six meshes (shown with different display colors for clarity) merged
into a single mesh

You can use the Merge Meshes command to organize your meshes in the
Simulation Navigator. Merge Meshes is particularly useful when you are
working with large, imported models. You can also use the Merge Meshes
command in conjunction with the Extract Elements command.

Where do I find it?

Application Advanced Simulation
Prerequisite Meshes that are not associated with geometry and

located in the same mesh collector.
Simulation
Navigator

Select multiple meshes®right-click a selected
mesh®Merge Meshes

Post-processing

Enhanced coordinate system support

What is it?

In previous releases, you could display results with respect to the absolute
and work coordinate systems, using rectangular (Cartesian), cylindrical, or
spherical coordinates. This release adds support for the following coordinate
systems:

• Native

• Material

• Selected Rectangular

• Selected Cylindrical

• Selected Spherical

Coordinate system support is available in the following post-processing dialog
boxes:

• Set Result

• Cutting Plane

• Free Body Results

What’s New in NX 8 6-267



CAE (Digital Simulation)

The following image compares contour plots of corresponding stress
components as transformed into different coordinate systems.

(1) XY shear stress, absolute rectangular CSYS; (2) XY shear stress,
untransformed native results (element CSYS); (3) 12 shear stress,
material CSYS; (4) rqqq shear stress; selected cylindrical CSYS.

Coordinate systems in the Post Processing Navigator

Coordinate systems in the solver output file are listed under the Post View
node in the Post Processing Navigator. Result coordinate systems are
hidden by default.
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Coordinate systems written to the solver output file include, for example,
nodal coordinate systems and local coordinate systems used to define
component force loads or user-defined constraints.

Selected coordinate system support

In previous releases, in order to display results in an arbitrary coordinate
system, you needed to align the work coordinate system (WCS) to the target
coordinate and then set the post-processing coordinate system to Work.
In this release, you can select any coordinate system that is visible and
selectable in the graphics region, or listed in the Simulation Navigator, to
arbitrarily transform results. You can select:

• Coordinate systems listed in the solver output file.

Expand the Post View node and select the visibility check box for the
Result CSYS node to display result coordinate systems and make them
selectable.

For more information, see Transform results in a selected solver output
coordinate system.

• Coordinate systems in the displayed part file (typically, the Simulation
file).

You must ensure that the displayed part coordinate systems are visible in
the graphics region. To do this, you can create a multiple viewport layout,
or you can control the visibility of layers containing coordinate systems.

For more information, see Graphically select a model coordinate system.

• Coordinate systems listed in the Simulation Navigator.

By default, all local coordinate systems defined in the currently displayed
Simulation or FEM file are listed in the Simulation Navigator. You can
click to highlight the CSYS node in the Simulation Navigator to select a
coordinate system when setting the result display in a post view.

For more information see Select a coordinate system listed in the
Simulation Navigator.
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The following figure compares arrow plots of (1) XYZ displacement in the
absolute rectangular coordinate system and (2) q displacement in a selected
cylindrical coordinate system, for a model undergoing twisting. The selectable
result coordinate system is just visible at the bottom center of each image.

Material coordinate system support

If any meshes or elements in your model have a defined material orientation
(as for orthotropic or anisotropic materials or composite laminates), you can
view tensor component results in the material coordinate system.

Optionally, when Material is selected for the coordinate system on the Set
Result dialog box, you can click Display Material Orientation to temporarily
display the material orientation vectors.

6-270 What’s New in NX 8



CAE (Digital Simulation)

Native coordinate system support

Native replaces the Local option used in previous releases of NX. The native
coordinate system is the untransformed coordinate system in which results
are written to the solver output file. Typically, this is the element coordinate
system, but may be some other coordinate system based on the solver,
analysis type, or element formulation.

Why should I use it?

The solver writes out results as a set of component values at nodes and/or
elements with respect to a coordinate system determined by the solver and
element formulation. When you load results into NX, this unprocessed data
is transformed into a consistent coordinate system, and derived results are
calculated.

When you define the results display for a post view, you can specify the
coordinate system into which component results are transformed.

When boundary conditions are defined with respect to local coordinate
systems, transforming results into those coordinate systems can produce
cleaner and more meaningful results displays.
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Where do I find it?

Application Advanced Simulation

Prerequisite

To view results in the material coordinate system, your
model must define material orientation.

To view results in a selected coordinate system, the
solver output file or the displayed part must include
defined coordinate systems.

Toolbar Post Processing toolbar® Set Result
Menu Tools®Result®Set Result

Free body results display

What is it?

This release introduces the Free Body Results command. Use this command
to display the total forces and moments for a specified interface summed
about a specified node or a point in space. The interface is defined by nodes
connected to a group of elements. You can display the results with respect to
the global coordinate system or another selected coordinate system.

The command lists the forces and moments in the Information window and
displays the magnitude or component vectors in the graphics window.

This command is supported only for solvers that can output grid point force
and moment results.
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Where do I find it?

Application Advanced Simulation
Prerequisite A solved solution containing Grid Point Force results,

and a post view displayed.
Post Processing
Navigator

Right-click the Post View node®Free Body Results

Sum option for grid point force and moment element-nodal results

What is it?

You can now display force or moment results summed at the nodes of all
elements or a subset of the elements in your model.

In the Set Result dialog box, the Averaged check box has been replaced with
a list named Nodal Combination, with three options:

• None

• Average

• Sum

At the nodes of the elements in consideration, the new Sum option sums the
force data (for grid point force results) or moment data (for grid point moment
results). This option is available only for Grid Point Force — Element-Nodal
and Grid Point Moment — Element-Nodal results, and only if the structural
output request for your solution specifies Grid Point Force.

The Exclude Elements Not Displayed option, which is available only with
the Sum option, lets you restrict the summation to the nodes in the elements
displayed in the post view. You can limit the post view display to a group of
elements by using the Show Only command on the group or by turning off
individual meshes in the Post Processing Navigator.
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Grid point force arrow plot; Nodal Combination = None
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Nodal Combination = Sum
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Nodal Combination = Sum; some elements hidden; Exclude Elements
Not Displayed option selected

Where do I find it?

Application Advanced Simulation
Prerequisite A solved solution containing Grid Point Force results,

and a post view displayed.
Post Processing
Navigator

Right-click the Post View node®Set Result

Location in dialog
box

Nodal Combination list®Sum

Box selection methods for elements and nodes in post-processing

What is it?

This release introduces two new methods for selecting nodes and elements
in the Identify command and the new Free Body Results command dialog
boxes: Box (Visible) and Box (All).
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• Box (Visible)— Lets you drag a selection box to select nodes or elements
that are visible in the model’s current orientation in the graphics window.
Nodes or elements that are hidden behind other post view elements are
not selected.

• Box (All) — Lets you drag a selection box to select nodes or elements.
Nodes and elements that are hidden behind other post view elements
are also selected.
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Where do I find it?

Application Advanced Simulation, Design Simulation
Prerequisite A solved solution and a post view displayed.
Post Processing
Navigator

Right-click the Post View node®Free Body Results or
Identify

Location in dialog
box

Pick list®Box (Visible) or Box (All)

Top and bottom stress and strain results for 2D elements

What is it?

You can now display the stress or strain results on both the top and bottom of
2D elements simultaneously using the new Top and Bottom option, which
has been added to the Location: Shell list in the Set Result dialog box.

This option is available for Smooth, Banded, and Element displays. It is not
supported in Cutting Plane displays.
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The shell top corresponds to the positive element normal. The shell bottom
corresponds to the negative element normal.

Note This option uses the Backface Culling visualization preference to
display the result correctly. When you request Top and Bottom stress
or strain results, you are prompted to turn on Backface Culling. The

Backface Culling button is now located on the Post Processing
toolbar. For more information, see **Unsatisfied xref title**.

When you use the Graph, Identify, and Marker commands on Top and Bottom
results, note the following:

• When you create a graph on a top-and-bottom display, the results are
extracted from the top of the elements.

• When you use the Identify command, both top and bottom results are
listed.

• When you use the Marker command, the marker boxes list both the top
and bottom results at the minimum and maximum locations. However,
the contour plot heading always displays the minimum and maximum of
the entire model, regardless of the top or bottom face.
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Where do I find it?

Application Advanced Simulation
Prerequisite A solved solution and a Smooth, Banded, or Element

post view displayed.
Toolbar

Post Processing toolbar®Set Result
Location in dialog
box

Location: Shell list®Top and Bottom

Bending stress and strain results for 2D elements

What is it?

You can now display bending stress or strain results for 2D shell elements
using the new Bending option, which has been added to the Location: Shell
list in the Set Result dialog box.

This option is available for Smooth, Banded, and Element contour displays.
It is not supported in Cutting Plane displays.
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The Bending option lets you isolate the bending stress, without including the
other components (such as membrane stress and shear stress) that have the
same stress value at the top and bottom of the element. The bending results
are calculated from the top and bottom stress results as:

sB = 1/2 (sTS – sBS)

where sTS is the selected stress component from the top surface of the
element and sBS is the selected stress component from the bottom surface.

In the following example, the model is loaded in the axial and vertical
directions. The difference between the top and bottom stress result and the
bending stress result is relatively small, which indicates that most of the
stress is due to bending.

Top and Bottom stress result, 9970 psi
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Bending stress result, 9074.22 psi

Where do I find it?

Application Advanced Simulation
Prerequisite A solved solution and a Smooth, Banded, or Element

post view displayed.
Toolbar

Post Processing toolbar®Set Result
Location in dialog
box

Location: Shell list®Bending

Backface Culling preference added to Post Processing toolbar

What is it?

The Backface Culling visualization preference has been added to the
Post-Processing toolbar for your convenience. The primary use for this
preference is to simultaneously display stress or strain results on both the top
and bottom of 2D elements. However, it is also useful for improving graphics
performance, and for quickly determining whether 2D element normals are
consistent across your model (the element is shaded only on the positive
normal side).
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Shell top and bottom stress results with Backface Culling turned on
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Shell top stress results with Backface Culling turned on

Where do I find it?

Application Advanced Simulation
Prerequisite A solved solution and a post view displayed.
Toolbar

Post Processing toolbar®Backface Culling

Load case names in post-processing

What is it?

Post views and results windows in post-processing now display the load
case names defined in Advanced Simulation or in the solver result file (for
imported results). In previous releases, load case names in post-processing
were generated dynamically when you displayed the results.
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“Load_in_neg_Z” was defined as the solution step subcase name

Load case name displayed in Information window from the Identify
command
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Import LS-Dyna results

What is it?

You can now import d3plot result files from the LS-DYNA solver.

The Import Results File command includes a new Files of Type filter named
LS-DYNA State Databases that allows you to select the d3plot results file.
When you import this file, all associated d3plotn children files are imported
automatically.

Post-processing of transient steps is supported.

Where do I find it?

Application Advanced Simulation
Post Processing
Navigator

Right-click the Imported Results node®Import
Results→Browse button

Location in dialog
box

Files of Type list®LS-DYNA State Databases(*.*)

Nastran support enhancements

Changes to parameter specifications

What is it?

This release includes several enhancements to the support for the Nastran
PARAM bulk data entry in Advanced Simulation.

Ability to specify solution parameters on export from a FEM file

When you have a FEM file active, the Export Simulation dialog box now
includes a new Additional PARAMs option in the Output Options group. This
allows you to include an existing Solution Parameters modeling object in
the Nastran input file.

Customer defaults support for parameters

This release includes a new Additional Parameters option in the customer
defaults that you can use to specify a list of parameters that you want the
software to include in every Nastran input file you export or solve. The
software writes out the PARAM options and values that you specify each
time you export or solve a solution.

Additionally, you can use the Additional Parameters option to override
any parameters that are hardcoded at export by the software, such as
PARAM,POST,-2 or PARAM,OMACHPR,YES.

6-286 What’s New in NX 8



CAE (Digital Simulation)

To access this option:

1. From the File menu, choose Utilities→Customer Defaults.

2. In the Customer Defaults dialog box, choose Simulation→Extras.

3. On the Nastran tab, use the Additional Parameters section to enter the
parameters you want the software to write out each time you export or
solve a solution.

• You must include the PARAM keyword.

• If you specify multiple parameters, you must separate them with
commas.

Solution Parameters modeling object updated

The Solution Parameters modeling object has been updated to include all
supported parameters for the NX Nastran 7.0 and MSC Nastran v. 2008
releases.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation with NX Nastran or MSC Nastran

as the specified solver

Automatic detection of units on import

What is it?

When you import a Nastran input file (.dat or .op2) into NX, you can have
the software use the units specified in the file as the unit system for the
model. When you select the new User solver file units if available option in
the Import Simulation dialog box, the software searches for the PARAM,UNITSYS
bulk data entry in the unit file.

• If the PARAM,UNITSYS entry is present, the software imports the file in the
unit system specified by PARAM,UNITSYS.

• If the PARAM,UNITSYS entry is not present, the software imports the file in
the unit system you specified in the Import Simulation dialog box.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation with NX Nastran or MSC Nastran

as the specified solver
Menu File®Import®Simulation

Option to export DOF Sets in the alternate format

What is it?

When you export a model that contains DOF Sets, you can now choose to
export those sets using the appropriate alternate format bulk data entries.
If you select the new Write DOF Sets Using Alternate Format option on the
Formatting Options tab in the Solver Parameters dialog box, the software
writes out any DOF Sets in their alternate format. For example, the software
writes out analysis degree-of-freedom sets as ASET1 bulk data entries rather
than ASET entries.

Most alternate format degree-of-freedom entries use the THRU keyword
to specify ranges of nodes. In contrast, the standard degree-of-freedom set
entries require a separate entry for each node. Consequently, using the
alternate format reduces the size of the Nastran input file.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation with NX Nastran or MSC Nastran

as the specified solver
Simulation
Navigator

Right-click an existing Simulation®Edit Solver
Parameters

Changing the orientation of a model on export

What is it?

You can now export a solver input file in a coordinate system that you specify.
In the Export Simulation dialog box, you can use the new Model Orientation
options to export the model in a different coordinate system than the one
used in the original Simulation file. This allows you to re-orient the model on
export to a specified coordinate system.

If you select a different coordinate system on export, the software replaces
the basic coordinate system references in your Nastran input file with a
Cartesian coordinate system that is equivalent to the one you select. The
software updates all entities in your model, such as nodes, loads, or material
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orientation vectors, that referred to the basic coordinate system, to refer to
the new coordinate system. This changes the orientation of the model.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation with NX Nastran or MSC Nastran

as the specified solver
Menu File®Export®Simulation

Coordinate system names retained on export and import

What is it?

When you export a model, NX now uses comment ($) bulk data entries to
preserve the names of any coordinate systems in your model. The software
writes out the name of the coordinate system immediately before the
associated CORDx bulk data entry in your input file. For example:

$*
$* COORDINATE SYSTEM CARDS
$*
$* NX Coordinate System: 100 - csys::w7_f
CORD2R* 100 05.7600000000E+020.0000000000E+00+
* 0.0000000000E+005.7600000000E+020.0000000000E+001.0000000000E+00+
* 5.7670710678E+027.0710678119E-010.0000000000E+00 +
*
ENDDATA

If you later re-import an ASCII format .dat input file back into NX, the
software preserves any coordinate system names. Comment ($) bulk data
entries are not stored in the binary format .op2 file.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation with NX Nastran or MSC Nastran

as the specified solver
Menu File®Export®Simulation

File®Import®Simulation

Ability to specify subcase labels for solution steps

What is it?

Use the new Use Step Name as Label option in the Solution Step dialog
box to control whether the software uses the specified Name for the solution
step as the label for the corresponding Nastran subcase. When you export or
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solve your model, the software uses the specified Name to write out a LABEL

case control command for the associated SUBCASE case control command in
the Nastran input file.

In previous releases, you had to manually specify a label for each solution
step. Beginning in this release, NX searches imported OP2 files for subcase
labels. It then displays the subcase labels in the Post-Processing Navigator.
To facilitate results management in the Post-Processing Navigator, you
should associate a meaningful label with each subcase in your solution.

This release also includes a new Customer Default that you can use to control
whether the Use Step Name as Label option is selected by default. To access
this option:

1. From the File menu, choose Utilities→Customer Defaults.

2. In the Customer Defaults dialog box, choose Simulation→Extras.

3. On the Nastran tab, either select or clear the Use Step Name as Label
option.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation with NX Nastran or MSC Nastran

as the specified solver
Simulation
Navigator

Right-click an existing solution and select New Subcase

Export nodes as fluid grid points

What is it?

Currently, you cannot directly designate nodes as fluid grid points for coupled
fluid-structural analyses in Advanced Simulation. However, when you export
or solve your model, the software now checks each node to see whether it
belongs to a solid element that is assigned a fluid material (MAT10 bulk data
entry). If element’s PSOLID physical property references a fluid material, NX
writes out a value of -1 for CD in field 7 of the corresponding GRID bulk data
entry. This designates the node as a fluid grid point.

Note Note that the existing displacement coordinate system in field CD on
the GRID card must be the BASIC (0) coordinate system for the exporter
to replace it by -1. Otherwise, the software issues an error.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation with NX Nastran or MSC Nastran

as the specified solver
Menu File®Export®Simulation

Nastran import and export support enhancements

What is it?

This release includes improved import and export support for Nastran bulk
data entries and case control commands.

Name NX Nastran

import/export

support

MSC Nastran

import/export

support

Newly supported fields

and other enhancements

Notes

ASET1 Yes Yes In previous releases, ASET1

entries were always exported

as ASET entries. They can

now be exported as ASET1

entries.

**Unsatisfied xref

title**

BNDFIX1 Yes Yes • BNDFIX1 entries are

now imported as a DOF

set and a constraint.

• In previous releases,

BNDFIX1 entries were

always exported as

BNDFIX entries. They

can now be exported as

BNDFIX1 entries

**Unsatisfied xref

title**

BNDFREE1 Yes Yes • BNDFREE1 entries are

now imported as a DOF

set and a constraint.

• In previous releases,

BNDFREE1 entries

were always exported as

BNDFREE entries.

They can now be

exported as BNDFREE1

entries

**Unsatisfied xref

title**
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BSET1 Yes Yes In previous releases, BSET1

entries were always exported

as BSET entries. They can

now be exported as BSET1

entries.

**Unsatisfied xref

title**

CSET1 Yes Yes In previous releases, CSET1

entries were always exported

as CSET entries. They can

now be exported as CSET1

entries.

**Unsatisfied xref

title**

NLPARM

case control

command

Yes Yes In previous releases, a

NLPARM command for

SUBCASE 1 was referenced

at the Solution level.

Therefore, you couldn’t

change the settings of

NLPARM and NLPCI from

one solution step to another.

Now, NX reads the NLPARM

command for each subcase.

This means that NLPARM is

referenced in the appropriate

solution steps (subcases) in

NX.
OMIT1 Yes Yes In previous releases, OMIT1

entries were always exported

as OMIT entries. They can

now be exported as OMIT1

entries.

**Unsatisfied xref

title**

RIGID case

control

command

Yes Yes The RIGID case control

command is now supported

for import and export with

MSC Nastran.
RLOAD2 Yes Yes The RLOAD2 entry is

converted to an RLOAD1

entry on import. On export,

the software exports the

RLOAD1 entry.
SUPORT1 Yes Yes In previous releases,

SUPORT1 entries were

imported as SUPORT

entries. Now, SUPORT1

entries are imported as

SUPORT1 entries.
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USET1 Yes Yes In previous releases, USET1

entries were imported as

USET entries. Now, USET1

entries are imported as

USET1 entries.

Where do I find it?

Application Advanced Simulation
Prerequisite An active Simulation with NX Nastran or MSC Nastran

as the specified solver
Menu File®Import®Simulation

File®Export®Simulation

Abaqus support enhancements

Reference nodes for bolts now imported

What is it?

When you import an Abaqus input file that contains a pre-loaded bolt
modeled with beam or continuum (solid) elements, NX now imports the NODE
parameter for the *PRE-TENSION SECTION keyword. In Abaqus, you use the NODE
parameter to specify the reference node across which the software applies the
bolt pre-load to the pre-tension section.

In previous releases, NX did not import the NODE parameter for the
*PRE-TENSION SECTION keyword. When you exported a model that contained
a Bolt Pre-Load constraint, NX automatically assigned a reference node to
the associated *PRE-TENSION SECTION keyword. Now, if you import an Abaqus
input file that contains an existing reference node for a pre-tension section,
NX uses that reference node when it creates the corresponding Bolt Pre-Load
constraint in your Simulation file.

Where do I find it?

Application Advanced Simulation
Prerequisite A Simulation file displayed with Abaqus as the specified

solver
Menu File®Import®Simulation
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ANSYS support enhancements

Including comments or files in an ANSYS input file

What is it?

You can now include specific text in an ANSYS input file. Use the new User
Defined Text modeling object to specify either text or an entire file to add
either to a particular solution or within a particular step. If you choose
to include a file, the software uses the ANSYS /INPUT command to insert
the file.

• If you include a User Defined Text object in a Solution, you can control
whether the software inserts the text:

o At the beginning of the ANSYS input file (after the /PREP7 command).

o At the end of the element block (after the EBLOCK command).

• If you include a User Defined Text object in a Solution Step, you can
control whether the software inserts the text:

o At the beginning of the step (before any of the cumulative option
commands such as DCUM or FCUM).

o At the end of the step (before the LSWRITE command).

For example, you can use the User Defined Text modeling object to insert
an external file that contains a portion of your ANSYS input file. The file
can contain, for example, model definition data, comment lines, or other
references to external files.

Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM or Simulation with ANSYS as the

specified solver
Toolbar

Advanced Simulation®Modeling Objects
Menu Insert®Modeling Objects

Contact now supported in modal and buckling solutions

What is it?

You can now use the Surface-to-Surface Contact command in Modal or
Buckling type solutions. In previous releases, the Surface-to-Surface
Contact command was only available in Linear Statics and Nonlinear Statics
type solutions.
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You can use the Surface-to-Surface Contact command to model the
interaction between contacting surfaces. For example, you can use the
Surface-to-Surface Contact command to include the effects of friction in a
modal analysis.

Where do I find it?

Application Advanced Simulation

Prerequisites

An active Simulation file with ANSYS as the specified
solver and either Model or Buckling as the specified
Solution Type.

Toolbar

Advanced Simulation→Surface-to-Surface Contact

LS-DYNA support enhancements

Improvements in display capabilities

What is it?

When you are working in the LS-DYNA environment, you can now create
several types of pre-processing displays to help validate your model.

• Use the Thickness Information command in the Simulation Navigator
to create a “hedgehog” type display of the 2D element thickness values
in your model. With the hedgehog display, the software uses both colors
and the relative length of lines (drawn at the centroid of each element)
to indicate the variance in thickness values across the mesh. This type
of thickness display is temporary and only lasts until you refresh your
graphics window.
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• Use the Display 2D Element Thickness and Offset option in the Mesh
Display dialog box to display the elements with their assigned thickness
and offset values. In this type of display, the shell elements look like
solid elements.

• Use the Element Material Orientation options in the Model Check dialog
box to view the direction of the assigned material coordinate system. For
shell elements, an arrow displays on each element to indicate the X-axis
of the material coordinate system. For solid elements, you can view one,
two, or three directions of the material coordinate systems.

In previous releases, these types of displays were not supported for models in
the LS-DYNA environment.
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Where do I find it?

Application Advanced Simulation
Prerequisite An active FEM with LS-DYNA as the specified solver
Toolbar

Advanced Simulation®Modeling Objects
Menu Insert®Modeling Objects

Durability

Pyramid element support

What is it?

Durability results can now be calculated and displayed on pyramid elements,
including the NX Nastran CPYRAM elements.

Fatigue safety factor results

Simulation Navigator enhancements

What is it?

The Simulation Navigator has the following enhancements in the Durability
solution process.

The Status column for a Durability results node displays Obsolete when
you:

• Deactivate an event whose results are cumulated in the Durability
solution process.

• Add a new event to the Durability solution process.
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The Description column for each Durability solution process displays
either NX Advanced Durability or NX Durability Wizard.

• NX Advanced Durability indicates that the Durability commands in
Advanced Simulation were used to create the process.

• NX Durability Wizard indicates that the Durability Wizard was used to
create the process.

Name Status Environment Description

Durability 1 NX Durability NX Advanced
Durability

Static
Event 1

Active NX Durability Static Event

Load
Pattern 1

NX Durability Load Pattern

Static
Event 1

Static
Event 2

Inactive NX Durability Static Event

Durability
1

Obsolete

Durability 2 NX Durability NX Durability
Wizard

Static
Event 1

Active NX Durability Static Event

Fatigue
Load Variation 1

NX Durability Load Pattern

Static
Event 1

Durability
2

Assembly FEM support

What is it?

NX now supports Durability analyses on assembly FEMs.

Show durability or event solution log

What is it?

A new Show Solution Log command is now available for the Durability
solution process. After you solve a durability event or a durability solution
process, use this command to display the information contained in the *.ftl
file in the Information window.
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The displayed information contains:

• The names of the following files: the *.ftl file, the source files containing
the stress or strain history, and the *.bud files that contains the durability
or event results.

• Event information: the list of strength and durability results that are
calculated, evaluation and stress axis options, and excitations.

• Minimum and maximum strength and durability results.

Why should I use it?

You can view the content of the durability and event solution log stored in
the *.ftl file directly in NX. You no longer need to search the computer disk
for this information.

Where do I find it?

Application Advanced Simulation

Prerequisite
The Durability solution process and/or the durability
events must be solved.

Simulation
Navigator

Right-click a Durability solution process node or an
event node ® Show Solution Log

Create Diagnostic Groups option

What is it?

A new Create Diagnostic Groups option is now available in the Durability
Event Solver dialog box and the Durability MetaSolution Solver dialog box.
When you select this option, the durability solver creates diagnostic groups
that show elements that do not have sufficient durability requirements. Two
types of diagnostic groups are created:

• Event diagnostic groups

• Durability diagnostic groups
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These groups are stored in the Simulation Navigator under the Groups node.

Groups
1 – Durability 1–Static Event

2_InvalidMaterialPropertiesGroup_Fatigue_Saftey_Factor
2 – Durability 1–Static Event

2_InvalidMaterialPropertiesGroup_Fatigue_Life
3 – Durability 1–Static Event 2_InteriorElementsGroup
4 – Durability 1_NoEventResultsGroup_Fatigue_Saftey_Factor
5 – Durability 1_NoEventResultsGroup_Fatigue_Damage
6 – Durability 1_NoEventResultsGroup_Fatigue_Life

The Durability solution process name appears as a prefix in the names of all
the diagnostic groups. The event name is included in the names of event
diagnostic groups.

The following event diagnostics groups can be created:

• [prefix]_InvalidElementGroup contains elements for which durability
solver internal functions returned an error code. If you see this group,
consider logging a problem report.

• [prefix]_NoMaterialGroup contains elements that do not point to any
material.

• [prefix]_IgnoredElementGroup contains elements of types not supported
by the durability solver.

• [prefix]_IgnoredNodeGroup contains nodes that are not processed by the
durability solver because they are attached to:

o Beam elements.

o Elements that point to different materials.

o Elements in one of the previously mentioned groups.

• [prefix]_InteriorElementGroup contains interior solid elements. Interior
elements are ignored for fatigue analysis.

• [prefix]_InvalidMaterialPropertiesGroup_[durability result type] contains
elements that do not have the necessary material properties defined for
the selected durability result type.

• [prefix]_NoResultsGroup_[durability result type] contains elements that
do not have the necessary stress or strain histories for the selected
durability result type.
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The following durability diagnostics group can be created:

• [prefix]_NoEventResultsGroup_[durability result type] contains elements
that do not have the selected durability results in all participating
durability events.

Where do I find it?

Application Advanced Simulation

Toolbar Durability ® Solve Durability Simulation
Menu Insert ® Durability ® Solve

Simulation
Navigator

Right-click the Durability solution process node ®
Solve

Right-click the static or transient event node® Solve
Location in dialog
box Create Diagnostic Groups check box

Support for *.rs2 files with no geometry information

What is it?

A transient event can now reference a Response Simulation results file that
does not contain geometry information.

In the previous release, a transient event could only reference Response
Simulation results files that contained geometry information.

Note When a transient event references a Response Simulation results file
that does not contain geometry information, the durability analysis is
performed over all iterations of the stress or strain histories. The Output
Start Time and Output End Time boxes on the Data Control tab of the
Transient Durability Event dialog box are unavailable.

Why should I use it?

You can now use previously created Response Simulation results that do not
contain geometry information for a transient durability event.
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Where do I find it?

Application Advanced Simulation

Toolbar Durability ® Transient Durability Event
Menu Insert ® Durability ® Event ® Transient
Simulation
Navigator

Right-click the Durability solution process node® New
Event ® Transient

Location in dialog
box Transient Solution List

NX Thermal and Flow, Electronic Systems Cooling, and Space Systems
Thermal

Preview the material orientation vector

What is it?

You can now display the material orientation vectors on shell, solid, or
axisymmetric elements in the mesh, while you assign an orthotropic material
in the 2D or 3D Mesh Collector dialog box.

Previously, you could only display the material orientation vectors using the
Model Check command after you defined the material orientation vectors.

Preview of the material orientation of 2D shell elements

Why should I use it?

Use this option to verify the material orientation that you set.
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Where do I find it?

Application Advanced Simulation
Prerequisite Existing 2D or 3D meshes

Toolbar Advanced Simulation ® Mesh Collectors
Menu Insert ® Mesh Collectors
Simulation
Navigator Right-click a 2D or 3D mesh collector node® Edit
Location in dialog
box Material group ® Preview

Laminate Composites

View the laminate physical property for a selected element

What is it?

Use the View Laminate command to display the laminate physical property
for a selected face or element.

In the FEM file, the information is displayed for a selected polygon face or
element face. All the elements in the polygon face must be in the same zone.
In the Simulation file, the information is displayed for a selected element. Ply
results must be displayed in the Simulation file.

The information is displayed in the command dialog box and includes the
following:

• A sketch of the laminate with the number of plies and total thickness (1).

• Ply layup information that includes the global ply ID, the material
composition, thickness, and angle of the ply (2).

• The minimum and maximum values of the selected results and the ply ID
where the extrema occur (3). (Simulation file only)
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You can double-click any of the following result types in the Post Processing
Navigator to display the ply results in the Simulation file:

• Ply stress results

• Ply strain results

• Ply failure index results

• Bond failure index results

• Ply margin of safety results

• Ply strength ratio results

Why should I use it?

This command lets you easily view the laminate definition and critical ply
results information for a selected element.

Where do I find it?

View Laminate in the FEM file

Application Advanced Simulation
Prerequisite Zones must be computed in the FEM file.
Simulation
Navigator Right-click the Zones node® View Laminate
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View Laminate in the Simulation file

Application Advanced Simulation

Prerequisite
Zones must be computed in the FEM file and results
displayed in Post Processing.

Toolbar Laminates ® View Laminate

Element selection for layup offset and material orientation

What is it?

When you define a layup offset or a user-defined material orientation, you can
now also select elements. Previously, you could select only polygon faces.

You can also mix polygon faces and elements in your selection.

Where do I find it?

Layup offset

Application Advanced Simulation

Simulation
Navigator

Right-click the Layup Offset node ® Create User
Defined Layup Offset Rule

Right-click the Top, Middle, Bottom, or User defined #
node under the Layup Offset node® Edit

Layup material orientation

Application Advanced Simulation

Simulation
Navigator

Right-click the Material Orientation node ® New
Orientation

Right-click the Orientation # node under the Material
Orientation node ® Edit

View fibers with high shear

What is it?

You can now use the View Red Fibers command to display the draped fibers
that shear beyond the lock angle for all plies of the selected global layup.
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Why should I use it?

Use this command to quickly see a problematic region over all the plies of the
selected global layup. To improve the shearing of a ply, you can:

• Use a different start point and draping direction.

• Add a splice in one or more plies.

• Introduce cut curves.

Where do I find it?

Application Advanced Simulation
Simulation
Navigator Right-click a global layup node® View Red Fibers

NX FE Model Correlation

Manual mode pairing

What is it?

In addition to automatically pairing the reference and work modes, you can
now manually pair modes by entering reference mode ID and work mode ID.

If you set the Method option to None in the Automatic Pairing group, only
manual pairs are used to build the mode pairs table. You can combine
manual mode pairing with automatic mode paring by selecting any pairing
method other than None. The manual pairs you define have precedence over
automatic pairs.
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Why should I use it?

You have more flexibility when pairing work modes and reference modes.

Where do I find it?

Application Advanced Simulation
Simulation
Navigator

Right-click the Mode Pairing node under the
Correlation node ® Edit

Location in dialog
box Manual Pairing group

View imported complex test mode shapes

What is it?

You can now display and animate complex mode shape results from an
imported test data solution.

Complex mode 10 animated over the phase angle

Why should I use it?

Before complex mode shapes can be used in a correlation solution process,
they must be converted to real mode shapes. Viewing complex test mode
shapes can reveal important information. For example, while viewing the
animation, you can visually assess that all nodes of the mode shape pass
through the equilibrium position at about the same time. If they do, it
indicates that the mode does not exhibit a high degree of complexity.
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Where do I find it?

To import a test solution into new FEM and Simulation files

Application Advanced Simulation
Menu File ® Import ® Simulation

Location in dialog
box

Import ® MODAL TEST DATA

Complex Mode Conversion list® None

To import a test solution into an existing analysis simulation

Application Advanced Simulation

Toolbar Correlation ® New Test Reference Solution

Menu

Insert ® Correlation ® New Test Reference Solution

or

Insert ® Solution
Simulation
Navigator Right-click the Simulation node® New Solution

Location in dialog
box

Solver ® MODAL TEST DATA

Complex Mode Conversion list® None

Complex mode conversion options

What is it?

Multiple methods for converting complex mode shapes to real mode shapes
are now available from the Complex Mode Conversion list. You can select a
method when you import, create, or edit the test data solution.

None When you select this method, NX imports complex modes
without converting them to real modes. Use this method
to display complex modes in Post Processing.

Signed
Amplitude

When you select this method, the correlation solver uses
the signed amplitude method to convert the complex
modes into real modes.

Real When you select this method, the correlation solver uses
the real part of the complex modes for the calculations.

Imaginary When you select this method, the correlation solver
uses the imaginary part of the complex modes for the
calculations.
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Previously, NX always converted the complex modes into real modes using
the signed amplitude method.

Where do I find it?

To import a test solution into new FEM and Simulation files

Application Advanced Simulation
Menu File ® Import ® Simulation

Location in dialog
box

Import ® MODAL TEST DATA

Complex Mode Conversion list

To import a test solution into an existing analysis simulation

Application Advanced Simulation

Toolbar Correlation ® New Test Reference Solution

Menu

Insert ® Correlation ® New Test Reference Solution

or

Insert ® Solution
Simulation
Navigator Right-click the Simulation node® New Solution

Location in dialog
box

Solver ® MODAL TEST DATA

Complex Mode Conversion list

To edit an existing test solution

Application Advanced Simulation
Simulation
Navigator Right-click the test solution node® Edit
Location in dialog
box Complex Mode Conversion list
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Display COMAC results in Post Processing

What is it?

You can now display (1 – COMAC) results in the graphics window.

(1–COMAC) results for the Y component

The results displayed are (1–COMAC) values at each translational
degree-of-freedom, not COMAC values. Thus, values approaching 1.0 indicate
that these degrees-of-freedom have poor correlation across the set of paired
mode shapes.

After you generate (1 – COMAC) results, you get the following results nodes
in the Post Processing Navigator:

Correlation 1
(1–COMAC), X Component – Nodal
(1–COMAC), Y Component – Nodal
Scalar
(1–COMAC), Z Component – Nodal

Why should I use it?

You can identify graphically the parts of the structure which are responsible
for the low degrees of correlation between reference solution and work
solution.

Where do I find it?

Application Advanced Simulation
Simulation
Navigator

Right-click the Correlation Metrics node under the
Correlation node® Generate (1 – COMAC) Results
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Correlation Metrics node in Simulation Navigator

What is it?

A new Correlation Metrics node is displayed under the Correlation node
in the Simulation Navigator.

Correlation 1
Solution 2 Results
Solution 1 Results
Node Map [30]
Mode Pairing
Correlation Metrics
(1 – COMAC)

The following commands are available when you right-click the Correlation
Metrics node.

Icon Command

name

Description Comments

Correlate Opens the Correlate dialog box to let
you select, evaluate, and export the

correlation metric.

In previous releases, this command

was a right-click command for the

Correlation node.
Generate
(1 –
COMAC)
Results

Generates the (1 – COMAC) results node
under the Correlation Metrics node.
The (1 – COMAC) results node contains
the (1 – COMAC) results that you can

display in the graphics window in Post

Processing.

For more information, see Title not
found.

UNV dataset 2414 support

What is it?

NX FE Model Correlation now supports UNV files that contain dataset 2414
for mode shape result data. Dataset 2414 is often written together with the
geometry datasets in a single UNV file.

When you import or create modal test data solutions, and the UNV file
contains both the geometry datasets and dataset 2414, in the Import Modal
Test Data dialog box or the Solution dialog box, specify the UNV file in the
Geometry File box and leave the Modes File blank.

Why should I use it?

The NX FE Model Correlation support of the dataset 2414 improves
compatibility with Test for I-deas and other test software.
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Where do I find it?

To import a test solution into new FEM and Simulation files

Application Advanced Simulation
Menu File ® Import ® Simulation
Location in dialog
box Import ® MODAL TEST DATA

To import a test solution into an existing analysis simulation

Application Advanced Simulation

Toolbar Correlation ® New Test Reference Solution

Menu

Insert ® Correlation ® New Test Reference Solution

or

Insert ® Solution
Simulation
Navigator Right-click the Simulation node® New Solution
Location in dialog
box Solver ® MODAL TEST DATA

To edit an existing test solution

Application Advanced Simulation
Simulation
Navigator Right-click the test solution node® Edit

Phase adjustment for side by side mode shape display

What is it?

NX now automatically adjusts the phases when you use Side-by-Side Display
and Side-by-Side Animation commands on mode pairs in the Correlation
Details View subpanel.

To achieve this, NX negatively scales the work mode shape deformation if the
modal scale factor between the modes is negative.
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Out-of-phase display of a mode pair

Automatically adjusted phase display of a mode pair

Where do I find it?

Application Advanced Simulation

Simulation
Navigator

Mode Pairs [#] node ® Correlation Details View
subpanel ® right-click one or more mode pairs ®
Side-by-Side Display/Side-by-Side Animation
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NX FE Model Updating

MSC Nastran DESOPT 200 solution support

What is it?

You can now select the MSC Nastran DESOPT 200 — Model Update solution
as your work solution for the Model Update solution process. In previous
releases, you could only select the NX Nastran DESOPT 200 — Model Update
solution.

MSC Nastran version 2007.0 or 2008.0 are supported.

Note A MSC Nastran DMAP license is required.

Where do I find it?

Application Advanced Simulation

Toolbar Model Update ® New Model Update
Menu Insert ® Model Update
Simulation
Navigator

Right-click the simulation node ® New Solution
Process ® Model Update

Location in dialog
box

Work Solution (Analysis) group ® Type column ®
MSC DESOPT 200 – Model Update solution

Sensitivity node in Simulation Navigator

What is it?

A new Sensitivity node is displayed under the Design Variables [#] node
in the Simulation Navigator.

Model Update 1
Solution 2 Results
Solution 1 Results
Node Map [52]
Mode Pairing
Correlation Metrics
Design Variables [18]
Sensitivity

Targets [20]
Errors [20]
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The following commands are available when you right-click the Sensitivity
node.

Icon Command name Description Comments
Plot Sensitivities In the Sensitivity

Matrix dialog
box, plots the
design variable
sensitivities with
respect to all
optimization
targets.

In previous
releases, this
command was
a right-click
command for the
Design Variables
[#] node.

Export to Excel
Spreadsheet

Exports sensitivity
values to an Excel
spreadsheet.

Export to CSV File Exports sensitivity
values to a CSV file.

Information Opens the
Information
window that lists
the sensitivity
values.

These are new
commands in this
release.
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7 Teamcenter Integration for NX

Performance improvement during part loading

What is it?

Multi-threading has been introduced in NX 7.5.1 into the file download
process. You can now load parts faster when the part files do not already
exist in the FMS client cache.

Though part loading performance depends upon several factors, the largest
improvement in performance happens when the following conditions are met:

• The deployment configuration is four-tier

• The network has high latency and low bandwidth

• There is no local Teamcenter volume

A typical scenario is loading an assembly for the first time where no
corresponding NX part files exist in the FMS client cache.

Why should I use it?

Performance is improved when loading NX part files.

Where do I find it?

Performance improvement is on by default and is activated with every NX
part load operation.

Application Teamcenter Integration

Menu
File®Open and other operations where you are loading
part files.
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Occurrence effectivity in Teamcenter and NX

What is it?

Occurrence effectivity defined in Teamcenter is applied to assemblies loaded
in NX. Occurrences that are configured out of an assembly in Teamcenter are
suppressed when you load the assembly in NX.

Occurrence effectivity is typically used to track major changes in the evolution
of a product. This is different from revision effectivity which is typically used
to track smaller changes in a product. Occurrence effectivity is used to track
the dates of effectivity for a part.

Occurrence effectivity is set in Teamcenter and cannot be changed in NX;
parts that are suppressed in NX when an assembly is loaded cannot be
unsupressed in NX. You can perform normal modeling operations that include
the suppressed components and when you save an assembly that contains
suppressed components, they are saved as part of the assembly in Teamcenter.

To see the components that are suppressed, in the Assembly Navigator,
you can right-click on a column heading and select Include Suppressed
Components.

The revision rule used (defined in Teamcenter) and the date in its definition
determines the occurrence effectivity applied. You can further control the
occurrence effectivity by changing the date value in NX for the revision rule.
If you cannot change the date, then Today is implied. Changing the revision
rule date in NX creates a transient revision rule.

When you use the Export Assembly outside Teamcenter command,
occurrence effectivity is ignored; suppressed components are considered a
direct part of the assembly and included in the operation.

For additional information on setting occurrence effectivity, see the
Teamcenter documentation.

Why should I use it?

You can control occurrence effectivity in Teamcenter and apply it to
assemblies loaded in NX.

Save As a non-master drawing to any Item Revision

What is it?

When you use Save As on a non-master drawing, you can save it to any
existing Item Revision of the same Item. This allows you to create an
initial drawing with a UGMaster dataset in an Item Revision, make several
revisions to the model, then save the drawing to a later Item Revision.
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In the Save Part File As dialog box, the Revision box is no longer
automatically set to the existing revision and grayed out. The Revision box is
now modifiable and you can enter any existing Item Revision.

A message prompting you to manually update the drawing to the UGMaster
of the new Item Revision is displayed. The update is also done automatically
when you open up the drawing in the new Item Revision if you have the
Update Master Model customer default selected.
You cannot save a non-master drawing to a Item Revision of a different Item.
However, you can use Save As to save a non-master drawing as a UGMaster of
a completely new Item/Item Revision and keep the master-model relationship
to the model in the source Item/Item Revision.

Note You cannot save a drawing as a UGMaster and keep the master-model
relationship if you save to a new Item/Item Revision and a new Item Type.

Why should I use it?

You can save a non-master drawing to a different Item Revision of the same
Item.

Where do I find it?

Application Teamcenter Integration
Menu File®Save As
Location in dialog
box Revision

Browse to a Teamcenter location when cloning or importing

What is it?

When you specify the Teamcenter location when you clone an assembly
or import an assembly, you can now browse to the location in Teamcenter
instead of manually typing the path.

In the Clone Assembly and Import Assembly dialog boxes, you can click
the Browse button for the Default Output Folder and select the folder in
the Folder Select dialog box.
The Browse button allows you to view your Home node and folders under it.
You can specify a folder outside of your Home by manually entering it in the
text box, but you must have write access to the folder.

Why should I use it?

Browsing for the folder results in fewer errors than when you manually type
the path.
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Where do I find it?

Application Teamcenter Integration

Menu

Assemblies®Cloning®Create Clone
Assembly

File®Import Assembly into Teamcenter

Location in dialog box

Clone Assembly dialog box®Numbering
tab®Default Output Folder box®Browse
button

Import Assembly dialog box®Numbering
tab®Default Output Folder box®Browse
button

Show revisions of a replacement component in an assembly

What is it?

When you are replacing a component in an assembly, you can show the
additional revisions of the component in the dialog box without browsing or
doing a part file search to find the revisions.

In the Replace Component dialog box, you can select a component, and
then click Show Revisions to display the additional revisions of the part
in the Unloaded Parts list. You can then select a revision and replace the
component with that revision.

Note You can select multiple components and click Show Revisions. All of
the available revisions for all of the components are displayed.

A Browse button is available under the Unloaded Parts list so you can browse
or search for another revision that you want to use as a replacement. If all
of the revisions are already listed in Loaded Parts or Unloaded Parts, the
Browse button is disabled.

Why should I use it?

You can easily find additional revisions for a component in an assembly and
use one of them to replace an existing revision.
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Where do I find it?

Application Teamcenter Integration

Menu
Assemblies®Components®Replace
Component

Assembly Navigator
Right-click a component ® Replace
Component

Location in dialog box Replacement Part group

Drawing booklets displayed in Teamcenter Navigator

What is it?

Drawing booklets are shown in Teamcenter Navigator as objects. A drawing
booklet contains related drawings and drawing sheets that are grouped
together. The booklets are typically used for very large assemblies or complex
parts that require a large number of drawings.

A drawing booklet contains Items and Item Revisions. Under the Item
Revision are containers that represent the drawings and drawing sheets. A
booklet can be located under Home or in any folder where you have write
access.

The Create Automated Drawings wizard determines the grouping of
drawings, location of the drawing booklets in Teamcenter Navigator, and how
containers are identified and arranged within the drawing booklets.

You can use the NX Part Navigator to get a more complete view of the
drawing booklet.

For additional information on the creation and use of drawing booklets, see
Drawing Booklets.

Why should I use it?

Drawing booklets make it easier to manage a large quantity of drawings
and drawing sheets.

Where do I find it?

Applcation Teamcenter Integration

Teamcenter Navigator
Drawing booklets are objects in the
Home folder or sub-folders.
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8 Inspection and Validation

Check-Mate

Updates to Check-Mate checkers

What is it?

Sixteen new checkers are added in the following three categories:

Modeling
Get Information
SASIG-PDQ test

Checker
category New Checker Description

Modeling –
Features

Check If The Part
File is Saved with
Rollback Data

Checks whether a part file is
saved with rollback data.

Get Information –
Modeling

Report Features
Without
Dependencies

Reports features without any
dependencies in a file.

An independent feature does not
have any parent or child feature.

Get Information –
Modeling

Report Features Alert
Messages

Reports alert messages from the
features.

Get Information –
Drafting

Report Information
About Section View

Reports available information
about the section view.

SASIG-PDQ test categories now include all 64 geometric quality criteria
contained in SASIG PDQ guidelines version 3.

Category New Checkers

Curves (G-CU)
• Fragmented Curve: G-CU-FG
• Curve with a small radius of curvature: G-CU-CR
• Inappropriate degree linear curve: G-CU-ID

Surface (G-SU) • Multi-face Surface: G-SU-MU
• Inappropriate degree planar surface: G-SU-ID
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Category New Checkers

Faces (G-FA)
• Analytical Face: G-FA-AN
• Closed face: G-FA-CL
• Inconsistent face on surface: G-FA-IT

Edges (G-ED) • Analytical edge: G-ED-AN
• Inconsistent edge on curve: G-ED-IT

Shells (G-SH) • Over-Used vertex: G-SH-OU
Solids (G-SO) • Intersecting Shells: G-SO-IS

The following checkers are changed:

DFM checkers Because the DFM checkers are not intended to be generic
checkers for any other sheet metal operations, to prevent
inappropriate use the DFM checkers are moved to a new
DFM example files folder, and the DFM checkers do
not appear in the out-of-the-box checkers list. The new
default folder location for the DFM checkers files is
%UGII_BASE_DIR%\DESIGN_TOOLS\checkmate\
examples\dfm\

To use these DFM checkers, copy them to a directory
and assign that full directory path (without a trailing
slash) to the Check-Mate environment variable
UGCHECKMATE_USER_DIR. When NX is subsequently
started, the DFM checkers should be visible in a DFM
category inside the Check-Mate list of available checks.
Please refer to Check-Mate system administration in the
NX Help document for details of the configuration process.

Why should I use it?

The new and updated checkers help you to better validate the quality of
product data.
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Where do I find it?

Resource bar HD3D Tools®Check-Mate
Toolbar Check-Mate
Menu Analysis®Check-Mate®Set Up Tests

Analysis®Check-Mate®Author Tests
Location in dialog
box

(Set Up Tests) Tests tab®Categories group

(Author Tests) Create/Edit Profile tab®Categories
group

File system %UGII_BASE_DIR%\DESIGN_TOOLS\checkmate\
examples\dfm\

Updates in Check-Mate KF functions

What is it?

New SASIG-PDQ checking functions and new modeling checking and
reporting functions are added for the new Check-Mate checkers.

You can use the part attribute functions in checkers to get the following part
data:

• Attribute values from attribute types of integer, number, string, boolean,
null, and date.

• Category
• Dimension and Unit of number type attribute values

The new functions include the following:

mqc_askPartAttributeValues
mgc_askPartAttributesOfTypes
mqc_askPartAttributesOfUnits
mqc_askPartAttributesOfCategories

Why should I use it?

The new functions enable you to gather more kinds of data from a part, and
thus create new kinds of checks.
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Where do I find it?

You can use the new functions when creating or editing checkers. You can use
the Author Tests dialog box for the steps required to author Check-Mate tests.

Resource bar HD3D Tools®Check-Mate
Toolbar Check-Mate
Menu Analysis®Check-Mate®Author Tests
Location in dialog
box

Create/Edit Checker tab

Updates in Check-Mate examples

What is it?

NXOpen Check-Mate checker source code file examples are added in the
examples folder.

Why should I use it?

The new examples help you to understand how to create NXOpen functions
for Check-Mate checkers, and thus create new kinds of checks.

Where do I find it?

File system %UGII_BASE_DIR%\DESIGN_TOOLS\
checkmate\examples\NXOpenExamples\

CMM Inspection Programming

General enhancements

Link to PMI enhancements

What is it?

When you link to PMI (Product and Manufacturing Information) data,
an information window reports on all Geometric Dimensioning and
Tolerancing (GD&T) and dimensional PMI markup linked to CMM Inspection
Programming.

In the Inspection Navigator:

• Items marked as successfully linked appear in their appropriate feature,
tolerance, and path locations.
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• PMI markup not supported or used by CMM Inspection Programming,
such as notes and labels, do not appear.

• Items marked as linked but incomplete also display the icon. These
may require some manual modification, such as clearly linking the
markup to new or existing inspection features, to reestablish links
between markup and inspection features.

Why should I use it?

The PMI report lets you quickly confirm that your PMI markup has
successfully linked to CMM Inspection Programming. In Inspection
Navigator, you can compare the results with the new inspection features and
tolerances and make changes in CMM Inspection Programming, PMI, or both.

Where do I find it?

Application CMM Inspection Programming

Prerequisite
You must define feature-based tolerance annotations in
PMI and create an inspection file.

Toolbar Operations®Link to PMI
Menu Tools®Inspection Navigator®Operation®Link to PMI

Inspection Navigator enhancements

What is it?

There are many enhancements to the Program Order view of the Inspection
Navigator.

• You can reorder inspection paths and other elements.

o You can click the element to be moved and then drop it on the element
that it should follow.

o You can select multiple elements by pressing Ctrl, and then drag them
to a new location. If you drag them into a group, they become the
last element in that group.
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• Measured and constructed features can correctly reference datum
definitions. In the DMIS General Setup template, the TOLERANCES
group follows the INSPECTION_PATHS and CONSTRUCTED_FEATURES
groups.

PROGRAM_HEADER
SENSORS
PART_ALIGNMENT
FEATURES
INSPECTION_PATHS
CONSTRUCTED_FEATURES
TOLERANCES
OUTPUTS

• You can lock an inspection path in the Program Order view of the
Inspection Navigator by right-clicking the path to be locked and choosing
Object®Lock.

INSPECTION_PATHS
BACK_PLANE_B
LINE_47430
TOP_PLANE_A
CENTER_BOSS
HOLE_3
HOLE_4

• The following elements now display the Out of Date icon to indicate
that they are not yet generated for inclusion in the program.

o Inspection features with modified underlying geometry.

o Tolerances whose underlying definitions have changed.

If any features or tolerances are out of date, then their parent groups
also display Out of Date icons. Parent groups include FEATURES,
TOLERANCES, and INSPECTION_PATHS, and as well as the
CMM_INSPECTION_PROGRAM header.

Why should I use it?

• Locking an inspection path ensures that no changes are accidentally
made to custom settings.

• Reordered program groups ensure that datum references to features and
constructed features can exist without program errors. You no longer need
to manually cut and paste datums to a higher group in the Inspection
Navigator.

8-6 What’s New in NX 8



Inspection and Validation

• The Out of Date icon for inspection features and tolerances now directly
indicates that you must regenerate your inspection program.

Where do I find it?

Application CMM Inspection Programming

Prerequisite
An inspection file with an inspection feature and an
inspection path on the inspection feature.

Resource bar Inspection Navigator

Toolbar Navigator®Program Order View

Menu
Tools®Inspection Navigator®View®Program Order
View

Inspection feature enhancements

What is it?

• When creating a plane inspection feature, you can now select multiple
faces as long as they are coplanar.

• The Plane Inspection Feature and Cone Inspection Feature dialog boxes
now include an Extent subgroup that lets you specify whether a plane
or cone inspection feature created with face geometry is Bounded or
Unbounded.

Plane features with multiple coplanar surfaces

When you create inspection paths on a plane feature that consists of multiple
coplanar surfaces, the path automatically avoids any voids or obstructions
in the surfaces.

Note You cannot automatically generate a plane feature on a part with
coplanar surfaces using the Link to PMI command.
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Bounded versus unbounded features

While bounded and unbounded features do not appear different from other
plane and cone features in the NX graphics window, bounded features differ
from unbounded features in that they have finite planar extent boundaries.
These generate BOUND events in your program output.

Any older inspection files containing planes or cones that were defined using
face geometry will be automatically set to bounded when you generate and
post process them.

Unbounded cone Bounded cone

BOUND/F(TruncatedCone),F(Top),F(Bottom)

Why should I use it?

• The ability to create a single feature from coplanar geometry lets you
quickly create a single plane feature instead of many plane features, and
to apply a single tolerance for all of them. Less features and tolerances
in the Inspection Navigator make your workspace easier to organize,
modify, and inspect.

• While plane and cone inspection features are unbounded by definition,
tolerances such as position and total runout require bounded features.

Where do I find it?

Application CMM Inspection Programming
Prerequisite You must create an inspection file.

Toolbar

Feature®Plane

Feature®Cone
Menu Insert®Feature®Plane or Cone
Inspection
Navigator

Right-click any node and choose Insert®Feature®Plane
or Cone
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Enhancements to constructed features

What is it?

Constructed features are mathematically constructed from the characteristics
of standard inspection features. The Constructed Features dialog box has
been reorganized and enhanced to let you:

• Select a nominal feature, now termed Design Feature, prior to selecting
the nominal and actual inspection features that define it.

• Create a new design feature for most types of constructed plane features
without selecting a nominal inspection feature.

• Filter standard inspection features to be selected by feature type, and
specify whether they should use actual or nominal values.

You can also select from a wide range of new and modified methods, now
termed construction forms.

Construction form,
design feature type Description
Best Fit

Point, line, plane, arc,
circle, cylinder, cone, or
sphere

Determines the best fit through or within any
number of previously defined, point-reducible
inspection features. If multiple solutions exist, the
feature is constructed as close to the design feature
as possible.

Example The following shows a constructed plane
feature in which the design feature does not use
an existing inspection feature for its nominal.
Using the actuals of four cylinder features, the
calculated plane rests on the axial center points
of the cylinders. Although it appears to be
bounded by the cylinders in the graphics window,
the constructed feature is actually unbounded.

Front
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Top
Transform

Point, line, plane, arc,
circle, cylinder, cone, or
sphere

Transforms the constructed feature using the
geometric attributes of a measured base feature and
the following:

• The current Part Coordinate System (PCS)

• A nominal or actual PCS created using the
Alignment command

Minimum, Maximum

Point

Using a selected Sub-Feature1 as an actual
reference, creates a constructed point feature at the
minimum or maximum distance to the subfeature in
one of the following ways:

• Along a specified vector

• Radially from the center of an arc, circle, cylinder,
cone, or sphere feature

• Using the ijk of another specified feature

Example The following shows a constructed point
feature that uses a nominal point at the center
of a large circle as the design feature. The
constructed feature uses the vector direction of
the green plane feature, as well as the maximum
distance of a closed slot feature. Actuals are
derived from both the plane and the slot.
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Move By Feature,Move
By Vector

Point

Move by Feature creates a constructed point feature
a specified distance from a nominal design feature,
using the vector direction of another selected feature.
Actuals are derived from the direction feature, a
different measured point-reducible feature, or both.

Move by Feature works similarly but uses a
specified, nominal direction vector rather than a
direction feature.

Example The following shows a constructed point
feature moved by vector. A nominal point design
feature, in orange, is projected 20 millimeters
along a specified direction vector, using a
point-reducible measured circle feature as the
actual.
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Middle

Point, line, or plane

Creates a constructed point, line, or plane feature
at the midline, midplane, or midpoint between two
inspection features.

Example Below is a constructed plane feature
in which the design feature does not use an
existing inspection feature for its nominal. The
plane design feature, in orange, lies midway
between two plane features, both of which are
actuals. Although it appears to be bounded, the
constructed feature is actually infinite.

Cone Diameter

Circle

Creates a constructed circle feature at the location
of the actual cone where the cone has the specified
Diameter value.

Example

The design circle
feature, with a
nominal diameter of
8.0 millimeters.
The actual cone feature.
A circle feature at the
base has a diameter of
15.5.
The constructed circle
feature. Since a
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Diameter of 11.75
is specified, the
constructed circle is
midway along the cone:

(15.5 - 8) / 2 = 3.75

and

3.75 + 8 = 11.75)
Cone Distance

Circle

Creates a constructed circle feature at a specified
distance from the actual cone vertex along the actual
cone axis toward the base of the cone. A negative
distance creates the constructed circle in the opposite
direction of the actual cone axis.

Example

Design feature

Actual cone feature

Vertex and point of
distance origin on
actual cone axis
Positive and negative
constructed circle
feature locations, based
on Distance

Why should I use it?

Constructed features are often used to measure the size, location, and
orientation of a theoretical feature or group of features relative to another
feature or group of features. Use constructed features to derive a single
feature from the point, line, and plane characteristics of other features.
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Where do I find it?

Application CMM Inspection Programming

Prerequisite

You must create an inspection file as well as any
inspection features you need to create the constructed
feature.

Toolbar Insert®Constructed Feature
Menu Insert®Constructed Feature
Inspection
Navigator

Right-click any node and choose Insert®Constructed
Feature

New DMIS 3.0 postprocessor available

What is it?

When you postprocess an inspection program, CMM Inspection Programming
now offers the ability to use the 3.0 Dimensional Measuring Interface
Specification (DMIS) standard, in addition to the recently approved DMIS
5.2 version. The 3.0 version is the second DMIS standard, after 2.1, to be
submitted to ANSI and accepted as an American National Standard.

Why should I use it?

Older machines and systems that do not support the 5.2 standard can use
the 3.0 standard.

Where do I find it?

Application CMM Inspection Programming
Prerequisite You must create an inspection program.

Toolbar Operations®Post Process

Menu
Tools®Inspection Navigator®Output®Inspection
Post Process

Inspection
Navigator

Right-click a node to be postprocessed and choose Post
Process
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Machine simulation enhancements

Sensor command

What is it?

Use the Sensor command to create personalized sensor definitions for each
probe in your workflow.

Touch probe sensors are used with dimensional measurement equipment to
gather measurement data. CMM Inspection Programming automatically
creates a best sensor for gathering measurement data based on the machine
head and probe combination used in an inspection path. However, you can
also create a custom sensor definition for which you define the probe tip,
angle combination, and unique name.

This example shows a sensor defined for an inspection path on the left side of
the part. To avoid potential collision with the part, the head (B) rotates 90°
around the Z-axis, and the barrel (A) rotates 45° around the X-axis.

Why should I use it?

Sensor definitions let you:

• Uniquely name each sensor as your workflow or standards require.

• Define a different sensor for each stem on a multi-tip probe, or different
sensors for any probe.
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• Specify default A and B angles to indicate how the probe should be
positioned or rotated.

Where do I find it?

Application CMM Inspection Programming

Prerequisite

An inspection file with at least one probe loaded, as
described in the NX 7.5 CMM Inspection Programming
help.

Toolbar Insert®Sensor
Menu Insert®Sensor
Inspection
Navigator Right-click any node and choose Insert®Sensor

Rotate table command

What is it?

Use the Rotary Table command to rotate a work part on a rotary table system
integrated with your CMM.

You can also define a second table either dependent on or independent of the
first table to further increase the flexibility of your inspection process and
reduce the machine time needed to calibrate probe angles.
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Why should I use it?

A rotary table can:

• Measure circular patterns of features on a complex work part while
maintaining coordinate system integrity.

• Provide probe access to blocked areas that might otherwise require
multiple setups to inspect.

Where do I find it?

Application CMM Inspection Programming

Prerequisite
You must create an inspection file and load a virtual
machine that contains a rotary table.

Toolbar Insert®Rotate Table

Menu Insert®Rotate Table
Inspection
Navigator Right-click any node and choose Insert®Rotate Table

New virtual probe and machine models

What is it?

The CMM Inspection Programming library features several new machine
models, as well as a new probe and head.

Brown and Sharpe X-cel 122010
with rotary table Zeiss Duramax
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Hermle dual-axis rotary machine Zeiss Prismo

Zeiss Contura
Star probe mounted to VAST

fixed head

Why should I use it?

New machine models offer more options when you run inspection simulations.
For detailed information on how to load machine components, see Load a
virtual CMM machine in the NX 8.0 online help.
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Where do I find it?

Application CMM Inspection Programming

Prerequisite
You must create an inspection file with no virtual
machine loaded.

Inspection
Navigator

In Machine View, double-click GENERIC_MACHINE
and load the components.

New tool changing rack capability

What is it?

You can now set up virtual machine and head tools to support virtual tool
changing racks, such as the following virtual Auto Change Rack (ACR).

Why should I use it?

Changing racks extend the inspection capabilities of your CMM to include
a variety of probes, extension lengths, and stylii. A rack can protect stored
modules from environmental contaminants.
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Where do I find it?

Application CMM Inspection Programming

Prerequisite

You must create an inspection file and load a virtual
machine that contains a virtual changing rack. To use
an actual changing rack you must configure your cmm
execution software, or insert a CMM command such as
the following DMIS statement into your program.

TH(Rack1)=THLDEF/SS(Tool1),1,SS(Tool2),2,SS(Tool3),3

Once set up, any probe change is automatically reflected
in your simulations.

Inspection Path dialog box enhancements

Sub-operations list enhancements

What is it?

The Sub-Operations list in the Inspection Path dialog includes three new
columns:

• The probe Tip index—0 for single-tipped probes, 0 or higher for multi-tip
probes.

• If applicable, the probe’s A Angle, in degrees. The A angle usually rotates
the probe barrel around the X-axis.

• If applicable, the probe’s B Angle, in degrees. The B angle usually rotates
the head around the Z-axis.

Why should I use it?

The probe tip and angles reported for each point or sub-operation let you
quickly view the sensor strategies used for each point and sub-operation in
the inspection path. You can select multiple points and sub-operations in the
Sub-Operations list and then apply tip, probe, and angle settings globally to
all those selected points and sub-operations.
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Where do I find it?

Application CMM Inspection Programming

Prerequisite

You must create an inspection file, and any necessary
inspection features in PMI or CMM Inspection
Programming.

Toolbar Insert®Inspection Path
Menu Insert®Inspection Path
Inspection
Navigator

Right-click any node and choose Insert®Inspection
Path

Enhanced approach logic and warnings

What is it?

The default programming logic related to how probes approach and retract
from small holes and slots is enhanced. When creating inspection paths and
sub-operations on such features, alerts will report potential problems in your
process, and require you to fix those problems before committing your path.

Alerts
Approach distance is too
large for this feature.
Value will not be used.
Retract distance is too
large for this feature.
Value will not be used.

Why should I use it?

Path warnings help you correct problems when you create an inspection path,
rather than encountering them later during simulations.

What’s New in NX 8 8-21



Inspection and Validation

Where do I find it?

Application CMM Inspection Programming

Prerequisite
You must create an inspection file, necessary inspection
features, and an inspection path on a small hole or slot.

Safe plane improvements

What is it?

When you define an inspection path and then click Specify Safe Plane ,
the standard NX Plane dialog box now provides many ways to define a safe
plane from part and machine geometry, as well as based on angles, distance,
and mathematical coefficients. In some cases the safe plane definition is
saved to the work part as a WAVE link so that the relationship between the
inspection part file and the work part is recorded.

This example shows a safe plane created by bisecting the planes from the
planar surfaces of the two cylinders adjacent to the cylinder being inspected.
The safe plane is offset to keep the probe from colliding with the adjacent
cylinders.

Show Clearance Plane also displays a better representation of the path’s
actual safe plane than in previous releases.
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Where do I find it?

Application CMM Inspection Programming

Prerequisite
You must create an inspection file, necessary inspection
features, and an inspection path.

Inspection Path
dialog box

Transitions tab®Transition Points group®

• Specify Safe Plane

• Show Clearance Plane

Inspection path sub-operation enhancements

General sub-operation enhancements

What is it?

An inspection path can contain sub-operations of many different types, each
of which depends on the type of feature being inspected. NX 8.0 Beta includes
the following sub-operation enhancements.

• You can quickly create multiple Measured Point sub-operations from
the Create Sub-Operation dialog box by clicking Apply after selecting
each point location.

• A magenta inspection path preview now displays when you edit any
parameter in a point set sub-operation except sensors. When you complete
the sub-operation, the preview path is replaced by the standard blue lines
to indicate the completed point set path.

• Icons for the following sub-operation types have been changed to better
represent their CMM functionality.

Old
icon

New
icon

Old
icon

New
icon

Old
icon

New
icon

Scan
Curve

Scan
Line

Scan
Arc
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• When you create point set sub-operations on a plane, cylinder, surface,
sphere, cone, or torus inspection feature, you can select the sequence and
U/V direction in which the measurement points are inspected.

Zig causes
the probe to zig
unilaterally across
the grid, one line at a
time.

Zig Zag causes the
probe to zigzag back
and forth across each
line in the grid.

Nearest causes
the probe to move
from each point to its
nearest neighbor.

Where do I find it?

Application CMM Inspection Programming

Prerequisite

You must create an inspection file, necessary inspection
features in PMI or CMM Inspection Programming, and
an inspection path.

Inspection Path
dialog box

Sub-Operations group®Add Sub-Operation

®Type group®sub-operation type

Custom sensor options in sub-operations

What is it?

You can either apply your own custom sensor to an inspection path, or you
can let the application automatically create and apply a new sensor as
needed. When you create or edit measurement points, transition points,
and sub-operations from the Inspection Path dialog box, a wide variety of
options related to sensor selection, path approach strategy, tips, and angles
are available.

This example shows a multi-tip probe inspecting a cylinder using a point grid
sub-operation. For each point location, the user has applied the most efficient
star probe tip using sensor options.
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Why should I use it?

Sensor options let you:

• Specify whether the application should automatically create a new sensor
as needed, or select the best existing sensor.

• Specify the sensor to be used.

• Manually specify probe angles.

• For multi-tip probes, specify a probe tip for the point or sub-operation.

• Specify probe angles as well as a specific probe tip.
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Where do I find it?

Application CMM Inspection Programming

Prerequisite

You must have:

1. An inspection file with at least one probe tool loaded.

2. A custom sensor, unless you want the application to
automatically create one.

3. An inspection feature.

4. An inspection path on the inspection feature.

Inspection Path
dialog box

Measurement tab®Sub-Operations group®

• Add Sub-Operation

• Name list®double-click point or sub-operation

Scan sub-operation enhancements

What is it?

One parameter has been modified, and three new parameters have been
added, to both scan curve and 5-Axis scan curve sub-operations.

Parameters
Minimum Points Formerly Number of Points, this parameter sets

the minimum number of points to be scanned.

This number may increase as the Curvature
Factor increases.

Minimum Spacing

Sets the minimum space that must exist between
measurement points on the curve.

Maximum Spacing

Sets the maximum space that must exist between
measurement points on the curve.

Curvature Factor

Sets the level of point density at areas that
represent the greatest bends in the curve.

A factor of 0 sets no increase in point density
due to curvature. The greater the factor, the
more point density increases at areas of greater
curvature.
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Why should I use it?

Increasing the curvature factor, as well as setting minimum and maximum
spacing between points, lets you better retrieve measurement data from the
most significant and variable areas of a curve. These settings retrieve less
data from straighter, less variable areas, and produce more meaningful
statistical results.

Where do I find it?

Application CMM Inspection Programming

Prerequisite

You must open a work part file with curved geometry,
create an inspection file, and create a curve inspection
feature.

Inspection Path
dialog box

Sub-Operations group®Add Sub-Operation

®Type group®Scan Curve or 5 Axis Scan

Curve

5 Axis Scan Curve sub-operation

What is it?

Use a 5-axis scan curve sub-operation to inspect tight, irregular, or
difficult-to-inspect areas of a complex model. Because 5-axis inspection
systems quickly calibrate all angles that the probe can possibly use, they
are generally preferable to three-axis scanners that require calibration each
time an angle changes.
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Why should I use it?

Use the synchronized motion of 5-axis heads and controllers to better reach
difficult-to-inspect irregular features such as blades and blisks, and to reduce
set up, programming, and measurement time.

Where do I find it?

Application CMM Inspection Programming

Prerequisite

You must open a work part file with geometry that
allows you to create a curve inspection feature, create
an inspection file, and load a virtual machine with a
5-axis head and probe.

Inspection Path
dialog box

Sub-Operations group®Add Sub-Operation

®Type group®5 Axis Scan Curve

Delta Move sub-operation

What is it?

Use a Delta Move sub-operation to move your probe incrementally from its
current location to another location, using either Work Coordinate System
(WCS) or Machine Coordinate System (MCS) coordinates.
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Probe at the stop location of an
inspection path on a cylinder feature,
with the MCS visible above the probe
and WCS visible to the left of the
work part

Probe at the location of a delta move
sub-operation based on the WCS,
with Delta ZC set to 40 so that the
probe moves 40 millimeters from its
previous location

Where do I find it?

Application CMM Inspection Programming

Prerequisite
You must open a work part file and create an inspection
file.

Inspection Path
dialog box

Sub-Operations group®Add Sub-Operation

®Type group®Delta Move

Molded Part Validation enhancements

What is it?

Molded Part Validation has been redesigned to be more intuitive and easy
to use. Check Regions and Check Wall Thickness are now two separate
commands. When you use either of these commands, you can:
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• Use the Select option in the dialog box to select a body for analysis.

• Change your selection without closing the dialog box.

• Record and playback your analysis by using journaling.

The wall thickness check in Molded Part Validation now includes a
dynamic results display, in which spheres of different colors and sizes
represent thickness at the points that you select. You can also display PMI
labels for thickness results.

Where do I find it?

Application Mold Wizard

Menu
Analysis→Molded Part Validation→Check Regions
or Check Wall Thickness
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9 Tooling Design

Die Engineering

Addendum Section enhancements

What is it?

It is now easier to use the Reuse Library from the Addendum Section dialog
box.

• Thumbnails of the addendum section templates are available in the
Member View subgroup of the Section group.

• The Search and Folder View subgroups of the Section group are removed.

• Addendum section templates for metric parts are saved in
\ugautomotive\diedes\reuse_lib\metric\addendum_section and
addendum section templates for English parts are saved in
\ugautomotive\diedes\reuse_lib\english\addendum_section.

Where do I find it?

Application Modeling
Prerequisite The Section group is available only when you select a

face in the Product group.

The Section Shape list is available only when you select

At Point or At Plane in the Section group.

Toolbar Die Engineering®Addendum Section
Menu Tools®Vehicle Manufacturing Automation®Die

Engineering®Addendum Section
Location in dialog
box

Section group®Section Shape list®Reuse Library

What’s New in NX 8 9-1



Tooling Design

Edit Addendum Section

What is it?

Use the Edit Addendum Section command to open the Section Parameters
dialog box and edit the parameters for a selected addendum section.

Note Currently, the Edit Addendum Section command works only after you
access any command on the Die Engineering toolbar in the Modeling
application.

Where do I find it?

Application Modeling
Graphics window Right-click an addendum section feature®Edit

Addendum Section
Part Navigator Right-click an addendum section®Edit Addendum

Section

Pierce Task enhancements

What is it?

When you use the Pierce Task command, you can now do the following.

• You can view the press direction line of a curve as you select the curve for
piercing. The value of the angle between the press direction line of the
curve and the normal direction of the plane on which the curve lies is
also displayed.

• You can detect whether the press direction of the pierce equipment is safe
by checking the color of the press direction line of a curve.

o Green = Safe

o Red = Unsafe

o Yellow = Needs investigation

The color of the line is determined by the values you set for the following
new options in the Pierce Task dialog box.
Angle Check
Lower Limit

If the angle between the press direction of a curve and
the normal direction of the plane on which the curve
lies is below this value, the color of the line is green.

Angle Check
Upper Limit

If the angle between the press direction of a curve and
the normal direction of the plane on which the curve
lies is above this value, the color of the line is red.
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Note If the angle between the press direction of a curve and the normal
direction of the plane on which the curve lies is in between the two
values, the color of the line is yellow.

In the example, Angle Check Lower Limit is set to 5 and Angle Check
Upper Limit is set to 10.

Press direction is safe

Press direction is unsafe

Press direction needs investigation

• You can view the center lines and the press direction line of a pierced hole.
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• You can pierce the following new types of holes.

Rounded rectangular Chord rectangular

Why should I use it?

In previous releases, to check the angle between the press direction of a curve
and the normal direction of the plane on which the curve lies, you needed to
close the Pierce Task dialog box and use the Measure Angle command.

Where do I find it?

Application Modeling

Toolbar Die Engineering®Pierce Task
Menu Tools®Vehicle Manufacturing Automation®Die

Engineering®Pierce Task
Location in dialog box Settings group®Angle Check Upper Limit or

Angle Check Lower Limit

Trim Angle Check enhancements

What is it?

The Trim Angle Check command is enhanced to also display the output in the
form of line segments of variable lengths and colors in the graphics window.

The length of a line segment indicates the trim angle at a sample check
point and the color indicates whether the trim angle is compliant with
manufacturing specifications.
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• Green = Compliant

• Red = Noncompliant

• Yellow = Within a specified range of becoming noncompliant

Note You can specify the range in the Dangerous Zone Range customer
default.

Tip To find a customer default, choose File→Utilities→Customer Defaults,

and click Find Default .

Why should I use it?

You can now check if a trim angle is compliant with manufacturing
specifications by checking the color and the length of the line segments in
downstream piercing punch or trimming design.

Where do I find it?

Application Modeling

Toolbar Die Engineering®Trim Angle Check
Menu Tools®Vehicle Manufacturing Automation®Die

Engineering®Trim Angle Check
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Die Design

Draw Punch

What is it?

Use this command to create a draw punch which forms the shape in the sheet
metal. This command is similar to the Draw Die Punch command but it has
additional options and enhanced performance.

Note The Draw Die Punch command is now called Draw Die Punch (Legacy).

When you use the Draw Punch command you can:

• Use the standard and reusable templates from the Reuse Library to add
details such as a rib, a keyway, or a handling hole. You can also define
your own templates and then add them to the Reuse Library.

• Identify a failed feature and repair it.

• Create the core draw punch using the Core Draw Punch option.

• Use any one of the two methods, exact and rough offset, to create the draw
punch. If the sheet body from Die Engineering or other CAD systems is
imperfect, or has many gaps and fragments, you can have NX create a
rough offset feature based on the input body and you can trim the body to
form the punch face.

Sample Punch
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Where do I find it?

Application Modeling

Toolbar Die Design®Draw Punch
Menu Tools®Vehicle Manufacturing Automation®Die

Design®Draw Punch

Draw Die

What is it?

Use this command to create a draw die which forms the shape in the sheet
metal. This command is similar to the Upper Draw Die command but it has
additional options and enhanced performance.

Note The Upper Draw Die command is now called Upper Draw Die (Legacy).

When you use the Draw Die command you can:

• Use the standard and reusable templates from the Reuse Library to add
details such as a rib, a keyway, and a handling hole. You can also define
your own templates and then add them to the Reuse Library.

• Identify a failed feature and repair it.

• Create the core draw die using the Core Draw Die option.

• Use anyone of the two methods, exact and rough offset, to create the
draw die. If the sheet body from Die Engineering or other CAD systems
is imperfect, or has many gaps and fragments, you can have NX create a
rough offset feature based on the input body and you can trim the body
to form the die face.

Where do I find it?

Application Modeling

Toolbar Die Design®Draw Die
Menu Tools®Vehicle Manufacturing Automation®Die

Design®Draw Die
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Pierce Insert Design

Use the Pierce Insert Design command to select a hole curve created using
the Pierce Task command and then insert a standard punch or die from the
standard parts library.

Selected curves Inserted punch and die

Note NX derives the pierce hole curve attributes from the Pierce Task
command. Therefore, the Pierce Insert Design command works only for
the hole curves that you created using the Pierce Task command.

Where do I find it?

Application Modeling

Toolbar

Die Design®Pierce Insert Design

Menu Tools®Vehicle Manufacturing Automation®Die
Design®Pierce Insert Design

Manufacturing Geometry enhancements

What is it?

When you use the Manufacturing Geometry command, you can now add or
delete attributes of different objects that are included in the grouped faces.

In previous releases, you could view these attributes but you could not add or
delete them.
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Where do I find it?

Application Modeling, Electrode Design, Mold Wizard, Progressive
Die Wizard

Toolbar
(Modeling) Die Design®Manufacturing Geometry

(Electrode Design) Electrode Design®Manufacturing

Geometry

(Mold Wizard) Mold Wizard®Mold

Tools®Manufacturing Geometry

(Progressive Die Wizard) Progressive Die

Tools®Manufacturing Geometry
Menu (Modeling) Tools®Vehicle Manufacturing

Automation®Die Design®Manufacturing Geometry

(Electrode Design) Tools®Process Specific®Electrode
Design®Manufacturing Geometry

(Mold Wizard) Tools®Process Specific®Mold
Wizard®Mold Tools®Manufacturing Geometry

(Progressive Die Wizard) Tools®Process
Specific®Progressive Die Tools®Manufacturing
Geometry

Reuse of Standard Parts

What is it?

The Standard Part Library in Die Design is now available through the Reuse
Library. You can drag and drop standard parts into your assembly, and more
easily customize standard parts to suit the needs of your design process.

The user interface of the Standard Part Management dialog box is redesigned
to make the workflow easier and more intuitive.
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Where do I find it?

Application Die Design

Resource Bar
Reuse Library ®Stamping Die Standard Part
Library

Toolbar Die Design®Standard Parts
Menu Tools®Vehicle Manufacturing Automation®Die

Design®Standard Parts

Reuse of Standard Features

What is it?

The Stamping Die Reusable Feature in Die Design is now available through
the Reuse Library. You can drag and drop reusable features into your draw
punch and draw die, and you can add more features to suit the needs of
your design process.

Where do I find it?

Application Die Design

Resource Bar Reuse Library ®Stamping Die Reusable Feature

Mold Wizard

Pocket enhancements

What is it?

The Pocket command now supports all thread types defined in NX. In
addition, you can view the results of a pocket interference check in the HD3D
environment.

Why should I use it?

The improvements to the Pocket command let you use many more threaded
parts and make pocket checking easier to use and interpret.
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Where do I find it?

Application Mold Wizard

Toolbar Mold Wizard→Pocket
Menu Tools→Process Specific→Mold Wizard→Pocket

Design Inserts enhancement

What is it?

When you import a design insert, you can now specify the parent. Previously,
the relationship of the design insert to the solid body was hard-coded and
you could not change it.

Why should I use it?

The ability to specify a parent part for a design insert gives you more
flexibility in structuring your mold design assembly.

Where do I find it?

Application Mold Wizard

Toolbar Mold Wizard→Mold Tools→Design Inserts
Menu Tools→Process Specific→Mold Wizard→Mold

Tools→Design Inserts

Stock Size enhancements

What is it?

When you use the Stock Size command, you can change the CSYS direction
dynamically. You can specify a clearance, and you can create an expression
attribute for stock size information.

Why should I use it?

The improvements to the Stock Size command let you position elements
associatively, and customize clearance according to your design requirements.
You can:

• Predefine a named CSYS as a default direction in part templates.

• Predefine stock size types and clearance in part templates.

• Generate stock size attributes by predefined CSYS type and clearance if
you select multiple components in the bill of materials.
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Where do I find it?

Application Mold Wizard

Toolbar Mold Wizard→Mold Tools→Stock Size
Menu Tools→Process Specific→Mold Wizard→Mold

Tools→Stock Size

Design Parting Surface enhancement

What is it?

When you use the Extrude method to create a parting surface, you can now
specify a draft angle by using the new Draft option.

Why should I use it?

You can create a drafted parting surface within Mold Wizard. You do not have
to go into the Modeling application to create the drafted parting surface.

Where do I find it?

Application Mold Wizard
Toolbar Mold Wizard→Mold Parting Tools→Design Parting

Surface
Menu Tools→Process Specific→Mold Wizard→Parting

Tools→Design Parting Surface
Location in dialog
box

Create Parting Surface group®Method

subgroup®Extrude

Mold Design Validation enhancements

What is it?

Additional checkers are available from the Mold Design Validation dialog box,
and the dialog box is redesigned to make it easier to use.

Mold Part Quality combines the Undercut Checker and Draft Angle Checker,
which were previously available as separate checkers.
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Component Validation checks are available for checking interferences and
overlaps.

• Electrode checks for interferences in the electrode assembly.

• Core/Cavity validates the division of the part into cavity and core, checks
the geometry of each sheet that is going to be sewn, and checks for and
highlights overlapping sheets.

• Pocket checks for intersecting components, and highlights and shows all
standard parts that have no corresponding pockets. (This checker is also
available in the Pocket dialog box.)

Parting Validation has the following new checkers:

• Overlap Patch Surface checks for patch surfaces that overlap each other
and must be repaired before you can create trim sheets.

• Sheet Body Boundary checks the boundaries of sheet bodies, and is
especially useful for finding gaps in sheet bodies that patch internal loops.

Why should I use it?

The new checkers help you to ensure the manufacturability of your part.

Where do I find it?

Application Mold Wizard
Toolbar

Mold Wizard→Mold Design Validation
Menu Tools→Process Specific→Mold Wizard→Mold Design

Validation
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Reuse of standard parts

What is it?

The Standard Part Library in Mold Wizard is now available through the

Reuse Library . You can drag and drop standard parts into your assembly,
create families of mold components, and more easily customize standard
parts to suit the needs of your design process.

The user interface of the Standard Part Management dialog box is redesigned
to make the workflow easier and more intuitive.

• It now supports multiple standard part libraries.

• You can search for a standard part in Mold Wizard standard part libraries.

• You can configure you own libraries separate from the default Mold
Wizard library.

• You can control catalog visibility, for example, you can hide catalogs that
you do not use.

• Bitmap, catalog information, and comments appear in a separate
Information window.
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Why should I use it?

Accessing standard parts through the Reuse Library simplifies the Standard
Part Management dialog box, making design information clearer and easier
to use. It gives you access to more standard part libraries and makes it easier
to find the parts you are looking for.

Where do I find it?

Standard Part Management

Application Mold Wizard
Resource Bar

Reuse Library →MW Standard Part Library
Toolbar

Mold Wizard→Standard Part Library
Menu Tools→Process Specific→Mold Wizard→Standard

Part Library

Standard Part Library Management

Resource Bar
Reuse Library →MB3 on Name column→Library
Management

Toolbar
Reuse Library ®Reuse Library Management
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Mold Wizard library enhancements

What is it?

The Standard Part Library, the Slide and Lifter Library, the Cooling Standard
Part Library, and the Insert Library are all improved in the following ways:

• The metric and English catalogs are now up-to-date.

• New components are added.

• Retired components are removed.

• Many new vendor libraries are available.

Why should I use it?

The libraries provide more up-to-date selections of parts.

Where do I find it?

Application Mold Wizard
Resource Bar

Reuse Library →Mold Wizard Standard Part
Library

Toolbar
Mold Wizard→Standard Part Library or Slide and

Lifter Library or Cooling Standard Part Library

or Insert Library
Menu Tools→Process Specific→Mold Wizard→Standard

Part Library or Slide and Lifter Library or Insert Library

Tools→Process Specific→Mold Wizard→Cooling
Tools→Cooling Standard Part Library

Cooling enhancements

What is it?

Mold Cooling Tools enhancements include:

• A Cooling Circuits command that you can use to create and analyze
water flow to help you complete your cooling circuit design. When you
use this command, you can define a circuit that needs to be marked,
get related fittings, set the color for the circuit bodies, and classify the
different circuits by name.
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• A Define Channel command that lets you recognize existing
channel bodies or cylinder bodies as Mold Wizard cooling channels and
cooling baffles, lets you change their color and layer, and lets you add
COOLING_CHANNEL attributes to the bodies for cooling channels or
COOLING_CHANNEL and COOLING_BAFFLE attributes to the bodies
for cooling baffles.

• Changes to the Cooling Fittings command that let you add a cooling
baffle automatically and select an intersection body so that fittings
can be designed in one part file. You can also have baffles created
automatically when the cooling body has both COOLING_CHANNEL and
COOLING_BAFFLE attributes. In this case, NX determines the baffle
length.

Why should I use it?

You can design cooling fittings and cooling circuits quickly and easily.

Where do I find it?

Application Mold Wizard

Toolbar Mold Wizard→Mold Cooling Tools
Menu Tools→Process Specific→Mold Wizard→Cooling

Tools

Create Box enhancements

What is it?

The Create Box dialog box has been redesigned so that the order in which
you enter your inputs now matches your workflow. Other enhancements to
the Create Box command include the following.

• You can specify the orientation of the box.

• You can specify the color of the box.
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Where do I find it?

Application Mold Wizard, Progressive Die Wizard, Electrode Design
Toolbar Mold Tools or Progressive Die Tools or Electrode

Design®Create Box
Menu Tools®Process Specific®Mold Wizard®Mold

Tools®Create Box

Tools®Process Specific®Progressive Die
Wizard®Progressive Die Tools®Create Box

Tools®Process Specific®Electrode Design®Create
Box

Location in dialog
box Reference CSYS®Specify Orientation

Settings®Color

Replace Solid enhancements

What is it?

The Replace Solid dialog box has been redesigned so that the order in which
you enter your inputs now matches your workflow. Other enhancements to
the Replace Solid command include the following.

• A Reverse Direction option that lets you reverse the direction of the
replacement solid.

• A Remove Parameters check box that, when you select it, removes feature
parameters from the bounding box.

• A Clearance option that lets you change the clearance value.
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Where do I find it?

Reverse Direction

Application Mold Wizard, Progressive Die Wizard, Electrode Design
Toolbar Mold Tools or Progressive Die Tools or Electrode

Design®Replace Solid
Menu Tools®Process Specific®Mold Wizard®Mold

Tools®Replace Solid

Tools®Process Specific®Progressive Die
Wizard®Progressive Die Tools®Replace Solid

Tools®Process Specific®Electrode Design®Replace
Solid

Location in dialog
box Replacement Face®Reverse Direction

Settings®Remove Parameters

Settings®Clearance

Trim Solid enhancements

What is it?

The Trim Solid dialog box has been redesigned so that the order in which you
enter your inputs now matches your workflow. Other enhancements to the
Trim Solid command include the following.

• A Select Target Component option that lets you link the resulting trim
body to a selected component.

• A Remove Parameters check box that, when you select it, removes feature
parameters from the bounding box.
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Where do I find it?

Application Mold Wizard, Progressive Die Wizard, Electrode Design
Toolbar Mold Tools or Progressive Die Tools or Electrode

Design®Trim Solid
Menu Tools®Process Specific®Mold Wizard®Mold

Tools®Trim Solid

Tools®Process Specific®Progressive Die
Wizard®Progressive Die Tools®Trim Solid

Tools®Process Specific®Electrode Design®Trim
Solid

Location in dialog
box Target®Select Target Component

Settings®Remove Parameters

Progressive Die Design

Quick Quotation

What is it?

Use the Quick Quotation command to calculate a quick cost estimation
of your progressive die based on your conceptual design. You can estimate
your complete design, or you can run an early estimate when you finish the
strip layout.

The Quick Quotation dialog groups have the following uses.
• Use the Job Information options to specify the job information, such as
the quote number and customer name.

• Use the Project Definition options to specify the base information of a
project.

• Use the Concept Design options to make a conceptual design for the die
base and each of the insert groups.

• Use the Grouping options to group the profile defined in Concert Design
into a different insert group. For example, you can identify a selected
insert group as piercing or bending.

• Use the Setting options to choose a material for the insert group and to
configure the quick quotation template. You can change the template
language, add materials, and change the material heat-treatment cost.
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Why should I use it?

The Quick Quotation command provides an automated standard method to
produce a cost estimation. Currently, most companies use manual methods
that are time-consuming and unreliable because they are based on the
experience of the quoter.

Where do I find it?

Application Progressive Die Wizard
Prerequisite You must initialize a progressive die project.

Toolbar Progressive Die Wizard®Quick Quotation

Menu
Tools®Process Specific®Progressive Die
Wizard®Quick Quotation

Changeover Management

What is it?

Use the Changeover Management command to reuse an existing die design
for a similar sheet metal part. You can then modify the existing design for a
new part, and also keep the previous design in one project assembly.

The Changeover Management command also helps you manage multiple
changeovers for different sheet metal parts.

In the Changeover Management dialog box, the Changeovers tree lists all
the changeovers in your current project assembly, with a green check beside
the currently-used changeover. You can select a different changeover for use,
or you can add or remove components from a selected changeover.

When you select a component in the graphics window, any changeovers that
use it are displayed in the Status line. The bill of material (BOM) reports only
the components related to the current active changeover.

Why should I use it?

When the die design you need is similar to an existing design, creating a
changeover instead of starting the design from scratch can save significant
time and effort. All unchanged designs can be shared for different product
packages.

What’s New in NX 8 9-21



Tooling Design

Where do I find it?

Application Progressive Die Wizard
Prerequisite You must initialize a progressive die project.

Toolbar

Progressive Die Wizard®Workflow Management

®Changeover Management

Menu

Tools®Process Specific®Progressive Die
Wizard®Workflow Management®Changeover
Management

Concurrent Design Management

What is it?

Use the Concurrent Design Management command when multiple designers
need to work on a progressive die design project simultaneously. The project
lead assigns the design tasks to the designers, and each designer works under
a separate node.

Why should I use it?

The advantages of using the Concurrent Design Management command
include the following.

• Having multiple designers work on the same project shortens the delivery
time.

• Other designers can modify and save in their own node without causing
unintentional modifications and saves in your node. If any of their
changes affect your node, you can wait until a convenient time to update.

• Each designer can check and reference other designers’ designs.

• You can use this command in both native NX and the Teamcenter
Integration for NX environments.

Where do I find it?

Application Progressive Die Wizard
Prerequisite You must initialize a progressive die project.

Toolbar

Progressive Die Wizard®Workflow Management

®Concurrent Design Management

Menu

Tools®Process Specific®Progressive Die
Wizard®Workflow Management®Concurrent Design
Management
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Bending Insert Design

What is it?

The Bending Insert Design command, which in NX 7.5 was a tab on the
Insert Group dialog box, now has a separate toolbar button and dialog box.
The Bending Insert Design dialog box has been redesigned so that the order
in which you enter your inputs now matches your workflow.

Other enhancements include the following:

• You can classify the die and punch when you load a bending insert using
the Standard Parts command.

• You can create a user-defined bending insert.
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Where do I find it?

Application Progressive Die Wizard and Engineering Die Wizard

Prerequisite
You must initialize a progressive or engineering die
project.

Toolbar Progressive Die Wizard or Engineering Die Wizard

Menu
Tools®Process Specific®Progressive Die Wizard or
Engineering Die Wizard®Bending Insert Design

Burring Insert Design

What is it?

The Burring Insert Design command, which in NX 7.5 was a tab on the Insert
Group dialog box, now has a separate toolbar button and dialog box. The
Burring Insert Design dialog box has been redesigned so that the order in
which you enter your inputs now matches your workflow.

You can rename burring punch or die components when you create them.
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Where do I find it?

Application Progressive Die Wizard and Engineering Die Wizard

Prerequisite
You must initialize a progressive or engineering die
project.

Toolbar

Progressive Die Wizard or Engineering Die

Wizard®Burring Insert Design

Menu
Tools®Process Specific®Progressive Die Wizard or
Engineering Die Wizard®Burring Insert Design

Component Drawing enhancements

What is it?

The Component Drawing command is enhanced to let you specify different
templates, drawing names, or sheet names for component drawings before you
create them. Also, you can now easily list the parts with existing drawings.

Why should I use it?

Many die and mold companies use component drawings to communicate
design information to machinists. Mold and die designs may require
hundreds of component drawings, so a well-designed automatic drawing
tool that can create component drawings in batch is essential. Specifying
dimensions and annotations for the drawings as part of their batch creation,
instead of manually finishing each drawing after batch creation, can save
you a lot of time and effort.
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Where do I find it?

Application Mold Wizard and Progressive Die Wizard
Prerequisite You must enter the Drafting application.

Toolbar

Mold Wizard or Progressive Die Wizard®Mold Drawing
Drop-down or Progressive Die Drawing Drop-down

list ®Component Drawing

Menu

Tools®Process Specific®Mold Wizard or Progressive
Die Wizard®Mold Drawing or Progressive Die
Drawing®Component Drawing

Standard part catalogs

What is it?

The library used by the Standard Parts command is enhanced with an
updated catalog of punches from MiSUMi, one of the largest standard part
companies. The punches are used in progressive dies and other dies that you
can create with the Progressive Die Wizard and the Engineering Die Wizard.

Where do I find it?

Application Progressive Die Wizard and Engineering Die Wizard

Toolbar

Progressive Die Wizard or Engineering Die

Wizard®Standard Parts

Menu
Tools®Process Specific®Progressive Die Wizard or
Engineering Die Wizard®Standard Parts

Progressive Die Wizard enhancements

What is it?

The following Progressive Die Wizard commands have been redesigned for
easier use.

• Die Base

• Bending Insert Design

• Burring Insert Design

• Clearance Management
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• Corner Design

• Delete Files

Why should I use it?

The redesigned dialog boxes are easier to use, because you fill them out from
top to bottom, so your inputs match your workflow.

Where do I find it?

Die Base

Application Progressive Die Wizard and Engineering Die Wizard

Toolbar

Progressive Die Wizard or Engineering Die

Wizard®Die Base

Menu
Tools®Process Specific®Progressive Die Wizard or
Engineering Die Wizard®Die Base

Bending Insert Design

Application Progressive Die Wizard and Engineering Die Wizard

Toolbar

Progressive Die Wizard or Engineering Die
Wizard®Bending Insert Design

Menu
Tools®Process Specific®Progressive Die Wizard or
Engineering Die Wizard®Bending Insert Design

Burring Insert Design

Application Progressive Die Wizard and Engineering Die Wizard

Toolbar

Progressive Die Wizard or Engineering Die

Wizard®Burring Insert Design

Menu
Tools®Process Specific®Progressive Die Wizard or
Engineering Die Wizard®Burring Insert Design
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Clearance Management

Application Progressive Die Wizard

Toolbar

Progressive Die Wizard®Progressive Die Tools

®Clearance Management

Menu

Tools®Process Specific®Progressive Die
Wizard®Progressive Die Tools®Clearance
Management

Corner Design

Application Mold Wizard and Progressive Die Wizard

Toolbar

Mold Wizard or Progressive Die Wizard®Mold Tools

or Progressive Die Tools ®Corner Design

Menu

Tools®Process Specific®Mold Wizard or Progressive
Die Wizard®Mold Tools or Progressive Die
Tools®Corner Design

Delete Files

Application Mold Wizard and Progressive Die Wizard

Toolbar

Mold Wizard®Unused Part Management

Progressive Die Wizard®Progressive Die

Tools®Delete Files

Menu

Tools®Process Specific®Mold Wizard®Unused Part
Management

Tools®Process Specific®Progressive Die
Wizard®Progressive Die Tools®Delete Files
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Direct Unfolding enhancements

What is it?

The Direct Unfolding command is enhanced to create a top-level assembly
only when you create intermediate stages.

Why should I use it?

When your project does not need intermediate stages, the number of part files
that NX creates is reduced.

Where do I find it?

Application Progressive Die Wizard

Toolbar

Progressive Die Wizard®Sheet Metal Tools

®Direct Unfolding

Menu
Tools®Process Specific®Progressive Die
Wizard®Sheet Metal Tools®Direct Unfolding

Location in dialog
box Type group®Create Intermediate Stages

Analyze Formability — One-step enhancements

What is it?

The Analyze Formability — One-step command is enhanced as follows:

• For the Entire Unform type, you can now select either a solid body or
faces. In previous releases, you could only select faces.

When you select a solid body, the middle surface is automatically created.

• For the Intermediate Unform type, the Outer Surface and Inner Surface
thickness options are now available. In previous releases, only the Middle
Surface thickness option was available.

• For all types, the Curve along Curve option now supports all the curve
options in selection intent. In previous releases, you could only select
single curves.
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Where do I find it?

Application Progressive Die Wizard

Prerequisite From the Type list, select Entire Unform .

Toolbar

Progressive Die Wizard®Sheet Metal Tools

®Analyze Formability — One-step
Menu Analysis®Analyze Formability — One-step

Location in dialog
box

Object Type group®Object Type list®Solid®select a
solid body in the graphics window

Thickness group®Surface Type®Outer Surface/Inner
Surface

Boundary Conditions group®Constraint Type®Curve
along Curve

Reuse of standard parts

What is it?

The Standard Part Library in Progressive Die Wizard is now available
through the Reuse Library. You can drag and drop standard parts into your
assembly, and more easily customize standard parts to suit the needs of
your design process.

The user interface of the Standard Part Management dialog box is redesigned
to make the workflow easier and more intuitive.

Where do I find it?

Application Progressive Die Wizard

Resource Bar Reuse Library ®PDW Standard Part Library

Toolbar Progressive Die Wizard®Standard Part Library

Menu
Tools®Process Specific®Progressive Die
Wizard®Standard Part Library
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Engineering Die Design (EDW)

Engineering Die Design

What is it?

Use the Engineering Die Design application to design various die types such
as the following:

• Transfer die

• Tandem die

• Compound die

• Single die

• Blanking die

• Reverse die

The Engineering Die Design shares most of its functions with the Progressive
Die Wizard. Items that are unique to the Engineering Die Design include
the following.

• The Station Management command

• A die base for the Engineering Die Design for different die types

Why should I use it?

The Engineering Die Design helps you design a wide variety of die types.

Transfer dies are used for sheet metal parts without a carrier in their strip,
such as covers for cell phones or video cameras.

Tandem dies are used for large sheet metal parts, such as automotive panels,
TV covers, washing machines, or desktop computer cases.

Where do I find it?

Menu Start®All Applications®Engineering Die Design
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Station Management

What is it?

Use the Station Management command to define the engineering die station
layout and station attributes, including the following.

• Create or delete a station.

• Define the station number and distance.

• Define the station name.

• Add or remove selected entities from the station.

Where do I find it?

Application Engineering Die Design

Prerequisite

You must initialize an engineering die project.
Choose Tools®Process Specific®Engineering Die
Design®Initialize Project.

Toolbar Engineering Die Design®Station Management

Menu
Tools®Process Specific®Engineering Die
Design®Station Management

Electrode Design

Electrode Fixture

What is it?

Use the Electrode Fixture command to do the following.

• Add electrode holder and pallet components from the Reuse Library to
your electrode design assembly.

• Edit electrode holder and pallet components installed in your electrode
design assembly.
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Where do I find it?

Application Electrode Design

Toolbar Electrode Design®Electrode Fixture

Menu
Tools®Process Specific®Electrode
Design®Electrode Fixture

Resource Bar
Reuse Library ®Electrode Holder Library or
Electrode Pallet Library

Delete Body/Component

What is it?

Use the Delete Body/Component command to delete a selected electrode
sparking body or component.

Where do I find it?

Application Electrode Design

Toolbar Electrode Design®Delete Body/Component

Menu
Tools®Process Specific®Electrode Design®Delete
Body/Component

Check Electrode enhancements

What is it?

The Check Electrode command is enhanced to show the checking results in
the HD3D Check-Mate dialog box.

The Check Electrode command replaces the Electrode Checking command
that was available in NX 7.5.

Why should I use it?

Results are now kept with the electrode assembly. You can get the last
checking status if you reopen the assembly.
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Where do I find it?

Application Electrode Design

Toolbar Electrode Design®Check Electrode

Menu
Tools®Process Specific®Electrode Design®Check
Electrode

Electrode Design enhancements

What is it?

The following Electrode Design commands are enhanced with redesigned
dialog boxes.

• Initialize Electrode Project

• Design Blank

• Electrode Drawing

Enhancements to the Design Blank command include the following:

• Graphics are displayed in a separate window.

• Parameters of the blank are displayed in the Design Blank dialog box.

• The recommended sizes of the blank are displayed after you choose the
electrode head bodies.

Enhancements to the Electrode Drawing dialog box include the following:

• You can generate EDM and CNC drawings.

• A4 size drawing sheet templates are available.

• You can change the drawing sheet template for existing drawings.

• Two drawing types, Master Model and Self Contained, are available.

• You can create PDF files for drawings.

Why should I use it?

The redesigned dialog boxes are easier to use, because you fill them out from
top to bottom, so your inputs match your workflow.
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Where do I find it?

Initialize Electrode Project

Application Electrode Design

Toolbar

Electrode Design®Initialize Electrode Project or

Design Blank or Electrode Drawing or Check

Electrode

Menu

Tools®Process Specific®Electrode Design®Initialize
Electrode Project or Design Blank or Electrode
Drawing or Check Electrode

Weld Assistant

Move spot welds using Easy Spot

What is it?

You can now move existing spot weld features to new locations using the new
Move option in the Easy Spot dialog box.

This option is useful if you have existing weld features and the underlying
part geometry has changed. Use the option to compute new centerlines and
map existing weld features to the new locations.

All the original attributes of the weld are maintained after it is moved.
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First component being welded
Second component being welded
Original position of the weld points
New position of the weld points
Moved weld

When you select the weld points to be moved in the graphics window, the
selected weld points appear in:

• A red color in the graphics window.

• A list in the Easy Spot dialog box.

If you select a weld point in this list, it appears in the graphics window
in a different color.

Tip You can customize these colors using the Dimension Color and
Preview Modeling customer defaults. These defaults are available
in the File®Utilities®Customer Defaults dialog box, on the
Modeling®General®Colors tab.

When you use the Move option, you can specify a Reuse Match Tolerance
value for the new location.

The weld points you select for moving are listed in the Easy Spot dialog
box as one of the following:

• Mapped Point— This indicates that the weld point is outside the specified
Reuse Match Tolerance value and will be moved.

• Coincident Point — This indicates that the weld point is within the
specified Reuse Match Tolerance value and will not be moved.

• New Point— This indicates that no mapping feature is assigned, and a
new weld feature will be created.

You can also specify a Uniform Spacing Tolerance value. Specify this value
as 0.0 to create a spacing less than the Maximum Spacing. This tolerance
creates one less point on each overlap region that is computed.

Why should I use it?

Because this command computes the new centerlines and maps the existing
weld features to the new locations, the process of locating the new positions
for existing weld points is simplified.
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Where do I find it?

Application Modeling

Toolbar Weld Assistant®Easy Spot
Menu Insert®Welding®Easy Spot
Location in dialog
box Type group®Move

Import/Export Template Separator String

What is it?

You can now substitute attribute titles in weld point CSV files using separator
strings in templates. Use the Import/Export Template Separator String
customer default to define the separator string.

You can also specify the template file when you import a weld points file.

Example Consider a .def file with the following contents:

NUMBER OF SHEETS WELDED
X_POS
Y_POS
Z_POS

The exported template file looks like the following example.

NUMBER
OF SHEETS
WELDED

X_POS Y_POS Z_POS

2 43.5 21.956708 0
2 43.5 57.276736 0
2 43.5 95.599374 0

If you use a colon as a separator string and customize the template as
follows:

NUMBER OF SHEETS WELDED
X_POS:x coordinate
Y_POS:y coordinate
Z_POS:z coordinate
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The exported template file looks like the following example.

NUMBER
OF SHEETS
WELDED

x coordinate y coordinate z coordinate

2 43.5 21.956708 0
2 43.5 57.276736 0
2 43.5 95.599374 0

Tip Use a string of two or more characters to make your separator string
unique. For example, ::: or :->. This is useful when the attributes have
colons such as PART1:A.

Where do I find it?

Application Modeling
Menu File®Utilities®Customer Defaults
Location in dialog
box Weld Assistant®Extras page®General tab

Rules-based Structure Welding

Structure Welding

What is it?

Structure Welding is a new suite of welding functions that are designed to
generate arc welds between prismatic type parts such as plates and extruded
profiles.

Use rules-based structure welding to:

• Define arc welds in a CAD model.

• Generate a light weight NX feature to represent each weld.

• Control weld placement using algorithms that analyze the geometry being
welded and identify the most logical location.

• Define welds by using commands that are available on the Structure
Welding toolbar or by using rules-based callbacks. You can customize
these callbacks to use any set of weld rules to control the weld definition.

• Drive the edge preparation and weld symbol creation from the welding
joint feature.
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Structure welding functions include the following:

• Welding Joint— creation and modification of welding joints.

• Assign Weld Attributes— edit and assignment of welding attributes
to curves or edges.

• Weld Preparation— preparation of edges of plates for welding.

• Auto Weld Symbol— creation of welding symbols.

• Rules-based callbacks.

Why should I use it?

Use these functions for prismatic type parts such as plates and extruded
profiles.

Each weld feature is saved as a light weight NX feature. This allows you to
define and work with a large number of welds in an NX session.

You can customize the callbacks to use a set of weld rules that comply with
the standards used in your company.

Where do I find it?

The callback location is ugweld\samples.

Application Modeling
Toolbar Structure Welding®[Structure welding command]

Menu
Insert®Structure Welding®[Structure welding
command]
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Welding Joint

Use the Welding Joint command to create T-joint and butt welds between
plate-like structures. You can use this command to create welding joint
features using lightweight connections when a solid representation of the
weld is not required.

Model
’Welding Joint (4) "WLD0"
’Welding Joint (5) "WLD1"
’Welding Joint (6) "WLD2"
’Welding Joint (7) "WLD3"
’Welding Joint (8) "WLD4"
’Welding Joint (9) "WLD5"
’Welding Joint (10) "WLD6"
’Welding Joint (11) "WLD7"

You can create welding joint features:

• Automatically. NX infers the weld edges based on the edge selections
you make.

• Manually. You must select all the faces and edges required to define the
welding joint feature.

• Using attributes placed on plates in the Ship Design application.

You can also:

• Display welding joints as curves. The curves are available for selection.

• Save the welding joint curves in Teamcenter.

• Configure the attributes assigned to the welding joints.

• Customize the color of the curves that represent these welding joint
features by using the Fillet Color and Butt Color customer defaults.

• Create individual weld joints or create joints that are component pairs.
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• Use the weld joints to prepare edges by using the Weld Preparation
command.

• Create weld symbols for the weld joints.

• Reduce user-interaction when defining weld joints.

• Create multiple welds simultaneously.

Where do I find it?

Welding Joint command

Application Modeling

Toolbar Structure Welding®Welding Joint
Menu Insert®Structure Welding®Welding Joint

Fillet Color/Butt Color customer defaults

Menu File®Utilities®Customer Defaults
Location in dialog
box Structure Welding®Common®Welding Joint tab

Weld Preparation

What is it?

Use the Weld Preparation command to prepare the edges of plates before
welding.

This command must be used in conjunction with welding joint features.
Welding joint features contain the information necessary to modify the
edges of components being joined. The Weld Preparation command applies
the modifications to the edges that are to be welded. The modifications are
applied to the manufacturing body.

For example, you can chamfer the edges on one or both sides of a plate to
prepare it for welding.
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You can modify the profile of an edge or plate according to custom parameters.
APIs are provided to specify the custom parameters.

The following are examples of the kinds of changes you can make.

Example 1

Example 2

Example 3

Why should I use it?

The resultant features from this command can be used to convey weld
preparation information on the model or on drawings.
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Where do I find it?

Application Modeling

Toolbar Weld Assistant®Weld Preparation
Menu Insert®Welding®Weld Preparation

Assign Weld Attributes

What is it?

Use the Assign Weld Attributes command to assign or edit welding attributes
to curves or edges.

When you use this command on curves or edge, weld attributes are
propagated as follows.

• If such curves are used to create plates in the Ship Design application,
then the weld attributes propagate to the plate edges.

• If such edges are used to create a welding joint, then the weld attributes
propagate to the welding joint.

Note You can restrict the attributes that are available for assignment using
customer defaults.

Why should I use it?

Use this command to update edges or curves so that they can be used to
define weld locations. The attributes you assign to the edges are transferred
to the welding joint itself.

Where do I find it?

Assign Weld Attributes command

Application Modeling

Toolbar Structure Welding®Assign Weld Attributes
Menu Insert®Structure Welding®Assign Weld Attributes

Characteristics customer default

Menu File®Utilities®Customer Defaults
Location in dialog
box Structure Welding®Common®Welding Joint tab
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Callbacks for creating welding joint definition

What is it?

NX now provides APIs to write callbacks that communicate with a customer’s
rule-base for creation of welding joints.

You can:

• Use these APIs to define welding joints as per custom rules using NX.

• Use any of the NX Open Automation Languages such as Open for C/C++,
Open for Java, Open for .NET, Knowledge Fusion, and Open C to write
callbacks.

• Use the Welding Joint command to execute a defined callback and store
the welding joint parameters with the welding joint feature. The Weld
Preparation command uses these values to prepare the edges on the
manufacturing body.

Where do I find it?

The callback location is ugweld\samples.
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10 Data translation

CATIA V5 Export/Import — CATIA V5 R20 SP3 support

What is it?

The NX CATIA V5 translator now supports the translation of CATIA V5
Revision 20 SP3 files to NX.

Why should I use it?

Use this option if you want to translate files created with CATIA V5 R20 SP3.

Where do I find it?

Support for CATIA V5 R20 SP3 files is available from all NX 8.0 CATIA V5
Translator interfaces.

The translator can be invoked from:

• command line

• the XlatorUI external user interface

• Teamcenter UI
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or

Application NX user interfaces.
Menu File®Open®Files of type: CATIA V5 Files (*.CATPart)

or CATIA V5 Assemblies (*.CATProduct).

or

File®Import®Part®Files of type: CATIA V5 Files
(*.CATPart) or CATIA V5 Assemblies (*.CATProduct).

or

File®Import®CATIA V5

or

File®Export®CATIA V5

or

File®Save as type: CATIA V5 Files (*.CATPart) or
CATIA V5 Assemblies (*.CATProduct).

DXF/DWG import interface

What is it?

The NX DXF/DWG translator import interface now has the following
capabilities.

1. Ability to Preview (with zoom and different backgrounds) the selected
DWF/DWG files.

2. Ability to select the template part file.

3. Options to select the data for import (model / layouts).

4. Options to control destination of selected data (modeling / drawing sheet /
drawing view).

5. Options to create sketch curves (for future edits).

6. Option to create customer symbol of AutoCAD blocks.

7. Options to control layer mapping.

8. User interface to define text fonts, line style and cross hatch mapping.
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Why should I use it?

Use this option if you want to configure the import of DWF/DWG data to NX.

Where do I find it?

Application NX
Menu File®Import®DXF/DWG

File®Open®DWG®Options

PMI support in STEP translator

What is it?

You can now translate PMI data from NX to STEP as polyline (presentation)
data. You can also now import PMI (polyline form) from STEP to NX.

Why should I use it?

Use this if you want to translate NX PMI to STEP and Import STEP PMI to
NX.

Where do I find it?

Application NX
Menu File®Import®STEP203

File®Import®STEP214

File®Export®STEP203

File®Export®STEP214

DXF/DWG Translator: Export to Drawing CGM data to DXF/DWG

What is it?

A new settings file keyword EXPORT_DRAWING_USING_CGM has been
added to export NX Drawing to DXF/DWG via CGM.

This functionality will export NX model data to ACAD model space and CGM
of selected drawing sheets to ACAD layouts.
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Why should I use it?

Use this option is you want to create DXF/DWG based on the display (mostly
for viewing/printing). It will allow you to create DXF or DXG based on the
CGM representation of the NX drawing.

Where do I find it?

The new keyword EXPORT_DRAWING_USING_CGM is present in the
settings file dxfdwg.def within $DWFDWG_DIR. The default value is set to
No. Set the value to Yes if you want to take advantage of this functionality.

DXF/DWG Translator: Retaining the original aspect ratio of text

What is it?

A new settings file keyword USE_NX_TEXT_ASPECT_RATIO has been added
to retain the same aspect ratio as that of NX Text in DXF/DWG.

Why should I use it?

While translating text from NX to DXF/DWG, because of the different fonts in
NX and AutoCAD, the DXF/DWG translator does an automatic calculation of
aspect ratio in order to keep the length of text the same as in AutoCAD. If you
want to retain the same aspect ratio as in NX you can use the new settings
file keyword USE_NX_TEXT_ASPECT_RATIO.

Where do I find it?

The new keyword USE_NX_TEXT_ASPECT_RATIO is present in the settings
file dxfdwg.def within $DWFDWG_DIR. The default value is set to No. Set
the value to Yes if you want to take advantage of this functionality.

DXF/DWG Translator: Translation of unsaved data

What is it?

You can now translate the unsaved data in your NX session to DXF/DWG
using File®Export®DXF/DWG.

Why should I use it?

Use this option if you want to translate unsaved data to DXF/DWG.
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Where do I find it?

If you export unsaved data to DXF/DWG, you will receive a warning asking
to save the part first. If you click Continue it will translate the unsaved
data to DXF/DWG.

Note Make use of the Continue option only when it is absolutely necessary.
The graphics updates on screen may cause an increase in the translation
time. We recommend working on saved drawings.

2D Exchange Translator: Translating multiple drawings

What is it?

You can translate multiple drawings using 2D Exchange to NX Part files
in DXF, DWG, and IGES formats. This is possible only while exporting to
Drafting.

Why should I use it?

Use this option if you want to translate multiple drawings to NX Part files in
DXF, DWG, and IGES formats.

Where do I find it?

Application NX user interface
Menu File®Export®2D Exchange, Data to Export tab, you

can select multiple drawings under Drawings Export.

Note Exporting multiple drawings is not possible when you export data to
Modeling.

NX CATIA V5 Translator: MAC operating system (OS) support

What is it?

The NX CATIA V5 translator is now available on MAC operating system (OS).

Why should I use it?

Use this option if you want to translate data between NX and CATIA V5 on
the MAC OS platform.
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Where do I find it?

The translator can be invoked on MAC OS from:

• command line

• the XlatorUI external user interface

• Teamcenter UI

or

Application NX user interface
Menu File®Open, File®Import®Part, under Files of type:

CATIA V5 Files (*.CATPart) or CATIA V5 Assemblies
(*.CATProduct)

or

File®Import®CATIA V5

or

File®Export®CATIA V5
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11 Programming and automation

Multiple libraries for linking in C++ projects

What is it?

When you perform linking in C++, you now have to include additional
libraries. Due to the continuous addition of JA functions, the libnxopencpp
library is reaching its limit, so the libnxopencpp library is split into multiple
libraries. The libraries are based on the namespaces available. There are
currently 35 different namespaces in NX Open, so 35 new libraries are added.

You need to refer to the appropriate libraries when building a new NX Open
C++ application, or when you modify existing projects to refer to the newly
added libraries.

Note Only linking is affected. The compilation process for NX Open programs
remains the same.

Why should I use it?

You need to incorporate the new library files into your C++ projects.

Where do I find it?

The NX Open C++ wizard and uflink script are updated for the new libraries.

Switching to another application within an NX Open program

What is it?

The ApplicationSwitchRequest API is added to enable you to switch to
another application within an NX Open program. This allows you to build
customizations that access multiple NX applications.

Due to existing coding limitations, the API is used to request the application
switch within the program but the actual switch does not occur until the NX
Open program terminates.

As long as the current file is a standard .prt file and the user has the
appropriate license, the application switch can be performed. If the current
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file is a .sim or .fem file and the current application is Simulation, then the
application switch cannot be performed.

Why should I use it?

You can switch to another application in your NX Open programs.

Where do I find it?

The new API is described in the NX Open API reference documentation.

Java objects supported when using remote applications

What is it?

UF wrapped Java methods that use UFVariant objects as parameters or
return types are now supported when they are used in applications that are
accessed remotely.

Why should I use it?

You can use the UFVarient objects in applications that are used remotely.

Where do I find it?

The JAVA APIs that use UFVariant objects are described in the NX Open
API reference documentation.

Block UI Styler

Balloon tooltip properties for dialog blocks

What is it?

You can use balloon tooltip properties to provide the end-user with additional
information for dialog blocks that you create using NX Open and Block UI
Styler. The tooltip appears when the user points to an option or icon in the
block. The balloon tooltip properties allow you to specify the text, the image,
and the layout of text with respect to the image in the balloon tooltip.

These properties are available for many dialog blocks. Blocks support
properties for single or multiple balloon tooltips.

Note The user must select the Show Balloon Tooltips on Dialog Options
check box in the Customize dialog box to turn on the balloon tooltips.
There is no special property to turn on balloon tooltips; the tooltip appears
when you specify text and an image for it.
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Blocks with a single balloon tooltip

The following blocks support a single balloon tooltip:

• Label/Bitmap

• Action Button

• Object Color
Picker

• RGB Color
Picker

• Specify Point

• Specify Vector

• Section
Builder

• Specify CSYS

• Specify Plane

• Specify
Orientation

• Select Object

• Select Feature

• Curve Collector

• Body Collector

• Face Collector

• Super Section

• Double

• Integer

• Expression

• Angular
Dimension

• Radius
Dimension

• Linear
Dimension

• On Path
Dimension

The balloon tooltip appears over the label or the bitmap for the block.

Property Name Description Access
Property

Type
List of Values

BalloonTooltipText Specifies text for the

balloon tooltip.

CIGS String Any string value. Type \n to

specify a line feed in the text.
BalloonTooltipImage Specifies the file name

of the image to be

displayed in the balloon

tooltip.

CIGS String Specify a valid bitmap file

name from the NX library. You

need not specify the suffix and

extension.

You can also specify the complete

path of an image file. NX

supports the following image

file formats: TIFF, PNG, GIF,

JPEG, and BMP.
BalloonTooltipLayout Specifies the location

of text with respect

to the image in the

balloon tooltip. This is

applicable only when

both text and image are

specified.

CIGS Enum Horizontal - This is the default

value. The text is placed to the

right of the image.

Vertical - The text is placed below

the image. Specify this value

when the image is more than

300 pixels wide or if the width

to height ratio of the image is

greater than 4.
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Blocks with two balloon tooltips

The Toggle block supports separate balloon tooltip properties for on and off
states. Therefore, different text and images can appear in the balloon tooltip
for on and off states. The balloon tooltip appears over the label, button, or
bitmap for the toggle block. The following table describes the balloon tooltip
properties that are available for the Toggle block.

Property Name Description Access
Property

Type
List of Values

BalloonTooltipOnText

BalloonTooltipOffText

Specifies text for the

balloon tooltip.

CIGS String Any string value. Type \n to

specify a line feed in the text.

BalloonTooltipOnImage

BalloonTooltipOffImage

Specifies the file

name of the image

to be displayed in the

balloon tooltip.

CIGS String Specify a valid bitmap file

name from the NX library.

You need not specify the suffix

and extension.

You can also specify the

complete path of an image file.

NX supports the following

image file formats: TIFF,

PNG, GIF, JPEG, and BMP.
BalloonTooltipLayout Specifies the location

of text with respect

to the image in the

balloon tooltip. This is

applicable only when

both text and image

are specified.

CIGS Enum Horizontal - This is the default

value. The text is placed to

the right of the image.

Vertical - The text is placed

below the image. Specify this

value when the image is more

than 300 pixels wide or if the

width to height ratio of the

image is greater than 4.

The Specify Axis block supports separate balloon tooltip properties for the
two sub-blocks: Specify Vector and Specify Point. The balloon tooltip appears
over the label of the Specify Axis sub-blocks. The following table describes the
balloon tooltip properties available for the Specify Axis block.

Property Name Description Access
Property

Type
List of Values

BalloonTooltipVectorText

BalloonTooltipPointText

Specifies text for the

balloon tooltip.

CIGS String Any string value. Type \n

to specify a line feed in the

text.
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BalloonTooltipVectorImage

BalloonTooltipPointImage

Specifies the file

name of the image

to be displayed in

the balloon tooltip.

CIGS String Specify a valid bitmap file

name from the NX library.

You need not specify the

suffix and extension.

You can also specify

the complete path of an

image file. NX supports

the following image file

formats: TIFF, PNG, GIF,

JPEG, and BMP.
BalloonTooltipLayout Specifies the

location of text

with respect to

the image in the

balloon tooltip. This

is applicable only

when both text and

image are specified.

CIGS Enum Horizontal - This is the

default value. The text is

placed to the right of the

image.

Vertical - The text is placed

below the image. Specify

this value when the image

is more than 300 pixels

wide or if the width to

height ratio of the image

is greater than 4.

Blocks with a list of balloon tooltips

The Enumeration block and String block with Combo Box presentation
provide a list of values. Therefore, these blocks have a list of balloon tooltip
properties, so that a value can be specified for each item in the list. The
balloon tooltip for each item appears when you point to the item in the list.

Property Name Description Access
Property

Type
List of Values

BalloonTooltipTexts Specifies balloon tooltip

text for each item in

the list. Each item

in the list must have

a corresponding text

value.

CIGS String List of any string values.

Type NULL for items

that do not have any text

value. Type \n to specify

a line feed in the text.
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BalloonTooltipImages Specifies the file name

of the image to be

displayed in the balloon

tooltip corresponding to

an item in the list. Each

item in the list must

have a corresponding

value.

CIGS String Specify a valid bitmap

file name from the NX

library. You need not

specify the suffix and

extension.

You can also specify

the complete path of an

image file. NX supports

the following image file

formats: TIFF, PNG, GIF,

JPEG, and BMP.

All images must have the

same size. Type NULL

for items that do not have

a corresponding image.
BalloonTooltipLayout Specifies the location

of text with respect

to the image in the

balloon tooltip. This is

applicable only when

both text and image are

specified.

CIGS Enum Horizontal - This is the

default value. The text is

placed to the right of the

image.

Vertical - The text is

placed below the image.

Specify this value when

the image is more than

300 pixels wide or if the

image width to height

ratio is greater than 4.

Enable OK/Apply Button

Code Generation options

Enable OK/Apply
Button

This callback is invoked by the dialog box that requests
whether to enable the OK and Apply buttons.

11-6 What’s New in NX 8



Programming and automation

Callbacks for Automation code

Enable OK/Apply
Button

This callback allows NX to enable or disable the OK and
Apply buttons. If the dialog box contains a Selection
Block and no selections are specified, the dialog box will
disable the OK and Apply buttons even if the callback
returns the value as True.

Callback return type — Boolean.

Possible return values —TRUE enables the OK and
Apply buttons, and FALSE disables the OK and Apply
buttons.

User Defined UI Block

What is it?

Block UI Styler now supports User Defined UI Block (UDB). You can:

• Create a UDB using the blocks available on the Block Catalog palette.
The automation code and catalog file are generated and newly created
UDB is automatically added to the palette.

• Reuse UDB that is previously saved in the pallete and insert it in dialog
boxes like any other block.

• Create a UDB that contains another UDB. NX allows multiple levels of
reusability.

A block defines the UI constituents. The automation code defines the
behaviour of the UDB and the catalog file defines the placement of the block
on the palette. The automation code for the dialog box is built with the
automation code used for the UDB automation code (or library) to create an
application library. The automation code for the dialog box and the UDB
must be in the same language.

The file extensions are as follows:

• Block — .dlx

• Automation code — .vb, .cs, .cpp, or .java based on the code generation
option

• Catalog file — .udx

The application library, the library of blocks, and the dlx files for the dialog
box and UDB complete the application. The dialog box is launched when
the application library is executed.
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NX allows multiple catalog files for better catalog management. The location
of these catalog files follows the same rules as specified for the dlx file for
the dialog box.

Where do I find it?

Application Block UI Styler
Menu Start®All Applications®Block UI Styler
Location in dialog
box

Dialog dialog box®Type group®from the list, select
User Defined UI Block

Knowledge Fusion

Automation Package Deployment

What is it?

This enhancement lets you use Teamcenter to deploy or upgrade automation
applications such as Knowledge Fusion, Check-Mate, or NX Open in NX. An
automated deployment or update must have the following components:

• The compressed automation package files saved in Teamcenter as an
item revision dataset.

• A list of item numbers for the automation packages saved in a text file.

• An environment variable that will be turned on by the deployment
administrator every time a deployment or an update needs to occur.

After these components are in place and the environment variable is turned
on, the deployment starts when users launch NX.

Cloning Knowledge Fusion components

What is it?

This enhancement automatically updates the values of the File_Name
attribute in appropriate Knowledge Fusion instances when you clone,
rename, import, or export an assembly. The updated attribute values refers
to the file name of the newly created part files.
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Where do I find it?

Application Assemblies

Prerequisite
You must have Knowledge Fusion components in the
assembly.

Menu

Assemblies® Clone® Create Clone Assembly

File® Import

File® Export

File® Save As
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12 Videos with audio

Videos with audio
Beginning with this release, the video examples included with the Help now
include voice-over narration. This narration provides important information
about the steps being demonstrated.

For each video, you can use the options on the play bar to display closed
caption text or to mute the narration.

Sample videos:

Where do I find it?

Videos are available in help topics where you see the Video
button or from the Video examples page in the Design, Manufacturing, and
Advanced Simulation Help.
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